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Conductor

About the Conductor

Overview of the QALoad Conductor

Use the QALoad Conductor to configure, run, and monitor aload test that utilizesthe scriptscreated in the
Script Development Workbench. The Conductor controlsthe QALoad Players and manages tests while they
arerunning. When the Conductor process stops for any reason during aload test, the associated Player
processes automatically terminate.

The primary windowsin the Conductor are:

I Conductor Sart Page - Thisisthe page that appears when you first open the Conductor. From the
Sart Page, you can open an existing Conductor session, create a new session, configure the
Conductor, or open the Test Configuration Wizard.

Once you create or open a session, the main Conductor window appears. The Conductor'sinterfaceis
dynamic — it changes depending whether you are setting up atest or running atest.

I Test Setup Interface - Thisisthe first window that appears when you open asession in the
Conductor. Beforerunning atest, you must set up general test options, configure Player
workstations, assign compiled test scriptsto Players, and set up monitoring options. You then save
thetest setup in afile called a session ID. Once you have configured and saved atest session 1D,
you can reuse it without re-entering any test information.

The Test Setup Interface presentstwo ways you can enter information about your test:

I TheVisual Designer isthe Conductor's main window. The Visual Designer graphically displays
a collection of iconsand nodesthat represent your test session. Use thisto enter information
about your test and set up the machines and scripts for the test.

I The Grid View window presents another way to perform these functions. The Grid View isa
dockable window that containstwo tabsin which you can enter the information for your test
session.

I RuntimeWindow - While atest isrunning, the Conductor interface changesto the Runtime
Window, which facilitates monitoring of individual machines and Players, and displaysreal-time
test results. You can view default graphs of performance datathat are created for you by the
Conductor and create custom graphsbased on the data being collected during the test. You can
save custom graph layoutsin the session ID file and reuse them in future tests.

QALoad Conductor Menus and Toolbar Buttons

The Conductor's menus and toolbar buttons are dynamic; their content depends on whether you are
opening the Conductor from the Sart Page, preparing atest setup or running atest.

Start Page
File

Edit
Actions

Tools

2
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Help
Sart Page Toolbar Buttons

Test Setup

The Conductor Configuration and Setup Menus allow you to configure the Conductor and your specific
test. The menus and toolbars are:

File

Edit

View

Actions

Tools

Help

Configuration and Setup Toolbar Buttons

Running a Test

Usethe Conductor's Runtime menus and toolbar to control your running test and the datathat is
displayed at test time. The menu names are:

View

Runtime Windows
Graph

Actions

Tools

Runtime Toolbar Buttons

Accessing the Conductor

The following procedure describes how to start the Conductor.

To start the QALoad Conductor from Windows:

Click Start>Programs>Compuware>QALoad>Conductor. The Conductor Sart Page appears.

To start the Conductor from the command prompt:

Type conductor <session_file nane> /| /e /a /t

The applicable parameters are defined in the following table.

Param eter Definition

/1 (Optional) Creates a log file showing error messages
and test status.

/ e (Optional) Exitsthe Conductor when the test
completes.
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/ a (Optional) Launches Analyze when the test
completes.
/'t (Optional) Executes Conductor at a set time. Valid

timeformatsare/t xx: xx or
[t xx/ xx/ xx [t xx:xx.

The Conductor start page appears.

Using the Conductor Start Page

When you first start the Conductor, the Sart Page displays. This provides a concise selection of optionsto
help you start defining or modifying a Conductor session.

From the Sart Page, you can perform the following tasks:

Recent Session
In the Recent Sessions section, you can:
I Create anew test session

I Open an existing session

Tasks
In the Tasks section, you can:
I Open the Test Configuration Wizard
I Create monitoring tasks
I Edit monitoring tasks
I Discover and verify Player machines

I Configurethe Conductor session options

Help

Usethe selectionsint he Help section to accessthe QALoad online help and Compuware's FrontLine
website.

Test Setup Interface

Overview of the Test Setup Interface

The Conductor providestwo methods for designing atest session: the Visual Designer and the Grid View.
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Visual Designer

The Conductor'smain window isthe Visual Designer. The Visual Designer consists of three partsthat you
use to create the test session:

I Visual Designer window - contains a series of nodes displayed in atree view. The session displays as
thetop-level node, whilethe scriptsin the session are represented as nodes underneath the session.

! Players/Groups panel - Thisisa dockable panel the appearson the left-hand side of the window. It
displays all Playersand Groups available for the session.

I Properties panel - Thisis a dockable panel the appearson theright-hand side of the window. Select
asession node, a script icon, or a Player machinein a script node to display information and set
optionsfor each one.

You can assign player machinesto a script by dragging a player or a player group from the Player/Groups
panel and dropping it into the script in the Visual Designer window. Review and update properties of the
test elementsin the Properties panel.

In addition, the Visual Designer'stoolbar provides accessto standard Windows functionality, such as Print
and Copy, aswell as quick accessto Conductor setup optionsand to QALoad Analyze.

*% Conductor. - [Untitled3. 10}

Fie Edic Yiew Actions Took Help
@ & =R E ) 'ﬂ‘f} fesign Scripts. .. y_@ hszsign PlayersGroups. .. E'S.: Test Carfigurabion Wizard & Review Yirtual Users o pun @8 T2 r
FlapersGioup: = 3 B - = = Task Configiration wizard o specty the desitad sorpts Tor thi SRRt IR | Propeitie: * 0 X
WU configurafions ko ran for sac 18
dw108872d01 || &[5k (B
AN | i
dewd 1742041 Untitlad21D Wiers b
7S | e e ——— —
dbwl1797541 | Tokal¥U's  Staring: B Endng @ Desciption
diw118316 : taniar tazk: | W B | EmablzRe: Falee
diwi3a002d0 . Erch - Seszion Do 00:00:00
dbw 55RO | ) nebie mankormg e
dbw 37 Ed5d0n | i T
W vMiPeROsP2 || i 1
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Grid View

Alternately, you can open the Grid View to enter test information and set up the machines and scripts for
thetest. The Grid View isa dockable window that appears at the bottom of the Visual Designer window.
Changes madein the Grid View appear in the Visual Designer.

The fieldsyou use to set optionsfor your load test are displayed in two tabs:

I Script Assignment tab - where you set up optionsfor any scriptsthat have previously been recorded
and compiled.

I Machine Assignment tab - where you assign scriptsto specific Player workstations, starting and
ending virtual users (VU), VU increments, and timing intervals.

The Grid View toolbars provides access to the main functions of assigning scripts and playersto your load
test session.

| | Ass
E 3 p—— _‘
~: |
Script Assignment | Machine Assigrment
"'5 Mew % Remove 3¢ Remowe All
Scrpt Mame + Middleware + Tranzaction: 8 Debug Options + Emor Handling + Pacing H T
# " Click here to add a new scnpt agzignment
p = google.cpp Wt 1 LNoREr Restart Trangzaction 00: 00:07.000
& ntm.cpp Wi 1 LNonEr Restart Tranzaction 00: 00:07.000
1w aoll.cpp i 2 <noner Fiestart Transaction 00:00:01.000

Visual Designer

Using the Visual Designer

The Visual Designer isthe main window, the test setup interface, that displays a collection of iconsand
nodesthat represent your test session. The top level nodeisthe current test session, and the child nodes
represent the scripts assigned to the session.

Usethe Visual Designer to enter information about your test and set up the machinesand scriptsfor the
test using the two panelsin the Visual Designer window:

I Players/Groups panel - Thisisatwo-tabbed window that list theinstalled QALoad Playersand any
groupsin which they are members. Assign Players and groupsto individual scripts by dragging and
dropping them into the script nodes.

! Properties panel - Thisisadynamic panel on theright-hand side of the Visual Designer that
changes content depending on the view you choose. Use the Properties panel to setup and review
configurationsfor session, script, and Player properties.

0 Session properties - Click the top-level Session node to display session propertiesin the Session
Properties panel. Use the Session Properties panel to enable recording and set session duration.
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0 Script properties - Click the script icon @ for any individual script to display its propertiesin
the Script Properties panel. Use the Script Properties panel to set optionsfor Application
Vantage, external filesand datapools, and additional script properties, such as debug options,
error handling, number of transactions, and timing options.

o Player properties - Click an individual Player in a script nodeto view it's propertiesin the Player
Properties panel. You can set starting and ending virtual users (VU), VU increments, mode and
timing intervals, and set expert user options.

Use thetoolbar buttonsto assign scripts, assign playersand groups, or to open the Test Configuration
Wizard, where you can easily configure your test session.

Using the Properties Panel
Usethe Visual Designer's Properties panel to review test information and setup test optionsfor:

Sessions - The session properties are displayed when you click on the Session node of the Visual Designer.

Scripts - Script properties for an individual script are displayed when you click on the script icon @ for
the selected script in the Visual Designer.

Players - Player properties for an individual Player are displayed when you click on a selected Player within
the script node in the Visual Designer.

Using the Player/ Groups Panel

The Players/Groups panel is a dockable, tabbed window on the left-hand side of the Visual Designer
window. It display alist of all players and all groups available for this session. You can drag and drop
individual Playersand Player groupsto the script nodein the Visual Designer to assign the script to the
Player or group.

To display available Players:

Click the Playerstab at the bottom of the Players/ Groupswindow to display alist of all players available
for this session.

To display available Player groups:

Click the Groupstab at the bottom of the Player/Groups window to display alist of all groupsto which
available players belong.

Grid View

Using the Grid View

You can usethe Grid View to enter test information about your test and set up the machines and scripts
for thetest. The Grid View containstwo tabs:

I Script Assignment tab - Use thistab to set up optionsfor any scriptsthat have previously been
recorded and compiled. Any scriptsyou add here areincluded in your load test, and one virtual
user isautomatically assigned to your script on the Machine Assignment tab. After setting up your
scripts here, you must assign additional virtual usersto your script from the Machine Assignment
tab.
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I Machine Assignment tab - Usethe Machine Assignment tab in the Grid View to assign scriptsto
specific Player workstations. You also assign starting and ending virtual users (VU), VU increments,
and timing intervals.

To open the Grid View:

Click View>Grid Window. The Grid View pane appears below the Visual Designer window.

Using the Script Assignment Tab

Use the Script Assignment tab in the Grid View window to assign scriptsto atest session, set middleware
optionsfor SAP and Citrix scripts, assign external data filesto a script, and set general script options. Use
the Script Assignment toolbar to add or remove items. Optionsyou select in the Grid View window are
reflected in the Script Properties panel on theright-hand side of the Visual Designer window.

To accessthe Script Assignment tab:

1. In the Conductor, click View>Grid Window. The Grid View window appears at the bottom of the
Visual Designer window.

2. Click the Script Assignment tab.
Use the Script Assignment tab to:
Assign a script to atest session
Assign External Data options
You also can set:
Middleware Options for SAPGUI and Citrix
Number of transactions
Debug Options
Error Handling Options
Pacing
Timing options

Seep Factor percent

Using the Machine Assignment Tab

Usethe Machine Assignment tab in the Grid View window to replace scriptsin atest session, assign a
player to a script, set Expert User options, and set Virtual User configurations. Usethe Machine Assignment
toolbar to add, remove, or sort itemsin the display. Optionsyou select in the Grid View window are
reflected in the Player Properties panel on theright-hand side of the Visual Designer window.

To accessthe Machine Assignment tab:

1. In the Conductor, click View>Grid Window. The Grid View window appears at the bottom of the
Visual Designer window.

2. Clickthe Machine Assignment tab.

Usethe Machine Assignment tab to:
8
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Replace a script in atest session
Soecify Virtual User Configurations
Enable the Expert User (WWW only)

Runtime Window Interface

Runtime Window Interface

When you start atest, the Conductor'sinterface changesto an interactive test control station called the
Runtime Window. The Runtime Window displaysinformation about the scripts, machines, and virtual
usersthat are executing the load test. The Runtime window isdivided into two areas—the main Runtime
window, and the dockable Runtime Options panel at the bottom of the window.

On the Runtime Window, you can observe the progress of individual scriptsand Player machines, view
real-time graphs, and start or suspend scriptsand Players from arunning test to better smulate the
unpredictability of real users. The Runtime main window dynamically displaystest details according to the
type of information you select in the Active View field.

The lower pane, the Runtime Options panel, displays data for the current view and the individual script
you select. Thisisadockable control station that allowsyou to change virtual user optionsand data
transfer optionswhile your test isrunning.

EBX

#, Conductor - [Run Time]

File Edit Wiew Rontime Windows  Graph Ackions  Tools  Help

-..,; _{_} = @ Active View:  all Yirtual Users hd j_—_'_} -i—

nﬁ‘

B0 . [x

Ulzer Script td achine FPaszz Fail it LET Last
- capture_webser.. | dbwl14310401

Wirtual Uzer Options
Allvirtual Deers

Script Optiohs | Global Options I

Dial UpsDoven

Currently Bunning/dwvailable:  0/0

Change Running To: Apply

Test Time: 00:00:00  Last Update: 00:00:00
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Runtime Window

When you start atest, the Conductor'sinterface changesto an interactive test control station called the
Runtime Window. From the Runtime Window, you can observe the progress of individual scriptsand
Player machines, create real-time graphs, and change the behavior of scriptsand Playersfrom arunning
test to better simulate the unpredictability of real users. Thiswindow hastwo unique areas:

! Runtimemain window - Theinformation in the main Runtime window dependson the view you
select in the Active View field. You can view details for all test scripts, individual test scripts, all
player machines, and individual player machines.

I Runtime Options Panel - The lower pane, called the Runtime Options Panel, displays data for the
current view and theindividual script you select. Thisisadockable control station that allows you
to change virtual user optionsand datatransfer optionswhile your test isrunning. The
information in the Runtime Options panel isdisplayed in three tabs: Virtual User Options Tab,
Script Options Tab, Global Options Tab.

BElements of the Runtime Window

Active View Detalils

Detailsfor arunning load test are displayed in the Runtime main window. The details displayed depend on
the option you select in the Active View field. You can choose:

All Virtual Users

Virtual Users by Script
Virtual Users by Machine
All Sripts

All Player Machines
GraphsView

Sessions View

All Virtual Users

Liststhe script and player machine involved in the test and other detail information by each virtual user.
Double-click a virtual user to display the Virtual User Info window. Select this option to view details about
each virtual user running a script in the test:

Statusicon: Thefirst column displaysan icon that indicatesthe status of the virtual user. A moving icon
representsarunning virtual user; a still icon representsa virtual user that hasn't yet started or is suspended;
and an icon with acheckmark through it representsavirtual user that has exited. A red circle with an X
indicates errors have occurred on that virtual user, or that the test session was manually terminated using
the Exit, Abort, or Quit Current Test buttons.

User: Virtual User'sidentification number assigned by QALoad.

Script: Name of the script the virtual user isrunning.

Machine: Name of the Player machine on which the script isrunning.

Pass. Number of transactions successfully completed.

Fail: Number of transaction that have failed to complete successfully.

Min: Liststhe shortest response time recorded for atransaction on the virtual user.

Max: Liststhe longest response time recorded for atransaction on the virtual user.

10
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Last: Liststhe most recent response time recorded on the virtual user.

Status: Listsa status for the virtual user if any errorshave been encountered, or liststhe name of the
checkpoint the user hasencountered if the option Send all timing dataincluding Checkpoint information
was selected on the Runtime window of the Session Optionsdialog box during test setup. Double-click a
virtual user for more information, or if the error message isto long to read.

Errors:

Error Message:

El Note: Double-click in any field to display the Virtual User Info dialog box with the details about each
virtual user.

Virtual Users by Script

Lists Virtual User and Player machine information within each assigned script. Double-click a virtual user
to display the Virtual User Info window. Select this option to view the following details for each virtual
user sorted by script:

User: Virtual User'sidentification number assigned by QALoad.

Machine: Name of the Player machine on which the script isrunning.

Pass: Number of transactions successfully completed.

Fail: Number of transaction that have failed to complete successfully.

Min: Liststhe shortest response time recorded for atransaction on the virtual user.
Max: Liststhe longest response time recorded for atransaction on the virtual user.
Last: Liststhe most recent response time recorded on the virtual user.

Status: Listsa status for the virtual user if any errorshave been encountered, or liststhe name of the
checkpoint the user hasencountered if the option Send all timing dataincluding Checkpoint information
was selected on the Runtime window of the Session Optionsdialog box during test setup. Double-click a
virtual user for more information, or if the error message isto long to read.

Errors:

Error Message:

2l Note: Double-click in any field to display the Virtual User Info dialog box with the details about each
virtual user.

Virtual Users by Machine

Lists Virtual User and script information within each assigned player machine. Double-click a virtual user
to display the Virtual User Info window. Select thisoption to view the following details for each virtual
user sorted by Player machine:

User: Virtual User'sidentification number assigned by QALoad.

Script: Name of the script the virtual user isrunning.

Pass: Number of transactions successfully completed.

Fail: Number of transaction that have failed to complete successfully.

Min: Liststhe shortest response time recorded for atransaction on the virtual user.
Max: Liststhe longest response time recorded for atransaction on the virtual user.
Last: Liststhe most recent response time recorded on the virtual user.

Status: Listsa status for the virtual user if any errorshave been encountered, or liststhe name of the
checkpoint the user has encountered if the option Send all timing dataincluding Checkpoint information
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was selected on the Runtime window of the Session Optionsdialog box during test setup. Double-click a
virtual user for more information, or if the error message isto long to read.

Errors:

Error Message:

Note: Double-click in any field to display the Virtual User Info dialog box with the details about each
virtual user.

All Scripts

Listsdetail information for each script assigned to the test. Select thisoption to display the following
summary details about every script in the test:

Script: The name of the script.
Total Users: The total number of virtual users assigned to run the script.

Running: The total number of virtual users currently running the script. Thisnumber may vary at different
timesin asingle test if you are configured for dial-up virtual users, or have configured the test asaramp-up
test.

Pass: The number of transactions successfully completed.
Fail: The number of transactionsthat have failed to complete successfully.
Response Time: The average response time of all virtual users currently running thetest script.

Throughput: The average number of transactions per second thisscript isrunning.

All Player machines

Lists detail information for each player machine assigned to the test. Select this option to display the
following summary information about each Player machinerunning the test.

Machine: The machine name, preceded by an icon indicating whether the test iscurrently running on the
machine or finished. A blue checkmark indicates a successfully completed test.

Total Users: The total number of virtual users controlled by that Player Agent.

Running: The total number of virtual users currently running on that Player Agent machine.
% Processor: The percentage of the Player Agent machine's processor that is currently in use.
% Memory: The percentage of the Player Agent machine'smemory that iscurrently in use.
% Disk: The percentage of the Player Agent machine'sdisk space that iscurrently in use.

Status: Listsa general statusfor the test. For example, Test isrunning.

Graphs View

Displaysreal-time graphs for checkpoints, performance counters, and Player machine health statistics. You
can control which types of data are graphed in addition to how the graphs appear. For detailed
information, refer to Graphs View.

Sessions View

Displayssummary information about the test and the Player machine. For more information, refer to
Session View
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Session View

When you select Session in the Active View field, the Conductor Runtime Window provides summary
information about the test session that iscurrently running. The Session view can be printed as areport by
right-clicking and choosing Print from the shortcut menu.

Click on the sectionsin the following graphic for more information about the Session view.
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Graphs View

The Graphsview in the Conductor Runtime Window displays graphs of data collected during the test. By
default, the Graphsview displays graphsfor response times, test status, and player machine health.

Other graphs, such asuser-defined checkpointsand Remote Monitoring counters, can also be plotted in
theright pane of the Graphsview if they were enabled for the session.
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To display graphs:

1. Right-click on acounter or other datatypein thetreeview that you want to plot in a graph.
2. Choose Add Graph or Add Plot To.

You can also modify a graph's appearance by right-clicking on the graph and choosing one of the
formatting options, such as colors and axes properties. To increase the visibility of a plot when you have
multiple plots on a graph, click on aplot (or that plot'snumber in the legend) to highlight it.
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Runtime Options Panel

This dockable control station enablesyou to change virtual user options and data transfer optionswhile
your test isrunning. The information in the Runtime Options panel isdisplayed in three tabs:

Virtual User Options Tab
Currently Running/Available: Displaysthe number of currently running Virtual Users.
Change Running To: Click the arrowsto change the number of Virtual Usersin the test.

Apply: Click to apply your changes.

Script Options Tab

Changes madein thiswindow will override options set during the original Script Assignment.

El Note: Optionson thistab are available only when Virtual Users by Script or All Scripts are selected
in the Active View.

Error Handling: Choose how to respond when an error occurs during execution of the transaction. During
large load tests, errors can sometimesindicate that the test isstraining the limits of the hardware/software
in thetesting environment. Options are:
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I Abort Transaction — If an error occurs while atransaction isbeing executed, the Player should
abort the current transaction and the virtual user who encountered the error should exit the test.
Use this option when errorswill make the virtual user invalid for executing more transactions.

I Continue Transaction — If an error occurswhile atransaction isbeing executed, the Player should
continue executing the transaction asif the error didn’t occur. Select this option when errorsare
not critical to the performance of the load test and can be safely ignored.

I Restart Transaction (WWW, SAPGUI, and Citrix scriptsonly) — If an error occurswhile a
transaction isbeing executed, the Player should abort the current transaction entirely and restart a
new transaction from the beginning. Note that the transaction count will increase for each
transaction that isrestarted.

Pacing: Enter avaluein thisfield to change therate of pacing. Pacing isthe timeinterval between the start
of atransaction and the beginning of the next transaction on each workstation running the script. For
example: if atransaction isdesigned to duplicate the process of someone handlingincoming telephone
callsand those calls arrive at arate of 40 per hour/per person, set the pacing rate at 90 seconds.

Sleep: QALoad recordsthe actual delays between requests and insertsthe DO_S_EEP command in the
script to mimic those delayswhen the script is played back in atest. You can maintain the exact length of
therecorded delays at playback, or shorten them by entering a smaller percentage of the originally
recorded delay to play back. For example, if you recorded a delay of 10 secondsthen DO_S EEP (10); is
written to your script. Then, if a Seep Factor of 50% is specified here, the Player will sleep for 5 seconds at
that statement when the test is executed.

Apply: Click to apply your changesto therunning script.

Cancel: Click to cancel any changes you have not yet applied to the running script.

Global Options Tab
Global Optionsapply to all scripts.

Timing Updates: Select when the Playersin your test should send timing information to the Conductor.
You can choose:

No Updates- No timing updates are sent to the Conductor
Send All - Sends all timing updatesto the Conductor

Periodic Updates - If you chose Periodic Updates, type how often, in seconds, timing updates should
be sent to the Conductor in the (1 - 1000 Sec.) field.

Apply: Click to apply your changesto therunning script.

Cancel: Click to cancel any changesyou have not yet applied to the running script.

Setting Up the Conductor

About Setting Up a Test

When you set up aload test, you set optionsrelated to general Conductor behavior aswell asinformation
about your specific test environment. Before you can successfully set up aload test, you must have
recorded and compiled one or more test scripts. For information about recording a test script, see
Developing <cripts.

Determining General Conductor Behavior

General Conductor optionsyou set are applicable for all testsrun until you change the options. Conductor
optionsarerelated to the following:
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I Viewing optionsfor real-time results
I Global Player options

! Player machine performance data

I Optionsfor runtime reporting

! And more...

All of the above information, and more, can be configured on the Conductor's Optionsdialog box.

Setting Up a Specific Test Session

To prepare the Conductor for a specific test, save information and parameters specific to that test into a
reusable session ID file (.id). You must enter the following types of information to set up atest's session 1D
file:

I General information about the test such asa description, the size of the database, the length of the
test, and any notes or comments

I Information about the test script(s) included in the test, including script name,
middleware/protocol type, pacing, whether to include external data, and so on

I Information about the workstationswhere the QALoad Playersreside, including which script is
assigned to each workstation, how many virtual users are assigned to each workstation, the
machine name, and so on.

All of the above information can be entered and saved when you set up atest from the Conductor's main
window or by using the Test Configuration Wizard. Once you open the new session in the Conductor, you
can do thefollowing:

I (Optional) configuration for server monitoring
I (Optional) integration with other Compuware products

Generating Random Number Seeds

Random number seeds are used to inject random delaysin script execution for each load test. The seed (or
value) isautomatically generated by QALoad. The random value used within the end of transaction
function isused to generate the pacing time. The Player uses a system-generated sequence of numbers, so
that each virtual user (VU) hasits own seed value.

Setting Up the Conductor

To prepare for running aload test, you must set up the Conductor.

To set up the Conductor:

1. Sart the Conductor.

2. Configurethe Conductor. After starting the Conductor, you may need to verify that the
Conductor’s configuration parameters are set properly.

3. Set Up aSession ID Fle. For every test you run, you must create a session ID file containing
information the Conductor needsto run thetest, such aswhich scriptsto run, which Player
machinesto use, and whether to collect server or performance monitoring data. Use the
Conductor's Visual Designer or Grid View window to create and save session ID filesin the
\ QAload\ Session directory.

16



QALoad Online Help

Configuring the Conductor

There are several settings for the Conductor that you should review before beginning your load test.

To set Conductor session optionsthat are not specificto one test:

1. Do oneof thefollowing:
I From the Conductor Sart Page, click Session Optionsin the Tasks area.
OR
I With asession open, click Tools>Options.

2. On the Optionsdialog box, set optionsrelated to post-test activity, warnings and prompts, runtime
grids, timing settings, interface refresh intervals, Conductor/Player communications, monitoring
intervals, and more. For detailed descriptions of the optionsthat are available, see Optionsdialog
box.

3. When you arefinished, click OK to save your changes. Any optionsyou set apply to all tests until
you change them.

Setting Up a Test

Starting a Session

Creating a New Session
When you open the Conductor, the Conductor Sart Page appears. Use these proceduresto create a new
session.

El Note: If you choose not to display this page, the Conductor opensto the Visual Designer window.
You can choose to show the Sart Page again in the Sartup page of the Conductor Sessions Options
dialog box.

To create a new session from the Conductor Start page:

1. Do oneof thefollowing:
I In the Recent Sessions area, click New.
OR
I Inthe Tasksarea, click New Session.

In the Name field of the Create New Session dialog box, type aname for the test session.

n

(Optional) In the Description field, type a description for the session.

4. (Optional) Select Launch Test Configuration Wizard to open the Test Configuration Wizard to
create your session.

5. Click OK.

If you do not select the option to use the Test Configuration Wizard, the Conductor openswith the session
you created displayed in the Visual Designer. You can begin to setup your test session.

To create a new session in the Visual Designer:
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1. With asession open in the Visual Designer window, click File>New. A confirmation dialog box
promptsyou to Save or discard changesto your current session. The Create New Session dialog box

appears.
2. Inthe Namefield, typeaname for the new session.

(Optional) In the Description field, type a description for the new session.

4. (Optional) Select Launch Test Configuration Wizard to start the Test Configuration Wizard,
which walks you through creating aload test session. If you do not select thisoption, the new test
session opensin Conductor's Visual Designer, where you can manually configure the load test
session.

Opening an Existing Session
When you open the Conductor, the Conductor Sart Page appears. Use these proceduresto open an
existing session.

Note: If you choose not to display this page, the Conductor opensto the Visual Designer window.
You can choose to show the Sart Page again in the Sartup page of the Conductor Sessions Options
dialog box.

To create a new session from the Conductor Start page:

1. Do oneof thefollowing:
I In the Recent Sessionsarea, click the name of the session to open.
OR
I Click Open Session, then select the name of the appropriate saved session, and click Open.

2. The Conductor's Visual Designer openswith the session you selected displayed. You can make any
changesto the session or run the load test.

To open an existing session in the Visual Designer:

1. From the Visual Designer window, click File>Open. A confirmation dialog box promptsyou to
Save or discard changesto your current session.

2. Select thename of the appropriate saved session, and click Open. The selected test session opensin
Conductor's Visual Designer, where you can manually configure the load test session.

Setting Up a Test Session

You can enter all theinformation necessary for your session ID filein the Conductor using one of the
following methods:

I Grid View window
! Visual Designer

I Test Configuration Wizard
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Assigning Scriptsto the Test Session

Script Assignment

Usethe Assign Scripts button on the Visual Designer toolbar, or the Script Assignment tab in the Grid
View window to set up any scriptsthat have previously been recorded and compiled. Any script you add
hereisincluded in your load test, and one virtual user isautomatically assigned to your script. After setting
up your scriptshere, you must assign additional virtual usersto your script from the Properties panein the
Visual Designer, or from the Machine Assignment tab in the Grid View window.

You can also add scriptsto atest session using the Test Configuration Wizard. For more information, see
About the Test Configuration Wizard.

Adding a Script to a Test

To add a script to a test session:

1. OntheVisual Designer toolbar, click Assign Scripts...
OR

In the Grid View window, click the Script Assignment tab, then click New in the toolbar. The
Assign Scriptsdialog box displays.

2. IntheMiddleware Type box, select your middleware type.

3. From thelist of available scriptsthat appearsin the Available Scripts pane, highlight a script name
and click * . The script ismoved to the Selected Scripts pane.

Note: To select more than one script, hold down the Ctrl key and click then scriptsto select, the click
# . To select all scriptsin the Available Scripts pane, click adl

4. Click Next to display the script transaction configuration dialog box.
In the Selected Scripts pane, highlight a script.

6. In the Transactionsfield, specify the maximum number of transactionsthat you want each virtual
user running thisscript to run. Once aworkstation executesthe number you specify, script
execution continueswith theline following the End_Transaction command rather than jumping
to the beginning of the transaction loop.

7. Enter avalue, in seconds, in the Pacing field. Pacing isthe time interval between the start of a
transaction and the start of the next transaction for each virtual user running a script.

8. Enter avaluein the Sleep Factor % field to specify the percentage of any originally-recorded delay
to preservein the script (for example, a value of 80 means preserve 80% of the original delay).
Valid values are 0-1000, or Random. The default value is 100%.

9. To apply these optionsto all scriptsin the Selected Scripts pane, click Apply thisto all selected
scripts.

10. Click Finish to save your changesto the current session ID file.
Replacing a Script in a Test

You can replace a script in atest session using the Visual Designer or the Grid View window. Use the
following procedure to replace a script in atest:
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To replace a script using the Visual Designer:

1. In the Conductor'smenu bar, click Actions>Replace Script. The Select Replacement Script dialog
box appears.

In the Middleware Type field, select the middleware environment of the replacement script.
Select the replacement script, then click OK.

4. Assign the script to Player machines, if necessary.

To replace a script using the Grid View window:

1. In the Grid View window, click the Machine Assignment tab.

2. Inthe Sript Name field, select the script to replace, then select the new script from the drop-down
dialog box.
3. Assign the script to Player machines, if necessary.

Removing a Script or a Player from a Test

To remove a script from a test:

1. Right-click on the script icon § for the appropriate script, then select Remove Script.

2. In the confirmation dialog box, click Remove.

To remove all scriptsfrom a test:

1. Click Actions>Remove All Scripts.

2. In the confirmation dialog box, click Remove.

To remove a single Player from atest:

1. In the script test setup node, right-click on the Player to remove, then select Remove Selected.

2. In the confirmation dialog box, click Remove.

To remove all Playersfrom atest:

1. Click Actions>Remove All Players/ Groups.

2. In the confirmation dialog box, click Remove.

Assigning Player Machines

Machine Assignment

Usethe Assign Players/Groupsbutton on the Visual Designer toolbar, or usethe Machine Assignment
tab in the Grid View window to open the Assign Players/Groupsdialog box and assign scriptsto specific
Player workstations. You also can drag and drop individual Player machinesin selected script test setup
nodesin the Visual Designer.
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Assigning Scriptsto Player Workstations

Once you've added scriptsto your test session, you must assign scriptsto Player workstationsand set up
Virtual User configurations. You can use:

! thedrag and drop method from the Players/Groups panel
! thetoolbar in the Visual Designer

I theMachine Assignment tab in the Grid View

To assign playersusing the drag and drop method from the Players/ Groups panel:

1. Select amachine or group from thelist in the Players/Groupswindow, then drag and drop it into
the appropriate script test setup node. The Configure All Players/Groups dialog box appears.

2. Usethearrow keysin each field to set the following options:

I Starting VUs - Number of Virtual Usersto launch the script on the machine when the test
begins.

! Ending VUs- Number of Virtual Usersat the end of the test.

I VU increment - Number of virtual usersto add at intervalsthroughout the test.

I Timeinterval - Timeinterval at which incremental virtual users should be added to the test.
! Mode- Thetest mode for the machine. You can select thread based or process based.

3. To usethese optionsfor all playersand groupsin the script, click Assign to all selected players
and groups.

4. Click Finish.

Click File>Save in the Conductor main menu.

To assign playersusing the toolbar in the Visual Designer:

1. Click the appropriate script icon in the Visual Designer.

2. Click the Assign Players/ Groups button @ in thetoolbar. The Assign Players/Groups dialog box
appears.

3. elect the Player machine or group, then click Next to display the Configure All Players/Groups
dialog box.

4. Click thearrowsin thefieldsto set the following options:

I Starting VUs - Number of Virtual Usersto launch the script on the machine when the test
begins.

! Ending VUs- Number of Virtual Usersat the end of the test.
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I VU increment - Number of virtual usersto add at intervalsthroughout the test.

=l Note: If you add incremental virtual users, you must designate the timeinterval and the ending
virtual users.

I Timeinterval - Timeinterval at which incremental virtual usersshould be added to the test.
! Mode- Thetest mode for the machine. You can select thread based or process based.

5. To usethese optionsfor all playersand groupsin the script, click Assign to all selected players
and groups.

6. Click Finish.

7. Click File>Save in the Conductor main menu.

To assign playersusing the Grid View:

1. IntheMachine Assignment tab, click the down arrow in the Player Name field, then select a
player from thelist.

2. (Optional - WWW only) In the Middleware field, click the browse [...] button to open the Expert
User Optionsdialog box. If you enable the Expert User, select the Virtual User number to represent
the Expert User.

3. Click each of the following fields to set optionsfor:

I Sarting VUs - Type the number of Virtual Usersto launch the script on the machine when the
test begins.

I Ending VUs- Typethe number of Virtual Usersat the end of the test.

I VU Increment - Usethe arrowsin thefield to set the number of virtual usersto add at intervals
throughout the test.

I Timing Interval - Click the browse [...] button in the field to open the Set Time Interval dialog
box. Set the timeinterval at which incremental virtual users should be added to the test.

=l Note: If you add incremental virtual users, you must designate the timeinterval and the ending
virtual users.

I Mode- Usethearrowsin thefield to select the test mode for the machine. You can select
thread based or process based.

4. Click File>Save in the Conductor main menu.

Adding Player Machinesto a Test Session

Follow these instructionsto add a Player workstation to your pool of available Playersin atest's session ID
file.

To add a new Player machine:

1. From the Conductor's main menu, click ToolssSManage Players. The Manage Players/ Groups
dialog box displays.

2. Click FilesNew>Player. A new page displaysin the detail area of the dialog box, where you enter
information and settings for the new Player.

22



QALoad Online Help

To enter information and settings for the new Player:

Enter information for the new Player in the following areas of the dialog box.
In the Player Information area:
1. IntheMachine (hostname or IP) field, type aname for the Player Machine.

2. IntheCommunications[TCP] port field, type the port number the Conductor should useto
communicate (using TCP) with thismachine during atest. The default is 3032.

3. Click Verify to check that the machineisactive. The Player or Agent returnsthe operating system,
processor type, amount of memory, and the maximum threads and processes available on the
machine.

El Note: If a Player does not respond, a message box appearsindicating that the Player is not
responding. If the Player isnot responding, one of the following scenariosis likely:

I Thehost name and/or port number you entered may not be correct. Check your parameters
and network connections, then try to send another request.

I ThePlayer isnot running. Sart the Player and then try to send another request.
Expand the Machine Settings area (Optional):

4. Select desired optionsto ping the host before attempting connection to the player, generate IP
spoof data, or override the default machine settings.

5. Closethe Machine Settings.
Expand the Group Membership area (Optional):

6. In the Available Groups pane, select a group to which you want this Player Machine added, then
click Add.

7. The selected groups are moved to the Member of Groups pane.

8. Closethe Group Membership.

2l Note: You also can add a Player to a Group by dragging and dropping the Player from thelist in the
Players area to the appropriate Group in the Groups area, or by dragging and dropping a Group in
there Groups areato a Player int he Players area.

In the ApplicationVantage Settings area:

El Note: The fields on thistab are available only if ApplicationVantage isinstalled on the Player
Machine and ApplicationVantage Mode is selected when you choose a script in the Script Assignment
tab.

From the drop-down list in the NIC Name field, select the Network Interface Card (NIC) that isused by
the machine, if necessary.

To save the Player machine:

Click Save, then click OK. The Player Machine appearsin the Manage Players and Groups dialog box
in the All Player Machines and Groups tree.

Saving Machine Configurations

After configuring the machinesto use for aload test, you can save the machine configuration information
into a configuration file (.cfg) that can bereused in later tests. This saves you significant time setting up
later tests. A configuration fileincludesinformation about which machineson the network were used as
Player machines. You can save multiple configurations under different names. By default, when first using
QALoad, the Conductor uses a configuration file named Def aul t . cf g. The Conductor saves any changes
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to your machine configurationsto thisfile unless you save your configuration to a new file with a different
name.

You can open or save .cfg files from the Manage Players/ Groups dialog box. The .cfg field always displays
the active configuration.

To create a new, empty .cfg file:

1. On the Conductor toolbar, click ToolsSManage Players. The Manage Players/ Groups dialog box
displays.

Click FilesNew>Player or click the New icon =1 " on the toolbar.

In the Player Information area of the window, type anamein the Machine [hostname or IP] field.

Click File>Save as... On the Save As dialog box, specify aname for the new file and click Save.

N

Add the necessary Player and agent machinesusing the fieldsand buttonson the Manage
Players/Groups dialog box. The machinesyou configure are saved automatically to the file you
just created.

To rename the current .cfg file:

1. On the Manage Players/Groups dialog box, click File>Save As...
2. On the Save Asdialog box, specify aname for the new file and click Save.

3. Make any necessary changesto the configuration. Your changes are saved automatically to the file
you just created.

To open a previously created .cfg file:

1. On the Manage Players/Groups dialog box, click File>Open. The Open Machine Configuration
dialog box displays.

2. Choosethe .cfgfileto open.

El Note: The .cfg fileonly storesinformation about Player machines. It does not store information
specific to a test, such as script names or settings. Test specific information is saved in the session ID file.
A session ID file for a specific test savesthe name of the .cfg file associated with that test, and opensit
automatically when the session ID fileisopened. You can change the .cfg file at any time without being
concerned about the session ID file.

Removing a Script or a Player from a Test

To remove a script from a test:

1. Right-click on the script icon g?) for the appropriate script, then select Remove Script.

2. In the confirmation dialog box, click Remove.

To remove all scriptsfrom a test:

1. Click Actions>Remove All Scripts.
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2. In the confirmation dialog box, click Remove.

To remove a single Player from a test:

1. In the script test setup node, right-click on the Player to remove, then select Remove Selected.

2. In the confirmation dialog box, click Remove.

To remove all Playersfrom atest:

1. Click Actions>Remove All Players/ Groups.

2. In the confirmation dialog box, click Remove.

Setting Script Properties

Enabling and Disabling ApplicationVantage Mode

Use the Script Properties panel to enable ApplicationVantage mode. This option isonly available if
ApplicationVantageisinstalled on the Player machine.

El Note: Setup the ApplicationVantage settings using the Tools menu, then selecting Manage Playersto
open the Manage Players/Groups dialog box.

To enable ApplicationVantage mode from the Script Properties panel:

Click the script icon § for the appropriate script to display the Script Properties panel on theright-had
side of the window. In the Script Properties panel, click the ApplicationVantage Mode field, then use the
arrow key to enable or disable ApplicationVantage mode. Selecting:

I Trueenables ApplicationVantage mode

I False disables ApplicationVantage mode

Setting External Data Options

Usethe external data optionsto add or remove attached files, specify a central datapool file, or specify
local datapool filesused by your script. You can setup external optionsusing the Script Properties panel in
the Visual Designer, or using the Grid View window.

To assign a Local Datapool file used by the script:

El Note: A local datapool file must reside in the directory \ QALoad\ Datapools on the Player
workstation.

1. Do oneof thefollowing:

! In the Visual Designer, click the script icon § for the appropriate script to display the Script
Properties panel on theright-hand side of the window, then click the browse [...] button in the
Local Datapoolsfield. The Script Properties dialog box appears with the Attached Fileswindow
displayed.

OR

25



Using the Conductor

I Inthe Grid View window, select the Script Assignment tab, then click the browse [...] button
in the External Data column. The Script Properties dialog box appears. Click Local Datapools.

2. Click Add. The Choose a Local Datapool File dialog box appears.
3. Select afile, and click Open.

4. Repeat steps?2 and 3 to include additional datapool files.

5. Click OK.

To assign attached filesused by the script:

1. Do oneof thefollowing:

I Open the Script Properties panel for the appropriate script, then click the browse [...] button in
the Attached Filesfield. The Script Properties dialog box appears with the Attached Files
window displayed.

OR

! Inthe Grid View window, select the Script Assignment tab, then click the browse [...] button
in the External Data column. The Script Properties dialog box appears. Click Attached Files.

2. Click Add. The Choose afileto attach dialog box appears.
3. Select afile, and click Open.

To assign a Central Datapool file used by the script:

1. Do oneof thefollowing:

I Open the <ript Properties panel for the appropriate script, then click the browse [...] button in
the Central Datapool field. The Script Properties dialog box appearswith the Central Datapool
window displayed.

OR

! Inthe Grid View window, select the Script Assignment tab, then click the browse [...] button
in the External Data column. The Script Properties dialog box appears. Click Central
Datapool.

Click Browse. The Choose a Central Datapool File dialog box appears.
3. Select afile, and click Open.

4. (Optional) Select Rewind to rewind therecordsfrom thisdatapool at the end of atest. Thisenables
you to reuse the recordsin a subsequent test of this session.

5. (Optional) Slect Strip to remove the datapool records from the test so that they cannot be used
again.

Setting Middleware Options for Citrix and SAP

You can set the following custom options for Citrix and SAP middlewares:

Middleware | Option Description ‘
Type

Citrix Hide Graphical User Interface Runs Citrix in "windowless' mode.
for Citrix Users
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SAPGUI Hide Graphical User Interface Runs SAPin "windowless' mode.
for SAP Users

You can setup Citrix and SAP middleware optionsusing the Script Properties panel in the Visual Designer
orin the Grid View window.

To set the middleware optionsin the Visual Designer's Script Properties panel:

1. Click the appropriate Citrix or SAP script icon § . The Script Properties panel appearson the
right-hand of the window.

2. Select the Hide Citrix/SAP graphical user interface field, and use the arrow key to select the
desired middleware option. You can select:

I True-to hidethegraphical user interface
! False-to display the graphical user interface
3. Click OK.

To set the middleware optionsin the Grid View window:

1. In the Script Assignment tab, select the appropriate Citrix or SAP script.

2. In the Middleware column, click the browse [...] button. The Middleware Options dialog box
appears.

Select Hide graphical user interface during replay to run the script in windowless mode.

4. Click OK.

Setting Debugging Optionsfor a Script

If you encountered errorswhile validating or testing a script, use QALoad's debugging optionsto monitor
the Player(s) that generated errorswhile they are running or after the test.

You can watch avirtual user execute a script on a Player Workstation whileit isrunning. To monitor
selected virtual usersat runtime, enable the Debug Trace option before you run your test. Each virtual user
for which you enabled Debug Trace displays messages on its assigned Player workstation indicating which
commands are being executed.

You can instruct the Conductor to generate and save details about the script execution of selected virtual
users by enabling Logfile Generation before you run your test. Thisappliesto Citrix, ODBC, Oracle, Oracle
Forms Server, SAP, Winsock, or WWW only.

You can set the Debug Optionsusing the Script Properties panel in the Visual Designer, or using the Grid
View window.

To enable the Debug options:

1. Do oneof thefollowing:
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OR

In the Visual Designer, click the script icon § for the appropriate script to display the Script
Properties panel on theright-hand side of the window, then click the browse [...] button in the
Debug Optionsfield. The Debug window of the Script Properties dialog box appears.

In the Grid View window, select the Script Assignment tab, then click the browse [...] button
in the Debug Optionscolumn, for the appropriate script. The Debug window of the Script
Properties dialog box appears.

the Debug Optionsdialog box, you can choose the following options:

To enablethe Debug Trace option: in the Debug Trace Virtual User Range area, choose which
virtual users (if any) to monitor. You can choose None or All Virtual Users, or choose Virtual
User(s) and then type the numbersassigned to the virtual usersyou want to monitor. You can
monitor individual virtual usersor ranges of virtual users.

To enable Logfile Generation: in the Logfile Generation Virtual User Range area, choose which
virtual users (if any) to monitor. You can choose None or All Virtual Users, or choose Virtual
User(s) and then type the numbersassigned to the virtual usersyou want to monitor. You can
monitor individual virtual usersor ranges of virtual users.

3. Click OK to save your changes.

4. From the Conductor'smain menu, click File>Save to save your test session ID.

5. Run your test asusual.

El Note: Some log files are generated automatically when you run atest in the Script Development
Workbench or Player.

Setting Eror Handling Options

You can configure the behavior of a virtual user when an error occursduring the load test so that the test
aborts or continues executing. You can set the Error Handling Optionsusing the Script Properties panel in
the Visual Designer, or using the Grid View window.

To set the Error Handling options:
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1. Do oneof thefollowing:

OR

In the Visual Designer, click the script icon § for the appropriate script to display the Script
Properties panel on theright-hand side of the window, then click the browse [...] button in the
Error Handling field. The Error Handling page of the Script Properties dialog box appears.

In the Grid View window, click the Script Assignment tab, then click the browse [...] button
in the Error Handling field for the appropriate script . The Error Handling page of the Script
Properties dialog box appears.

2. Select the option you want applied to the script. You can select:

Abort, stopping further execution of transactions. Use this option when errors will make the
virtual user invalid for executing more transactions.

Continue executing and ignore the error. Select thisoption when errorsare not critical to the
performance of the load test
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I (WWW, SAPGUI, and Citrix scriptsonly) Restart the transaction from the beginning. When
you select thisoption, you must type anumber for the attempts made to restart the transaction
in the Maximum restart attemptsfield.

=l Note:The transaction count increases for each transaction that is restarted.

3. (Optional) Slect Apply Error Handling to all scriptsin thissession. Thisensuresthat all scripts
in the session respond to errorsthe same way.

Setting Script Pacing

Script Pacing isthetimeinterval between the start of atransaction and the beginning of the next
transaction on each workstation running the script. For example: if atransaction isdesigned to duplicate
the process of someone handlingincoming telephone callsand those calls arrive at arate of 40 per
hour/per person, set the pacing rate at 90 seconds. The default pacing value is one second, which enables
the Conductor to control runaway virtual users.

El Note: QALoad randomly schedules transactions so that each transaction executes on an average
according to this predetermined rate. When atransaction completes faster than its pacing rate, QALoad
delaysthe execution of the next transaction for that workstation so that proper pacing ismet. Snce we
do not normally time events according to this predetermined rate, QALoad randomly accelerates or
delaysthe pacing on aworkstation-by-workstation basis. However, on the average, QALoad provides
pacing according to the value that you assign.

You can set the Pacing rate using the Script Properties panel in the Visual Designer, or using the Grid View
window.

To set the Pacing rate:

1. Do one of the following:

! In the Visual Designer, click the script icon § for the appropriate script to display the Script
Properties panel on theright-hand side of the window, then click the browse [...] button in the
Pacing field. The Set Script Pacing dialog box appears.

OR

! Inthe Grid View window, click the Script Assignment tab, then click the browse [...] button
in the Pacing field. The Set Script Pacing dialog box appears.

2. Usethearrowsin each field to set the pacing rate. You can set Hours, Minutes, Seconds, and
Milliseconds.

3. Click OK.

Setting the Service Level Threshold

Use the service level threshold to specify aresponse timethat isused to compare against incoming
responsetime data. Thethreshold appears asahorizontal linein theruntime Graphsview.

Service level thresholds are similar to thresholdsthat can be specified for real-time graphsin the
Conductor, but are limited to transaction time and must be specified before atest runs.

Set the Service Level Threshold in the Visual Designer's Script Properties panel.

To set the service level threshold:
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1. Inthe Visual Designer, click the script icon § for the appropriate script to display open the
Script Properties panel on theright-hand side of the window.

2. Inthe Service Level Threshold field, click the browse [...] button to open the Set Service Level
Threshold dialog box.

Usethe arrow keysin the Hours, Minutes, and Seconds fieldsto set the threshold.

4. Click OK.

Setting the Seep Factor Percentage

Use the Seep Factor % field to specify the percentage of any originally recorded delay to preservein the
script. QALoad recordsthe actual delays between requests and insertsthe DO_S_EEP command in the
script to mimic those delayswhen the script is played back in atest. You can maintain the exact length of
therecorded delays at playback, or shorten them by entering a smaller percentage of the originally
recorded delay to play back. For example, if you recorded a delay of 10 seconds, then DO_S EEP (10); is
written to your script. Then, if a Seep Factor of 50% is specified here, the Player sleepsfor 5 seconds at that
statement when thetest is executed.

Valid values for Seep Factor % are 0-1000%, and Random. Random causes the Player to sleep for a
randomly selected duration between 0 and 100. A value of 100% causesthe script to execute at exactly the
same speed at which it was recorded; therefore, you can simulate the performance of faster users by
specifying a lower Seep Factor % value.

€' Hint: Enter avalue of zero during unit testing to eliminate the actual sleeps from the script. After
you unit test the script, you can restore the original recorded delays by changing the Seep Factor to a
higher percentage.

You can set the sleep factor percentage using the Script Properties panel in the Visual Designer, or using
the Grid View window.

To set the Sleep Factor percentage:

1. Do oneof thefollowing:

! In the Visual Designer, click the script icon § for the appropriate script to display the Script
Properties panel on theright-hand side of the window.

OR

! Inthe Grid View window, click the Script Assignment tab, then click the Sleep Factor % field
for the appropriate script.

2. Inthe Seep Factor % field, do one of the following:
I Click thearrow in thefield to select Random or 100
OR
I Typethe number representing the percent of the originally recorded delay to keep in the script.

3. In the Conductor, click File>Save.

Setting Options for Large Amounts of Timing Data

Your load test probably includes alarge number of checkpointsand virtual usersin order to adequately test
your system. When your test isrunning and your Conductor is collecting timing information from your
Player machines, the sheer amount of data can take up more of your resources than you'd like to expend.
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Use QALoad's Timing Data Thinning option to thin the amount of timing data being transferred back to
the Conductor during the test so that your test can run longer without stressing your resources.

You can set the Timing Optionsusing the Script Properties panel in the Visual Designer, or using the Grid
View window.

To open the Timing Options dialog box:

! In the Visual Designer:

1. Click thescripticon § for the appropriate script to display the Script Properties panel on
theright-hand side of the window.

2. IntheTiming Optionsfield in the Script Properties panel, click the browse [...] button. The
Timing page of the Script Properties dialog box appears.

! Inthe Grid View window:
1. Click the Script Assignment tab.

2. IntheTiming Optionscolumn, click the browse [...] button. The Timing page of the Script
Properties dialog box appears.

To set timing options:

In the Timing Options area of the dialog box, select optionsfor checkpointsand for custom counter data
collection. For more information on these options, refer to Timing Options.

To thin timing data:

1. IntheTiming Data Thinning area of the dialog box, choose one or both of the following:

I Thin counter timing data by to control the amount of counter timing datathat is collected
and saved in thetiming file. Do not select thisoption if you want to collect all available timing
data for counters.

! Thin checkpoint timing data by to control the amount of checkpoint timing datathat is
collected and saved in the timing file. Do not select this option if you want to collect all
available timing data for checkpoints.

2. Dooneof thefollowing:

I Select Script to thin data by script. In the Summary interval field, type the number of seconds
between each data collection.

I Select Virtual User to thin data by virtual user. In the Summary interval field, typethe
number of seconds between each data collection.

2l Note: Thinning by script minimizesthe amount of data collected.
3. Theaverageissent to the Conductor for inclusion in thetimingfile, rather than every value.
4. Click OK.

Save your changesto your test session ID file by choosing File>Save from the Conductor main
menu.
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Setting the Number of Transactions

Usethe Transactionsfield to set the number of transactionsthat each Virtual User running the script
should run. Once the workstation executesthe number of transactionsthat you specify, script execution
continues with the line following the End Transaction command rather than jumping to the beginning of
the transaction loop.

You can set the number of transactionsusing the Script Properties panel in the Visual Designer, or using
the Grid View window.

To set the number of transactionsin the Visual Designer:

1. Click the scripticon § for the appropriate script. The Script Properties panel displayson the
right-hand side of the window.

In the Transactionsfield, type the number of transactionsthat each Virtual User should run.

3. From the Conductor menus, click File>Save.

To set the number of transactionsin the Grid View window:

1. Click the Script Assignment tab.

2. Inthe Transactionscolumn for the appropriate script, use the arrow keysto select the number of
transactionsthat each Virtual User should run.

3. From the Conductor menus, click File>Save.

Setting Player Properties

Specify Virtual User Configurations

Once you've selected the scriptsand configured the transaction settings, you must assign Player machines
and groups, and set the Virtual User configurations. You can set the Virtual User configurationsusing:

I thetoolbar in the script test setup nodein the Visual Designer
! the Player Properties panel in the Visual Designer
! the Machine Assignment tab in the Grid View

! thetoolbar in the main Visual Designer window

To set the Virtual User configurationsin the script test setup node:

1. Click the appropriate Player in the script test setup node in the Visual Designer.

2. Click the Configure All button r*‘*‘ in the script test setup node toolbar. The Configure All
Players/ Groups dialog box appears.

3. Click thearrowsin thefieldsto set the following options:

I Starting VUs - Number of Virtual Usersto launch the script on the machine when the test
begins.

! Ending VUs- Number of Virtual Usersat the end of the test.
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I VU increment - Number of virtual usersto add at intervalsthroughout the test.

=l Note: If you add incremental virtual users, you must designate the timeinterval and the ending
virtual users.

I Timeinterval - Timeinterval at which incremental virtual usersshould be added to the test.
! Mode- Thetest mode for the machine. You can select thread based or process based.

4. To usethese optionsfor all playersand groupsin the script, click Assign to all selected players
and groups.

5. Click Finish.

6. Click File>Save in the Conductor main menu.

To set the Virtual User configurations using the Player Properties panel of the Visual Designer:

1. Click theindividual Player in the script test setup nodein the Visual Designer. The Player
Properties panel displayson theright-hand side of the window.

2. Inthe[Starting VUg| field, type the number of Virtual Usersto launch the script on thismachine
when thetest begins.

3. (Optional) In the [VU Increment] field, type the number of virtual usersthat should be added at
intervals. When you fill in thisfield, you must also fill in the Time Interval and Ending VUs fields.

4. IntheEnding VUsfield, typethe number of Virtual Usersat the end of the test.

5. IntheModefield, usethe arrow to select the test mode, process-based or thread-based, for this
Player.

6. (Optional) In the Time Interval field, click the browse [...] button to display the Set Time Interval
dialog box.

El Note: If you filled in the VU Increment field, you must fill in the Time Interval.

7. Usethearrowsin the Hours, Minutes, and Secondsfieldsto set the timeinterval at which
incremental Virtual Users should be added to the test, then click OK.

8. Click File>Save in the Conductor main menu.

To set the Virtual User configurations using the Grid View:

1. IntheMachine Assignment tab, click the down arrow in the Player Name field, then select a
player from thelist.

2. (Optional - WWW only) In the Middleware field, click the browse [...] button to open the Expert
User Optionsdialog box. If you enable the Expert User, select the Virtual User number to represent
the Expert User.

3. Click each of the following fieldsto set optionsfor:

I Starting VUs - Type the number of Virtual Usersto launch the script on the machinewhen the
test begins.

I Ending VUs- Typethe number of Virtual Usersat the end of the test.

! VU Increment - Usethe arrowsin thefield to set the number of virtual usersto add at intervals
throughout the test.

I Timing Interval - Click the browse [...] button in the field to open the Set Time Interval dialog
box. Set thetime interval at which incremental virtual users should be added to the test.
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Note: If you add incremental virtual users, you must designate thetime interval and the ending
virtual users.

I Mode- Usethearrowsin thefield to select the test mode for the machine. You can select
thread based or process based.

4. Click File>Save in the Conductor main menu.

To set the Virtual User Configurations using the Visual Designer toolbar:

1. Select the appropriate script test setup node, then click Review Virtual Usersin the Visual
Designer toolbar.

2. Usethecolumnsin the Review Virtual Configuration dialog box to set the Virtual User
configurations for each Player listed.

Enabling Expert User

When you enable the Expert User, thisVU collects more detailed information about requeststhat are made
while the script isrunning. Every main request and subrequest logsthe amount of server and network time
used. This helpsdiagnose why page loads may be taking longer than expected. You enable Expert User
from the Conductor, either before or during aload test. Expert User usesthe existing custom counter
support so Conductor can graph the custom counter information. Oncetheload test iscomplete, you can
view the datain Analyze.

Note: Currently, Expert User capability is provided only for the WWW middleware.
You can enable the Expert User:
Before aload test beginsfrom the Visual Designer or Grid View windows.

During aload test from the Runtime window.

To enable Expert User before the load test begins:

1. Do oneof thefollowing:
I Using the Visual Designer:

a. Click an individual player machinein the script test setup node to display the Player
Properties panel on theright-hand side of the window.

b. Click the browse[...] button in the Expert User Optionsfield to open the Expert User
Optionsdialog box.

OR
I Using the Grid View window:
a. Clickthe Machine Assignment tab.

b. IntheMiddleware field for the appropriate WWW script, click the browse [...] button to
display the Expert User Options dialog box.

2. Click Enable Expert User timings.

3. IntheVirtual User Number field, type the Virtual User (VU) number to represent the Expert User.
The default VU number is zero (0).

4. Click OK.
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To enable Expert User during the load test:

1. Inthe Runtimewindow, click Actions>Set Expert User Options. The Update Expert User
Optionsdialog box displayslisting all the scriptsthat support Expert User counters.

2. Click the scriptsin which you want to enable Expert User, then click OK.

El Note: Selecting Expert User Scripts at the top level enables or disables expert user on all associated
scripts.

Changing the Number of Virtual Users

Change the number of virtual usersassigned to a script using the Visual Designer or on the Machine
Assignment tab of the Grid View window.

To change the number of virtual usersusing the Visual Designer:

1. Do oneof thefollowing:

I In the Visual Designer window, select a player machine in the appropriate script node. The
Player Properties panel displayson theright-hand of the window. Type anew valuein the
Starting VUs column of the Player Properties panel.

OR
[ . .
| Click Review Virtual Users &b Reviewtirtuallsers G p o v/igia Designer toolbar, then type a
new valuein the Starting VUs column for the selected script. Click OK.

2. If you have assigned incremental virtual users, changethe valuesin the VU Increment column
and the Ending VUs column to determine how many virtual usersto add at the interval specified
in the Time Interval column.

3. Select File>Save to save your changesto the current session ID file, or File>Save Asto save them to
anew session ID file.

To change the number of virtual usersusing the Grid View:

1. IntheMachine Assignment tab, type anew value in the Starting VUs column for the selected
script.
2. If you have assigned incremental virtual users, changethe valuesin the VU Increment column

and the Ending VUs column to determine how many virtual usersto add at the interval specified
in the Time Interval column.

3. Select File>Save to save your changesto the current session ID file, or File>Save Asto save them to
anew session ID file,

Using the Test Configuration Wizard

About the Test Configuration Wizard

The Test Configuration Wizard consists of a series of screensthat guide you through the process of setting
up aload test. Usethe Test Configuration Wizard to select scripts, configure the script'stransaction
settings, select playersor groupsto assign to the test, and specify desired Virtual User configurations. You
also can add scriptsto an existing session using the Test Configuration Wizard. Once you setup your load
test with the Test Configuration Wizard, you can run thetest immediately without additional
configuration.
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You can usethe Test Configuration Wizard to:
Create a New Test Session Using the Test Configuration Wizard
Modifying an Existing Test Session Using the Test Configuration Wizard

Creating a Test Session Using the Test Configuration Wizard

The Test Configuration Wizard guides you through the process of setting up aload test. Use the series of
screensin the Test Configuration Wizard to:

1. Select scripts

2. Configurethe script'stransaction settings
3. Select playersor groupsto assign to the test
4. Specify desired Virtual User configurations

You can open the Test Configuration Wizard from the Conductor Sart page or with atest session open in
the Conductor.

To accessthe Test Configuration Wizard from the Conductor Start page:

1. Do oneof thefollowing:
I Inthe Tasksarea, click Test Configuration Wizard to open the first screen of the wizard.
OR

I In the Recent Sessionsarea, click New to open the Create New Session dialog box. Select the
Launch Test Configuration Wizard option.

= Note: If you do not select the Launch Test Configuration Wizard option, the new test session
opensin Conductor's Visual Designer, where you can manually configure the load test session.

2. Inthe Namefield, typeaname for the new session.
3. (Optional) In the Description field, type a description for the new session.

4. Click Next to start configuration of your test session.

To accessthe Test Configuration Wizard with a session open in Conductor:

Click File>New, then follow steps 2 through 4 above.
Modifying a Test Session Using the Test Configuration Wizard

You can usethe Test Configuration Wizard to add a script to an open test session by following the steps for
each screen in the Test Configuration Wizard.

To start the process of adding a script using the Test Configuration Wizard:

On thetoolbar, click the Test Configuration Wizard button. The Select Script to Configure dialog box
appears.
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Anticipating Error Conditions

You know before beginning aload test that errors are a possibility, but you may not alwayswant them to
stop your progress during testing.

QALoad helpsanticipate error conditionsand determine, before running the test, how Playersreact to non-
fatal errors. By setting one option, you can instruct a Player to continue asif no error was encountered,
stop running immediately, or restart at the beginning of the transaction.

=l Note: When the Conductor process stops for any reason during aload test, the associated Players
automatically terminate.

Managing Large Amounts of Test Data

With alarge number of virtual users, it ispossible to create atiming file containing hundreds of thousands
of timing records for each checkpoint. Attempting to graph just a few of those checkpoints can slow down
QALoad Analyze considerably.

For example, if atiming file contained 250,000 timing records for each data point, attempting to graph
even one checkpoint meansthat QALoad Analyze must paint 250,000 lineson the graph. Snce most
monitorsonly have 1024 pixels acrossthe screen, the 250,000 data pointswould mostly be plotted atop
one another and theresultswould be unreadable.

Now imagine attempting to graph the data of several data points of that size. The sheer amount of data
could easily overwhelm a workstation. And every time you move the window, resize the window, or right-
click on the graph, QALoad Analyze hasto re-draw the graph. You could conceivably spend enormous
amounts of time simply attempting to graph data.

To make large amounts of data manageable, QALoad Analyze provides an option that allowsyou to
determine how to thin data. That is, how to determine how many data pointsto plot.

When your test isrunning and your Conductor iscollecting timing information from your Player
machines, the sheer amount of data can take up more of your resourcesthan you would like to expend.
Use QALoad's Timing Data Thinning option to thin the amount of timing data being transferred back to
the Conductor during the test so that your test can run longer without stressing your resources.

Validating Scriptsin Conductor

Before running atest, you should run your script in asimpletest to ensure that it runswithout errors. You
can validate UNIX or Win32 scriptsin the Conductor.

Managing Players and Groups

Overview of Players and Groups

You can configure the various machines and agentsthat will participate in aload test from asingle screen.
Click Tools>Manage Playersto display the Manage Players/Groups dialog box, where you can configure
Player Machines, Player Groups, and ApplicationVantage settingsinformation from asingle screen.

You should use thisoption to update Player or Agent information whenever a Player or Agent isadded to
thetest network, removed from the test network, or the network address of a Player or Agent has changed.

You can collect Player machinesinto logical groupsusing the Group Membership optionsin the dialog
box.

Player Agents
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Player machines execute the virtual usersthat perform the transactionsrecorded in your test scripts. You
can view information on Player machinesfrom either the Visual Designer or the Grid View window. If no
Player machines are listed, you can retrieve information from Player machineson thelocal network, or you
can add Player machines manually.

Managing Player Machines
Adding Player Machinesto a Test Session

Follow these instructionsto add a Player workstation to your pool of available Playersin atest's session ID
file.

To add a new Player machine:

1. From the Conductor's main menu, click ToolssSManage Players. The Manage Players/ Groups
dialog box displays.

2. Click FilesNew>Player. A new page displaysin the detail area of the dialog box, where you enter
information and settings for the new Player.

To enter information and settings for the new Player:

Enter information for the new Player in the following areas of the dialog box.
In the Player Information area:
1. IntheMachine (hostname or IP) field, type aname for the Player Machine.

2. IntheCommunications[TCP] port field, type the port number the Conductor should useto
communicate (using TCP) with thismachine during atest. The default is 3032.

3. Click Verify to check that the machineisactive. The Player or Agent returnsthe operating system,
processor type, amount of memory, and the maximum threads and processes available on the
machine.

El Note: If a Player does not respond, a message box appearsindicating that the Player is not
responding. If the Player isnot responding, one of the following scenariosis likely:

I Thehost name and/or port number you entered may not be correct. Check your parameters
and network connections, then try to send another request.

I ThePlayer isnot running. Sart the Player and then try to send another request.
Expand the Machine Settings area (Optional):

4. Select desired optionsto ping the host before attempting connection to the player, generate IP
spoof data, or override the default machine settings.

5. Closethe Machine Settings.
6. Expand the Group Membership area (Optional):

7. In the Available Groups pane, select a group to which you want this Player Machine added, then
click Add.

8. The selected groups are moved to the Member of Groups pane.

Close the Group Membership.
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Note: You also can add a Player to a Group by dragging and dropping the Player from thelist in the
Players areato the appropriate Group in the Groups area, or by dragging and dropping a Group in there
Groups areato a Player int he Players area.

In the ApplicationVantage Settings area:

El Note: The fields on thistab are available only if ApplicationVantage isinstalled on the Player
Machine and ApplicationVantage Mode is selected when you choose a script in the Script Assignment
tab.

From the drop-down list in the NIC Name field, select the Network Interface Card (NIC) that isused by
the machine, if necessary.

To save the Player machine:

Click Save, then click OK. The Player Machine appearsin the Manage Players and Groups dialog box
in the All Player Machines and Groups tree.

Editing a Player Machine

From the Conductor'smain menu, click ToolssSManage Players. The Manage Player Machines and Groups
dialog box displays. Use the following procedure to edit Player Machines.

To edit a Player machine:

Select an individual Player Machine in the Playerslist.
In the Player Information area:

1. Inthe Communications port field, type the port number the Conductor should use to
communicate (using TCP) with thismachine during atest. The default is 3032.

2. Click Verify to check that the machine isactive. The Player or Agent returnsthe operating system,
processor type, and amount of memory on the machine.

In the Machine Settings area:

1. Open theMachine Settings area.

2. Make any necessary selection or changes here, then close the Machine Settings.
In the Group Membership area (Optional):

1. Open the Group Membership area.

2. Addthe Player to appropriate groups by selecting agroup in the Available Groups pane and
clicking Add.

3. Closethe Group Membership.

In the ApplicationVantage Settings area:
El Note: These fields are enabled only if Application Vantage isinstalled on the Player machine.

I Inthe NIC Name field, select the Network Interface Card (NIC) that isused by the machine.

Save the editsto the Player machine:
I Click Saveto save your settings for this player machine, then click OK.

To delete a Player machine:
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Select the Player machine in the Players panel, then click Edit>Delete.
Discovering and Verifying Player Machines

In Conductor, you can retrieve information from Player machines on the local network by doing the
following:

To discover and information on Player machines:

1. Click Tools>Manage Players. The Manage Players/Groups dialog box displays.

2. Click Actions>Discover Players. QALoad Conductor queriesthe network for available Player
workstations and addsthe resultsunder Player Machinesin the Players area.

To verify a Player machine:

1. In the Players area of the screen, select the Player machine to verify.

2. IntheCommunications[TCP] port field in the Player Information area, click Verify. A
confirmation dialog box appearswhen the verification is successful.

Viewing Information on Player Machines

In Conductor, you can retrieve information from Player machineson thelocal network by doing the one
of following:

To view information on Player machinesin the Visual Designer:

In the script node, select the individual Player you want to view. The information on the Player appearsin
the Properties panel on theright-hand side of the window.

To view information on the Player in the Grid View:

Click View>Grid Window to display the Grid View window, then click the Machine Assignment tab to
display information on the Player.

Managing Groups

Adding a Group

You can combine playersinto logical groupsusing the following procedure:

To create a group:

1. From Conductor'smain menu, click Tools>Manage Players. The Manage Players/ Groups dialog
box displays.

2. Click FilesNew> Group. The Group Information dialog box appears.
In the Name field, type a name for the group.

4. In theDescription field, type a description for the group.
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To add Playersto the group:

1. In the Available Players panel, select the player or playersto add to the group.

2. Click Add. The Player ismoved to the Member Players pane.

Note: You can select more than one machine by holding down the Ctrl key and selecting each
Player Machine to select. Select all the available Player Machines by clicking Add All.

3. Click Save, then click OK.

Editing a Group

Use the following procedure to edit a group.

To edit a group:

1. On Conductor'smain menu, select Tools>Manage Players. The Manage Players/Groups dialog box
displays.

2. Select agroup in the Groups panel to display the Group Information window.
Usethefieldsin thisdialog box to change the Group Name or Description.

To add a Player Machineto the group, use the procedures for adding a Player machine to a group.

To remove a Player from the group:

1. Select the Player machinein the Member Players panel, then click Remove.

2. Click Save to save your changes, then click OK to return to the main Conductor window.

Running a Test

Running a Load Test

After validating a script, it is safe to run aload test with that script.

To start a load test:

In the Conductor, click the Run button on the configuration and setup toolbar, or from the Actions menu,
choose Run. While atest isrunning, the Conductor's Interface changesto provide you with real-time test
options. For moreinformation, see Runtime Window Interface.

El Note: While any window on the desktop isre-sizing or re-positioning, all Windows applications
pause. Do not click and hold on awindow caption or border for extended periodsduring a load test
because it delays message handling and may have an impact on test results.

While aload test isrunning, the Conductor’stoolbar changes from the Configuration and Setup Toolbar to
the Runtime Toolbar. The Runtime Toolbar buttonslet you control the test and access detailed

information about the test while it isrunning. For more information, see Monitoring a Load Test. This
gives detailed information about what to expect from the QALoad Conductor while atest isrunning —
including descriptions of the Runtime Toolbar buttons
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Running a Series of Tests

You can also run a series of tests — a batch test. A batch test comprises multiple session ID files. When you
run abatch test, the session files are executed sequentially until all of them are executed. The Conductor
enablesyou to run multiple batch testswithout operator intervention. For more information, see Running
a Batch Test.

Checking Out Virtual User Licenses

If you are licensed to run multiple copies of the Conductor, for example so different work groups have
accessto QALoad, you can check out virtual user licenses before running aload test to ensure that enough
are available for your test run.

If you do not choose to check out your licenses before starting atest, QALoad promptsyou after you start
thetest and attemptsto check out the appropriate number of licenses. We recommend that you check
your licenses out manually before starting so you can be sure you have enough virtual users available
before beginning your test run.

To check out virtual user licenses:

1. From the Conductor menu, select Tools>Licensing. The License Information dialog box appears.

I If you arelicensed for concurrent licensing (multiple Conductors) the Conductor queries your
license server to determine how many licenses are currently available, and returnsthe resultsto
thisdialog box. Go to step 2.

I If you have anode-locked license (a single Conductor), then most of the optionson thisdialog
box are unavailable, as you will not need to, or be able to, check out virtual user licenses. All
virtual usersfor which you are licensed are available only to this Conductor. Click OK to return
to your test setup.

2. IntheLicensing Operations area, select Check Out Virtual User Licenses, then type how many
virtual user licenses you want to check out in the Number of Licensesfield.

3. Click Check Out. Thelicenses are checked out to your Conductor, and are unavailable to any other
Conductor workstations on the network.

When you are done using your licensed virtual users, check them back in so they are once again available
to other Conductor workstations on your network.

To check in virtual user licenses:

1. From the Conductor menu, choose Tools>Licensing. The License Information dialog box appears.

2. If you havelicenses checked out, the Check in Virtual User License option isautomatically selected
for you.

3. Click Check In. Thelicenses are made available to other Conductor workstations on the network.

Dialing Up/Down Virtual Users

QALoad'sdial-up/dial-down feature in Conductor allowsyou to dynamically add or reduce virtual usersto
your test at the script or Player level while your test isrunning. Thisenablesyou to adjust your running
test according to test behavior on-the-fly, rather than stopping to re-configure playback criteria.

To usethedial-up/dial-down feature, you must:
! belicensed for at least the number of virtual usersrequested
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I configure adial-up/dial-down session beforerunning the test

! If you have not configured a dial-up/dial-down session, you will not be allowed to add or suspend
virtual userswhilethetest isrunning. For more information, see Configuring a Dial-up Session.

! Dial-up/dial-down isenabled only after all Virtual Users configured for the test session are ramped
up.
I Dial-up/dial-down isnot supported for amachine assignment entry that isusing a player group.

When your test isrunning, the bottom of the Test Information window turnsinto the dockable Runtime
Options panel, a portion of which isshown below:

F!untime Dptions

Wirtwal User Options | Script Options | Global Options
Al Yirtual Users

Cial Up/Dovn
Currently Bunning/dywvailable: 040

Change Funning To; 0 g Apply

When you click on a Player or script in the test'stree-view, the Runtime Options panel indicates how many
virtual usersare currently running on the selected Player machine or script. You can change the number of
running virtual users per script or per Player by selecting the appropriate script or Player machinein the
tree-view, and then typing anew number in the Change Running To field (or by using the up/down
arrows).

To dial up or down (add or subtract) virtual users during a test:

1. When your test isrunning, click on the script or Player workstation in the Runtime Window's tree-
view for which you want to add or subtract virtual users. On the Virtual User Optionstab, the
Currently Running/Available field shows how many virtual usersare currently running on that
script or Player.

2. IntheChange Running To field, type a new number or use the up/down arrowsto changethe
number.

3. When you are done, click Apply. The Conductor will release or suspend the specified number of
virtual users.

El Notes:
I Your changes do not take effect until you click Apply.

! When you dial down avirtual user, the virtual user finishesthe current transaction before going
into a suspended state.

Increase/ Decrease Runtime Timing Updates

While atest isrunning, you can change the frequency at which timing updates are sent from the Playersto
the Conductor in the Runtime window. Decreasing the update interval reducesthe amount of overhead
incurred in large load tests due to the communications between the Conductor and large numbers of
virtual users.

To change the Runtime Timing updates:
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1. On the Global Optionstab of the Runtime Options panel (bottom pane), choose from the
following options:

I No Updates: Choose thisoption to stop sending timing datawhile thetest isrunning. Data
will still be collected at the end of the test.

I Send All: Choose thisoption to send all timing data asit iscompiled.

I Periodic Updates: Choose thisoption to specify atime interval for sending updates, then type
thetimeinterval (in seconds) below.

2. Click Apply. Any change takes effect immediately, and appliesto all scriptsin the test.

Removing a Script or a Player from a Test

To remove a script from a test:

1. Right-click on the script icon § for the appropriate script, then select Remove Script.

2. In the confirmation dialog box, click Remove.

To remove all scriptsfrom a test:

1. Click Actions>Remove All Scripts.

2. In the confirmation dialog box, click Remove.

To remove a single Player from a test:

1. In the script test setup node, right-click on the Player to remove, then select Remove Selected.

2. In the confirmation dialog box, click Remove.

To remove all Playersfrom atest:

1. Click Actions>Remove All Players/ Groups.

2. In the confirmation dialog box, click Remove.

Removing Used Datapool Records After a Test

You can remove used datapool recordsfrom a Central datapool after atest completes by setting the Srip
Datapool function before you run thetest. Use thisfunction when running atest where you have datain
the external datapool that can only be used once by one virtual user at atime. (For example, when running
transactionsthat have unique data constraints.) When activated, the Srip Datapool function marks each
piece of datain the datapool that isused during your test. When the test is over, the Srip Datapool
function promptsyou to remove the identified used data from the datapool. If you run the test again, only
new dataisused for your subsequent test.

To use the Strip Datapool function:

1. With thecurrent test's session ID file open, do one of the following:
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I Click the script icon § for the appropriate script to display the Script Properties panel on
theright-hand of thewindow. In the External Data area, click the browse [...] button in the
Central Datapoolsfield.

OR

! In Grid View window's Script Assignment tab, click the browse [...] button in the External
Data field of the appropriate script. When the Script Properties dialog box appears, click
Central Datapool.

2. In the Central Datapool dialog box, click the browse [...] button to select the Central Datapool file,
then select the Strip check box. Click OK.

3. Attheend of your test, a Srip Datapools prompt appears asking if you wish to go to the Srip
Datapoolsscreen. Click Yes.

4., The Srip Data Pool dialog box appearswith the Srip option selected. Click the Strip button.

When you are finished, click Close.

Stopping a Load Test
A load test iscomplete when all virtual usersexit. A virtual user automatically exitswhen one of the
following occurs:

I Ascript encountersan EXIT command.

I Ascript completesitstransaction loop.

I A QALoad function failsand Abort on Error isset in Error Handling

To stop aload test:

Click the Exit All Virtual Users button or click the Quit Current Test button. The Virtual User icon
changesto @ and the message, "Session aborted by User", displays.

Adding Post-test Comments

If you selected the Display post test commentsdialog option when you configured the Conductor, the
Post Test Commentswindow openswhen you click the Quit Current Test button. Type any comments,
which are saved to the test’s Summary Report that you can view in QALoad Analyze.

Adding Post-test Comments

By setting the appropriate options when you configure the Conductor, you can add commentsto a
completed test. The comments appear in thetest's Summary Report in QALoad Analyze.

To configure the Conductor for adding post-test comments:

1. Select Tools>Options. The Optionsdialog box appears.
2. In the Dialog section of the Conductor Sessions page, select Display post test commentsdialog.

3. Click OK. The Conductor isnow configured so that you can add commentswhen atest completes.

To add post-test comments:
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1. IntheTest Completed dialog box, click Exit Test.
OR

In the Runtime toolbar, click the Quit current test button. The Post Test Comments dialog box

displays.

2. Typeany commentsin the dialog box, then click OK. Your commentsare saved in the Post Test
Commentsfield of the Summary Report in

3. QALoad Analyze.

Monitoring a Running Test

Monitoring CPU Usage

To help you monitor the impact of running aload test on a server, QALoad can collect data from selected
Players about CPU usage during aload test. The statistics collected during the test are merged into the test's
timing file so you can view them in QALoad Analyze after the test.

El Note: During aload test, if the CPU idle time of your machine falls below 25%, check the individual
processes on your machine. If the Playersand virtual users are utilizing most of the active CPU time, you
should use additional Player machines and fewer virtual users per Player to conduct your load test.

Watching a Script Execute

Usethe Debug tab in the Conductor Runtime window to view the executing script. Note that it is possible
that you will not see the execution of every statement. In order to minimize network traffic between the
Conductor and the Players, the Player sendsits script debug statusto the Conductor once per second, so
that the Player can execute several statementswithout sending a debug message to the Conductor.

To open the Debug tab:

i=
Select a Player in the Runtime window, then click the Debug Virtual User - = toolbar button.
Note: The Conductor highlightsthe script line that it is currently executing.

Graphing Checkpointsin Conductor

Usethe Graphsview of the runtime Conductor to create real-time graphs of checkpoint response times
during script execution.

El Note: Smilar graphs are also available for post-test analysisin QALoad Analyze.
Checkpointsare listed in the tree view on the left side of the Graphsview of the runtime Conductor, as

shown in the example below. Both automatic and user-defined checkpoints appear in the Response Times
folder of each running script.
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Creating a Graph of Checkpoint Response Times

Before you can review checkpoint response timesin graph form, you must select the checkpoint counters
to include. To choose a checkpoint that should appear in a graph, highlight the checkpoint name, right-
click and choose either Add Graph to create anew graph or Add Plot To to add a data plot to an existing
graph.

If you choose the Add Graph option, the Add Graph dialog box appears. Select the optionsfor how the
graph should appear and click OK.

Adding Thresholds

To better identify problem checkpoints, you can set thresholds on plotsor graphsthat indicate the number
of timesthe datarecord for that checkpoint has gone above or below the number you set. Thresholds can
be set from the Advanced tab of the Add Graph dialog box or by right-clicking on an existing graph and
choosing Thresholds.

Highlighting Individual Plots

If you create several plotson asingle graph, it may become difficult to see individual plots. To increase a
plot'svisibility, click on a plot in the graph or a plot'snumber in the graph'slegend. When highlighted,
the plot appearsthicker and darker on the graph.

Saving Checkpoint Graphsto a Session ID

Checkpoint graphsthat are created in the Conductor are automatically saved to the current session ID file.
To remove all graphsyou added, click Graph>Restore Default Graph Layout.

47



Using the Conductor

Graphing Counter Data

Usethe Graphsview of the runtime Conductor to create real-time graphs of counter data during script
execution. Smilar graphs are also available for post-test analysisin QALoad Analyze.

Selecting Countersto Graph

All counter datathat isavailable for graphing islocated in the tree view on the left side of the of the
Graphsview Data window, as shown below.

- % Global Courters

b Errors

= 3‘3 Script Counters
= 3‘3 testnew.cpp
= 3‘3 Responze Times
= -—\_‘!'3 Auto Checkpoints
= 3‘3 Trans:

) Line 152 Page 1 - Google
) Line 176: Page 2 - map of antar
) Line 209: Page 3 - Google Imac
) Line 239: Page 4 - hitp: //:9.ad:
) Line 283 Page 5 - hitp: //page:
) Line 327: Page E - hitp: //page:
) Line 357: Page ¥ - hitp: //a.tnbz
) Line 369 Page 8 - Where are y
) Line 392 Page 9 - hitp: //a.tnbz
) Line 421: Page 10 - azk_TSney
) Line 442 Page 11 - hitp://a.tik
1 Line 431: Page 12 - mastercard

] ] o ] ] O ] O O O O O O O

Scripts of any middleware type collect the following default counter data, which isavailablein the
Conductor for real-time graphing:

! Global counters: Running VU%, total running VUs, and errors
I Script counters: Running VUs, response times, and transactions

I Player machine health: % processor, % memory used, % disk space, %disk time, % paging file
Additional middleware-based graphs are also generated by default and vary by middleware. For example,
for the WWW middleware, several performance-based counters are automatically collected and available

for graphing, including server responses and WWW traffic. You can monitor thisdatato determinethe
optimum rate of performance of the application that isrunning.

Graphing Counter Satistics

To choose a counter that should appear in a graph, highlight the checkpoint counter name or group of
counters (folder), right-click and choose either Add Graph to create a new graph or Add Plot To to add a
data plot to an existing graph.

If you choosethe Add Graph option, the Add Graph dialog box appears. Select the optionsfor how the
graph should appear and click OK.

To better identify problemsin thetest, you can set thresholdson plotsor graphsthat indicate the number
of timesthe datarecord for that counter has gone above or below the number you set. Thresholds can be
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set from the Advanced tab of the Add Graph dialog box or by right-clicking on an existing graph and
choosing Thresholds.

Highlighting Individual Plots

If you create several plotson asingle graph, it may become difficult to see individual plots. To increase a
plot'svisibility, click on a plot in the graph or a plot'snumber in the graph'slegend. When highlighted,
the plot appearsthicker and darker on the graph.

Saving Counter Data Graphsto a Session ID

Counter data graphsthat are created in the Conductor are automatically saved to the current session 1D
file. To remove all graphsyou added, click Graph>Restore Default Graph Layout.

Running a Series of Tests (Batch)

Running a Batch Test

By setting the appropriate optionsin the Conductor, you can elect to run a series of tests as a batch, rather
than oneat atime. A batch test comprises multiple session ID filesthat are executed sequentially.

You can create a batch test by adding a number of session ID filesto a batch file. Before you can add a
session ID to a batch file, the following conditions must be true;

I Thesession must include a defined number of transactions. Sessions of unlimited transactions
cannot be used in a batch test.

I All scriptsto beincluded must exist before starting the batch test.

To run a batch test:

1. Select Actions>Batch Test. The Configure Batch Test dialog box appears.

2. Select therequired session ID filesin the Available Session Fileslist and click Add to add them to
the Selected Sessions list.

3. If you want to run apreviously defined batch, click the Load Batch File button in the toolbar to
navigate to the directory where the batch file (.run) resides. Select it, and click OK.

4. IntheDelay Between Testsfield, click the up or down arrow to set the number of secondsto wait
before starting the next test.

5. Click Save to save the current batch file, or click Save As... to save the batch file under anew
name.

6. Click OK to return to the main Visual Designer window
OR
Click Start to begin running the batch test.

The Conductor then executes each of the session ID filesin sequence.

Adding Sessionsto a Batch Test

Before a session is added, the following conditions must be true:
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I Thesession must include adefined number of transactions. Sessions of unlimited transactions
cannot be used in abatch test.

I All scriptsmust exist prior to starting the batch test. Thismeansthat the filesreferenced in the
selected session ID filesare present in the script directory.

A session can be placed in a batch multipletimes. Thisfeature might be used to re-run atest or to perform
housekeeping chores, such aslogging usersin or out of ahost or database.

To add a session:

1. From the Actionsmenu, choose Batch Test. The Configure Batch Test dialog box displays.

2. Inthe Available Session Files box, highlight the session you want to add, and click the Add

™

Add button.

If you want to run apreviously defined batch, click the Load button to navigate to the directory where
the batch file (.run) resides. Select it, and click OK.

The session isadded to the Selected Sessionslist on the right side of the dialog box.

3. IntheDelay Between Testsfield, click the up or down arrow to set the number of secondsto wait
before starting the next test.

4. Click Saveto savethe current batch file, or click Save As... to save the batch file under a new
name.

5. Click Start to begin running the batch test, or click OK to return to the main Visual Designer
window.

Setting Delays Between Tests

You can set afixed delay or pause between tests by specifying avaluein the Delay Between Tests field on
the Configure Batch Test dialog box. After each test is complete, the Conductor delays for the specified
amount of time before starting the next test. To set up a series of tests, see Running a Batch Test.

Removing a Session from a Batch Test

To remove a session from a batch test:

1. Select Actions>Batch Test. The Configure Batch Test dialog box appears.

2. Click Load Batch File and select the file you want to modify.

3. In the Selected Sessions pane, highlight the session to remove and click Remove.
4

Click OK.

Terminating a Batch Test

Sop abatch of teststhe same way you would stop a single session test, by clicking the Abort All Virtual

Users or Exit All Virtual Userson thetoolbar. The Virtual User icon changesto @ and the m essage,
"Session aborted by User", displays. When the Conductor process stops for any reason during a load test,
the associated Player processes automatically terminate.
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Expert User

Overview of Expert User

Expert User provides an easy, logical guide for drilling down to the root performance problemsfor
applications. It enablesyou to break web pages down into their individual components, providing more
detailed response time data. Response time for each component isbroken into network and server time.

More detailed information helpstroubleshoot application performance problems. The ability to see timing
fileson acomponent level can spotlight where the majority of time isbeing spent. A breakdown of
network and server times per component can identify areas for improvement in either the network or
server hardware or configuration, or in application performance.

The main functionality is provided by a special virtual user (VU). When you enable the Expert User, this
VU collects more detailed information about requeststhat are made while the script isrunning. Every
main request and subrequest logsthe amount of server and network time used. This helps diagnose why
page loads may be taking longer than expected. For example, a particular subrequest, such as css, gif, html,
and so forth, may betaking moretimeto download from the server than other requests. Expert User data
can show you this. It also can help you determine whether the problem isanetwork or a server problem.

You enable Expert User from the Conductor, either before or during aload test. Expert User usesthe
existing custom counter support so Conductor can graph the custom counter information.

Oncetheload test iscomplete, you can view the datain Analyze. The Analyze Workspace includes an
Expert User tab, from which you can access detail reportsand graphson server and network data. The pre-
defined reportsinclude an Expert User report.

El Note: Currently, Expert User capability is provided only for the WWW middleware.

Enabling Expert User

When you enable the Expert User, thisVU collects more detailed information about requeststhat are made
while the script isrunning. Every main request and subrequest logsthe amount of server and network time
used. This helpsdiagnose why page loads may be taking longer than expected. You enable Expert User
from the Conductor, either before or during aload test. Expert User usesthe existing custom counter
support so Conductor can graph the custom counter information. Once theload test iscomplete, you can
view the datain Analyze.

Note: Currently, Expert User capability is provided only for the WWW middleware.
You can enable the Expert User:
Before aload test beginsfrom the Visual Designer or Grid View windows.

During aload test from the Runtime window.

To enable Expert User before the load test begins:

1. Do oneof thefollowing:
I Using the Visual Designer:

a. Click an individual player machinein the script test setup node to display the Player
Properties panel on theright-hand side of the window.

b. Click the browse[...] button in the Expert User Optionsfield to open the Expert User
Options dialog box.

OR
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I Using the Grid View window:
a. Clickthe Machine Assignment tab.

b. IntheMiddleware field for the appropriate WWW script, click the browse [...] button to
display the Expert User Optionsdialog box.

2. Click Enable Expert User timings.

3. IntheVirtual User Number field, type the Virtual User (VU) number to represent the Expert User.
The default VU number is zero (0).

4. Click OK.

To enable Expert User during the load test:

1. Inthe Runtimewindow, click Actions>Set Expert User Options. The Update Expert User
Optionsdialog box displayslisting all the scriptsthat support Expert User counters.

2. Click the scriptsin which you want to enable Expert User, then click OK.

E Note: Selecting Expert User Scripts at the top level enables or disables expert user on all associated
scripts.

Analyzing Load Test Data

Analyzing Load Test Data

By default, load test timing datais sent from the Conductor to Analyze at the end of aload test. Any
appropriate server monitoring dataisalso sent to Analyze and merged into your timing file (.tim).

You can set an option in the Conductor to automatically launch Analyze at the end of aload test (details),
or you can open Analyze manually from the Conductor toolbar or your QALoad program group.

Creating a Timing File (.tim)

Once all workstations stop executing, click the Quit Current Test button on thetoolbar to complete
thetest and automatically create the timing file (.tim).

Viewing Test Statistics

Compute and view test statisticsin QALoad Analyze.

To access Analyze from the Conductor:

From the Conductor's Tools menu, choose Analyze.
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Integration and Server Monitoring

Server and Performance Monitoring

QALoad integrates several mechanismsfor merging load test response time data with server utilization data
and performance metrics. Select the method that best suitsyour needs, or for which you are licensed (if
applicable). Most methods produce datathat isincluded in your load test timing results and processed in
QALoad Analyze. The only exception is Application Vantage. Data captured from ApplicationVantage can
be opened in ApplicationVantage, but not in QALoad.

This section briefly describes each method, and provideslinksto more detailed information about setting
up atest that includesthe appropriate method.

I Remote Monitoring — allowsyou to monitor server utilization statistics from aremote machine
without installing any software on the remote machine.

I ServerVantage — integrates with your existing ServerVantage installation. You must be licensed for
and haveinstalled and configured the appropriate product in order to integrate with QALoad .

I ApplicationVantage — collectstest datathat you can open in ApplicationVantage.

I Vantage Analyzer - enablesyou to easily drill into specific problem transactionsto determinethe
cause of bottlenecksin your production applications

Integration and Monitoring Requirements

Integration Requirements

ApplicationVantage
I QALoad 5.7 supportsintegration with ApplicationVantage 10.0 Service Pack 2 and 10.1.

I Integration with ApplicationVantageis supported on the Windows platform only.

ServerVantage
I QALoad 5.7 supportsintegration with ServerVantage (SVI Monitoring) 10.0 and 10.1.
I QALoad 5.7 supportsintegration with ServerVantage (Remote Monitoring) 10.1 Service Pack 1.5
only.
ClientVantage
QALoad supportsintegration with ClientVantage. QALoad is packaged with the current version of
ClientVantage at time of release.
Vantage Analyzer

QALoad 5.7 supportsintegration with Vantage Analyzer 10.1 Service Pack 1.

Monitoring Requirements

In addition to the integration requirements, your system may need to meet specific requirementsto
support remote monitoring.

JVM Requirements
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Oracle Application Server (AS), VM, SAP, WebLogic, WebShere, and WebShere MQ monitoring all
require WM installed on the Conductor machine.

For Oracle ASmonitoring, if monitoring Oracle AS10g, you must use Java Virtual Machine 1.5.
For SAP monitoring, you must use VM 1.4.

For WebLogic monitoring version 7 and earlier versions, use M 1.3. For WebLogic version 8.1,
use WM 1.4. For WebLogic 9, use VM 1.5. You may also usethe WM that isdistributed with the
WebLogic Application Server.

For WebSphere monitoring, you must usethe WM provided with the WebSphere client or server.
For WebSphere MQ monitoring, you must use VM 1.4,

File Installation Requirements

Oracle Application Server (AS), SAP, WebLogic, WebSphere, WebSphere MQ, WMI, and Cold Fusion
monitoring require the following files.

Oracle AS

For Oracle AS10g, you must store copies of the dms.jar, xmlparserv2.jar, ons.jar, and optic.jar filesfrom
the monitored Oracle ASserver on the Conductor machine.

SAP Monitoring

The SAPfileslisted below must be placed on the Conductor machine:

librfc32.dll
sapjco.jar
sapjcorfc

To obtain thesefiles, install the SAP Java Connector package (JCo) on the Conductor machine. The JCo
package is available from SAP. Add the location of the files, to the Path System Variable of the Conductor
machine. For more information, refer to the Requirements for SAP Remote Monitoring topicin the
ServerVantage Reconfigure Agent Online Help.

W ebLogic Monitoring

The weblogic.jar file must be placed on the Conductor machine. Copy thejar file from thelib directory of
the WebLogic application server to a separate directory in the Conductor machine. If you are monitoring
WebLogic version 8.1, copy the weblogic.jar and webservices.jar filesto the same directory. If you are
monitoring WebLogic 9.x, copy the weblogic.jar and wljmxclient.jar fileto the same directory. For more
information, refer to Requirements for WebLogic Remote Monitoring in the ServerVantage Reconfigure
Agent Online Help.

W ebSphere Monitoring

Note the following requirements for WebShere monitoring:
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The WebSphere client filesmust be installed on the Conductor machine. Installing the WebSphere
Application Server Admin Server software on the Conductor machine providesthe necessary client
files. Note the directory path of the WebSphere\ AppServer\ Java files. For more information, refer
to Requirements for WebSphere Remote Monitoring in the ServerVantage Reconfigure Agent
Online Help.

The Java Home for the monitoring task must be setup for compatible Java version; for example,
WebSphere\ AppServer\ Java.
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I If authentication isrequired and soap.client.props and ssl.client.props authentication files are
installed in acustom directory, you must also place copies of the filesin
WebSphere\ AppServer\ properties.

W ebSphere MQ Monitoring

The WebSpohere client fileslisted below must be placed in adirectory on the Conductor machine:
I com.ibm.mg.jar
I com.ibm.mgq.pcf.jar
I connector.jar

Thefilesmay be obtained from theinstallation of the WebShere Application Server Admin Server
software on the Conductor machine. If the installation doesnot include the com.ibm.mgq.pcf.jar file,
obtain thefile from the IBM Support Pac M 0B. See "http://www-
l.ibm.com/support/docview.wss?rs=171& uid=swg24000668&loc=en_US& cs=utf-8&lang=en".

For more information, refer to Configuring W ebSphere MQ for Remote Monitoringin the ServerVantage
Reconfigure Agent Online Help.

W MI Monitoring

WM security must be enabled on the monitored server machine and the WM service must be started. For
moreinformation, refer to Configuring WMI for Remote Monitoring in the ServerVantage Reconfigure
Agent Online Help.

Cold Fusion Monitoring

Performance Monitoring must be enabled from the Cold Fusion Administrator Page — Debugging Settings
of the monitored server machine. Cold Fusion is available under Windows Registry monitoring.

Host Verification for QALoad Monitoring

I Ensure host accessibility. Add an entry for the monitored machine to the system hosts file of the
Conductor machine. Consult the network administrator for more information.

I Test host availability. Typethe following command at the Run command: ping <noni t or ed
machi ne nanme>.

Remote Monitoring

Overview of Remote Monitoring

Remote Monitoring enables you to extract data from Windows Registry, VM, Oracle Application Server
(A9, SAP, NMP, ServerVantage, Vantage Analyzer, WebLogic, WebSphere, WebShere MQ, and WM
counterson the serversunder stresswithout installing any software on the servers.

Note: Select countersfor monitor typesin the application.

To use Remote Monitoring:
I You must have login accessto the machinesyou want to monitor.

I You must select the serversand countersto monitor on the machinesyou identify using the
monitoring optionson Conductor's Manage Monitoring Tasks window.

I To collect SNMP counters, SNMP must be enabled on the Remote Monitor machine. Refer to your
operating system help for information about enabling SNMP.

I To collect Windows registry counters, you must have avalid sign-on for the serversunder test.
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I Forrequirementsfor Oracle AS, SAP, WebLogic, WebSphere, WebSphere MQ, and WM, see
Integration and Monitoring Requirements.

QALoad usesthe default ports 7790 and 7788 when it communicateswith the ServerVantage agent and
client. You can override the default portsif your ServerVantage installation requiresit.

While your test isrunning, QALoad collectsthe appropriate counter data and writesit to your timing file
whereyou can view it in Analyze after the test. What counters are available?

You can simplify the configuration process by creating or applying pre-defined monitoring templates. A
monitoring templateisapredefined group of counters not associated with a specific machine.

To set up Remote Monitoring, see Creating a New Monitoring Task.

Monitoring Counters

About Countersand Instances

You use countersand, in some cases, specific instances of counters when you monitor servers.

Counters

Countersarethe numeric data valuesthat are collected when you monitor servers. Counters exist for
componentssuch as processor, memory, processes, hard disk, and cache, with a set of countersthat
measure statistical information. For Windows, a large number of performance counters are provided by the
operating system registry and Windows server applications. Registry counters can monitor external
componentsof the environment such as databases, applications, and printers.

Many of the countersthat are collected are pointsin time data values, such as Process\ thread count. Some
counters are cumulative, such as server logon errors, and some are averages, such asthe page faults per
second in Job Object Details.

In addition to the countersfor numeric values, a set of extended data countersis provided for anumber of
key performance indicators. These extended data counters can provideintelligent data pointsthat have
associated textual data for the numeric value. For example, the extended CPU usage counter'sintelligent
datapoint showsthe top 10 processes consuming CPU at that time.

Note: (SNMP) You can use acustomized OID fileto supplement the standard counters provided by
QALoad during counter discovery. See Customizing SNMP Counter Discovery for more information.

Instances

When you select a counter to monitor, the available instances, or occurrences, for that counter appear.
Counters can have several instances or no instances. For example, if a system has multiple processors, then
the Processor counter has multiple instances. For counterswith multipleinstances, alist of the available
instances for that counter is presented. Many counters also have an instance called _Total, which isan
aggregate of the individual instances.

Countersfor an object, such as processor, have instancesthat are numbered, beginning with 0 (zero). A
machine with a single processor has an instance of _Total and 0. A dual-processor machine hasinstances of
_Total, 0, and 1. Other instances are based on what iscurrently running on the server, and the instance list
displaysthese for each processname or service name that is active.

Some instances represent the most recent value for the resource, for example, Processes. Thisisthe number
of processesin the computer at the time of data collection. Other instances are average values between the
last two measurements.

Windows NT Registry Counters
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Windows NT Registry Server Counters

QALoad supportsthe following MSWindows NT Server counter categories:

Counter Category Description

Active Server Pages

This object type handlesthe Active Server Pages device on your system.

Browser

This object type displays Browser Satistics.

Cache

The Cache object type manages memory for rapid accessto files. Files
on Windows NT are cached in main memory in units of pages. Main
memory not being used in the working sets of processesis available to
the Cache for this purpose. The Cache preservesfile pagesin memory
for aslong as possible to permit accessto the datathrough the file
system without accessing the disk.

Context Index

This object type handlesthe Content Index.

Context Index Filter

This object type handlesthe Content Index Flter.

ICMP

The ICMP object typeincludesthe countersthat describe the ratesthat
ICMP Messages are received and sent by a certain entity using the ICMP
protocol. It also describes various error countsfor the ICMP protocol.

This object type includesthose countersthat describe the ratesthat IP
datagrams arereceived and sent by a certain computer using the IP
protocol. It also describes various error countsfor the IP protocol.

LogicalDisk

A LogicalDisk object type isa partition on a hard or fixed disk drive and
assigned a drive letter, such as C. Disks can be partitioned into distinct
sectionswhere they can store file, program, and page data. The disk is
read to retrieve these itemsand written to record changesto them.

Memory

The Memory object type includesthose countersthat describe the
behavior of both real and virtual memory on the computer. Real
memory isallocated in units of pages. Virtual memory can exceed real
memory in size, causing page traffic asvirtual pages are moved between
disk and real memory.

Network Interface

The Network Interface Object Type includesthose countersthat
describe the ratesthat bytes and packets are received and sent over a
Network TCP/IP connection. It also describes various error counts for
the same connection.

Objects

The Objects object type isa meta-object that containsinformation

about the objectsin existence on the computer. Thisinformation can be
used to detect the unnecessary consumption of computer resources.
Each object requires memory to store basic information about the
object.

Paging File

This object displaysinformation about the system's Page File(s).

PhysicalDisk

A PhysicalDisk object type isahard or fixed disk drive. It contains 1 or
more logical partitions. Disks are used to store file, program, and paging
data. Thedisk isread to retrieve theseitems and written to record
changesto them.
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Process The Process object typeis created when a program isrun. All the threads
in aprocess share the same address space and have accessto the same
data.

Process Address Sace Process Address Space object type displays details about the virtual

memory usage and allocation of the selected process.

Processor The Processor object type includes asinstances all processors on the
computer. A processor isthe part in the computer that performs
arithmetic and logical computations, and initiates operationson
peripherals. It executes (such asruns) programson the computer.

Redirector The Redirector isthe object that manages network connectionsto other
computersthat originate from your own computer.

Server The Server object typeisthe processthat interfacesthe services from the
local computer to the network services.

Server Work Queues The Server Work Queues object type handles explain text performance
data.

SMTP Server This object type handlesthe counters specific to the SMTP Server.

System This object type includesthose countersthat apply to all processorson

the computer collectively. These countersrepresent the activity of all
processorson the computer.

TCP The TCP object typeincludesthe countersthat describe theratesthat
TCP Segments are received and sent by a certain entity using the TCP
protocol. In addition, it describesthe number of TCP connectionsin
each possible TCP connection state.

Telephony This object type handlesthe Telephony System.

Thread The Thread object type isthe basic object that executesinstructionsin a
processor. Every running process has at least one thread.

UDP The UDP object typeincludesthe countersthat describe the ratesthat
UDP datagrams are received and sent by a certain entity using the UDP
protocol. It also describes various error countsfor the UDP protocol.

Active Server Pages Counters

QALoad supportsthe Active Server Pages category for Windows NT. This object type handlesthese registry
counters:

Debugging Requests Requests Rejected
Errors During Script Runtime Requests Succeeded
Errors From ASP Preprocessor Requests Timed Out
Errors From Script Compilers Requests Total
Errors/Sec Script Engines Cached
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Memory Allocated
Request BytesIn Total
Request Bytes Out Total
Request Execution Time
Request Wait Time
Requests/Sec

Requests Disconnected
Requests Executing
Requests Failed Total
Requests Not Authorized
Requests Not Found

Requests Queued

QALoad Online Help

Session Duration
Sessions Current
Sessions Timed Out
Sessions Total

Template Cache Hit Rate
Template Notifications
Templates Cached
Transactions/Sec
Transactions Aborted
Transactions Committed
Transactions Pending

Transactions Total

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Browser Counters

QALoad supportsthe Browser category for Windows NT. This object type handlesthese registry counters:

Announcements Domain/sec
Announcements Server/sec
Announcements Total/sec

Duplicate Master Announcements

Election Packets/sec

Enumerations Domain/sec

Enumerations Other/sec
Enumerations Server/sec
Enumerations Total/sec

Illegal Datagrams/sec

Mailslot Allocations Failed

Mailslot Opens Failed/sec

Mailslot Receives Failed

Mailslot Writes/sec

Mailslot Writes Failed

Missed Mailslot Datagrams

Missed Server Announcements

Missed Server List Requests

Server Announce Allocations Failed/sec

Server List Requests/sec

For information on theregistry counters, refer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.
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Cache Counters

QALoad supportsthe Cache category for Windows NT. This object type handlesthese registry counters:

Async Copy Reads/sec
Async Data Maps/sec
Async Fast Reads/sec
Async MDL Reads/sec

Async Pin Reads/sec

Fast Reads/sec

Lazy Write Hushes/sec
Lazy Write Pages/sec
MDL Read Hits %

MDL Reads/sec

Copy Read Hits % Pin Read Hits %
Copy Reads/sec Pin Reads/sec

Data FHush Pages/sec Read Aheads/sec
Data Hushes/sec Sync Copy Reads/sec
Data Map Hits % Sync Data Maps/sec
Data Map Pins/sec Sync Fast Reads/sec
Data Maps/sec Sync MDL Reads/sec
Fast Read Not Possibles/sec Sync Pin Reads/sec

Fast Read Resource Misses/ sec

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Content Index Filter Counters

QALoad supportsthe Content Index Filter category for Windows NT. Thisobject type handlesthese
registry counters:

Binding time (msec) Total filter speed (MBytes/hr)

Filter speed (MBytes/hr)

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Content Index Counters

QALoad supportsthe Content Index category for Windows NT. This object type handlesthese registry
counters:
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# documentsfiltered
Flesto befiltered
Index size (MBytes)
Merge progress

Persistent indexes

QALoad Online Help

Running queries
Total # documents
Unique keys

Wordlists

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

ICMP Counters

QALoad supportsthe ICMP category for Windows NT. This object type handlesthese registry counters:

M essages/ sec

M essages Outbound Errors
M essages Received/sec

M essages Received Errors

M essages Sent/sec

Received Address M ask
Received Address Mask Reply
Received Dest. Unreachable
Received Echo/sec

Received Echo Reply/sec
Received Parameter Problem
Received Redirect/sec
Received Source Quench

Received Time Exceeded

Received Timestamp/sec
Received Timestamp Reply/sec
Sent Address Mask

Sent Address Mask Reply

Sent Destination Unreachable
Sent Echo/sec

Sent Echo Reply/sec

Sent Parameter Problem

Sent Redirect/sec

Sent Source Quench

Sent Time Exceeded

Sent Timestamp/sec

Sent Timestamp Reply/sec

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

IP Counters

QALoad supportsthe IP category for Windows NT. This object type handlesthese registry counters:
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Datagrams/sec

Datagrams Forwarded/sec
Datagrams Outbound Discarded
Datagrams Outbound No Route

Datagrams Received/sec

Datagrams Received Address Errors

Datagrams Received Delivered/sec

Datagrams Received Discarded

Datagrams Received Header Errors

Datagrams Received Unknown Protocol
Datagrams Sent/sec

Fragment Re-assembly Failures
Fragmentation Failures

Fragmented Datagrams/sec

Fragments Created/sec

Fragments Re-assembled/sec

Fragments Received/sec

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

LogicalDisk Counters

QALoad supportsthe LogicalDisk category for Windows NT. This object type handlesthese registry

counters:

% Disk Read Time

% Disk Time

% Disk Write Time

% Free Space

Avg. Disk Bytes/Read

Avg. Disk Bytes/ Transfer
Avg. Disk Bytes/Write

Avg. Disk Queue Length

Avg. Disk Read Queue Length
Avg. Disk sec/Read

Avg. Disk sec/Transfer

Avg. Disk sec/Write

Avg. Disk Write Queue Length
Current Disk Queue Length
Disk Bytes/sec

Disk Read Bytes/sec

Disk Reads/sec

Disk Transfers/sec

Disk Write Bytes/sec

Disk Writes/sec

Free Megabytes

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Memory Counters
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QALoad supportsthe Memory category for Windows NT. This object type handlesthese registry counters:

% Committed BytesIn Use
Available Bytes

Cache Bytes

Cache Bytes Peak

Cache Faults/sec

Commit Limit

Committed Bytes

Demand Zero Faults/sec
Free System Page Table Entries
Page Faults/sec

Page Reads/sec

Page Writes/sec

Pages/sec

Pages Input/sec

Pages Output/sec

Pool Nonpaged Allocs

Pool Nonpaged Bytes

Pool Paged Allocs

Pool Paged Bytes

Pool Paged Resident Bytes
System Cache Resident Bytes
System Code Resident Bytes
System Code Total Bytes
System Driver Resident Bytes
System Driver Total Bytes
Transition Faults/sec

Write Copies/sec

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Network Interface Counters

QALoad supportsthe Network Interface category for Windows NT. This object type handlesthese registry

counters:

Bytes Received/sec

Bytes Sent/sec

Bytes Total/sec

Current Bandwidth

Output Queue Length
Packets/sec

Packets Outbound Discarded
Packets Outbound Errors

Packets Received/sec

Packets Received Discarded
Packets Received Errors

Packets Received Non-Unicast/sec
Packets Received Unicast/sec
Packets Received Unknown
Packets Sent/sec

Packets Sent Non-Unicast/sec

Packets Sent Unicast/sec
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For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Object Counters
QALoad supportsthe Objects category for Windows NT. This object type handlesthese registry counters:

Events Sections
Mutexes Semaphores
Processes Threads

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Paging File Counters

QALoad supportsthe Paging File category for Windows NT. This object type handlesthese registry
counters:

% Usage % Usage Peak

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Physical Disk Counters

QALoad supportsthe Physical Disk category for Windows NT. Thisobject type handlesthese registry
counters:

% Disk Read Time Avg. Disk sec/Write

% Disk Time Avg. Disk Write Queue Length
% Disk Write Time Current Disk Queue Length
Avg. Disk Bytes/Read Disk Bytes/sec

Avg. Disk Bytes/Transfer Disk Read Bytes/sec

Avg. Disk Bytes/Write Disk Reads/sec

Avg. Disk Queue Length Disk Transfers/sec

Avg. Disk Read Queue Length Disk Write Bytes/sec

Avg. Disk sec/Read Disk Writes/sec
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For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to

http://msdn.microsoft.com/library/default.asp.

Process Address Sace Counters

QALoad supportsthe Process Address category for Windows NT. This object type handlesthese registry

counters:

Bytes Free

Bytes Image Free

Bytes Image Reserved

Bytes Reserved

ID Process

Image Sace Exec Read/Write
Image Sace Exec Read Only
Image Space Exec Write Copy
Image Sace Executable
Image Space No Access
Image Sace Read/Write
Image Sace Read Only

Image Space Write Copy

Mapped Space Exec Read/Write

Mapped Space Exec Read Only

Mapped Space Exec Write Copy

Mapped Space Executable
Mapped Space No Access

Mapped Space Read/Write

Mapped Space Read Only

Mapped Space Write Copy
Reserved Space Exec Read/Write
Reserved Space Exec Read Only
Reserved Space Exec Write Copy
Reserved Space Executable
Reserved Space No Access

Reserved Space Read/Write
Reserved Sace Read Only
Reserved Space Write Copy
Unassigned Space Exec Read/Write
Unassigned Sace Exec Read Only
Unassigned Space Exec Write Copy
Unassigned Sace Executable
Unassigned Space No Access
Unassigned Space Read/Write
Unassigned Space Read Only

Unassigned Space Write Copy

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Process Counters
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QALoad supportsthe Process category for Windows NT. This object type handlesthese registry counters:

% Privileged Time Pool Nonpaged Bytes
% Processor Time (See Note below) Pool Paged Bytes

% User Time Priority Base

Elapsed Time Private Bytes

Handle Count Thread Count

ID Process Virtual Bytes

Page Faults/sec Virtual Bytes Peak
Page File Bytes Working Set

Page File Bytes Peak Working Set Peak

=l Note: If you use the % Processor Time counter in an event rule, set the event rule to trigger after two or
more occurrences of the event. The CPU consumption for the first datapoint sample is artificially high
because the agent is starting the task.

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Processor Counters

QALoad supportsthe Processor category for Windows NT. This object type handlesthese registry counters:

% DPC Time APC Bypasses/sec
% Interrupt Time DPC Bypasses/sec
% Privileged Time DPC Rate

% Processor Time DPCs Queued/sec
% User Time Interrupts/sec

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Redirector Counters
QALoad supportsthe Redirector category for Windows NT. This object type handlesthese registry counters:

Bytes Received/sec Read Operations Random/sec

Bytes Total/sec Read Packets/sec
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Bytes Transmitted/sec
Connects Core

Connects Lan Manager 2.0
Connects Lan Manager 2.1
Connects Windows NT
Current Commands

File Data Operations/sec
File Read Operations/sec
File Write Operations/sec
Network Errors/sec
Packets/sec

Packets Received/sec
Packets Transmitted/sec
Read Bytes Cache/sec

Read Bytes Network/sec
Read Bytes Non-Paging/sec

Read Bytes Paging/sec

QALoad Online Help

Read Packets Small/sec
Reads Denied/sec

Reads Large/sec

Server Disconnects

Server Reconnects

Server Sessions

Server Sessions Hung

Write Bytes Cache/sec
Write Bytes Network/sec
Write Bytes Non-Paging/sec
Write Bytes Paging/sec
Write Operations Random/sec
Write Packets/sec

Write Packets Small/sec
Writes Denied/sec

Writes Large/ sec

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Sarver Counters

QALoad supportsthe Server category for Windows NT. This object type handles these registry counters:

Blocking Requests Rejected
Bytes Received/sec

Bytes Total/sec

Bytes Transmitted/sec
Context Blocks Queued/sec
Errors Access Permissions

Errors Granted Access

Logon Total

Pool Nonpaged Bytes
Pool Nonpaged Failures
Pool Nonpaged Peak
Pool Paged Bytes

Pool Paged Failures

Pool Paged Peak
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Errors Logon Server Sessions
Errors System Sessions Errored Out
File Directory Searches Sessions Forced Off
Files Open Sessions Logged Off
Files Opened Total Sessions Timed Out
Logon/sec Work Item Shortages

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Server Work Queues Counters

QALoad supportsthe Server Work Queues category for Windows NT. This object type handles these registry
counters:

Active Threads Queue Length
Available Threads Read Bytes/sec
Available Work Items Read Operations/sec
Borrowed Work Items Total Bytes/sec

Bytes Received/sec Total Operations/sec
Bytes Sent/sec Work Item Shortages
Bytes Transferred/sec Write Bytes/sec
Context Blocks Queued/sec Write Operations/sec

Current Clients

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

SMITP Srver Counters

QALoad supportsthe SMTP Server category for Windows NT. This object type handlesthese registry
counters:

% Recipients Local M essage Bytes Received/sec
% Recipients Remote M essage Bytes Received Total
Avg Recipients/msg Received M essage Bytes Sent/sec
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Avg Recipients/msg Sent

Avg Retriesymsg Delivered

Avg Retriesymsg Sent

Base % Recipients Local

Base % Recipients Remote
Base Avg Recipients/msg Received
Base Avg Recipients/msg Sent
Base Avg Retriesymsg Delivered
Base Avg Retriessmsg Sent
Bytes Received/sec

Bytes Received Total

Bytes Sent/sec

Bytes Sent Total

Bytes Total

Bytes Total/sec

Connection Errors/sec
Directory Drops/sec

Directory Drops Total
Directory Pickup Queue Length
DNSQueries/sec

DNSQueries Total

ETRN M essages/ sec

ETRN Messages Total

Inbound Connections Current
Inbound Connections Total
Local Queue Length

Local Retry Queue Length
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M essage Bytes Sent Total

M essage Bytes Total

M essage Bytes Total/sec
Message Delivery Retries

M essage Received/sec

Message Send Retries

M essages Delivered/sec
Messages Delivered Total

M essages Received Total

M essages Refused for Address Objects
M essages Refused for Mail Objects
M essages Refused for Sze

M essages Retrieved/sec

M essages Retrieved Total

M essages Sent/sec

Messages Sent Total

NDRs Generated

Number of MailFiles Open
Number of QueueFiles Open
Outbound Connections Current
Outbound Connections Refused
Outbound Connections Total
Remote Queue Length

Remote Retry Queue Length
Routing Table Lookups/sec
Routing Table Lookups Total

Total Connection Errors

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to

http://msdn.microsoft.com/library/default.asp.
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System Counters

QALoad supportsthe System category for Windows NT. This object type handles these registry counters:

% Registry Quotaln Use File Read Operations/sec
% Total DPC Time File Write Bytes/sec

% Total Interrupt Time File Write Operations/sec
% Total Privileged Time Hoating Emulations/sec
% Total Processor Time Processor Queue Length
% Total User Time System Calls/sec
Alignment Fixups/sec System Up Time
Context Switches/sec Total APC Bypasses/sec
Exception Dispatches/sec Total DPC Bypasses/sec
File Control Bytes/sec Total DPC Rate

File Control Operations/sec Total DPCs Queued/sec
File Data Operations/sec Total Interrupts/sec

File Read Bytes/sec

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

TCP Counters
QALoad supportsthe TCP category for Windows NT. This object type handlesthese registry counters:

Connection Failures Segments/sec

Connections Active Segments Received/sec
Connections Established Segments Retransmitted/sec
Connections Passive Segments Sent/sec

Connections Reset

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Tdephony Counters
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QALoad supportsthe Telephony category for Windows NT. This object type handlesthese registry
counters:

Active Lines Incoming Calls/sec
Active Telephones Lines

Client Apps Outgoing Calls/sec
Current Incoming Calls Telephone Devices

Current Outgoing Calls

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Thread Counters

QALoad supportsthe Thread category for Windows NT. This object type handles these registry counters:

% Privileged Time ID Thread

% Processor Time Priority Base

% User Time Priority Current
Context Switches/sec Sart Address
Elapsed Time Thread Sate

ID Process Thread Wait Reason

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

UDP Counters
QALoad supportsthe UDP category for Windows NT. This object type handles these registry counters:

Datagrams/sec Datagrams Received Errors
Datagrams No Port/sec Datagrams Sent/sec

Datagrams Received/sec

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Windows Win2K Registry Counters
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Windows Win2K Server Registry Counters

Remote Monitoring Agents can monitor the same Windows registry counters as PERFMON, the
performance monitoring application available with the Windows operating system. The Windows registry
option monitors machinesthat run Windows 2000 and XP. To retrieve Windows Registry Counters, you
must have access, via a user name and password, to the remote machine.

QALoad supportsthe following MSWindows counter categories:

Counter Category

|

ACSRSVP Service

Description

RSVP or ACSservice performance counters.

Active Server Pages

This object type handlesthe Active Server Pages device on your system.

Browser The Browser performance object consists of countersthat measure the
rates of announcements, enumerations, and other Browser
transmissions.

Cache The Cache performance object consists of countersthat monitor the file

system cache, an area of physical memory that storesrecently used data
aslong as possible to permit accessto the data without reading from
the disk. Because applicationstypically use the cache, the cacheis
monitored as an indicator of application 1/O operations. When memory
is plentiful, the cache can grow, but when memory is scarce, the cache
can become too small to be effective.

IAS Accounting Clients

IAS Accounting Clients

IAS Accounting Server

IAS Accounting Server

IAS Authentication Clients

IAS Authentication Clients

IAS Authentication Server

IAS Authentication Server

ICMP

The ICMP performance object consists of countersthat measure the
rates at which messages are sent and received by using ICMP protocols.
It also includes countersthat monitor ICMP protocol errors.

The IP performance object consists of countersthat measure the rates at
which IP datagrams are sent and received by using IP protocols. It also
includes countersthat monitor IP protocol errors.

LogicalDisk

The Logical Disk performance object consists of countersthat monitor
logical partitions of ahard or fixed disk drives. Performance Monitor
identifies logical disks by their adrive letter, such asC.

Memory

The Memory performance object consists of countersthat describe the
behavior of physical and virtual memory on the computer. Physical
memory isthe amount of random access memory on the computer..
Virtual memory consists of the space in physical memory and on disk.
Many of the memory counters monitor paging, which isthe movement
of pages of code and data between disk and physical memory. Excessive
paging, asymptom of a memory shortage, can cause delays which
interfere with all system processes.

NBT Connection

The NBT Connection performance object consists of countersthat
measure the rates at which bytes are sent and received over the NBT
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connection between thelocal computer and aremote computer. The
connection isidentified by the name of the remote computer.

Network Interface

The Network Interface performance object consists of countersthat
measure the rates at which bytesand packets are sent and received over
a TCP/IP network connection. It includes countersthat monitor
connection errors.

Objects

The Object performance object consists of countersthat monitor logical
objectsin the system, such as processes, threads, mutexes, and
semaphores. Thisinformation can be used to detect the unnecessary
consumption of computer resources. Each object requires memory to
store basic information about the object.

Paging File

The Paging File performance object consists of countersthat monitor
the paging file(s) on the computer. The paging fileisareserved space
on disk that backs up committed physical memory on the computer.

PhysicalDisk

The Physical Disk performance object consists of countersthat monitor
hard or fixed disk drive on acomputer. Disks are used to store file,
program, and paging data and are read to retrieve these items, and
written to record changesto them. The values of physical disk counters
are sums of the values of the logical disks (or partitions) into which
they are divided.

Print Queue

Displays performance statistics about a Print Queue.

Process

The Process performance object consists of countersthat monitor
running application program and system processes. All thethreadsin a
process share the same address space and have accessto the same data.

Process Address Space

The Process Address Space performance object consists of countersthat
monitor memory allocation and use for a selected process.

Processor

The Processor performance object consists of countersthat measure
aspects of processor activity The processor isthe part of the computer
that performsarithmetic and logical computations, initiates operations
on peripherals, and runsthe threads of processes. A computer can have
multiple processors. The processor object represents each processor as
an instance of the object.

Redirector

The Redirector performance object consists of counter that monitor
network connectionsoriginating at the local computer.

Server

The Server performance object consists of countersthat measure
communication between thelocal computer and the network.

Server Work Queues

The Server Work Queues performance object consists of countersthat
monitor the length of the queues and objectsin the queues.

SMTP NTFS Sore Driver

This object represents global countersfor the Exchange NTFS Sore
driver.

SMTP Server

The counters specific to the SV TP Server.

System

The System performance object consists of countersthat apply to more
than oneinstance of acomponent processors on the computer.
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TCP The TCP performance object consists of countersthat measure the rates
at which TCP Segmentsare sent and received by using the TCP
protocol. It includes countersthat monitor the number of TCP
connectionsin each TCP connection state.

Telephony The Telephony System.

Thread The Thread performance object consists of countersthat measure
aspects of thread behavior. A thread isthe basic object that executes
instructionson aprocessor. All running processes have at least one
thread.

UDP The UDP performance object consists of countersthat measure the rates
at which UDP datagrams are sent and received by usingthe UDP
protocol. It includes countersthat monitor UDP protocol errors.

ACSRSVP Sarvice Counters

QALoad supportsthe ACSRSVP Service category for Windows. This object type handlesthese registry
counters:

API notifications Interfaces

API sockets Network sockets
Bytesin API notifies PATH from API

Failed API requests RESV from API

Failed APl sends RSVP msg buffersin use
GQOSsessions Timers

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Active Server Pages Counters

QALoad supportsthe Active Server Pages category for Windows. This object type handlesthese registry
counters:

Debugging Requests Requests Succeeded
Errors/Sec Requests Timed Out
Errors During Script Runtime Requests Total

Errors From ASP Preprocessor Script Engines Cached
Errors From Script Compilers Session Duration
Request BytesIn Total Sessions Current
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Request Bytes Out Total
Request Execution Time
Request Wait Time
Requests/ Sec

Requests Disconnected
Requests Executing
Requests Failed Total
Requests Not Authorized
Requests Not Found
Requests Queued

Requests Rejected
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Sessions Timed Out
Sessions Total

Template Cache Hit Rate
Template Notifications
Templates Cached
Transactions/Sec
Transactions Aborted
Transactions Committed
Transactions Pending

Transactions Total

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Browser Counters

QALoad supportsthe Browser category for Windows. This object type handlesthese registry counters:

Announcements Domain/sec
Announcements Server/sec
Announcements Total/sec

Duplicate Master Announcements

Election Packets/sec

Enumerations Domain/sec

Enumerations Other/sec
Enumerations Server/sec
Enumerations Total/sec

Illegal Datagrams/sec

Mailslot Allocations Failed

Mailslot Opens Failed/sec

Mailslot Receives Failed

Mailslot Writes/sec

Mailslot Writes Failed

Missed Mailslot Datagrams

Missed Server Announcements

Missed Server List Requests

Server Announce Allocations Failed/sec

Server List Requests/sec

For information on theregistry counters, refer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.
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Cache Win2K Counters

QALoad supportsthe Cache category for Windows. This object type handlesthese registry counters:

Async Copy Reads/sec
Async Data Maps/sec
Async Fast Reads/sec

Async MDL Reads/sec

Fast Reads/sec
Lazy Write Hushes/sec
Lazy Write Pages/sec

MDL Read Hits %

Async Pin Reads/sec MDL Reads/sec
Copy Read Hits % Pin Read Hits %
Copy Reads/sec Pin Reads/sec

Data FHush Pages/sec Read Aheads/sec
Data FHushes/sec Sync Copy Reads/sec
Data Map Hits % Sync Data Maps/sec
Data Map Pins/sec Sync Fast Reads/sec
Data Maps/sec Sync MDL Reads/sec
Fast Read Not Possibles/sec Sync Pin Reads/sec

Fast Read Resource Misses/ sec

For information on theregistry counters, refer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

IAS Accounting Clients Counters

QALoad supportsthe IASAccounting Clients category for Windows. This object type handlesthese registry
counters:

Accounting-Requests Malformed Packets
Accounting-Requests/sec Malformed Packets/sec
Accounting-Responses No Record
Accounting-Responses/sec No Record/sec

Bad Authenticators Packets Received

Bad Authenticators/sec Packets Received/sec
Dropped Packets Packets Sent
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Duplicate Accounting-Requests

Duplicate Accounting-Requests/sec
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Packets Sent/sec
Unknown Type

Unknown Type/sec

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

IAS Accounting Server Counters

QALoad supportsthe IAS Accounting Server category for Windows. This object type handlesthese registry

counters:

Accounting-Requests
Accounting-Requests/sec
Accounting-Responses
Accounting-Responses/sec

Bad Authenticators

Bad Authenticators/sec
Dropped Packets

Dropped Packets/sec

Duplicate Accounting-Requests
Duplicate Accounting-Requests/sec
Invalid Requests

Invalid Requests/sec

Malformed Packets
Malformed Packets/sec
No Record

No Record/sec
Packets Received
Packets Received/sec
Packets Sent

Packets Sent/sec
Server Reset Time
Server Up Time
Unknown Type

Unknown Type/sec

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

IAS Authentication Clients Win2K Counters

QALoad supportsthe IASAuthentication Clients category for Windows. This object type handlesthese

registry counters:

Access-Accepts
Access-Accepts/ sec

Access-Challenges

Dropped Packets/sec
Duplicate Access-Requests

Duplicate Access-Requests/sec
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Access-Challenges/sec
Access-Rejects
Access-Rejects/sec
Access-Requests
Access-Requests/sec
Bad Authenticators
Bad Authenticators/sec

Dropped Packets

Malformed Packets
Malformed Packets/sec
Packets Received
Packets Received/sec
Packets Sent

Packets Sent/sec
Unknown Type

Unknown Type/sec

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

IAS Authentication Server Counters

QALoad supportsthe IASAuthentication Server category for Windows. This object type handlesthese

registry counters:

Access-Accepts
Access-Accepts/ sec
Access-Challenges
Access-Challenges/sec
Access-Rejects
Access-Rejects/sec
Access-Requests
Access-Requests/ sec
Bad Authenticators
Bad Authenticators/sec
Dropped Packets

Dropped Packets/sec

Duplicate Access-Requests

Duplicate Access-Requests/sec
Invalid Requests
Invalid Requests/sec
Malformed Packets
Malformed Packets/sec
Packets Received
Packets Received/sec
Packets Sent

Packets Sent/sec

Server Reset Time
Server Up Time
Unknown Type

Unknown Type/sec

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.
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QALoad supportsthe ICMP category for Windows. This object type handlesthese registry counters:

M essages/ sec

M essages Outbound Errors
M essages Received/sec

M essages Received Errors

M essages Sent/sec

Received Address M ask
Received Address Mask Reply
Received Dest. Unreachable
Received Echo/sec

Received Echo Reply/sec
Received Parameter Problem
Received Redirect/sec
Received Source Quench

Received Time Exceeded

Received Timestamp/sec
Received Timestamp Reply/sec
Sent Address Mask

Sent Address Mask Reply

Sent Destination Unreachable
Sent Echo/sec

Sent Echo Reply/sec

Sent Parameter Problem

Sent Redirect/sec

Sent Source Quench

Sent Time Exceeded

Sent Timestamp/sec

Sent Timestamp Reply/sec

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

IP Counters

QALoad supportsthe IP category for Windows. This object type handles these registry counters:

Datagrams/sec

Datagrams Forwarded/sec

Datagrams Received Unknown Protocol

Datagrams Sent/sec

Datagrams Outbound Discarded Fragment Re-assembly Failures

Datagrams Outbound No Route Fragmentation Failures
Datagrams Received/sec Fragmented Datagrams/sec
Datagrams Received Address Errors Fragments Created/sec
Datagrams Received Delivered/sec Fragments Re-assembled/sec

Datagrams Received Discarded Fragments Received/sec
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Datagrams Received Header Errors

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

LogicalDisk Counters
QALoad supportsthe LogicalDisk category for Windows. This object type handlesthese registry counters:

% Disk Read Time Avg. Disk sec/Write

% Disk Time Avg. Disk Write Queue Length
% Disk Write Time Current Disk Queue Length
% Free Ypace Disk Bytes/sec

% ldle Time Disk Read Bytes/sec

Avg. Disk Bytes/Read Disk Reads/sec

Avg. Disk Bytes/ Transfer Disk Transfers/sec

Avg. Disk Bytes/Write Disk Write Bytes/sec

Avg. Disk Queue Length Disk Writes/sec

Avg. Disk Read Queue Length Free Megabytes

Avg. Disk sec/Read Plit 10/Sec

Avg. Disk sec/Transfer

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Memory Counters

QALoad supportsthe Memory category for Windows. This object type handlesthese registry counters:

% Committed BytesIn Use Pool Nonpaged Allocs
Available Bytes Pool Nonpaged Bytes
Cache Bytes Pool Paged Allocs

Cache Bytes Peak Pool Paged Bytes

Cache Faults/sec Pool Paged Resident Bytes
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Commit Limit System Cache Resident Bytes
Committed Bytes System Code Resident Bytes
Demand Zero Faults/sec System Code Total Bytes

Free System Page Table Entries System Driver Resident Bytes

Page Faults/sec System Driver Total Bytes

Page Reads/sec System VLM Commit Charge

Page Writes/sec System VLM Commit Charge Peak
Pages/sec System VLM Shared Commit Charge
Pages Input/sec Transition Faults/sec

Pages Output/sec Write Copies/sec

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

NBT Connection Counters

QALoad supportsthe NBT Connection category for Windows. This object type handlesthese registry
counters:

Bytes Received/sec Bytes Total/sec

Bytes Sent/sec

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Network Interface Counters

QALoad supportsthe Network Interface category for Windows. This object type handlesthese registry
counters:

Bytes Received/sec Packets Received Discarded

Bytes Sent/sec Packets Received Errors

Bytes Total/sec Packets Received Non-Unicast/sec
Current Bandwidth Packets Received Unicast/sec
Output Queue Length Packets Received Unknown
Packets/sec Packets Sent/sec
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Packets Outbound Discarded Packets Sent Non-Unicast/sec
Packets Outbound Errors Packets Sent Unicast/sec

Packets Received/sec

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Objects Counters
QALoad supportsthe Objects category for Windows. This object type handlesthese registry counters:

Events Sections
Mutexes Semaphores
Processes Threads

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Paging File Counters

QALoad supportsthe Paging File category for Windows. This object type handlesthese registry counters:

% Usage % Usage Peak

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

PhysicalDisk Counters
QALoad supportsthe PhysicalDisk category for Windows. Thisobject type handlesthese registry counters:

% Disk Read Time Avg. Disk sec/Write

% Disk Time Avg. Disk Write Queue Length
% Disk Write Time Current Disk Queue Length
% ldle Time Disk Bytes/sec

Avg. Disk Bytes/Read Disk Read Bytes/sec

Avg. Disk Bytes/Transfer Disk Reads/sec

Avg. Disk Bytes/Write Disk Transfers/sec
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Avg. Disk Read Queue Length

Avg. Disk sec/Read
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Disk Write Bytes/sec
Disk Writes/sec

Slit 10/Sec

Avg. Disk sec/Transfer

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Print Queue Counters

QALoad supportsthe Print Queue category for Windows. This object type handlesthese registry counters:

Add Network Printer Calls Max References

Bytes Printed/sec Not Ready Errors

Enumerate Network Printer Calls Out of Paper Errors

Job Errors References
Jobs Total Jobs Printed
Jobs Sooling Total Pages Printed

Max Jobs Spooling

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Process Address Space Counters

QALoad supportsthe Process Address Space category for Windows. Thisobject type handles these registry
counters:

Bytes Free Mapped Space Read Only

Bytes Image Free Mapped Space Write Copy
Bytes Image Reserved Reserved Space Exec Read/Write
Bytes Reserved Reserved Space Exec Read Only
ID Process Reserved Space Exec Write Copy
Image Space Exec Read/Write Reserved Space Executable
Image Sace Exec Read Only Reserved Sace No Access

Image Sace Exec Write Copy Reserved Space Read/Write
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Image Sace Executable Reserved Sace Read Only

Image Space No Access Reserved Space Write Copy

Image Sace Read/Write Unassigned Space Exec Read/Write
Image Sace Read Only Unassigned Sace Exec Read Only
Image Space Write Copy Unassigned Space Exec Write Copy
Mapped Space Exec Read/Write Unassigned Space Executable
Mapped Space Exec Read Only Unassigned Space No Access
Mapped Space Exec Write Copy Unassigned Space Read/Write
Mapped Space Executable Unassigned Space Read Only
Mapped Space No Access Unassigned Space Write Copy

Mapped Space Read/Write

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Process Counters

QALoad supportsthe Process category for Windows. This object type handles these registry counters:

% Privileged Time IO Write Operations/sec
% Processor Time (See Note below.) Page Faults/sec

% User Time Page File Bytes
Creating Process ID Page File Bytes Peak
Elapsed Time Pool Nonpaged Bytes
Handle Count Pool Paged Bytes

ID Process Priority Base

10 Data Bytes/sec Private Bytes

IO Data Operations/sec Thread Count

IO Other Bytes/sec Virtual Bytes

IO Other Operations/sec Virtual Bytes Peak

IO Read Bytes/sec Working Set

IO Read Operations/sec Working Set Peak
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1O Write Bytes/sec

=l Note: If you use the % Processor Time counter in an event rule, set the event rule to trigger after two or
more occurrences of the event. The CPU consumption for the first datapoint sample is artificially high
because the agent is starting the task.

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Processor Counters

QALoad supportsthe Processor category for Windows. This object type handles these registry counters:

% DPC Time APC Bypasses/sec
% Interrupt Time DPC Bypasses/sec
% Privileged Time DPC Rate

% Processor Time DPCs Queued/sec
% User Time Interrupts/sec

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Redirector Counters

QALoad supportsthe Redirector category for Windows. This object type handlesthese registry counters:

Bytes Received/sec Read Operations Random/sec
Bytes Total/sec Read Packets/sec

Bytes Transmitted/sec Read Packets Small/sec
Connects Core Reads Denied/sec
Connects Lan Manager 2.0 Reads Large/sec
Connects Lan Manager 2.1 Server Disconnects
ConnectsWindows NT Server Reconnects
Current Commands Server Sessions

File Data Operations/sec Server Sessions Hung
File Read Operations/sec Write Bytes Cache/sec
File Write Operations/sec Write Bytes Network/sec
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Network Errors/sec Write Bytes Non-Paging/sec
Packets/sec Write Bytes Paging/sec
Packets Received/sec Write Operations Random/sec
Packets Transmitted/sec Write Packets/sec

Read Bytes Cache/sec Write Packets Small/sec

Read Bytes Network/sec Writes Denied/sec

Read Bytes Non-Paging/sec Writes Large/ sec

Read Bytes Paging/sec

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Server Counters

QALoad supportsthe Server category for Windows. This object type handles these registry counters:

Blocking Requests Rejected Logon Total

Bytes Received/sec Pool Nonpaged Bytes
Bytes Total/sec Pool Nonpaged Failures
Bytes Transmitted/sec Pool Nonpaged Peak
Context Blocks Queued/sec Pool Paged Bytes
Errors Access Permissions Pool Paged Failures
Errors Granted Access Pool Paged Peak
Errors Logon Server Sessions
Errors System Sessions Errored Out
File Directory Searches Sessions Forced Off
Files Open Sessions Logged Off
Files Opened Total Sessions Timed Out
Logon/sec Work Item Shortages

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.
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Server Work Queues Counters

QALoad supportsthe Server Work Queues category for Windows. This object type handlesthese registry
counters:

Active Threads Queue Length
Available Threads Read Bytes/sec
Available Work Items Read Operations/sec
Borrowed Work Items Total Bytes/sec

Bytes Received/sec Total Operations/sec
Bytes Sent/sec Work Item Shortages
Bytes Transferred/sec Write Bytes/sec
Context Blocks Queued/sec Write Operations/sec

Current Clients

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

SMTP NTFS Sore Drive Counters

QALoad supportsthe SMTP NTFS Sore Drive category for Windows. This object type handlesthese registry
counters:

M essages allocated Messages in the queue directory
M essages deleted Open message bodies
M essages enumerated Open message streams

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

SMTP Server Counters
QALoad supportsthe SMTP Server category for Windows. This object type handlesthese registry counters:

% Recipients Local Local Retry Queue Length

% Recipients Remote M essage Bytes Received/sec
Avg Recipients/msg Received M essage Bytes Received Total
Avg Recipients/msg Sent M essage Bytes Sent/sec

Avg Retriesymsg Delivered Message Bytes Sent Total
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Avg Retriessmsg Sent

Badmailed Messages (Bad Pickup File)
Badmailed Messages (General Failure)
Badmailed Messages (Hop Count Exceeded)
Badmailed Messages (NDR of DSN)
Badmailed Messages (No Recipients)
Badmailed Messages (Triggered via Event)
Base % Recipients Local

Base % Recipients Remote

Base Avg Recipients/msg Received
Base Avg Recipients/msg Sent

Base Avg Retriessmsg Delivered

Base Avg Retriesymsg Sent

Bytes Received/sec

Bytes Received Total

Bytes Sent Total

Bytes Sent/sec

Bytes Total

Bytes Total/sec

Categorizer Queue Length
Connection Errors/sec

Current Messagesin Local Delivery
Directory Drops/sec

Directory Drops Total
DNSQueries/sec

DNSQueries Total

ETRN M essages/ sec

ETRN Messages Total

Inbound Connections Current
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M essage Bytes Total

M essage Bytes Total/sec

Message Delivery Retries

M essage Received/sec

Message Send Retries

Messages Currently Undeliverable

M essages Delivered/sec

Messages Delivered Total

M essages Pending Routing

M essages Received Total

M essages Refused for Address Objects
M essages Refused for Mail Objects

M essages Refused for Sze

M essages Sent/sec

Messages Sent Total

NDRs Generated

Number of MailFiles Open

Number of QueueFiles Open
Outbound Connections Current
Outbound Connections Refused
Outbound Connections Total

Pickup Directory M essages Retrieved/sec
Pickup Directory M essages Retrieved Total
Remote Queue Length

Remote Retry Queue Length

Routing Table Lookups/sec

Routing Table Lookups Total

Total Connection Errors

Total DSN Failures
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Inbound Connections Total Total messages submitted

Local Queue Length

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

System Counters

QALoad supportsthe System category for Windows. This object type handles these registry counters:;

% Registry Quotaln Use File Write Bytes/sec
Alignment Fixups/sec File Write Operations/sec
Context Switches/sec Foating Emulations/sec
Exception Dispatches/sec Processes

File Control Bytes/sec Processor Queue Length
File Control Operations/sec System Calls/sec

File Data Operations/sec System Up Time

File Read Bytes/sec Threads

File Read Operations/sec

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

TCP Counters
QALoad supportsthe TCP category for Windows. This object type handlesthese registry counters:

Connection Failures Segments/sec

Connections Active Segments Received/sec
Connections Established Segments Retransmitted/sec
Connections Passive Segments Sent/sec

Connections Reset

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Tdephony Counters
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QALoad supportsthe Telephony category for Windows. This object type handlesthese registry counters:

Active Lines Incoming Calls/sec
Active Telephones Lines

Client Apps Outgoing Calls/sec
Current Incoming Calls Telephone Devices

Current Outgoing Calls

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

Thread Counters

QALoad supportsthe Thread category for Windows. This object type handlesthisregistry counter:
User PC

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

UCP Counters
QALoad supportsthe UCP category for Windows. This object type handles these registry counters:

Datagrams/sec Datagrams Received Errors
Datagrams No Port/sec Datagrams Sent/sec

Datagrams Received/sec

For information on theregistry countersrefer to the documentation or developer network for that product
or the developer kit provided with the product. For Microsoft products, refer to
http://msdn.microsoft.com/library/default.asp.

SAP Counters

SAP R/3 Remote Extended Counters

The following extended SAP R/3 remote counters are provided. These counters extend the monitoring of
your SAP R/3 system:

Active Servers Page/Roll Area
Active Users Page/Roll Area M ax
Alerts Process Monitoring
Buffer Satistics Sool Queue
CCMSMonitoring System Log Entries
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Connection Test (SM59) Top CPU Utilization
CPU Consumption Top Load

Itemized Active Users User Function Call
Itemized Job Satus Workload Statistic
Itemized Spool Queue Work Processes

Job Status

Memory Usage

Number of Dumps

SAP Active Servers

Thiscounter returnsthe active SAP application servers for a specified SAP R/3 instance.
Parameters

SAP Instance
Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable.
Select an instance from the discovered list.

Server Count
Maximum number of serverson which to report data. The default is10. The value can range between
00 and 100.

Data Point

Primary Data Point
The primary data point (PDP) is the number of active SAP application servers in the specified SAP instance.
If an error isencountered during data collection, the counter returns 999.

Intelligent Data Point

Theintelligent data point (IDP) displaysthe following information for each server:

Name Full application server name.
Hostname Name of application server host.
Type Service name.
IP Application server host IP address.
Num Services Service port number.

Interval

Recommended minimum is5 minutes.

SAP Active Users

Thiscounter returns all SAP users connected to either a specific SAP R/3 instance or system-wide.
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Parameters

SAP Instance

Composite name of the SAP R/3 instance you want to monitor. Enter an instance name asastringin
the format:

<Syst em nanme>- <Appl i cati on server name>-<R/ 3 system nunber>-<Cient nunber>

For example:
Cl1- sapappserver-01-001

SAP User Count
Maximum number of serverson which to report data. The default is10. The value can range between
00 and 100.

Level
The monitoring level. This parameter is pre-defined and single-selectable. Possible values are:

Selected instance only (default) Only usersin theinstance specified by the SAP
Instance parameter are reported.

All instancesin the system All users of any instance available through the
specified instance are reported.

Data Point

Primary Data Point

The primary data point (PDP) isthe current queue depth as a percentage of the defined maximum. The
Level parameter impactsthe number of serversthat will be scanned. If an error isencountered during
data collection, the counter returns 999.

Intelligent Data Point

The intelligent data point (IDP) displaysthe following information:

Sysname Full application server name.
TerminallD Terminal identification.
Client User’slogon client number.
Username Name of the user.
Report/Tcode Name of tcode or report currently used by
user.
Terminal Terminal name.
Time Dialog time.
Sessions Number of user sessions.
Interval

Recommended minimum is5 minutes.
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SAP Alerts

Thiscounter returns a description of all the SAP alerts for the specified severity level.
Parameters

SAP Instance
Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable.
Select an instance from the discovered list.

Monitor Set

Name of the monitor set. You can specify one or more sets. In any combination, select values from the
discovered list, or enter values manually.

Monitor

Name of the monitor within the selected monitor set. You can specify one or more monitors. In any
combination, select valuesfrom the discovered list, or enter values manually.

Severity

Alert severity level you want to monitor. This parameter is pre-defined and multi-selectable. Possible
values are:

Error - Red (default)

Warning - Yellow

Pattern

Pattern to search for in result. The default isall (* wildcard). You can either accept the default or enter a
string. Wildcard characters cannot beincluded in the string.

Show Alert Text

Secify whether to show the alert'stext. Thisparameter ispre-defined and single-selectable. Possible
values are:

Yes

No (default)

Alert Type

Select whether datareturned presentsonly current alert activity or presentsa history of activity. This
parameter is pre-defined and multi-selectable. Possible values are:

Active alerts (default)

Alert history

Show last minutes

Number of minutes of data history to return.
Data Point

Primary Data Point
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A primary data point (PDP) isreturned for each combination of parameters. The value returned isthe
number of alerts of the specified type. If an error isencountered during data collection, the counter
returns 999.

Intelligent Data Point

Theintelligent data point (IDP) displaysthe following information:

Color Red for errors and yellow for warnings

Severity Severity of alert

Date/Time Alert timestamp

Alert Unique ID Alert ID

Status Satus (for example: active, cone, auto
completed)

System MTE system name

Context MTE context

Object MTE object

Short Name MTE short name

Alert Text Alert text, if any.

Interval

Recommended minimum is5 minutes.

SAP Buffer Satistic
This counter returns statistics for the specified SAP R/3 buffers.

The primary data point returnsthe buffer hit ratio, which isan indicator of how efficiently the buffer is
being used. For a frequently accessed buffer, the hit ratio should exceed 95%.

Parameters

SAP Instance
Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable.
Select an instance from the discovered list.

Buffer Name
Name of the SAP R/3 buffer you want to monitor. You can specify one or more buffers. In any
combination, select valuesfrom the discovered list, or enter values manually.

Statistic Name

The SAP R/3 buffer statistic to be used for the primary data point. This parameter is predefined and
single-selectable. Possible values are:

% of active objects
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% of free objects

Free Size (%)

Free Size (KB)

Hit rate SAP buffer (%) (default)
Maximum no. of objects

No. of active objects

No. of database accesses

No. of free objects

No. of objects swapped

Size of allocated address space (KB)
Storage space available (KB)
Used size (%)

Used size (KB)

Data Point

Primary Data Point

A primary data point (PDP) isreturned for each combination of parameters. The primary data point is
the value for the statistic specified in the Satistic Name parameter. If an error isencountered during
data collection, the counter returns 999.

Intelligent Data Point
Theintelligent data point (IDP) liststhe valuesreturned for all statistics.

Interval

Recommended minimum is5 minutes.

SAP CCMSMonitoring

The Computer Center Management System (CCMS) Monitoring counter returnsthe value of the R/I3 CCMS
Monitoring Tree Element (MTE) asin R/3 transaction RZ20. The performance, statusand log attributes are
distinguished. Each MTEin CCMSisrepresented using four elements: system name, context, object and
name. For example, CW2\ Database\ Tablespaces\ ...\ PSAPTABD.

The counter ignores any relationshipswithin RZ20’stree for the monitor set-monitor pair. Instead, it
allowsyou to select each of these four elementsusing the parameter dependency feature. That is, after a
monitor set is selected, the monitor list hasonly monitorsbelonging to that monitor set. After the monitor
isselected, the system name parameter only hasvaluesthat belong to the combination of monitor set-
monitor, etc.

Performance attributes show anumeric value asthe primary datapoint and any other messages as an
extended datapoint.

Satusand log attributes show their status value — green, yellow, red and white (normal, warning, critical
and no datareported, respectively). The primary datapoint isshown as 1, 2, 3 and O respectively. The
intelligent datapoint isavailable as explanation of returned status.
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This counter enables monitoring of any parts of R/3 of SAP modules, which supply datato CCMS
Parameters

SAP Instance

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable.
Select an instance from the discovered list.

Monitor Set
Name of the monitor set. You can specify one or more sets. In any combination, select values from the
discovered list, or enter values manually.

Monitor
Name of the monitor within the selected monitor set. You can specify one or more monitors. In any
combination, select values from the discovered list, or enter values manually.

System ID
The system ID (or system name) of the monitoring system. You can specify one or more systems. In
any combination, select values from the discovered list, or enter values manually.

Context
The monitored context within the system ID. You can specify one or more contexts. In any
combination, select values from the discovered list, or enter values manually.

Object
The monitored object within the specified context. You can specify one or more objects. In any
combination, select values from the discovered list, or enter values manually.

Name

Name of MTE from R/3’s RZ20 transaction. You can specify one or more names. In any combination,
select values from the discovered list, or enter values manually.

Stat Type
Select what type of dataisreturned. Thisparameter is pre-defined and single-selectable. Possible values
are:
Active alerts returns number of alerts
Alert history returns number of alerts
Value (default) returns MTE value

Show last minutes

Number of minutes of data history to return.

Data Point

Primary Data Point
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A primary data point (PDP) isreturned for each combination of parameters. The value returned isthe
MTE value or number of alerts, depending on the selection in the Sat type parameter. If an error is
encountered during data collection, the counter returns 999.

Intelligent Data Point
The intelligent data point (IDP) providesthe following information:
! MTE status
I Timestamp

! MTE Name

Interval

Not applicable.

SAP Connection Test (SVI59)

Thiscounter teststhe connection to the selected remote system, asdescribed in R/3. Thisisthe same
connection test asthe R/3 transaction SM59.

Parameters

SAP Instance

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable.
Select an instance from the discovered list.

Connection Name

Name of the connection described in SM59. Enter a string. There isno default value.

Data Point

Primary Data Point
The primary data point (PDP) is one of the following values:
I 0ifthetest fails
I 1if thetest issuccessful

I 999 if the counter experiences an error during data collection

Intelligent Data Point
The intelligent data point (IDP) returnsone of the following messages:
I Failurereason if the test failed
I "Connection tested OK” message if the test succeeded

I Error message if the counter encountersan error during data collection

Interval

Recommended minimum is5 minutes.
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SAP CPU Consumption

This counter monitors CPU consumption for the specific users or transactions.
Parameters

SAP Instance
Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable.
Select an instance from the discovered list.

User Name
The user name to monitor. The default isall (* wildcard). You can either accept the default or enter a
specific name. Wildcard characters cannot beincluded in the name.

TCode/Program
The user transaction code or report code to monitor. The default isall (* wildcard). You can either

accept the default or enter a specific name. Wildcard characters cannot be included in the name.

Data Point

Primary Data Point

A primary data point (PDP) isreturned for each combination of parameters. The value returned isthe
percentage of SAP CPU consumption. If an error isencountered during data collection, the counter
returns 999.

If you do not specify values for the User Name or TCODE/Program parameters, the value returned is
always 100%.
Intelligent Data Point

The intelligent data point (IDP) providesthe following information:

Username Name of the user.
Tcode/ Program Name of transaction code or report.
CPU (ms) Current CPU consumption in milliseconds.
CPU (%) Current CPU consumption in percentage.
WP-Type Number of user sessions.

Interval

Recommended minimum is5 minutes.

SAP Itemized Active Users

Thiscounter returnsthe SAP users connected to the specified SAP instance and application servers. It is
similar to the SAP active users counter, with the addition of the Application Server Name parameter (multi-
selectable and wildcard enabled).

Parameters

SAP Instance
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Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable.
Select an instance from the discovered list.

Count

Maximum number of serverson which to report data. The default is10. The instance number can
range between 00 and 100.

Apply Operation

The monitoring level. This parameter is pre-defined and single-selectable. Possible values are:

None A primary data point isreturned for each server specified in the Application
Server parameter.

Sum The primary data point isasum for all servers specified in the Application
Server parameter.
Application Server

Name of the application server you want to monitor. You can specify one or more names. In any
combination, select valuesfrom the discovered list, or enter values manually.

Data Point

Primary Data Point

The primary data point (PDP) isthe current queue depth as a percentage of the defined maximum. The
Apply Operation parameter determineswhether the counter returnsa summary data point or
individual data points. If an error isencountered during data collection, the counter returns 999.

Intelligent Data Point

The intelligent data point (IDP) displaysthe following information:

Sysname Full application server name.
TerminallD Terminal identification.
Client User’slogon client number.
Username Name of the user.
Report/Tcode Name of tcode or report currently used by
user.
Terminal Terminal name.
Time Dialog time.
Sessions Number of user sessions.
Interval

Recommended minimum is5 minutes.
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SAP Itemized Job Satus

This counter reportsthe status of jobsthat meet the specified criteria. It issimilar to the SAP Job Satus
counter, with the addition of the Apply Operation parameter and the all (* wildcard) default setting for the
Job Satus parameter.

Parameters

SAP Instance

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable.
Select an instance from the discovered list.

Job Name

Thejob nameto monitor. The default isall. You can either accept the default or enter aname.

User Name

The user name to monitor. The default isall. You can either accept the default or enter a name.

Job Status

The statusesyou want to monitor. This parameter is predefined and multi-selectable. Possible values
are:

* (all - default)
Active
Canceled
Finished
Ready
Released

Scheduled

Event Name

Name of a SAP job event. If you specify an event name for this parameter, this counter returns batch
jobsrelated to that event only. The default isto monitor all events. You can either accept the default or
enter aname.

Start Time

Number of minutes back from the current time you want thiscounter to monitor job entries. Secify a
value from -999999 to 0 (in minutes). The default valueis -60.

End Time

Number of minutes forward from the current time you want this counter to monitor job entries.
Soecify avalue from 0 to 999999 (in minutes). The default value is 60.

Apply Operation

The monitoring level. This parameter is predefined single-selectable. Possible values are:

None A primary data point isreturned for each statustype specified in the Job
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Status parameter.

Sum (default) The primary data point isasum for all statustypes specified in the Job

Status parameter.

Data Point

Primary Data Point

The primary data point (PDP) isthe number of jobs. The Apply Operation parameter determines
whether the counter returnsa summary data point or individual data points. If an error is encountered
during data collection, the counter returns 999.

Intelligent Data Point

The intelligent data point (IDP) liststhe following information for each job status:

Total jobsfound

I Scheduled

| Released

I Ready

I Active

! Finished

I Cancelled

The IDP also includes atable with the following information, organized by job status:
Jobname Name of the job.
Job-count Internal job ID.
Status Job status.

Log Short log messages.

Interval

Recommended minimum is5 minutes.

SAP Itemized Spool Queue

Thiscounter returnsthe current number of entriesin the SAP spool queue that match the specified criteria.
It issimilar to the SAP ool Queue counter, with the addition of the Apply Operation parameter and the
all default setting for the Request Satus parameter.

Parameter

SAP Instance

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable.
Select an instance from the discovered list.

Request Status
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Request statusthat you want to monitor. This parameter is predefined and multi-selectable. Possible
values are:

* (all - default)
Problem
Processing
Succeeded
Without

Apply Operation
The monitoring level. This parameter is predefined and single-selectable. Possible values are:

None A primary data point isreturned for each statustype specified in the
Request Satus parameter.

Sum (default) The primary data point isasum for all statustypes specified in the Request
Status parameter.

Data Point

Primary Data Point

The primary data point (PDP) isthe number of current entriesin the SAP spool queue. The Apply
Operation parameter determines whether the counter returnsa summary data point or individual data
points. If an error is encountered during data collection, the counter returns 999.

Intelligent Data Point

The intelligent data point (IDP) is the number of entries in the spool queue for each request status.
Interval

Recommended minimum is5 minutes.
SAP Job Satus
This counter reportsthe number of jobsthat are selected that meet the criteria you specify.

Parameters

SAP Instance

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable.
Select an instance from the discovered list.

Job Name

Thejob nameto monitor. The default isall. You can either accept the default or enter aname.

User Name

The user name to monitor. The default isall. You can either accept the default or enter a name.

Job Status
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Thejob statusyou want to monitor. This parameter is predefined and single-selectable. Possible values
are:

* (all)
Active
Canceled
Finished
Ready
Released

Scheduled (default)

Event Name
Name of a SAP job event. If you specify an event name for this parameter, this counter returns batch
jobsrelated to that event only. The default isto monitor all events. You can either accept the default or
enter aname.

Start Time
Number of minutes back from the current time you want thiscounter to monitor job entries. ecify a
value from -999999 to 0 (in minutes). The default valueis -60.

End Time

Number of minutes forward from the current time you want this counter to monitor job entries.
Soecify avalue from 0 to 999999 (in minutes). The default value is 60.

Data Point

Primary Data Point

A primary data point (PDP) isreturned for each combination of parameters. The number returned is

the number of jobs. If an error is encountered during data collection, the counter returns 999.
Intelligent Data Point

Theintelligent data point (IDP) liststhe following information:

! Total jobsfound

I Sheduled

| Released

I Ready

I Active

! FHnished

I Cancelled

The IDP also includes atable with the following information, organized by job status:

Jobname Name of the job.

Job-count Internal job ID.
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Status Job status.
Log Short log messages.
Interval

Recommended minimum is5 minutes.

SAP Memory Usage

This counter returnsthe total memory usage for the specified number of SAP usersin the SAP system.
Parameters

SAP Instance
Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable.
Select an instance from the discovered list.

Count
Maximum number of usersfor which the counter isto report memory utilization values. Secify a
value from 0 to 100. The default is10. Thisnumber isthe number rows of information that isreported
in theIntelligent Data Point (IDP) table (described below).

Metrics

Unitsin which you want memory usage returned. This parameter is predefined and single-selectable.
Possible values are:

bytes
KB
MB

Data Point

Primary Data Point
The primary data point (PDP) isthe total memory utilization. If an error is encountered during data
collection, the counter returns 999.

Intelligent Data Point

Theintelligent data point (IDP) isatable with the following information, organized by user:

Client Client number.

User User name or owner of the job.
TransCode Transaction code name.

Roll Area Sze of roll area.

Page Area Sze of page area.

Shared Memory Sze of shared memory.
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Heap Memory Sze of heap memory.

Summary Memory Summary of all types of memory.

TerminallD Terminal identification number.
Interval

Recommended minimum is5 minutes.

SAP Number of Dumps

This counter returnsthe number of dumps generated by the target system in the current day (since
midnight on the SAP system).

Parameters

SAP Instance
Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable.
Select an instance from the discovered list.

Expression

Pattern to useto match dump’s short text. The default is all

Data Point

Primary Data Point
The primary data point (PDP) isthe number dumps. If an error is encountered during data collection, the
counter returns 999.

Intelligent Data Point

Theintelligent data point (IDP) liststhe following information for each dump:

Time Time dump was created.

Application Host Application host name.

User User name.

Client Client number.

Short Text Dump description.
Interval

Recommended minimum is 15 minutes.

SAP Page/Roll Area

Thiscounter monitorsthe page or roll area statistics.
Parameters

SAP Instance
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Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable.
Select an instance from the discovered list.

Return Value Metrics
The page and roll area metrics. This parameter is pre-defined and multi-selectable. Possible values are:

Maximum Paging Area Used
(%)

Maximum Paging Area Used
(KB)

Maximum Roll Area Used (%)
Maximum Roll Area Used (KB)
Size of the Paging Area (KB)

Size of the Paging Areain the
Shared Memory (KB)

Size of the Paging File (KB)
Size of the Roll Area (KB)

Size of the Roll Areain the
Shared Memory (KB)

Size of the Roll File (KB)

Size of the Work Process-Local
Paging Buffer (KB) (default)

Used Paging Area (%)
Used Paging Area (KB)
Used Roll Area (%)
Used Roll Area (KB)

Data Point

Primary Data Point

A primary data point (PDP) isreturned for each combination of parameters. The value returned isthe
value of the specified metric (KB or %). The counter returns 999 if it encountersan error during data
collection.

Intelligent Data Point
Theintelligent data point (IDP) liststhe statistics for all page and roll metrics.

Interval

Recommended minimum is5 minutes.
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SAP Page/Roll Area Max

This counter returnsthe maximum page or roll area statistics for the specified task interval.

Determining a Satistic's Maximum Value

A Remote Function Call (RFC) ismade at each task interval to get the data. It searchestheinternal cache
for the previously stored value of the same metric with atimestamp within thetime range specified with
the “Period in min” parameter.

If avalueisfound for the specified metric, it iscompared with the current value. The SAP Page/Roll Area
Max counter returnsthe greater of the two values and storesit in the cache with current timestamp.

If astored valueisnot found for the specified metric, the cache iscleared and the current valueisstored in
it. The counter returnsthisvalue.

Parameters

SAP Instance

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable.
Select an instance from the discovered list.

Return Value Metrics
The page and roll area metrics. This parameter is predefined multi-selectable. Possible values are:

Maximum Paging Area Used
(%)

Maximum Paging Area Used
(KB)

Maximum Roll Area Used (%)
Maximum Roll Area Used (KB)
Size of the Paging Area (KB)

Size of the Paging Areain the
Shared Memory (KB)

Size of the Paging File (KB)
Size of the Roll Area (KB)

Size of the Roll Areain the
Shared Memory (KB)

Size of the Roll File (KB)

Size of the Work Process-Local
Paging Buffer (KB) (default)

Used Paging Area (%)
Used Paging Area (KB)
Used Roll Area (%)
Used Roll Area (KB)

Period in min
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Secify amaximum duration of time in minutes. The default is 60.
Data Point

Primary Data Point
A primary data point (PDP) isreturned for each combination of parameters. The valuereturned isthe
maximum value of the specified metric (KB or %), determined by the method described in Determining
a statistic's maximum value. The counter returns 999 if it encountersan error during data collection.
Intelligent Data Point

The intelligent data point (IDP) lists, for the period, the maximum values for all statistics.

Interval

Recommended minimum is5 minutes.

SAP Process Monitoring

This counter returns CPU utilization or memory usage for selected processes. These processes must be set
up to be monitored by the SAP Operation System Collector.

To gather thisdata from the target R/3 instances, you must set up SAP OS Collector (saposcol) to gather
information about system processes. Completeinstructions are described in the document called
“Operation System Collector SAPOSCOL: Propertied, Operation and Installation”. It isavailable from the
SAP web site.

Parameters

SAP Instance

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable from
the discovered list.

Process Pattern or User Pattern

Process or user to monitor. This parameter is single-selectable from the dynamically discovered list.

Metrics

Usage metrics for monitoring. This parameter is predefined and multi-selectable. Possible values are:
CPU Utilization (%)

Process Count (default)

Resident Size (KB)

VM Size (KB)

Data Point

Primary Data Point

A primary data point (PDP) isreturned for each combination of parameters. The returned valueisthe
value of the selected metric. If an error is encountered during data collection, the counter returns 999.

Intelligent Data Point
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Theintelligent data point (IDP) displaysthe following information for each metric:

Last SapOsCol sample wastaken at: <date><time>
SapOsCol collection interval: <number_of_seconds> sec.

Interval

Recommended minimum is5 minutes.

SAP Sool Queue

Thiscounter returnsthe current number of SAP spool queue entriesthat match the specified criteria.
Parameter

SAP Instance

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable.
Select an instance from the discovered list.

Request Status

Request statusthat you want to monitor. This parameter is predefined and single-selectable. Possible
values are:

Problem
Processing (default)
Succeeded
Without

Data Point

Primary Data Point

The primary data point (PDP) for this counter isthe number of current SAP spool queue entriesthat
match the specified criteria. If an error is encountered during data collection, the counter returns 999.

Intelligent Data Point

The intelligent data point (IDP) is the number of entries in the spool queue for each request status.
Interval
Recommended minimum is5 minutes.
SAP System Log Entries
This counter returns, for the selected time period, the entriesthat match the specified expression.

Parameters

SAP Instance

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable.
Select an instance from the discovered list.

Time Period (Minutes)
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Number of minutes back from the current time you want thiscounter to monitor job entries. ecify a
value from 5 to 180 (in minutes). The default value is 60.

Expression
Pattern to useto match the message text in the SAP system log . The default isall. You can either
accept the default or enter a string.

Data Point

Primary Data Point
The primary data point (PDP) isthe number of entriesin the SAP system log that match the selection
criteria.

Intelligent Data Point

Theintelligent data point (IDP) displaysthe following information for each message:

Severity M essage severity level: Error, Warning, or
Normal.

Time Message time.

Type Work processtype and number.

PID System processidentifier of the work
process.

Client Client number.

User User name.

Tcode Transaction code.

Mno M essage number.

Text M essage text.

Interval

Recommended minimum is 10 minutes.

SAP Top CPU Utilization

This counter returnsthe highest CPU utilization, by process, for the top 40 processeson the SAPR/3
application server.

Parameters

SAP Instance

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable.
Select an instance from the discovered list.

Data Point
Primary Data Point
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The primary data point (PDP) isthe highest CPU utilization value. If an error is encountered during data
collection, the counter returns 999.

Intelligent Data Point

Theintelligent data point (IDP) displaysthe following information for the top 40 processes:

PID System process identifier.

Instance Name of SAP R/3 instance.

Command System process name.

CPU Util[%)] CPU utilization value.

CPU Time[g] CPU time value.

Working Set[KB] Top physical memory that isassigned to the process.

Private Pages[KB] Total of the entire memory (physical and virtual) that
isassigned to the process (Windows systemsonly,
thisvalueis 0 on UNIX).

Prior Process priority.

Interval

Recommended minimum is5 minutes.

SAP Top Load

This counter returnsa maximum workload statistic for the SAP system.
Parameters

SAP Instance

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable.
Select an instance from the discovered list.

Count

Maximum number of active servers monitored for workload information. Valid entries are from 0 to
100. The default is 10.

Sorting Parameter

Workload characteristic you want to monitor. This parameter is predefined and multi-selectable.
Possible values are:

CPU Time

DB Time

Response Time (default)
Transfer Size

Wait Time
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Time Metrics

Unitsfor monitoring CPU Time, DB Time, and Response Time, and Wait Time. This parameter is
predefined and single-selectable. Possible values are:

MilliSeconds (default)
Seconds

Size Metrics

Unit of space for monitoring Transfer Sze. This parameter is predefined and single selectable. Possible
values are:

Bytes
KiloBytes (default)
MegaBytes

Data Point

Primary Data Point

A primary data point (PDP) isreturned for each combination of parameters. The returned valueisthe
top workload, in time or size. If an error is encountered during data collection, the counter returns 999.

Intelligent Data Point

The intelligent data point (IDP) displaysthe following information for each transaction:

User User name.

Transaction Transaction code name.

Report Report name.

Background Job Name Name of background job, if valid.

Task Type Type of the task.

Response Time Response name.

CPU Time CPU time.

Wait Time Wait time.

DB Time Database time.

Transfer Size Number of transferred bytes.
Interval

Recommended minimum is 10 minutes.
SAP User Function Call
Thiscounter callsany R/3 RFC-enabled function when it isdesigned according the following

ServerVantage rules. This counter enablesyou to create and implement your own custom SAP R/3 counters.
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ServerVantage User Function Call Guiddines
I Thefunction name can be any character string.
I Thefunction should have oneimport, one export, and one table parameter.

Import parameter: SY_PARAMETERSIis a character string that serves for passing data from
ServerVantage to R/3 function. You define how thisstringis parsed in R/3 function.

Export parameter: SY_VALUE must be float type and serves for passing data point valuesfrom R/3
function to the Java Agent.

Table parameter: SY_EXTENDED_DPisan optional parameter that serves for passing intelligent
(extended) data pointsfrom R/3 function to Java Agent. It can be any character string. To pass
intelligent data points, you need to include the table header.

I Parameter names cannot be changed.

Exceptions: You can define any number of exceptions. In the case of an exception within RFM, the
Monitoring tree displays—1 in the primary data Point (PDP) and an exception message in Intelligent
Data Point (IDP).

! In the body of the function, you may use any manipulationsto retrieve data from R/3 and set
SV_VALUE and SV_EXTENDED_DP.

I Thefunction MUST NOT have any GUI or screen output statements, or any statementsrequiring
dialog, interaction, or additional answers.

Parameters

SAP Instance

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable.
Select an instance from the discovered list.

Function Name
R/3 Remote Function Module (RFM) name.

Parameters

Parametersto passto the function.

Data Point

Primary Data Point

The primary data point (PDP) is the value returned by the R/3 RFM. If an error is encountered during data
collection, the counter returns 999.

Intelligent Data Point
The intelligent data point (IDP) isreturned by the R/3 RFM.

Interval

Not applicable.

SAP W ork Processes

This counter returnsthe number of work processesrunning on a SAP instance according to the specified
criteria.
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Parameters

SAP Instance

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable.
Select an instance from the discovered list.

Process Type

Type of work process. This parameter is predefined and multi-selectable. Possible values are:

BDG Background
DIA (default) Dialog
ENQ Enqueue
SPO Soool

upP2 Update 2
UPD Update

Process State

Process state to monitor. This counter is predefined and multi-selectable. Possible values are:

Completed

Running

Stopped

Waiting (default)

Data Point

Primary Data Point

A primary data point (PDP) isreturned for each combination of parameters. The valuereturned isthe
number of work processes. If an error is encountered during data collection, the counter returns 999.

Intelligent Data Point

Theintelligent data point (IDP) liststhe following processinformation:

Total Work Processes

Work Processes - Waiting Sate
Work Processes - Running Sate
Work Processes - Sopped Sate

Work Processes - Completed Sate

TheIDP also includes atable with the following information, for each process:

Number Process sequential number.
Type Process type.
Process ID Process system ID.
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Status Process status.

Reason Work processiswaiting.

Semaphore Semaphore for which the work processiswaiting.

Restart Restart work process after dump.

Dumps Number of dumps.

CPU CPU time.

Elapsed Time Previous execution time of request (elapsed).

Client Client number.

User User that isusing the process.

Report Report or tcode name used by the process.

Action What the processisdoing.

Table Database table last accessed by the work process.
Interval

Recommended minimum is 10 minutes.

SAP W orkload Satistic

This counter returns selected ST03 workload statistics for selected task types.

Parameters

SAP Instance

QALoad Online Help

Composite name of the SAP R/3 instance you want to monitor. This parameter is single-selectable.
Select an instance from the discovered list.

Task Type

The task type you want to monitor. This parameter is predefined and multi-selectable. Possible values

are:

ALE

AUTOABA (default)

BCKGRD
BUF.SYN
DIALOG
ENQUEUE
FTP
HTTP
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HTTPS
NNTP
RFC
SMTP
SPOOL
UPDATE
UPDATE2

Statistic Name
The workload statistic. This parameter is predefined and multi-selectable. Possible values are:
CPU time avg (ms)
CPU time total(s)
Database calls
Database requests
Database requests: Changes
Database requests: Direct reads
Database requests: Sequential reads
DBtimeavg (ms)
DB time total(s)
Dialog Steps (default)
Dialog steps/s
Frontend net time avg (ms)
Frontend net time total(s)
GUI time avg (ms)
GUI time total(s)
Requested kBytes
Responsetime avg(ms)
Response time total(s)
Roll in time
Roll ins
Roll out time
Roll outs
Roll wait time

Time per DB request
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Time per DB request: Changesand commits
Time per DB request: Direct reads

Time per DB request: Sequential reads

Wait time avg (ms)

Wait time total(s)

Data Point

Primary Data Point

A primary data point (PDP) isreturned for each combination of parameters. The value returned isthe
selected workload statistic. If an error is encountered during data collection, the counter returns 999.

Intelligent Data Point
The intelligent data point (IDP) displays alist of the remaining statistics, for example:
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4} -- web Page Dialog ' x|
Selected Data Point H
Server: qacsapdb

Workload Statistic (SAP Instance: "C62-gacsapdb-01-000", Task

Counter: Type: "DIALOG", Statistic Name: "Dialog Steps™)
Task: workload

Cateqory: SAP B3 Remote Extended

Task Collection Frequency: 5 minutes

Time /17,2004 4:15:56 PM

Value 569

Description Dialog Steps

Workload for the task type DIALOG:

Instance:
SAP System C&2 Date 17 Bap Z004
Instance no. oL

Server gacszapdb

CPT time 108.& = Databaze calls 43,048
Elapsed Time 15, 624.0 = Database regquests Qi 408
= Direct reads 653, E55
Dialoyg steps 1] - Segquential reads 26,419
Dimlog steps / = .o = Changes 1,734
Av. CPU timea 190, % m=
Av. RBFC4#CPIC time 1l2.5 ms Time per DB request 3.0 as
- Direct reads 1.5 ms
Av. response time 1,504, 2 ms = Sequential reads 5.6 ms
- Aw. walt Time 196, 7 ms - Changes and coumits 15.7 ms
= ar. load time d05. 1 m=
- Aw. roll it+w time 135.2 ms Boll-in time 0.& =
= Av. DB reg. tins 475, 0 m= Fall=aout tins 1.8 =
- Av. engueue Time 4.4 ms Boll walt times 6.3 =5
Ball=ins 1,399
bv. bytes reg. 425, 4 ms Boll-outs 1,388
Frontend:
Av. net time BEZ.Z m= Av. GUOL time 133.5 a=

Currenkt Position ; 1 Total ;1

This is the first datapoint,

Close | Freyigus NERE I

Interval

Recommended minimum is 60 minutes.

SNMP Counters

SNMP Counters

SNMP Remote Monitoring usesthe SNMP service to provide network and system counters. SNMP counters
can beretrieved from any machine that isrunning an SNMP server. QALoad usesthe default SNMP port
(161) and default Community (public). If necessary, you can enter a different port and community in the
Configure Monitor Dialog screen when you create or edit an SNMP monitoring task and when you create
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or edit an SNMP monitoring template. Although SNMP does not require a user name and password, the
SNMP agent must be configured to allow read-only access from the Conductor machine.

In addition to the standard SNMP counters supported by QALoad Remote Monitoring, you can create your
own custom Object Identifier (OID) file with countersyou define. See Customizing SNMP Counter
Discovery for more information.

Sandard SNMP Counters

Sandard SNMP countersthat are supported by QALoad Remote Monitoring are categorized below.

ICMP

icmplnMsgs/sec: the rate at which ICMP messages are received

icmplnErrors: the number of ICMP messages received having ICMP errors
IcmplnDestUnreachs: the number of ICMP Destination Unreachable messages received
IcmplnTimeExcds: the number of ICMP Time Exceeded messages received
IcmplnParmProbs: the number of ICMP Parameter Problem messages received

IcmplinSrcQuenchs: the number of ICMP Source Quench messages received
icmplnRedirects/sec: the rate at which ICMP Redirect messages are received
icmplnEchos/sec: therate at which ICMP Echo messages are received
icmplnEchoReps/sec: therate at which ICMP Echo Reply messages are received
icmplnTimestamps/sec: the rate at which ICMP Timestamp messages are received
icmplnTimestampReps/ sec: therate at which ICMP Timestamp Reply messages are received
icmplnAddrMasks: the number of ICMP Address Mask Request messages received
icmplnAddrMaskReps: the number of ICMP Address Mask Reply messages received
icmpOutMsgs/sec: therate at which ICMP messages are sent

icmpOutMsgs/ sec: the number of ICMP messages not sent dueto ICMP errors
icmpOutDestUnreachs: the number of ICMP Destination Unreachable messages sent
icmpOutTimeExcds: the number of ICMP Time Exceeded messages sent
icmpOutParm Probs: the number of ICMP Parameter Problem messages sent
icmpOutSrcQuenchs: the number of ICMP Source Quench messages sent
icmpOutRedirects/ sec: the number of ICMP Redirect messages sent
icmpOutEchos/sec: the number of ICMP Echo messages sent
icmpOutEchoReps/sec: the number of ICMP Echo Reply messages sent
icmpOutTimestam ps/sec: the number of ICMP Timestamp messages sent
icmpOutTimestam pReps/ sec: the number of ICMP Timestamp Reply messages sent
icmpOutAddrMasks: the number of ICMP Address Mask Request messages sent
icmpOutAddrMaskReps: the number of ICMP Address Mask Reply messages sent

IP

ipForwarding: the indication of whether thisentity isacting asan IP router in respect to the forwarding of
datagramsreceived by, but not addressed to, thisentity.

ipDefaultTTL: the default value inserted into the Time-To-Live field of the IP header of datagrams
originated at thisentity, whenever a TTL value isnot supplied by the transport layer protocol.
iplnReceives/sec: the rate of input datagramsreceived from interfaces, including those received in error.
iplnHdrErrors: the number of input datagrams discarded due to errorsin their IP headers, including bad
checksums, version number mismatch, other format errors, time-to-live exceeded, errors discovered in
processing their IP options, and so on.

iplnAddrErrors: the number of input datagrams discarded because the IP addressin their IP header's
destination field was not avalid addressto be received at thisentity.

ipForwDatagram s/ sec: the rate of input datagrams for which thisentity wasnot their final IP destination,
asaresult of which an attempt was made to find aroute to forward them to that final destination.
iplnUnknownProtos: the number of locally-addressed datagrams receive successfully but discarded
because of an unknown or unsupported protocol.
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iplnDiscards: the number of input IP datagrams for which no problemswere encountered to prevent their
continued processing, but which were discarded (for example, for lack of buffer space).

iplnDelivers/ sec: the rate of input datagrams successfully delivered to IP user-protocols (including ICMP).
ipOutRequests: the number of IP datagramswhich local IP user-protocols (including ICMP) supplied to IP
in requests for transmission.

ipOutDiscards: the number of output IP datagrams for which no problem was encountered to prevent
their transmission to their destination, but which were discarded (for example, for lack of buffer space).
ipOutNoRoutes: the number of IP datagrams discarded because no route could be found to transmit them
to their destination.

ipReasm Timeout: the maximum number of secondswhich received fragmentsare held while they are
awaiting reassembling at this entity.

ipReasm Reqds: the number of IP fragments received which needed to be reassembled at this entity.
ipReasm OKs: the number of IP datagrams successfully re-assembled.

ipReasm Fails: the number of failures detected by the IP re-assembly algorithm (for whatever reason: timed
out, errors, etc).

ipFragOKs: the number of IP datagramsthat have been successfully fragmented at this entity.

ipFragFails: the number of IP datagramsthat have been discarded because they needed to be fragmented at
thisentity but could not be, for example, because their Don't Fragment flag was set.

ipFragCreates/ sec: the rate of IP datagram fragmentsthat have been generated as a result of fragmentation
at thisentity.

ipRoutingDiscards: the number of routing entrieswhich were chosen to be discarded even though they
arevalid.

NMP

snmplnPkts/ sec: the rate of messages delivered to the SNMP entity from the transport service.
snmpOutPkts/ sec: the rate at which SNMP Messages were passed from the SNMP protocol entity to the
transport service.

snmplnBadVersions: the number of SNMP messages which were delivered to the SNMP entity and were
for an unsupported SNMP version.

snmplnBadCommunityNames: the number of SNMP messages delivered to the SNMP entity which used a
SNMP community name not known to said entity.

snmplnBadCommunityUses: the number of SNMP messages delivered to the SNMP entity which
represented an SNMP operation which was not allowed by the SNMP community named in the message.
snmplnASNParseErrs: the number of ASN.1 or BER errors encountered by the SNMP entity when decoding
received SNM P messages.

snmplnTooBigs: the number of SNMP PDUs which were delivered to the SNMP protocol entity and for
which the value of the error-statusfield istooBig.

snmplnNoSuchNames: the number of SNMP PDUswhich were delivered to the SNMP protocol entity and
for which the value of the error-status field isnoSuchName.

snmplnBadValues: the number of SNMP PDUswhich were delivered to the SNMP protocol entity and for
which the value of the error-statusfield is badValue.

snmplnReadOnlys: the number valid SNMP PDUs which were delivered to the SNMP protocol entity and
for which the value of the error-statusfield isreadOnly.

snmplnGenErrs: the number of SNMP PDUswhich were delivered to the SNMP protocol entity and for
which the value of the error-statusfield is genErr.

snmplnTotalReqVars/sec: the rate of MIB objects which have been retrieved successfully by the SNMP
protocol entity asthe result of receiving valid SNMP Get-Request and Get-Next PDUs.
snmplnTotalSetVars/ sec: the rate of MIB objectswhich have been altered successfully by the SNMP
protocol entity asthe result of receiving valid SNMP Set-Request PDUs.

snmplnGetRequests/ sec: the rate of SNMP Get-Request PDUswhich have been accepted and processed by
the SNMP protocol entity.

snmplnGetNexts/sec: the rate of SNMP Get-Next PDUswhich have been accepted and processed by the
SNMP protocol entity.

snmplnSetRequests/sec: the rate of SNMP Get-Response PDUswhich have been accepted and processed
by the SNMP protocol entity.
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snmplnGetResponses/sec: the rate of SNMP Set-Request PDUs which have been accepted and processed
by the SNMP protocol entity.

snmplnTraps: the number of SNMP Trap PDUswhich have been accepted and processed by the SNMP
protocol entity.

snmpOutTooBigs: the number of SNMP PDUswhich were generated by the SNMP protocol entity and for
which the value of the error-statusfield istooBig.

snmpOutNoSuchNames: the number of SNMP PDUswhich were generated by the SNMP protocol entity
and for which the value of the error-statusisnoSuchName.

snmpOutBadValues: the number of SNMP PDUswhich were generated by the SNMP protocol entity and
for which the value of the error-statusfield is badValue.

snmpOutGenErrs: the number of SNMP PDUswhich were generated by the SNMP protocol entity and for
which the value of the error-statusfield is genErr.

snmpOutGetRequests/ sec: the rate of SNMP Get-Request PDUswhich have been generated by the SNMP
protocol entity.

snmpOutGetNexts/sec: the rate of SNMP Get-Next PDUswhich have been generated by the SNMP
protocol entity.

snmpOutSetRequests/sec: the rate of SNMP Set-Request PDUs which have been generated by the SNMP
protocol entity.

snmpOutGetResponses/ sec: the rate of SNMP Get-Response PDUswhich have been generated by the
SNMP protocol entity.

snmpOutTraps: the number of SNMP Trap PDUswhich have been generated by the SNMP protocol entity.
snmpOutTraps: indicates whether the SNMP entity is permitted to generate authenticationFailure traps.

TCP

tcpRtoAlgorithm: the algorithm used to determine the timeout value used for retransmitting
unacknowledged octets.

tcpRtoMin: theminimum value permitted by a TCPimplementation for the retransmission timeout.
tcpRtoMax: the maximum value permitted by a TCPimplementation for the retransmission timeout.
tcpMaxConn: thelimit on the total number of TCP connectionsthe entity can support.
tcpActiveOpens: the number of times TCP connections have made a direct transition to the SYN-SENT
state from the CLOSED state.

tcpAttem ptFails: the number of times TCP connections have made a direct transition to the SYN-RCVD
state from the LISTEN state.

tcpEstabResets: the number of times TCP connectionshave made a direct transition to the CLOSED state
from either the ESTABLISHED state or the CLOSE-WAIT state.

tcpCurrEstab: the number of TCP connections for which the current state is either ESTABLISHED or
CLOSE-WAIT.

tcplnSegs/ sec: the rate at which segmentsare received, including those received in error.
tcpOutSegs/sec: therate at which segments are sent, including those on current connections but
excluding those containing only retransmitted octets.

tcpRetransSegs/ sec: the rate at which segments are retransmitted.

tcpinErrs/sec: therate at which segments are received in error.

tcpOutRsts/ sec: the rate at which segments containing the RST flag are sent.

tcpPassiveOpens: the total number of times TCP connections have made a direct transition to the SYN-
RCVD state from the LISTEN state.

UbpP

udplnDatagrams/ sec: the rate of UDP datagrams being delivered to UDP users.

udpNoPorts/ sec: therate of received UDP datagrams for which there was no application at the destination
port.

udplnErrors: the number of received UDP datagramsthat could not be delivered for reasons other than
thelack of an application at the destination port.

udpOutDatagrams/sec: therate at which UDP datagrams are sent.
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Solaris; Sun System

Collisions/ sec: therate of output collisions.

CpuUser%: the percentage of non-idle processor time that is spent in user mode.
CpuNice%: the percentage of non-idle processor time that is spent in nice mode.
CpuSys%: the percentage of non-idle processor time that isspent in system mode.
Cpuldle%: the percentage of idle processor time.

IfInPackets/ sec: the rate of input packets.

IfOutPackets/sec: therate of output packets.

IfInErrors: the total number of input errors.

IfOutErrors: the total number of output errors.

Interrupts/sec: the rate of system interrupts.

Pagesln KBytes/ sec: the rate of pagesread in from disk.

PagesOut KBytes/sec: the rate of pageswritten to disk.

Swapln KBytes/sec: therate at which pages are being swapped in.

SwapOut KBytes/sec: therate at which pages are being swapped out.

HP-UX: HP System

AvgJobsl: the average number of jobsin thelast minute * 100.

AvgJobsb: the average number of jobsin thelast 5 minutes* 100.

AvgJobsl5: the average number of jobsin thelast 15 minutes* 100.

CpuUser%: the percentage of non-idle processor time that is spent in user mode.
CpuNice%: the percentage of non-idle processor time that is spent in nice mode.
CpuSys%: the percentage of non-idle processor time that isspent in system mode.
Cpuldle%: the percentage of idle processor time.

FreeMemory KBytes: the amount of idle memory.

FreeSwap KBytes: the amount of free swap space on the system.

MaxProc: the maximum number of processes allowed.

MaxUserMem KBytes: the amount of maximum user memory on the system.
PhysMemory KBytes: the amount of physical memory on the system.

Users: the number of userslogged on to the machine.

LINUX Memory

AvailableSwap KBytes: the available swap on the system.
Buffered KBytes: the amount of memory used as buffers.

Cached KBytes: the amount of memory cached.

FreeMemory KBytes: the amount of idle memory.

Shared KBytes: the amount of memory shared.

TotalMemory KBytes: the total amount of memory on the system.
TotalSwap KBytes: the total swap size for the system.

LINUX System

CpuUser%: the percentage of non-idle processor time that isspent in user mode.
CpuNice%: the percentage of non-idle processor time that is spent in nice mode.
CpuSys%: the percentage of non-idle processor time that isspent in system mode.
Cpuldle%: the percentage of idle processor time.

Windows HTTP Server

httpTotalFilesSent: the total number of files sent by thisHTTP server.

httpTotalFilesReceived: the total number of filesreceived by thisHTTP server.
httpCurrentAnonymousUsers: the number of anonymous users currently connected to thisHTTP server.
httpCurrentNonAnonymousUsers: the number of non-anonymous users currently connected to this
HTTP server.

httpTotalAnonymousUsers; the total number of anonymous usersthat have ever connected to thisHTTP
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server.
httpTotaINonAnonymousUsers: the total number of non-anonymoususersthat have ever connected to
thisHTTP server.

httpMaximum AnonymousUsers: the maximum number of anonymous users simultaneously connected
to thisHTTP server.

httpMaximumNonAnonymousUsers: the maximum number of non-anonymous users simultaneously
connected to thisHTTP server.

httpCurrentConnections: the current number of connectionsto the HTTP server.
httpMaximumConnections: the maximum number of simultaneous connectionsto the HTTP server.
httpConnectionAttempts: the total number of connection attemptsto the HTTP server.
httpLogonAttempts: the total number of logon attemptsto the HTTP server.

httpTotalOptions: the total number of requests made to thisHTTP server using the OPTIONSmethod.
httpTotalGets: the total number of requests made to thisHTTP server using the GET method.

httpTotal Posts: the total number of requests made to thisHTTP server using the POST method.
httpTotalHeads: the total number of requests made to thisHTTP server using the HEAD method.
httpTotalPuts: the total number of requests made to thisHTTP server using the PUT method.
httpTotalDeletes: the total number of requests made to thisHTTP server using the DELETE method.
httpTotal Traces: the total number of requests made to thisHTTP server using the TRACE method.
httpTotalMove: the total number of requests made to thisHTTP server using the MOVE method.
httpTotalCopy: the total number of requests made to thisHTTP server using the COPY method.
httpTotalMkcol: the total number of requests made to thisHTTP server using the MKCOL method.
httpTotalPropfind: the total number of requests made to thisHTTP server using the PROPFIND method.
httpTotalProppatch: the total number of requests made to this HTTP server using the PROPPATCH
method.

httpTotalSearch: the total number of requests made to thisHTTP server using the MSSEARCH method.
httpTotalLock: the total number of requests made to thisHTTP server using the LOCK method.
httpTotalUnlock: the total number of requests made to thisHTTP server using the UNLOCK method.
httpTotalOthers: the total number of requests made to thisHTTP server not using the OPTIONS, GET,
HEAD, POST, PUT, DELETE, TRACE, MOVE, MKCOL, PROPFIND, PROPPATCH, MSSEARCH, LOCK or
UNLOCK methods.

httpCurrentCGIRequests: the number of Common Gateway Interface requests currently being serviced by
thisHTTP server.

httpCurrentBGIRequests: the number of Binary Gateway Interface requests currently being serviced by
thisHTTP server.

httpTotal CGIRequests: the total number of Common Gateway Interface requests made to thisHTTP
server.

httpTotalBGIRequests: the total number Binary Gateway Interface requests made to this HTTP server.
httpMaximum CGIRequests: the maximum number of Common Gateway Interface requests
simultaneously processed by thisHTTP server.

httpMaximumBGIRequests: the maximum number of Binary Gateway Interface requests simultaneously
processed by thisHTTP server.

httpCurrentBlockedRequests: the current number of requests being temporarily blocked by thisHTTP
server.

httpTotalBlockedRequests: the total number of requeststhat have been temporarily blocked by thisHTTP
server.

httpTotalRejectedRequests: the total number of requeststhat have been rejected by thisHTTP server.

Windows FTP Server

ftpTotalFilesSent: the total number of files sent by this FTP server.

ftpTotalFilesReceived: the total number of filesreceived by this FTP server.
ftpCurrentAnonymousUsers: the number of anonymous users currently connected to this FTP server.
ftpCurrentNonAnonymousUsers: the number of non-anonymous users currently connected to this FTP
server.

ftpTotalAnonymousUsers: the total number of anonymoususersthat have ever connected to this FTP
server.
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ftpTotaINonAnonymousUsers: the total number of non-anonymous usersthat have ever connected to
this FTP server.

ftpMaximumAnonymousUsers: the maximum number of anonymous users simultaneously connected to
this FTP server.

ftpMaximumNonAnonymousUsers: the maximum number of non-anonymous users simultaneously
connected to this FTP server.

ftpCurrentConnections: the current number of connectionsto the FTP server.

ftpMaximum Connections: the maximum number of simultaneous connectionsto the FTP server.
ftpConnectionAttempts: the total number of connection attemptsto the FTP server.

ftpLogonAttem pts: the total number of logon attemptsto the FTP server.

Customizing SNMP Counter Discovery

QALoad currently has a standard list of Object Identifiers (OID) that it searches when discovering SNMP
counters. You can create and import alist of additional OIDsin an XML file. The XML file, called the
Custom OID File, introduces additional SNMP countersthat you want to include during the counter
discovery phase when you create or edit tasks and templates.

Note: You can include multiple categories and multiple countersin the custom OID file.

Once you create the custom OID file, you select it using the Custom OID Filefield in the Configure
Monitor Dialog screen of the monitoring wizards. Snce thereisaoneto one relationship between
monitoring tasks and the custom file, multiple filescan exist. These reside in acommon, default location:
QALoad\ Moni t ori ng\ SNVP. The browse button for the Custom OID File field defaultsto thislocation.
Thisdirectory also containstwo filesto assist you in developing your Custom OID File:

I OID structure.xml - atemplate you can use for creating your custom supplemental file. This
containsthe basic XML structure you need to create your own Custom OID file. The Table of
Custom OID File Elements describes and givesthe rulesfor each of the XML elementsin the
structure.

I OID example.xml - acustom OID XML file structure. Thisisasample Custom OID File.

Custom OID Template File

Use the following template, located in QALoad\Monitoring\SNMP\OID structure.xml, to create your custom OID
file:

Table of Custom OID File Elements

The following table shows each element in the XML file structure, and describesits purpose and the rules
that apply.

Tag Description Rules |

. o Must be first element of
XML file header indicating | fjje.

<?xml version="1.0" 7> . .
files structural version.

Only one per file.

Begin bracket for entire OID Only one per file.

custom information. Used

<OIbCustom> to both identify content Must immediately follow
XML version header.

type and begin/end of file.

Begin bracket for list of Only one per file.
<CategorvList> categoriesdefined in this . _
gory file. Used to help group all | Must immediately follow

the contained categories. <OIDCustom> tag.

124



QALoad Online Help

<Category>

Begin bracket for an
individual category within
the category list. Used to
help group individual
categories.

One required per category
group.

First instance must
immediately follow
<CategoryList> tag.
Subsequent instances
immediately follow
</Category> end tag of
previous group.

<CategoryName>?</CategoryName>

The display name for the
category group. The*?
represents where the user
definesthe category name.

One required per
category. Must
immediately follow
<Category> tag.

<Counter>

Begin bracket for individual
counter information
contained in a category.
Multiple counters can exist
per category.

One required per counter.

Frst instance must
immediately follow
</CategoryName> tag.
Subsequent instances
immediately follow
</Counter> tag.

<CounterName>?</CounterName>

The display name for the
counter. The “?’ represents
where the user definesthe
counter name.

One required per counter.

Only one allowed per
counter.

<OID>?%</0ID>

The OID for the counter.
The OID must start with a
period “.” (see example
below). The “?" represents
wherethe user definesthe
OID.

One required per counter.

Only one allowed per
counter.

<Units>?</Units>

The optional calculation
unitsfor the counter. The
“? representswherethe
user definesthe calculation
type which isone of the
following:

“/sec” —for countersthat
must take into account the
time between samplings.

“Cpu%” —for countersthat
must take into account the
number of processors. A
counter for which this
appliesis Cpullde%.

“Kbits/sec” —for
converting countersthat
natively report in Kbit/sec
to Kbytes/ sec.

Optionally, one per
counter.

Only one allowed per
counter.
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<Description>?</Description>

The optional description for
the counter. The“?
represents where the user
definesthe OID.

Optionally, one per
counter.

Only one allowed per
counter.

</Counter>

The end bracket for an
individual counter
information set. Used to
denotethe end of
individual counters
attribute information.

One required per counter.

</Category>

The end bracket for an
individual category, used to
denotetheend of a
category and all of its
associated counters.

One required per category.

</CategoryList>

End bracket for list of
categories.

Only one per file.

Must immediately precede
<OIDCustom> tag.

</OIDCustom>

End bracket for entire OID
custom information. Used
to identify the end of file.

Only one per file.
Must be last file element.

Custom OID SampleFile

The sample Custom OID File shown here is located in QALoad\Monitoring\SNMP\OID example.xml:
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<?xml version="1.0" #>
- Z0IDCustoms=
- <CategoryList>
- «zCategory:>
=CategaryName sip</Catzgoryblame =
<Counters
<Counteriame =ipDefault TTL =/ Counterame =
<000>.1.3.6.1.2.1.4.2.0=/0I0=
<Description=The default value inserted into the Time-To-Live field of the IP header. </Description >
= Counter=
- <Counters=
=Counterdame ~ipRoutingDiscards </ Counteriame >
<0ID>.1.3.6.1.2.1.4.23.0</0ID >
<Description:=The number of routing entries which were chosen to be discarded even though they
are valid. </Dezcription=
<fCounter>
</Catagoty =
- <Category=
<CategoryMame >tcp</CategoryMamsa >
- «<Countar=
<Counteriame =tcpActiveOpens </ Counterflamea =
20I0>.1.3.6.1.2.1.6.5.0=/ 010>
<Description=The number of times TCP connections have made a direct transition to the SYN-SENT
state from the CLOSED state.</Description
= Counters
<Countar:s
<CountzrName>tcpInSeqgs</Counterfams =
<0i0=.1.3.6.1.2.1.6.10.0</ 010 =
<Description=The total number of segments received, including those recelved in
arror.</Description
</ Counter:>
/Category >
<Category>
wCategoaryMame =Cpu Attributes</CategoryMame:
- «Counter>
<iCounteriame >Cpu Idle% </ Countertame =
<0ID>.1.3.6.1.4.1.2021.11.53.0</010:
<Units>Cpu®%p </Lnits =
zDescription=Cpu Idle%s is the percentage of idle processor time. </Dascrption:
=/ Counter=
</ Catagory >
</CategoryList=
< OIDCustom=

WeblLogic7/8 Counters

W ebLogic Remote Extended Counters

The following dynamically discovered WebLogic remote extended counter categories are provided in
QALoad. Each category provides countersthat extend the monitoring of your WebLogic system. The
categories, counter names, and parameters are all dynamically discovered by processing the set of MBeans
availablein the WebLogic M X Server.

WebLogic Application Runtime WebLogic M S Session Runtime
WebLogic Connector Service Runtime WebLogic JTA Recovery Runtime
WebLogic Deployer Runtime WebLogic JTA Runtime

WebLogic Domain Log Handler Runtime WebLogic VM Runtime

WebLogic Domain Runtime WebLogic Log Broadcaster Runtime
WebLogic EB Cache Runtime WebLogic Message Driven EBB Runtime
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WebLogic EB Component Runtime
WeblLogic EB Locking Runtime
WebLogic EB Pool Runtime
WebLogic EB Transaction Runtime
WebLogic Entity EJB Runtime
WebLogic Execute Queue Runtime
WebLogic IDBC Connection Pool Runtime
WebLogic MSConnection Runtime
WebLogic MSConsumer Runtime
WebLogic MSDestination Runtime
WebLogic MSRuntime

WebLogic IMS Server Runtime

W ebLogic Application Runtime

WebLogic Migratable Service Coordinator
Runtime

WebLogic Server Life Cycle Runtime
WebLogic Server Runtime

WebLogic Server Security Runtime
WebLogic Servlet Runtime

WebLogic Sateful EBB Runtime
WebLogic Sateless EIB Runtime
WebLogic Time Service Runtime
WebLogic Transaction Resource Runtime
WebLogic Web App Component Runtime
WebLogic Web Server Runtime

The WebLogic Application Runtime category includesthe counterslisted in the following table. Some of
the counterslisted in the table may not be available on your system. WebLogic counter categories, counter
names, and parameters are dynamically discovered by processing the set of MBeansin the WebLogic M X
Server. Which counters are discovered isdetermined by the WebLogic version you arerunning and how

WebLogic is configured.

M Description S A

CachingDisabled Prlvgte property that disables caching in Boolean Yes Yes
proxies.
. Returnsfalse if the MBean represented by
Registered thisobject has been unregistered Boolean Yes ves
Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. This allows you to select
between the multiple parametersand always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web

Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domains for monitoring. In any combination, select values from the discovered

list, or enter values manually.

Location
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WebLogic Application Server where the instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values

manually.

Application

The application name. You can specify one or more names for monitoring. In any combination, select
values from the discovered list, or enter values manually.

Data Point
For each counter that you haveincluded in atask:
I Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.
The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values and wildcard patterns, a PDP and IDP are returned for each discovered
combination of parameters.

Datapoint Details g

Server: secotdvZ, Time: 8192003 6:15:56 PH. Value: 1. 00000 :J
Valuse : 1 (Boolean) (Trus=1, Fal=z==0)

ApplicationRuntime Cachinglis=abled

Frivate property that disables caching in proEies.

Attribute waluss for MBsan:

ApplicationName = wl_management internall
Cachingli=abled = trues
Fegiztered = false

il 2

Interval

Recommended minimum is5 minutes.

W ebLogic Connector Service Runtime

The WebLogic Connector Service Runtime category includesthe counterslisted in the following table.
Some of the counterslisted in the table may not be available on your system. WebLogic counter categories,
counter names, and parameters are dynamically discovered by processing the set of MBeansin the
WebLogic M X Server. Which countersare discovered isdetermined by the WebLogic version you are
running and how WebLogic is configured.

Counters

Description

Private property that disables caching in

. Boolean Yes | Yes
proxies.

CachingDisabled

Returnsthe number of currently

deployed connection pools. Integer Yes | Yes

ConnectionPoolCurrentCount

Returnsthetotal number of deployed Integer Yes | Yes

ConnectionPoolsTotalCount . . ) X
connection poolsinstantiated sincethe
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Server startup.

Returnsfalseif the MBean represented by

thisobject has been unregistered. Boolean Yes | Yes

Registered

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parametersand always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain
Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select valuesfrom the discovered list, or enter values
manually.

Service
Name of the connector service runtime MBean. You can specify one or more names for monitoring. In
any combination, select values from the discovered list, or enter values manually.

StatType

This parameter appliesonly to the countersthat are returning a count or total
(ConnectionPoolCurrentCount isone examplein this counter category). Possible values are:

ACTUAL Thecounter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.
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Datapoint Details g |
Eerver: secotdw?, Time: 8-19-2003 6:23:56 PHM., ¥Valus: 1. 00000 :J
Value : 1 {(Boolean) {(Trus=1. Fal=e=0]}

ConnectorServiceRuntime CachingDi=zabled

Private property that disables caching in proxies.

Attribute waluss for MBean:

ConnectionPool=TotalCount = 0
Fegiztered = false
ConnectionPool CurrentCount = 0
Cachingli=zabled = trus

il 2

Interval

Recommended minimum is5 minutes.

W ebLogic Deployer Runtime

The WebLogic Deployer Runtime category includesthe counterslisted in the following table. Some of the
counterslisted in the table may not be available on your system. WebLogic counter categories, counter
names, and parameters are dynamically discovered by processing the set of MBeansin the WebLogic M X
Server. Which countersare discovered isdetermined by the WebLogic version you are running and how
WebLogic is configured.

Counters

Description
CachingDisabled Prlva}te property that disables cachingin Boolean Yes Yes
proxies.
Registered Re.turn.sfalse if theM Bean_represented by Boolean Yes Yes
this object has been unregistered.
Parameters

The parameters for a WebLogic counter category are derived from the MBean name. The parameters values
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parametersand always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server where the instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values
manually.
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Deployer

Name of the deployer runtime MBean. You can specify one or more names for monitoring. In any
combination, select values from the discovered list, or enter values manually.

Data Point
For each counter that you haveincluded in atask:
I Theprimary data point (PDP) isthe value returned for that counter.
I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

Datapoint Details g |

Server: =s=ecotdw?, Time: 8192003 6:14:56 PH., Valu=: 1. 00000 :J
Value : 1 (Boolean) (True=1. Fal=se=0)

DeploverBuntine CachingDizabled

Frivate property that di=sables caching in proxies.

Attribute wvalue=s for MBean:

Cachingli=sabled = true
Fegistered = fal=se

A 2y

Interval

Recommended minimum is5 minutes.

W ebLogic Domain Log Handler Runtime

The WebLogic Domain Log Handler Runtime category includesthe counterslisted in the following table.
Some of the counterslisted in the table may not be available on your system. WebLogic counter categories,
counter names, and parameters are dynamically discovered by processing the set of MBeansin the
WebLogic M X Server. Which countersare discovered isdetermined by the WebLogic version you are
running and how WeblLogic is configured.

Counters

Description
i i ing i Boolean
CachingDisabled Prlva}te property that disables cachingin Yes Yes
proxies.
. Returnsfalse if the MBean represented by
Registered this object has been unregistered. Boolean Yes Yes
Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parametersand always end up with avalid combination of parameters. This
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parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domains for monitoring. In any combination, select values from the discovered

list, or enter values manually.

Location

WebLogic Application Server where the instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values

manually.

Name

The name of the domain log handler to be monitored. You can specify one or more names for
monitoring. In any combination, select values from the discovered list, or enter values manually.

Data Point
For each counter that you haveincluded in atask:
I Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

Datapoint Details i |
Server: secotdwZ., Time: B-19-2003 6:18:56 PH. Value: 1.00000 :J
Valuse : 1 (Boolean) (Trus=1, Fal===0)

DomainlogHandlerBuntime CachingDi=abled

Frivate property that disables caching in proEies.

Attribute waluss for MBsan:

Fegiztered = false
Cachingli=abled = true

il 2y

Interval

Recommended minimum is5 minutes.

W ebLogic Domain Runtime

The WebLogic Domain Runtime category includesthe counterslisted in the following table. Some of the
counterslisted in the table may not be available on your system. WebLogic counter categories, counter
names, and parameters are dynamically discovered by processing the set of MBeansin the WebLogic M X
Server. Which counters are discovered isdetermined by the WebLogic version you arerunning and how

WebLogic is configured.

% Description
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Private property that disables caching

CachingDisabled . !
in proxies.

Boolean | Yes | Yes

Setsthe timeout value in milliseconds
of the current deployment to a
CurrentClusterDeploymentTimeout | cluster. Thisisset at the beginning of | Long No | Yes
the deployment to a cluster and is
reset after the deployment.

Returnsfalse if the MBean
Registered represented by this object has been Boolean | Yes | Yes
unregistered.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parametersand always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select valuesfrom the discovered list, or enter values
manually.

Data Point
For each counter that you haveincluded in atask:

! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

Datapoint Details i |
Eerver: secotdw?, Time: 3-19-2003 6:12:56 FM, Valus: 1.00000 :J
Valuse : 1 (Boolean) (Trus=1. Fal===0)

DomainFuntime Cachinglizabled

Private property that disables caching in prozies.

Attribute waluss for MBsan:

CachinglDi=zabled = trues
Fegiztered = false
ActivationTime = Mondaw., Augu=st 13, 2003 3:01:35 FH EDT

A v 4
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Interval

Recommended minimum is5 minutes.

W ebLogic EB Cache Runtime

The WebLogic EBB Cache Runtime category includesthe counterslisted in the following table. Some of the
counterslisted in the table may not be available on your system. WebLogic counter categories, counter
names, and parameters are dynamically discovered by processing the set of MBeansin the WebLogic M X
Server. Which counters are discovered isdetermined by the WebLogic version you arerunning and how
WebLogic is configured.

WL

ActivationCount Returns_thetotal number of timesthe EB Long ves | Yes
was activated.

CacheAccessCount Returnst_hetotal number of times EB was Long ves | Yes
accessed in the cache.

CachedBeansCurrentCount Eg:rnsthe current number of cached Integer Yes | Yes

CacheHitCount Returr_ws_thetotal number of timesthe EB Long ves | Yes
was hit in the cache.

Returnsthetotal number of times an
CacheMissCount attempt to access a bean from the cache Long No | Yes
failed.

Private property that disables caching in

. Boolean Yes | Yes
proxies.

CachingDisabled

N Returnsthetotal number of timesthe EJB
PassivationCount . Long Yes | Yes
was passivated.

Returnsfalse if the MBean represented by

thisobject has been unregistered. Boolean Yes | Yes

Registered

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parametersand always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.
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Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values
manually.

Application

The application prefix of the EB ear. You can specify one or more application prefixesfor monitoring.
In any combination, select values from the discovered list, or enter values manually.

Component
The EB component prefix of the EB ear. You can specify one or more component prefixes for
monitoring. In any combination, select values from the discovered list, or enter values manually.
Name
Theremainder of the EBB name. You can specify one or more names for monitoring. In any
combination, select valuesfrom the discovered list, or enter values manually.
StatType

This parameter is available for countersthat are returning a count or total (ActivationCount isone
examplein thiscounter category). Possible values are:

ACTUAL Thecounter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

Datapoint Details : |
Eerver: secotdw?, Time: 8-19-2003 6:20:56 PM, ¥Walue=: 0.00000 :J
Valus : 0 [(Long)

EJBCacheFuntime ActiwvationCount

Feturn=s the total number of bean=s from thi= EJB Home that hawve been
actiwvated.

Attribute walus=s for MBesan:

CacheiccessCount = 0
CachedBeansCurrentCount = [
CachinglDi=zabled = trues
Fegiztered = false
CacheHitCount = 0
ActivationCount = 0O
Fas=ivationCount = 0

il 2
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Interval

Recommended minimum is5 minutes.

W ebLogic EB Component Runtime

The WebLogic EBB Component Runtime category includesthe counterslisted in the following table. Some
of the counterslisted in the table may not be available on your system. WebLogic counter categories,
counter names, and parameters are dynamically discovered by processing the set of MBeansin the
WeblLogic M X Server. Which counters are discovered isdetermined by the WebLogic version you are
running and how WebLogic is configured.

Counters Type e ool
S Description AN % 8.X

CachingDisabled Prlvgte property that disables cachingin Boolean Yes Yes
proxies.

DeploymentState Returnscurrent deployment state of the Integer No Yes
module.

. Returnsfalse if the MBean represented by

Registered this object has been unregistered. Boolean Yes ves
Returnsthe deployment's status. The set of

Satus statusisdefined in the EJB Deployment Integer Yes Yes
interface (DEPLOYED, UNDEPLOYED, g
ERROR).

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. This allows you to select
between the multiple parametersand always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domains for monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values
manually.

Application

The application prefix of the EB ear. You can specify one or more application prefixesfor monitoring.
In any combination, select values from the discovered list, or enter values manually.
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EJBName

Theremainder of the EBB component name. You can specify one or more names for monitoring. In any
combination, select values from the discovered list, or enter values manually.

Data Point
For each counter that you haveincluded in atask:

I Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

Datapoint Details

Serwver: secotdv?, Time: 8192003 6:20:56 PH, ¥alus: 1. 00000
Value : 1 (Boolean) (Trus=1. Fal=ss=0)

EJBComponentRuntime CachingDizabled

Frivate property that disables caching in prozies.

e

Attribute valuse=s for HBesan:

Statuz = 0
DeplovmentHame = adminszserver app=dir =31b20 _homemsethods ear e1b20_homemsethod= . jar

Fegistered = false
Cachingli=zakbled = trus

A A

Interval

Recommended minimum is5 minutes.

W ebLogic EB Locking Runtime

The WebLogic EB Locking Runtime category includesthe counterslisted in the following table. Some of
the counterslisted in the table may not be available on your system. WebLogic counter categories, counter
names, and parameters are dynamically discovered by processing the set of MBeansin the WebLogic MM X
Server. Which counters are discovered isdetermined by the WebLogic version you arerunning and how
WebLogic is configured.

CachingDisabled Prlvgte property that disables caching in Boolean ves | No
proxies.

LockEntriesCurrentCount Retu'rnsthe number of current EJB lock Integer Yes | No
entries.

LockM anager AccessCount Returnsthe number of accessesto the lock Long ves | No
man ager.

. Returnsfalse if the MBean represented by

Registered this object has been unregistered. Boolean Yes | No

TimeoutTotal Count Ret'urnst'h'e number of objectstimed out Long ves | No
while waiting on the lock.
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Returnsthe number of objects waiting on

WaiterTotalCount the lock.

Long Yes | No

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. This allows you to select
between the multiple parameters and always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domains for monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values
manually.

Application
The application prefix of the EB ear. You can specify one or more application prefixesfor monitoring.
In any combination, select values from the discovered list, or enter values manually.

Component
The EIB component prefix of the EJB ear. You can specify one or more component prefixes for
monitoring. In any combination, select values from the discovered list, or enter values manually.

Name
Theremainder of the EBB name. You can specify one or more names for monitoring. In any
combination, select valuesfrom the discovered list, or enter values manually.

StatType

This parameter is available for countersthat are returning a count or total (LockEntriesCurrentCount is
one examplein thiscounter category). Possible values are:

ACTUAL Thecounter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.
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The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

Datapoint Details k|
Eerver: secotdw?, Time: 8-19-2003 6:21:56 BHM, ¥Valus: 1. 00000 x|
Value : 1 (Boolean) (Trus=1, Fal=se=0)

EJBLockingRuntimne Cachingli=zabl=ed

Frivate property that dimables caching in proEies.

Attribute valuses for MBsan:

LockEntriesCurrentCount = 0
Fegistered = fal=e=
WaiterTotalCount = 0O
Cachingli=abled = trues
TimeoutTotalCount = 0
LoclkManagericcessCount = 0

il 2

Interval

Recommended minimum is5 minutes.

W ebLogic EB Pool Runtime

The WebLogic EB Pool Runtime category includesthe counterslisted in the following table. Some of the
counterslisted in the table may not be available on your system. WebLogic counter categories, counter
names, and parameters are dynamically discovered by processing the set of MBeansin the WebLogic M X
Server. Which counters are discovered isdetermined by the WebLogic version you arerunning and how
WebLogic is configured.

Counters

Description

Returnsthetotal number of times
AccessTotalCount an attempt was made to get an Long No Yes
instance from the free pool.

Returnsthe number of beans

BeanslnUseCount . Integer Yes Yes
currently in use.
Returnsthe number of bean

BeansinUseCurrentCount instances currently in use from the | Integer No Yes
free pool.
Private property that disables Boolean Yes Yes

CachingDisabled S n .
cachingin proxies.

Returnsthetotal number of times
abean instance from this pool was
DestroyedTotalCount destroyed due to anon- Long No Yes
application Exception being
thrown from it.

Returnsthe number of idle beans

in this EB. Integer Yes Yes

IdleBeansCount

MissTotalCount Returnsthetotal number of times | Long No Yes
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afailed attempt was made to get
an instance from the free pool. An
attempt to get a bean from the
pool failsif there are no available
instancesin the pool.

Returnsthe current number of
PooledBeansCurrentCount available bean instancesin the free | Integer No Yes
pool.

Returnsfalse if the MBean
Registered represented by thisobject has Boolean Yes Yes
been unregistered.

TimeoutTotalCount Returnsthe_total number of timed Long Yes Yes
out transactions.

Returnsthe current number of
WaiterCurrentCount available bean instancesin the free | Integer No Yes
pool.

WaiterTotalCount Returnsthe nL_meer of EBs Long Yes Yes
currently waiting.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parameters and always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values
manually.

Application

The application prefix of the EJB ear. You can specify one or more application prefixes for monitoring.
In any combination, select values from the discovered list, or enter values manually.

Component

The EB component prefix of the EJB ear. You can specify one or more component prefixes for
monitoring. In any combination, select values from the discovered list, or enter values manually.

Name
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Theremainder of the EIB name. You can specify one or more names for monitoring. In any
combination, select values from the discovered list, or enter values manually.

StatType

This parameter is available for countersthat are returning a count or total (BeansinUseCount isone
examplein thiscounter category). Possible values are:

ACTUAL The counter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

Datapoint Details i |
Server: secotdwvZ., Time: 8192003 6:21:56 PM. Value: 0.00000 :J
Valus : 0 [(Integer)

EJEFPoolBEuntime_BeansInls=Count

Feturn=s the total number of bean instances currently in use from the

free pool.

Attribute wvaluses for MB=san:

Fegiztered = false
TimeoutTotalZount
Beans=Inll=zeCount
Cachingli=zabled
IdleBean=Count = 0
WaiterTotalCount =

4 v oz

Interval

o

I}
true

0

Recommended minimum is5 minutes.

W ebLogic EB Transaction Runtime

The WebLogic EB Transaction Runtime category includesthe counterslisted in the following table. Some
of the counterslisted in the table may not be available on your system. WebLogic counter categories,
counter names, and parameters are dynamically discovered by processing the set of MBeansin the
WebLogic M X Server. Which counters are discovered isdetermined by the WebLogic version you are

running and how WeblLogic is configured.

Counters

Description

Private property that disables caching Boolean | Yes | Yes

CachingDisabled . !
in proxies.
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Returnsfalse if the MBean
Registered represented by this object has been Boolean | Yes | Yes
unregistered.

TransactionsCommittedTotalCount Returnslthetotal number of E‘B Long Yes | Yes
transactionsthat were committed.

TransactionsRolledBackTotalCount Returnslthetotal number of EB Long Yes | Yes
transactions rolled back.

TransactionsTimedOutTotalCount Returnslthetotal n.umber of EB Long Yes | Yes
transactionsthat timed out.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parametersand always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values
manually.

Application
The application prefix of the EJB ear. You can specify one or more application prefixes for monitoring.
In any combination, select values from the discovered list, or enter values manually.

Component
The EB component prefix of the EJB ear. You can specify one or more component prefixes for
monitoring. In any combination, select values from the discovered list, or enter values manually.

Name
Theremainder of the EBB name. You can specify one or more names for monitoring. In any
combination, select values from the discovered list, or enter values manually.

StatType

This parameter is available for countersthat are returning a count or total
(TransactionsCommittedTotalCount isone example in thiscounter category). Possible values are;

ACTUAL The counter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
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task interval and the raw data value of the counter in the current task interval.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

Datapoint Details i |
Server: secotdvZ, Time: 8192003 6:18:56 PH. Value: 1. 00000 :J
Valuse : 1 (Boolean) (Trus=1, Fal===0)

EJBTran=zactionRuntime CachingDi=zabled

Frivate property that disables caching in proEies.

Attribute waluss for MBesan:

Fegiztered = false

TransactionsRol ledBackTotalCount = 0
TransactionsTimedOutTotalCount = 0
Cachingli=zabled = trues
TransactionsCommnittedTotalCount = 0

il v

Interval

Recommended minimum is5 minutes.

W ebLogic Entity EB Runtime

The WebLogic Entity EIB Runtime category includesthe counterslisted in the following table. Some of the
counterslisted in the table may not be available on your system. WebLogic counter categories, counter
names, and parameters are dynamically discovered by processing the set of MBeansin the WebLogic M X
Server. Which counters are discovered isdetermined by the WebLogic version you arerunning and how
WebLogic is configured.

M Description S A

CachingDisabled Prlvgte property that disables caching in Boolean Yes Yes
proxies.
. Returnsfalse if the MBean represented by
Registered this object has been unregistered. Boolean Yes ves
Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. This allows you to select
between the multiple parametersand always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.
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Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values
manually.

Application
The application prefix of the EJB ear. You can specify one or more application prefixes for monitoring.
In any combination, select values from the discovered list, or enter values manually.
Component
The EB component prefix of the EJB ear. You can specify one or more component prefixes for
monitoring. In any combination, select values from the discovered list, or enter values manually.
Name
Theremainder of the EBB name. You can specify one or more names for monitoring. In any
combination, select values from the discovered list, or enter values manually.
Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

Datapoint Details |
Server: secotdwZ, Time: B-19-2003 6:19:56 PH. Value: 1.00000 :J
Value : 1 {(Boolean) {(Trus=1. Fal=e=0]}

EntitwEIBRuntime CachinglDi=zabled

Private property that disables caching in proxies.

Attribute wvaluss for MBean:

EJBHam= = beanManaged
Cachingli=zabled = trues
Begistered = falsd

il 2

Interval

Recommended minimum is5 minutes.
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W ebLogic Execute Queue Runtime

The WebLogic Execute Queue Runtime category includesthe counterslisted in the following table. Some
of the counterslisted in the table may not be available on your system. WebLogic counter categories,
counter names, and parameters are dynamically discovered by processing the set of MBeansin the
WebLogic M X Server. Which counters are discovered isdetermined by the WebLogic version you are
running and how WebLogic is configured.

Counters

Description

Private property that disables caching in

CachingDisabled .
proxies.

Boolean | Yes | Yes

ExecuteThreadCurrentldleCount Ret_urnsthenumber of idle threads Integer | Yes | Yes
assigned to the queue.

ExecuteThreadTotalCount Returnsth(_etotal number of execute Integer No | Yes
threads assigned to the queue.

Returnsthe number of waiting requests

PendingRequestCurrentCount .
in the queue.

Integer Yes | Yes

Returnsthetimethat the longest
PendingRequestOldestTime waiting request was placed in the Long Yes | Yes
queue.

Returnsfalse if the MBean represented

by this object has been unregistered. Boolean | Yes | Yes

Registered

Returnsthe number of requeststhat

ServicedRequestTotal Count have been processed by this queue.

Integer | Yes | Yes

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. This allows you to select
between the multiple parameters and always end up with avalid combination of parameters. This
parameter dependency information is enforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domains for monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values
manually.

Queue

The execution queue name. You can specify one or more names for monitoring. In any combination,
select values from the discovered list, or enter values manually.
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StatType

This parameter is available for countersthat are returning a count or total (ExecuteThreadTotalCount is
one examplein thiscounter category). Possible values are:

ACTUAL The counter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

Datapoint Details 5 |
Server: secotdvZ, Time: 8192003 6:20:56 PH. Walue: 1.00000 :J
Value : 1 (Boolean) (Trus=1, Fal=e=0)

ExecutefususFuntine CachinglDi=abled

Frivate property that disables caching in proEies.

Attribute valuses for MBsan:

PendingRequestCurrentCount = 0

ServicedEequestTotalCount = 0

Cachingli=zabled = trus

Fegistered = falss

ExecuteThreadCurrent IdleCount = 2

PendingRequestlldestTime = Tussday, August 19, 2003 &6:21:37 PHM EDT

4 H oz

Interval

Recommended minimum is5 minutes.

W ebLogic DBC Connection Pool Runtime

The WebLogic DBC Connection Pool Runtime category includesthe counterslisted in the following table.
Some of the counterslisted in the table may not be available on your system. WebLogic counter categories,
counter names, and parameters are dynamically discovered by processing the set of MBeansin the
WebLogic M X Server. Which counters are discovered isdetermined by the WebLogic version you are
running and how WebLogic is configured.

Returnstherunning average of
active connectionsin thethis
ActiveConnectionsAverageCount MBean. The count starts at zero Integer | No | Yes
each timethe MBean is
instantiated.

ActiveConnectionsCurrentCount Returnsthe current number of Integer | Yes | Yes
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active connections.

ActiveConnectionsHighCount

Returnsthe highest number of
active current connections. The
count starts at zero each timethe
JDBCConnectionPoolRuntime
MBean isinstantiated.

Integer

Yes

Yes

CachingDisabled

Private property that disables
caching in proxies.

Boolean

Yes

Yes

ConnectionDelayTime

Returnsthe number of milliseconds
it takesto get a physical connection
from database. It iscalculated as
summary time to connect, divided
by summary number of
connections.

Integer

Yes

Yes

ConnectionLeakProfileCount

Returnsthe current number of
connection leak profilesin the
profile storage.

Integer

Yes

Yes

ConnectionsTotalCount

Returnsthe total number of JDBC
connectionsin this
JDBCConnectionPoolRuntime
MBean since the pool was
instantiated.

Integer

Yes

Yes

FailuresToReconnectCount

Returnsthe count of attemptsto
refresh aconnection to a database
that failed. Failure may happen
because of database unavailability
or abroken connection to the
database.

Integer

Yes

Yes

HighestNumAvailable

Returnsthe highest number of
available connectionsin this pool.

Integer

No

Yes

HighestNumUnavailable

Returnsthe highest number of
unavailable connectionsin this
pool.

Integer

No

Yes

LeakedConnectionCount

Returnsthe number of connections
that were checked out from the
connection pool but were not
returned to the pool by calling
close ().

Integer

Yes

Yes

MaxCapacity

Returnsthe maximum capacity of
thisconnection pool.

Integer

Yes

Yes

NumAvailable

Returnsthe number of available
connectionsin thispool.

Integer

No

Yes

NumUnavailable

Returnsthe number of unavailable
connectionsin thispool.

Integer

No

Yes
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Returnstrueif the pool isenabled,

false if the pool is disabled. Boolean | Yes | Yes

PoolSate

Returnsthe number of prepared
statement cache profiling stores
cache snapshotsthat arein external
storage.

PreparedSatementCacheProfileCount Integer | Yes | Yes

Returnsthe cumulative, running
PrepSmtCacheHitCount count of the use of each cached Integer | Yes | Yes
statement.

Returns a count of the cases when
PrepSmtCacheMissCount the cache does not have a cached Integer | Yes | Yes
statement to satisfy a request.

Returnsfalse if the MBean
Registered represented by thisobject hasbeen | Boolean | Yes | Yes
unregistered.

Returnsthe number of statement

StatementProfileCount profiling storesin external storage.

Integer | Yes | Yes

Returnsthe current number of

WaitingForConnectionCurrentCount L )
requests waiting for a connection.

Integer | Yes | Yes

Returnsthe highest number of
requests waiting for a connection.
WaitingForConnectionHighCount The count starts at zero each time Integer | Yes | Yes
the DBCConnectionPoolRuntime
MBean isinstantiated.

Returnsthe highest number of

WaitSecondsHighCount . .
seconds a connection waited.

Integer | Yes | Yes

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. This allows you to select
between the multiple parameters and always end up with avalid combination of parameters. This
parameter dependency information is enforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values
manually.
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Pool

The connection pool name. You can specify one or more names for monitoring. In any combination,

select values from the discovered list, or enter values manually.

StatType

This parameter is available for countersthat are returning a count or total (ConnectionsTotalCount is

one examplein thiscounter category). Possible values are:

ACTUAL The counter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Data Point
For each counter that you haveincluded in atask:

! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter

category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

Datapoint Details

Eerver: secotdw?, Time: 8-19-2003 6:20:56& PH, Value: 1. 00000
Value : 1 {Integer)

JOECConnectionPoolRuntimne ActiveConnectionsCurrentCount
Counter description not defined in MBean metadata.

Attribute wvaluse=s for MB=an:

ActiveConnectionsHighCount = 2
Fegiztered = false
LeakedConnectionCount = 0
FrepStmntCacheMissCount = 3

WaitingForConnectionHighCount = 0
FreparedStatemnentCacheProfileCount = 0
FailuresToReconnectCount = 0

WaitSecond=sHighCount = 0
StatemnentProfileCount = 0
ConnectionlelayTime = 71
PrepStmtCacheHitCount = 0

PoolState = true

VerzionJDECDriver = com.pointbass.jdbc. jdbcllniversallriver
ConnectionsTotalCount = 2
MamCapaczity = 10
ConnectionleslProfileCount = 0
WaitingForConnectionCurrentCount = 0
ActiveConnectionsCurrentCount = 1
Cachingli=zabled = trus

ki

2]

Interval

Recommended minimum is5 minutes.
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WebLogic MS Connection Runtime

The WebLogic MSConnection Runtime category includesthe counterslisted in the following table. Some
of the counterslisted in the table may not be available on your system. WebLogic counter categories,
counter names, and parameters are dynamically discovered by processing the set of MBeansin the
WebLogic M X Server. Which counters are discovered isdetermined by the WebLogic version you are
running and how WebLogic is configured.

Counters

Description

Private property that disables caching in

. Boolean Yes Yes
proxies.

CachingDisabled

Returnsfalseif the MBean represented by

this object has been unregistered. Boolean Yes | Yes

Registered

SessionsCurrentCount Re_turnsthegurrentnumber of sessions for Long Yes Yes
thisconnection.

Returnsthe peak number of sessions for

SessonsHighCount thisconnection since the last reset.

Long Yes Yes

SessionsTotalCount Returns_then_umber of sessionson this Long Yes Yes
connection since the last reset.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parametersand always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location
WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select valuesfrom the discovered list, or enter values
manually.

Connection
The M Sconnection name. You can specify one or more names for monitoring. In any combination,
select values from the discovered list, or enter values manually.

StatType

This parameter is available for countersthat are returning a count or total (SessionsTotalCount isone
examplein thiscounter category). Possible values are:

ACTUAL The counter returnsthe raw data value.
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INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Data Point
For each counter that you haveincluded in atask:
I Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

Datapoint Details e 1 |
Server: secotdvZ, Time: 8-19-2003 6:19:56 PH., Value: 1.00000 :J
Valuse : 1 (Boolean) (Trus=1. Fal===0)

JHSConnectionRuntime CachingDisabled

Frivate property that disables caching in proEies.

Attribute valuss for MBsan:

Cachingli=zabled = trus
Fegistered = fal=e=
SezzionsHighCount = 8
Sesz=zions=CurrentCount =
Sezzion=TotalCount = 8

A 2

Interval

=

Recommended minimum is5 minutes.

WebLogic MS Consumer Runtime

The WebLogic M SConsumer Runtime category includesthe counterslisted in the following table. Some
of the counterslisted in the table may not be available on your system. WebLogic counter categories,
counter names, and parameters are dynamically discovered by processing the set of MBeansin the
WebLogic M X Server. Which counters are discovered isdetermined by the WebLogic version you are
running and how WebLogic is configured.

w
Counters o
Description S A

Determinesif the consumer is active.
Determineswhether the consumer hasa
message listener set up or a synchronous
receivein progress.

Active Boolean Yes | Yes

Returnsthe number of bytes pending
BytesPendingCount (uncommitted and unacknowledged) by Long Yes | Yes
thisconsumer.

Returnsthe number of bytes received by

thisconsumer since the last reset. Long Yes | Yes

BytesReceivedCount

CachingDisabled Private property that disables cachingin Boolean Yes | Yes
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proxies.

Durable gj:zgl‘r:neswhetherthe consumer is Boolean ves | Yes

Returnsthe number of messages pending
MessagesPendingCount | (uncommitted and unacknowledged) by Long Yes | Yes
thisconsumer.

Returnsthe number of messages received

M essagesReceivedCount by this consumer since the last reset. Long Yes | Yes

Registered Re_turnsfalself the MBean_represented by Boolean ves | Yes
thisobject has been unregistered.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parameters and always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values
manually.

Consumer
The M Sconsumer name. You can specify one or more names for monitoring. In any combination,
select values from the discovered list, or enter values manually.

StatType

This parameter is available for countersthat are returning a count or total (MessagesReceivedCount is
one examplein thiscounter category). Possible values are:

ACTUAL The counter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Data Point
For each counter that you haveincluded in atask:

! Theprimary data point (PDP) isthe value returned for that counter.
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I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

Datapoint Details 2 |
Server: =ecotdw?, Time: 8-19-2003 6:19:56 PM. Values: 1. 00000 :J
Value : 1 (Boolean) (Trus=1, Fal=es=0)

JHSCon=umerRuntime Active

Determines if the cons=umser active. Determines whether the consumer has

a meszage listener sst up or a synchronous recelve 1n Drogress .

Attribute wvalus= for MBesan:

Fegiztered = false
MessagesPendingCount = 0

Durable = false

Active = true

BvtesReceivedCount = 0
DestinationHamse = szamnplefususSend

MezzagesReceivedCount = 0

BytesPendingCount = 0

CachingDi=abled = trus =
I M
Interval

Recommended minimum is5 minutes.

W ebLogic MSDestination Runtime

The WebLogic MSDestination Runtime category includesthe counterslisted in the following table. Some
of the counterslisted in the table may not be available on your system. WebLogic counter categories,
counter names, and parameters are dynamically discovered by processing the set of MBeansin the
WebLogic M X Server. Which countersare discovered isdetermined by the WebLogic version you are
running and how WeblLogic is configured.

Counters

Description

Returnsthe current number of bytes
BytesCurrentCount stored in the destination. This does not Long Yes | Yes
include the pending bytes.

Returnsthe peak number of bytes stored

in the destination since the last reset. Long Yes | Yes

BytesHighCount

Returnsthe number of pending bytes
stored in the destination. Pending bytes
are over and above the current number of
bytes.

BytesPendingCount Long Yes | Yes

Returnsthe number of bytesreceived in

thisdestination since the last reset. Long Yes | Yes

BytesReceivedCount

Returnsthe amount of timein the

BytesThresholdTime threshold condition since the last reset.

Long Yes | Yes
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CachingDisabled

Private property that disables caching in
proxies.

Boolean

Yes

Yes

ConsumersCurrentCount

Returnsthe current number of consumers
accessing thisdestination.

Long

Yes

Yes

ConsumersHighCount

Returnsthe peak number of consumers
accessing thisdestination since the last
reset.

Long

Yes

Yes

ConsumersTotalCount

Returnsthe total number of consumers
accessing thisdestination since the last
reset.

Long

Yes

Yes

MessagesCurrentCount

Returnsthe current number of messagesin
the destination. Thisdoesnot include the
pending messages.

Long

Yes

Yes

M essagesHighCount

Returnsthe peak number of messagesin
the destination since the last reset.

Long

Yes

Yes

M essagesPendingCount

Returnsthe number of pending messages
in the destination. Pending messages are
over and above the current number of

messages. A pending message isone that
haseither been sent in atransaction and
not committed, or that has been received
and not committed or acknowledged.

Long

Yes

Yes

M essagesReceivedCount

Returnsthe number of messages received
in thisdestination since that reset.

Long

Yes

Yes

MessagesThresholdTime

Returnsthe amount of timein the
threshold condition since the last reset.

Long

Yes

Yes

Registered

Returnsfalse if the MBean represented by
this object has been unregistered.

Boolean

Yes

Yes

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues

are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parameters and always end up with avalid combination of parameters. This
parameter dependency information is enforced by the task creation wizard in the VantageView Web

Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered

list, or enter values manually.

Location

155



Using the Conductor

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values

manually.

Destination

The name of the M Sdestination. You can specify one or more names for monitoring. In any
combination, select valuesfrom the discovered list, or enter values manually.

StatType

This parameter is available for countersthat are returning a count or total (MessagesReceivedCount is
one examplein thiscounter category). Possible values are:

ACTUAL The counter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

Datapoint Details Bt |
Eerver: secotdw?. Time: 8-19-2003 6:20:56 PM, ¥Walus: 0.00000 :J
Value : 0 (Long)

JMSDestinationFuntime BytesCurrsntCount

Feturn= the current number of bytes s=tored in the destination. Thi=

dos=z not include the pending bytes=.

Attribute walus=s for MBesan:

MeszzagesCurrentCount = 0
MessagesReceivedCount = 0
BvtesReceivedCount = 0
BrtesThresholdTime = 0
BrtesCurrentCount = 0
MeszzagesHighCount = 0
Consunser=HighCount = 0
BvtesPendingCount = 0
MessagesThresholdTime
Consumnsers_CurrentCount
BrtesHighCount = 0
ConsumersTotalCount =
Cachingli=zabled = trus
MessagesPendingCount = 0
DeztinationType = Jusus
Fegistered = false

A 2

Interval

=]

Recommended minimum is5 minutes.
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WebLogic MSRuntime

The WebLogic MSRuntime category includesthe counterslisted in the following table. Some of the
counterslisted in the table may not be available on your system. WebLogic counter categories, counter
names, and parameters are dynamically discovered by processing the set of MBeansin the WebLogic M X
Server. Which counters are discovered isdetermined by the WebLogic version you arerunning and how
WebLogic is configured.

Counters

Description

Private property that disables caching in

CachingDisabled .
proxies.

Boolean Yes | Yes

. Returnsthe current number of
ConnectionsCurrentCount connections to this WebLogic Server. Long Yes | Yes

Returnsthe peak number of connections
ConnectionsHighCount to thisWebLogic Server sincethe last Long Yes | Yes
reset.

Returnsthe total number of connections
ConnectionsTotalCount made to thisWebLogic Server since the Long Yes | Yes
last reset.

Returnsthe current number of M Sservers
JM SServersCurrentCount that are deployed on thisWebLogic Server | Long Yes | Yes
instance.

Returnsthe peak number of MSservers
that were deployed on thisWebLogic
Server instance since the server was
started.

IM SServersHighCount Long Yes | Yes

Returnsthe number of M Sserversthat
JM SServersTotalCount were deployed on this WebLogic Server Long Yes | Yes
instance since the server was started.

Returnsfalseif the MBean represented by

this object has been unregistered. Boolean Yes | Yes

Registered

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parameters and always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location
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WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values

manually.

JMSServer

The M Sserver name. You can specify one or more names for monitoring. In any combination, select
values from the discovered list, or enter values manually.

StatType
This parameter is available for countersthat are returning a count or total (ConnectionsTotalCount is
one examplein thiscounter category). Possible values are:

ACTUAL The counter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

Datapoint Details = |
Eerver: secotdw?, Time: 2-19-20032 6-19:56 PH, Value: 1.00000 :J
Valuse : 1 (Boolean) (Trus=1. Fal===0)

JHSEuntine CachingDi=zabled

Private property that dizables caching in proxies.

Attribute waluse=s for MB=an:

ConnectionsCurrentCount = 0
Fegistered = fal=se
JHSServersCurrentCount = 0
JHSServersHighCount = (0
JHSServer=TotalCount
ConnectionsHighCount
ConnectionsTotalCount = 0
CachinglDi=zabled = trus

= 0
= 0

4 a7

Interval

Recommended minimum is5 minutes.

WebLogic MS Server Runtime

The WebLogic M S Server Runtime category includesthe counterslisted in the following table. Some of the
counterslisted in the table may not be available on your system. WebLogic counter categories, counter
names, and parameters are dynamically discovered by processing the set of MBeansin the WebLogic MM X
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Server. Which counters are discovered isdetermined by the WebLogic version you arerunning and how
WebLogic is configured.

% Description

Returnsthe current number of bytes
BytesCurrentCount stored on this MM Sserver. Thisdoes not Long Yes | Yes
include the pending bytes.

Returnsthe peak number of bytes stored

BytesHighCount in the M Sserver since the last reset.

Long Yes | Yes

Returnsthe current number of bytes
pending (unacknowledged or
BytesPendingCount uncommitted) stored on this M Sserver. Long Yes | Yes
Pending bytes are over and above the
current number of bytes.

Returnsthe number of bytes received on

BytesReceivedCount this MS server since the last reset. Long Yes | Yes
. Returnsthe amount of timein the

BytesThresholdTime threshold condition since the last reset. Long Yes | Yes

CachingDisabled Private property that disables caching in Boolean ves | Yes

proxies.

S Returnsthe current number of
DestinationsCurrentCount destinations for this M S server. Long Yes | Yes

Returnsthe peak number of destinations

DestinationsHighCount on this MSserver since the last reset. Long Yes | Yes
Returnsthe number of destinations
DestinationsTotalCount instantiated on thisMMSserver since the Long Yes | Yes

last reset.

Returnsthe current number of messages
M essagesCurrentCount stored on this M Sserver. Thisdoes not Long Yes | Yes
include the pending messages.

Returnsthe peak number of messages
M essagesHighCount stored in the M Sserver since the last Long Yes | Yes
reset.

Returnsthe current number of messages
pending (unacknowledged or

M essagesPendingCount uncommitted) stored on this M Sserver. Long Yes | Yes
Pending messages are over and above the
current number of messages.

Returnsthe number of messages received

M essagesReceivedCount on thisdestination since the last reset.

Long Yes | Yes

Returnsthe amount of timein the

MessagesThresholdTime threshold condition since the last reset.

Long Yes | Yes
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Returnsfalseif the MBean represented by

this object has been unregistered. Boolean Yes | Yes

Registered

. Returnsthe current number of session
SessionPoolsCurrentCount poolsinstantiated on this M S server. Long Yes | Yes

Returnsthe peak number of session pools
SessionPoolsHighCount instantiated on this M Sserver since the Long Yes | Yes
last reset.

Returnsthe number of session pools
SessionPoolsTotalCount instantiated on thisMSserver since the Long Yes | Yes
last reset.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parametersand always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain
Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location
WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select valuesfrom the discovered list, or enter values
manually.

JMSServer
The M Sserver name. You can specify one or more names for monitoring. In any combination, select
values from the discovered list, or enter values manually.

StatType

This parameter is available for countersthat are returning a count or total (SessionPoolsTotalCount is
one examplein thiscounter category). Possible values are:

ACTUAL The counter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.
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The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

Datapoint Details |
Eerver: secotdw?, Time: 8-19-2003 6:20 56 PH, Value: 0. 00000 :J
Value : 0 {Long)

JHSServerFuntime_BytesCurrentCount

Feturn=s the current numbsr of bvtes s=tored on thi= JHS =erver. This
doez not include the pending bytes.

Attribute wvalus= for MBesan:

Mes=zagesPendingCount = 0
MessagesHighCount = (0
HeszzagesThresholdTinse = 0
Deztinations=TotalCount = 5
ByrtesHighCount = 0
SezzionPoolsHighCount = 0

SezzionPool=CurrentCount = 0
MessagesCurrentCount = [
HezzagesReceivedCount = 0

Fegistered = false
Cachingli=zabled = trues
BvteszPendingCount = 0
BrtesThresholdTine
ByrtesFeceivedCount
BvtesCurrentCount = 0
SezzionPoolsTotalCount = 0
DeztinaticonsCurrentCount =
DeztinationsHighCTount = 5

il H oz

Interval

=0
= 0

5

Recommended minimum is5 minutes.

WebLogic MS Ssssion Runtime

The WebLogic M S Session Runtime category includesthe counterslisted in the following table. Some of
the counterslisted in the table may not be available on your system. WebLogic counter categories, counter
names, and parameters are dynamically discovered by processing the set of MBeansin the WebLogic MM X
Server. Which counters are discovered isdetermined by the WebLogic version you arerunning and how
WebLogic is configured.

Counters

Description

Returnsthe number of bytes pending
BytesPendingCount (uncommitted and unacknowledged) for Long Yes | Yes
this session.

Returnsthe number of bytes received by

BytesReceivedCount this session since the last reset. Long Yes | Yes
BytesSentCount RetL_Jrnst_he number of bytes sent by this Long ves | Yes
session sincethe last reset.
Private property that disables caching in Boolean ves | Yes

CachingDisabled

proxies.

161



Using the Conductor

ConsumersCurrentCount Returnsthe_current number of consumers Long Yes | Yes
for this session.

ConsumersHighCount Re_turns_the peak number of consumers for Long Yes | Yes
thissession since the last reset.
Returnsthe number of consumers

ConsumersTotalCount instantiated by this session since the last Long Yes | Yes
reset.
Returnsthe number of messages pending

MessagesPendingCount | (uncommitted and unacknowledged) for Long Yes | Yes
this session.

M essagesReceivedCount Re_turns_the n_umber of messages sent by Long Yes | Yes
thissession since the last reset.

M essagesSentCount RetL_Jrnst_he number of bytes sent by this Long ves | Yes
session since the last reset.

ProducersCurrentCount Returnsthe_current number of producers Long ves | Yes
for this session.

ProducersHighCount Re_turns_the peak number of producers for Long Yes | Yes
thissession since the last reset.

ProducersTotal Count RetL_Jrnst_he number of producers for this Long ves | Yes
session since the last reset.

Registered Re_turn_sfalselftheMBean_represented by Boolean ves | Yes
thisobject has been unregistered.

Transacted Returnswhether the session istransacted. | Boolean Yes | Yes

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parametersand always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select valuesfrom the discovered list, or enter values
manually.

Session
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The M Ssession name. You can select a value from the discovered list.

StatType

This parameter is available for countersthat are returning a count or total (ConsumersTotalCount is
one examplein thiscounter category). Possible values are:

ACTUAL Thecounter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

Datapoint Details = |
Eerver: secotdw?,. Time: 8-19-2003 6:21:56 PHM, Valus: 0. 00000 _:J
Value : 0 {(Long)

JMSSes=ionBEuntime BvtesPendingCount

Feturn= the number of bytes pending (uncommitted and unaclknowledged)

for thiz ses=ion.

Attribute waluss for MBesan:

HeszzagesReceivedCount = 0
ConsunerzHighCount = 1
Tranzacted = fal=es
BrtesSentCount = 0
AcknowledgedMode = Auto
BytesPendingCount = [
FroducerzsHighCount = I
HeszzagesSentCount = 0
FProducer=TotalCount = 0
HeszzagesFPendingCount = 0
BrtesReceivedCount = 0
ProducersCurrentCount
ConsunersCurrentCount
Cachingli=zabled = trues
Fegiztered = false
Consumners=TotalCount = 1

il 2y

Interval

=0
= il

Recommended minimum is5 minutes.

WebLogic JTA Recovery Runtime

The WebLogic JTA Recovery Runtime category includesthe counterslisted in the following table. Some of
the counterslisted in the table may not be available on your system. WebLogic counter categories, counter
names, and parameters are dynamically discovered by processing the set of MBeansin the WebLogic MM X
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Server. Which counters are discovered isdetermined by the WebLogic version you arerunning and how
WebLogic is configured.

Counters

Description

Returnswhether the
Transaction Recovery Serviceis
currently activated on this
server.

Active Boolean | Yes | Yes

Private property that disables

CachingDisabled S .
cachingin proxies.

Boolean | Yes | Yes

Returnsthe total number of
InitialRecoveredTransaction TotalCount transactions that are recovered Integer | Yes | Yes
from the Transaction Log

initially.

Returnsthe percentage of the
RecoveredTransactionCompletionPercent | initially recovered transactions | Integer | Yes | Yes
that are completed.

Returnsfalse if the MBean
Registered represented by thisobject has Boolean | Yes | Yes
been unregistered.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. This allows you to select
between the multiple parameters and always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domains for monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values
manually.

StatType

This parameter is available for countersthat are returning a count or total
(InitialRecoveredTransaction TotalCount isone example in thiscounter category). Possible values are:

ACTUAL Thecounter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.
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Data Point
For each counter that you haveincluded in atask:
I Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

Datapoint Details i |
Server: secotdvZ, Time: 8-19-2003 6:20:56 PH, Value: 1. 00000 :J
Value : 1 (Boolean) (Trus=1, Fal===0)

JTARecovervEuntine Active

Feturn= whether the Transaction Recowvery Service 1= currently activated

on thiz =erwver.

Attribute waluss for MBesan:

Active = trues

Cachingli=abled = trues
InitialPecoveredTransactionTotalCount
FecoveredTransactionComnpletionPercent
Fegistered = false

il AW

Interval

Recommended minimum is5 minutes.

WebLogic JTA Runtime

The WebLogic JTA Runtime category includesthe counterslisted in the following table. Some of the
counterslisted in the table may not be available on your system. WebLogic counter categories, counter
names, and parameters are dynamically discovered by processing the set of MBeansin the WebLogic MM X
Server. Which counters are discovered isdetermined by the WebLogic version you are running and how
WebLogic is configured.

Counters

Description

Returnsthe number of
ActiveTransactionsTotalCount active transactionson the Integer Yes | Yes
server.

Private property that

. .2 . Boolean Yes | Yes
disables caching in proxies.

CachingDisabled

Returnsfalse if the MBean
Registered represented by this object Boolean Yes | Yes
has been unregistered.

Returnsthe total number of
SecondsActiveTotalCount seconds for all committed Long Yes | Yes
transactions

Returnsthe number of

. Long Yes | Yes
transactionsthat were

TransactionAbandonedTotalCount

165



Using the Conductor

abandoned.

TransactionCommittedTotalCount

Returnsthe number of
committed transactions.

Long

Yes

Yes

TransactionHeuristicsTotalCount

Returnsthe number of
transactionsthat completed
with a heuristic status.

Long

Yes

Yes

TransactionRolledBackAppTotalCount

Returnsthe number of
transactionsthat were rolled
back dueto an application
error.

Long

Yes

Yes

TransactionRolledBackResourceTotalCount

Returnsthe number of
transactionsthat were rolled
back due to aresource error.

Long

Yes

Yes

TransactionRolledBackSystem TotalCount

Returnsthe number of
transactionsthat were rolled
back dueto an internal
system error.

Long

Yes

Yes

TransactionRolledBack TimeoutTotalCount

Returnsthe number of
transactionsthat were rolled
back dueto atimeout
expiration.

Long

Yes

Yes

TransactionRolledBackTotalCount

Returnsthe number of
transactionsthat were rolled
back.

Long

Yes

Yes

TransactionTotalCount

Returnsthe total number of
transactions processed. This
total includes all committed,
rolled back and heuristic
transaction completions.

Long

Yes

Yes

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select

between the multiple parametersand always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web

Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered

list, or enter values manually.

Location
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WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values
manually.

JTA

The JTA MBean name. You can specify one or more names for monitoring. In any combination, select
values from the discovered list, or enter values manually.

StatType
This parameter is available for countersthat are returning a count or total (TransactionTotalCount is
one examplein thiscounter category). Possible values are:

ACTUAL The counter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

Datapoint Details |
Server: =ecotdw?, Time: 8192003 6:19:56 PH, Valus: 0.00000 :J
Value : 0 {Integexr)

JTARuntime Actiwelranzactions=TotalCount

Feturn= the number of active tran=zactionz on the =erver.

Attribute wvalus=s for MB=an:

Second=sActiveTotalCount = 0
Transactionkol ledBackTotalCount = 0
TranzactionHeuristicsTotalCount = 0

Fegistered = fals=

Tran=sactionkol ledBackSy=temTotalCount = 0
TranzactionBRolledBackippTotalCount = 0
TransactionAbandonedTotal Count = 0
TransactionTotalCount = 0

TransactionBol ledBackTimeout TotalCount = 0
ActiwveTransactionsTotalCount = 0
TranzactionCommittedTotalCount = 0
Cachingli=abled = trues

Tran=sactionkol ledBackREesourceTotalCount = 0

il 2

Interval

Recommended minimum is5 minutes.
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WebLogic M Runtime

The WebLogic WM Runtime category includesthe counterslisted in the following table. Some of the
counterslisted in the table may not be available on your system. WebLogic counter categories, counter
names, and parameters are dynamically discovered by processing the set of MBeansin the WebLogic M X
Server. Which counters are discovered isdetermined by the WebLogic version you arerunning and how
WebLogic is configured.

el Description
CachingDisabled Prlvgte property that disables caching in Boolean Yes Yes
proxies.
Returnsthe current amount of free memory
HeapFreeCurrent (in bytes) in the M heap. Long Yes Yes
HeapSizeCurrent Returnsthe current size (in bytes) of the Long Yes Yes
VM heap.
. Returnsfalseif the MBean represented by
Registered thisobject has been unregistered. Boolean Yes ves
Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parametersand always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location
WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select valuesfrom the discovered list, or enter values
manually.

Data Point

For each counter that you haveincluded in atask:

! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.
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Datapoint Details E |
Eerver: zecotdv?, Time: 8192003 6:19:56 PH., Valu=: 1. 00000 :J
Value : 1 (Boolean) (True=1. Fal=e=0)

JVHEuntime_ Cachingli=sabled

Frivate property that disables caching in proxies.

Attribute walues for MBean:

HeapFresCurrent = 14234392
JavaVer=ion = 1.3.1_06
HeapSizelCurrent = 48488448

JavaVendor = Sun Microsystem=s Inc.
Fegistered = fal=se

0SHame = SunCS

0SVersion = 5.8

CachinglDi=zabled = true

A Ay

Interval

Recommended minimum is5 minutes.

W ebLogic Log Broadcaster Runtime

The WebLogic Log Broadcaster Runtime category includesthe counterslisted in the following table. Some
of the counterslisted in the table may not be available on your system. WebLogic counter categories,
counter names, and parameters are dynamically discovered by processing the set of MBeansin the
WebLogic M X Server. Which counters are discovered isdetermined by the WebLogic version you are
running and how WebLogic is configured.

M Description S A

CachingDisabled Prlva}te property that disables cachingin Boolean Yes Yes
proxies.
Returnsthe total number of log messages

MessagesLogged | generated by thisinstance of the WebLogic Long Yes Yes
server.

. Returnsfalse if the MBean represented by
Registered this object has been unregistered. Boolean Yes ves
Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parametersand always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain
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Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered

list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values

manually.

Name

The name of the log broadcaster. You can specify one or more names for monitoring. In any
combination, select valuesfrom the discovered list, or enter values manually.

StatType
This parameter is available for countersthat are returning a count or total (MessagesLogged in this
counter category). Possible values are:

ACTUAL Thecounter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.
The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

E]

Datapoint Details :
Server: secotdwZ, Time: B-19-2003 6:20:56 PH., Value: 1.00000 :J
Value : 1 (Boolean) {(Trus=1. Fal=se=0]}

LogBroadocasterFuntime CachingDi=sasbled

Private property that disables caching in proxies.

Attribute valuss for MBsan:

Fegi=stered = fal=e

Heszzages=logged = 270

Cachingli=abled = trus
Al W 4
Interval

Recommended minimum is5 minutes.

W ebLogic Message Driven EB Runtime

The WebLogic Message Driven EJB Runtime category includesthe counterslisted in the following table.
Some of the counterslisted in the table may not be available on your system. WebLogic counter categories,
counter names, and parameters are dynamically discovered by processing the set of MBeansin the
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WeblLogic M X Server. Which counters are discovered isdetermined by the WebLogic version you are
running and how WebLogic is configured.

m Description

CachingDisabled Prlva_te property that disables cachingin Boolean Yes Yes
proxies.
JMSConnectionAlive Returns_thestate of the EB's MS Boolean Yes Yes
connection.
. Returnsfalseif the MBean represented by
Registered this object has been unregistered Boolean Yes Yes
Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parameters and always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domains for monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values
manually.
Application
The application prefix of the EB ear. You can specify one or more application prefixesfor monitoring.
In any combination, select values from the discovered list, or enter values manually.
Component
The EIB component prefix of the EJB ear. You can specify one or more component prefixes for
monitoring. In any combination, select values from the discovered list, or enter values manually.
Name

Theremainder of the EBB name. You can specify one or more names for monitoring. In any
combination, select valuesfrom the discovered list, or enter values manually.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.
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The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

1.00000 4

Datapoint Details 3
Server: secotdwZ, Time: 8-19-2003 6:19:56 FH, Value:
Value : 1 (Boolean) (Trus=1, Fal===0)
HessagelrivenElBRuntime CachingDi=abled

Private property that disables caching in proxies.

Attribute waluse=s for MBean:

EJIBHame = jmsMessageformat

CachingDi=zabled = trud

Fegiztered = false

JHSConnectiondlive = trus

Al M 4
Interval

Recommended minimum is5 minutes.

W ebLogic Migratable Service Coordinator Runtime

The WebLogic Migratable Service Coordinator Runtime category includesthe counterslisted in the
following table. Some of the counterslisted in the table may not be available on your system. WebLogic
counter categories, counter names, and parameters are dynamically discovered by processing the set of
MBeansin the WebLogic M X Server. Which counters are discovered isdetermined by the WebLogic
version you arerunning and how WebLogic is configured.

M Description S A

CachingDisabled ana@te property that disables cachingin Boolean Yes Yes
proxies.
. Returnsfalse if the MBean represented by
Registered this object has been unregistered. Boolean Yes ves
Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parameters and always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domains for monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location
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WebLogic Application Server where the instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values

manually.

Service

The name of the migratable service coordinator. You can specify one or more names for monitoring. In
any combination, select values from the discovered list, or enter values manually.

Data Point
For each counter that you haveincluded in atask:

I Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

1.00000 4

Datapoint Details 3
Server: =zecotdwvZ, Time: 8-19-2003 6:21:56 FH, Value:
Value : 1 (Boolean) (Trus=1, Fal===0)
HigratableServiceCoordinatorBuntime Cachingli=abled
Private property that disables caching in proxies.

Attribute wvaluss for MBean:

Cachingli=zabled = trus
Fegistered = fal=se

4 2y

Interval

Recommended minimum is5 minutes.

W ebLogic Server Life Cycle Runtime

The WebLogic Server Life Cycle Runtime category includesthe counterslisted in the following table. Some
of the counterslisted in the table may not be available on your system. WebLogic counter categories,
counter names, and parameters are dynamically discovered by processing the set of MBeansin the
WeblLogic M X Server. Which counters are discovered isdetermined by the WebLogic version you are
running and how WebLogic is configured.

SN Description

CachingDisabled Prlva}te property that disables cachingin Boolean Yes Yes
proxies.

Registered Re'turn'sfalse if theM Bean'represented by Boolean Yes Yes
this object has been unregistered.
Returnsan integer that identifiesthe current

Stateval state of the server. Valuesrange from 0 to 8. Integer Yes ves
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Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parametersand always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select valuesfrom the discovered list, or enter values

manually.

Name

The application server name. You can specify one or more names for monitoring. In any combination,
select values from the discovered list, or enter values manually.

Data Point
For each counter that you haveincluded in atask:

! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

Datapoint Details |
Eerver: secotdw?, Time: 2-19-2003 &:20:56 FM, Valus: 1. 00000 :J
Valuse : 1 (Boolean) (Trus=1, Fal===0)

ServerlifeCycleFuntime CachingDi=abled

Private property that disables caching in proxies.

Attribute wvalus= for MBsan:

Cachingli=zabled = trus
Fegistered = fal==
State = RUHHIHG
StateVal = 2

4 2y

Interval

Recommended minimum is5 minutes.
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W ebLogic Server Runtime

The WebLogic Server Runtime category includesthe counterslisted in the following table. Some of the
counterslisted in the table may not be available on your system. WebLogic counter categories, counter
names, and parameters are dynamically discovered by processing the set of MBeansin the WebLogic M X
Server. Which counters are discovered isdetermined by the WebLogic version you arerunning and how
WebLogic is configured.

Counters

Description

ActivationTime ng;gsthenmewhen the server was Long Yes | Yes

Returnsthe administration port on which

AdministrationPort . o . .
thisserver islistening for connections.

Integer Yes | Yes

AdministrationPortEnabled _Returnswhether the AdministrationPort Boolean Yes | Yes
isenabled on the server.

AdminServer g:err]\(lagI:SH the server isan administrator Boolean ves | Yes

Returnsthe port on which admin server

AdminServerListenPort L . .
islistening for connections.

Integer Yes | Yes

Returnsthe secureType on which admin

S ) . Boolean Yes | Yes
server islistening for connections.

AdminServerListenPortSecure

Private property that disables caching in

. Boolean Yes | Yes
proxies.

CachingDisabled

Returnsthe port on which thisserver is

ListenPort listening for connections.

Integer Yes | Yes

ListenPortEnabled Returnswhether the default ListenPort is Boolean ves | Yes
enabled on the server.

OAMVersion ReturnstheOAM_versmn info. Indicates Integer ves | Yes
release level of this server.

Returnsthe current number sockets
Open SocketsCurrentCount registered for socket muxing on this Integer Yes | Yes
server.

Returnsfalse if the MBean represented by

Registered this object has been unregistered. Boolean Yes | Yes
Returnsthetotal number of restarts for

RestartsTotalCount this server since the cluster was last Integer Yes | Yes
activated.

SocketsOpenedTotal Count Returnsthetotgl num bgr of registrations Long ves | Yes
for socket muxing on thisserver.

<9 Listen Port Returnsthe port on which thisserver is Integer ves | Yes

listening for SSL connections
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<9 Listen PortEnabled Returnsif the default ISSListenPort is Boolean ves | Yes
enabled on the server.

Integer
SateVal Returns current state of the server. Yes | Yes

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. This allows you to select
between the multiple parameters and always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location
WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values
manually.

StatType

This parameter is available for countersthat are returning a count or total (SocketsOpenedTotalCount
isone examplein thiscounter category). Possible values are:

ACTUAL Thecounter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.
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Datapoint Details |
Eerver: =ecotdw?, Times: 3-13-2003 £:1%9:56 PH., Valus: 106123368EL576 :J
Value : 1061233653334 (Long)

ServerFuntimne ActivationTimes

Feturn the time when the server was s=tarted.

Attribute walusez for ME=an:

Soclket=0penedTotalCount = 2
ActivationTime = Mondaw. August 18, 2003 3:07:38 PH EDT
WeblogicVersion = Weblogic Server 7.0 SP2 Sun Jan 26 23:09%:32 PST 2003 2341492

JVHMID = 35456500233173095 secotdv2-null mull-<168041316-7-7005-7005-2006-70067005.~700
CachingDi=zabled = true

LiztenAddress = secotdwid-10.4 27 100
State = RUHNHIHG

LiztenPort = 7005

Festart=TotalCount = 00

Fegiztered = fal=e
OpenSocketsCurrentCount = 2
AdminServerHost = zecotdw:d
SSLLiztenAddress = zecotdv2- 10 4 27 100
AdminServerlistenFort = 7001

AdminServer = fal=e

AdminServerlistenPortSecure = falss

AdministrationFort = 9002

AdministrationPortEnabled = fal=e

CurrentDirectory = <opt<bea?lZ-user projectz testdomain- .
ListenPortEnabled = trues

DAHYerszion = 2
S51LLi=tenPort = 7006
SS5LLiztenFPortEnabled = trus
StateWal = 2

1| | v s

Interval

Recommended minimum is5 minutes.

W ebLogic Server Security Runtime

The WebLogic Server Security Runtime category includesthe counterslisted in the following table. Some of
the counterslisted in the table may not be available on your system. WebLogic counter categories, counter
names, and parameters are dynamically discovered by processing the set of MBeansin the WebLogic MM X
Server. Which counters are discovered isdetermined by the WebLogic version you arerunning and how
WebLogic is configured.

Counters

Description

Private property that disables

CachingDisabled S .
cachingin proxies.

Boolean | Yes | Yes

Returnsthe cumulative number of
InvalidLoginAttemptsTotalCount invalid logins attempted on this Long Yes | Yes
server.

Returnsthe highest number of
InvalidLoginUsersHighCount userswith outstanding invalid Long Yes | Yes
login attemptsfor this server.

LockedUsersCurrentCount Returnsthe number of currently Long Yes | Yes
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locked userson this server.

Returnsthe cumulative number of
LoginAttemptsWhileLockedTotalCount | invalid logins attempted on this Long Yes | Yes
server while the user was locked.

Returnsfalse if the MBean
Registered represented by this object has Boolean | Yes | Yes
been unregistered.

UnlockedUsersTotalCount Returns the number of t|.mes a Long Yes | Yes
user was unlocked on this server.

UserLockoutTotalCount Returnsthe cumulative n_umber of Long Yes | Yes
user lockoutsdone on this server.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parameters and always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values
manually.

StatType

This parameter is available for countersthat are returning a count or total
(InvalidLoginAttemptsTotalCount isone examplein this counter category). Possible values are:

ACTUAL Thecounter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.
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Datapoint Details |
Eerver: =secotdw?, Time: 8-19-2003 6:21-:56 PM, Valus: 1. 00000 :J
Value : 1 (Boolean) (Trus=1, Fal===0)

ServerSecurltyFuntime CachingDi=sasbled

Private property that disables caching in proxies.

Attribute walues for MBsan:

Logindttenpt=WhilelockedTotalCount = 0
TzerlockoutTotalCount = 0
MnlockedlUzersTotalCount = 0

Fegistered = fal=se
InvalidloginAttemptsTotalCount = 0
InvalidLloginl=zersHighCount = 0
Cachingli=zabled = trus
LockedlU=zersCurrentCount = 0

il v 4

Interval

Recommended minimum is5 minutes.

WebLogic Servliet Runtime

The WebLogic Application Runtime category includesthe counterslisted in the following table. Some of
the counterslisted in the table may not be available on your system. WebLogic counter categories, counter
names, and parameters are dynamically discovered by processing the set of MBeansin the WebLogic M X
Server. Which counters are discovered isdetermined by the WebLogic version you are running and how
WebLogic is configured.

Counters

Description

Private property that disables caching in

. Boolean Yes Yes
proxies.

CachingDisabled

Returnsthe average amount of time all
ExecutionTimeAverage | invocations of the servlet have executed Integer Yes | Yes
since it was created.

Returnsthe amount of timethe single
ExecutionTimeHigh longest invocation of the servlet has Integer Yes | Yes
executed since it was created.

Returnsthe amount of timethesingle
shortest invocation of the servlet has
ExecutionTimelLow executed since it was created. Note: For the | Integer Yes | Yes
CounterMonitor, the difference option
must be used.

Returnsthe amount of time all invocations

ExecutionTimeTotal of the servlet has executed since it was Integer Yes | Yes
created.

Internal Servlet Returnswhether thisisan Internal Servlet. | Boolean No Yes

InvocationTotalCount | Returnsthe total number of timesthe Integer Yes | Yes
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servlet has been invoked.

Returnsthe maximum capacity of this

PoolMaxCapacity servlet for single thread model servlets.

Integer Yes | Yes

Returnsfalse if the MBean represented by

thisobject has been unregistered Boolean Yes Yes

Registered

ReloadTotal Count Returnsthe total number of timesthe Integer Yes Yes
servlet has been reloaded.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parametersand always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select valuesfrom the discovered list, or enter values
manually.

Application
The application name. You can specify one or more names for monitoring. In any combination, select
values from the discovered list, or enter values manually.

Servlet
The serviet name. You can specify one or more names for monitoring. In any combination, select
values from the discovered list, or enter values manually.

StatType

This parameter is available for countersthat are returning a count or total (InvocationTotalCount is
one examplein thiscounter category). Possible values are:

ACTUAL The counter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Data Point
For each counter that you haveincluded in atask:

! Theprimary data point (PDP) isthe value returned for that counter.
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I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

Datapoint Details e |
Eerver: secotdw?, Time: 8-19-2003 6:21- 56 PH, Value: 1. 00000 :J
Value : 1 {(Boolean) {(Trus=1, Fal=se=0]

ServletFuntine Cachingli=abled

Frivate property that di=zables caching in proEies.

Attribute wvalus=s for MB=an:

PoolMaxCapacity = 0

Fegistered = fal=e=
ExecutionTimelow = 0
FeloadTotalCount = 0

ExecutionTimeHigh = 10

ServletPath = ~domain-HTRealm.j=p

ExecutionTimeTotal = 0

InvocationTotalCount 0

ExecutionTimsAverage 0

TEL = HTTE:~<<=ecotdw?: 7001 -console<domain-HNTEealmn.j=p

ServletHanse = weblogic managemsnt console webapp. _domain.  ntrealm
Cachingli=zabled = trus

ContextPath = <console

il v

Interval

Recommended minimum is5 minutes.

W ebLogic Sateful EB Runtime

The WebLogic Sateful EJB Runtime category includesthe counterslisted in the following table. Some of
the counterslisted in the table may not be available on your system. WebLogic counter categories, counter
names, and parameters are dynamically discovered by processing the set of MBeansin the WebLogic M X
Server. Which counters are discovered isdetermined by the WebLogic version you arerunning and how
WebLogic is configured.

M Description S A

CachingDisabled Prlvgte property that disables caching in Boolean Yes No
proxies.
. Returnsfalse if the MBean represented by
Registered this object has been unregistered. Boolean Yes No
Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. This allows you to select
between the multiple parameters and always end up with avalid combination of parameters. This
parameter dependency information is enforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.
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Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered

list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values

manually.

Application

The application prefix of the EJB ear. You can specify one or more application prefixes for monitoring.
In any combination, select values from the discovered list, or enter values manually.

Component

The EB component prefix of the EJB ear. You can specify one or more component prefixes for
monitoring. In any combination, select values from the discovered list, or enter values manually.

Name

Theremainder of the EBB name. You can specify one or more names for monitoring. In any
combination, select values from the discovered list, or enter values manually.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.
The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

|

Datapoint Details
Server: secotdvZ, Time: 8192003 6:20:5 PH., Value: 1.00000 :J
Value : 1 (Boolean) (Trus=1., Fal===0)

Stateful ETERuntime CachingDi=abled

Frivate property that disables caching in proEies.

Attribute wvaluse=s for MB=an:

EJBHame = =statefulSse=s=s=ion
Cachingli=zabled = trus

Fegiztered = false =
| M 4
Interval

Recommended minimum is5 minutes.

W ebLogic Sateess EB Runtime

The WebLogic Sateless EB Runtime category includesthe counterslisted in the following table. Some of
the counterslisted in the table may not be available on your system. WebLogic counter categories, counter
names, and parameters are dynamically discovered by processing the set of MBeansin the WebLogic MM X
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Server. Which counters are discovered isdetermined by the WebLogic version you arerunning and how
WebLogic is configured.

M Description A

CachingDisabled Prlva}te property that disables cachingin Boolean Yes Yes
proxies.
. Returnsfalse if the MBean represented
Registered by this object has been unregistered. Boolean Yes ves
Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parameters and always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values
manually.
Application
The application prefix of the EJB ear. You can specify one or more application prefixesfor monitoring.
In any combination, select values from the discovered list, or enter values manually.
Component
The EIB component prefix of the EJB ear. You can specify one or more component prefixes for
monitoring. In any combination, select values from the discovered list, or enter values manually.
Name
Theremainder of the EBB name. You can specify one or more names for monitoring. In any
combination, select valuesfrom the discovered list, or enter values manually.
Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.
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Datapoint Details G

Eerver: secotdw?, Time: 3-19-2003 6:19:56 PM, Valus=: 1.00000 :J
Walue : 1 (Boolean) (Trus=1. Fal===0)

Statelez=sEJERuntime CachingDi=sabled

Private property that disables caching in prozies.

Attribute wvalues for MBsan:

Fegistered = fal=ses
Cachingli=zabled = trus
EJEHame = receivelnT=

A v 4

Interval

Recommended minimum is5 minutes.

WebLogic Time Service Runtime

The WebLogic Time Service Runtime category includesthe counterslisted in the following table. Some of
the counterslisted in the table may not be available on your system. WebLogic counter categories, counter
names, and parameters are dynamically discovered by processing the set of MBeansin the WebLogic M X
Server. Which counters are discovered isdetermined by the WebLogic version you are running and how
WebLogic is configured.

CachingDisabled Prlvgte property that disables caching in Boolean Yes | Yes
proxies.

ExceptionCount Returnsthgtotal num ber of exceptions Integer Yes | Yes
thrown while executing scheduled triggers.

Execution Count Returnsthetotal number of triggers Integer Yes | Yes
executed.

ExecutionsPerMinute Returnsthe average number of triggers Integer Yes | Yes
executed per minute.

Registered Rta_turn§false if the MBean.represented by Boolean Yes | Yes
thisobject has been unregistered.

ScheduledTriggerCount Returnsthe pumber of currently active Integer Yes | Yes
scheduled triggers.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parametersand always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

184



QALoad Online Help

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location
WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or

more servers for monitoring. In any combination, select values from the discovered list, or enter values

manually.

Name

The name of the time service. You can specify one or more names for monitoring. In any combination,

select values from the discovered list, or enter values manually.

StatType

This parameter is available for countersthat are returning a count or total (ExecutionCount isone
examplein thiscounter category). Possible values are:

ACTUAL Thecounter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

Datapoint Details g |
Server: secotdvZ, Time: 8-19-2003 6:1%9:56 PH, Walue: 1.00000 :J
Walue : 1 (Boolean) (Trus=1. Fal===0)

TimeServiceRuntime Cachingli=abled

Private property that disables caching in prozies.

Attribute walues for MBsan:

Fegistered = fal=ses

ExceptionCount = 0
Cachingli=abled = trus
ExecutionsFPerMinute = 21

ExecutionCount = 34696
ScheduledTriggerCount = 11

A v 4

Interval

Recommended minimum is5 minutes.
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W ebLogic Transaction Resource Runtime

The WebLogic Transaction Resource Runtime category includesthe counterslisted in the following table.
Some of the counterslisted in the table may not be available on your system. WebLogic counter categories,
counter names, and parameters are dynamically discovered by processing the set of MBeansin the
WebLogic M X Server. Which counters are discovered isdetermined by the WebLogic version you are
running and how WebLogic is configured.

Counters

Description

Private property that disables

CachingDisabled S .
cachingin proxies.

Boolean | Yes | Yes

Returnsfalse if the MBean
Registered represented by thisobject has Boolean | Yes | Yes
been unregistered.

TransactionCommittedTotalCount Return_sthe number_ of Long Yes | Yes
committed transactions.

Returnsthe number of
TransactionHeuristicCommitTotalCount transactions for which th's. . Long Yes | Yes
resource hasreturned a heuristic

commit decision.

Returnsthe number of
TransactionHeuristicHazardTotalCount transactions for which this . Long Yes | Yes
resource hasreported a heuristic

hazard decision.

Returnsthe number of
TransactionHeuristicMixedTotalCount transactions for which this . Long Yes | Yes
resource hasreported a heuristic

mixed decision.

Returnsthe number of
TransactionHeuristicRollbackTotalCount transactions for which th's. . Long Yes | Yes
resource hasreturned a heuristic

rollback decision.

Returnsthe number of
TransactionHeuristicsTotalCount transactionsthat completed with | Long Yes | Yes
a heuristic status.

Returnsthe number of
TransactionRolledBackTotalCount transactionsthat were rolled Long Yes | Yes
back.

Returnsthe total number of
transactions processed. Thistotal
TransactionTotalCount includes all committed, rolled Long Yes | Yes
back and heuristic transaction
completions.
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Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between the multiple parametersand always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select valuesfrom the discovered list, or enter values
manually.

Transaction Runtime
The JTA runtime name. You can specify one or more names for monitoring. In any combination, select
values from the discovered list, or enter values manually.

Component
The JTA component name. You can specify one or more names for monitoring. In any combination,
select values from the discovered list, or enter values manually.

StatType

This parameter is available for countersthat are returning a count or total
(TransactionCommittedTotalCount isone examplein this counter category). Possible values are:

ACTUAL The counter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.
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Datapoint Details :

Server: secotdvZ, Time: 8-19-2003 6:20:5 PH, Value: 1.00000 :J
Value : 1 (Boolean) (Trus=1., Fal===0)

TransactionREesourceRuntime CachingDisabled

Private property that disables caching in proxies.

Attribute walues for MBsan:

TranzactionTotalCount = 1
TransactionBEol ledBackTotalCount = 0

TransactionHeuristicHazardTotalCount = 0
TransactionHeuristic=TotalCount = 0
Cachingli=zabled = trus
TransactionHeuristicCommitTotalCount = 0

Fegistered = fal=se
TransactionCommittedTotal Count = 1
TransactionHeuristicHizedTotalCount = 0
Fezourcelamnse = weblogic. jdbc. jt=s . Connection
TransactionHeuristicRol lbackTotalCount = 0

il 2y

Interval

Recommended minimum is5 minutes.

W ebLogic Web App Component Runtime

The WebLogic Web App Component Runtime category includesthe counterslisted in the following table.
Some of the counterslisted in the table may not be available on your system. WebLogic counter categories,
counter names, and parameters are dynamically discovered by processing the set of MBeansin the
WebLogic M X Server. Which counters are discovered isdetermined by the WebLogic version you are
running and how WebLogic is configured.

Private property that disables caching in
proxies.

CachingDisabled Boolean | Yes | Yes

Returnsthe current deployment state of

DeploymentState the module.

Integer No | Yes

Returnsthe directory indexing indicator

X i : Boolean | No | Yes
configured in weblogic.xml.

IndexDirectoryDisabled

Returnsthe JSP'sdebug/line numbers
JSPDebug parameter values configured in Boolean | No | Yes
weblogic.xml.

Returnsthe JSP's KeepGenerated
JSPKeepGenerated parameter value configured in Boolean | No | Yes
weblogic.xml.

Returnsthe JSP's PageCheckSecs value

JSPPageCheckSecs configured in weblogic.xml.

Long No | Yes

Returnsthe JSP's Verbose parameter

value configured in weblogic.xml. Boolean | No | Yes

JSPVerbose
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Returnsthe current total number of

Open SessionsCurrentCount . : .
open sessionsin thiscomponent.

Integer Yes | Yes

Returnsthe highest of the total number
of open sessionsin this server. The count
starts at zero each time the server is
Open SessionsHighCount activated. Note that thisisan Integer Yes | Yes
optimization method for a highly useful
statistic that could be implemented less
efficiently using change notification.

Returnsfalseif the MBean represented

by this object has been unregistered. Boolean Yes | Yes

Registered

Returnsthe servlet reload check seconds

ServletReloadCheckStatus . : ;
configured in weblogic.xml.

Integer No | Yes

Returnsthe session's cookie max age

SessionCookieMacAgentSecs configured for http sessions.

Integer No | Yes

Returnstheinvalidation check timer

SessionlInvalidationIntervalSecs | . : .
interval configured for http sessions.

Integer No | Yes

Returnsthe session monitoring indicator

) . . Boolean | No | Yes
configured in weblogic.xml.

SessionMonitoringEnabled

Returnsthe total number of sessions

SessionsOpenedTotalCount ) )
opened in thisserver.

Integer Yes | Yes

Returnsthetimeout configured for http

Session TimeoutSecs .
sessions.

Integer No | Yes

Returnsthe single threaded servlet pool

SngleThreadServletPoolSze ) . ) )
size configured in weblogic.xml.

Integer No | Yes

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. This allows you to select
between the multiple parametersand always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values
manually.
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Application

The application name. You can specify one or more names for monitoring. In any combination, select
values from the discovered list, or enter values manually.

StatType

This parameter is available for countersthat are returning a count or total (OpenSessionsCurrentCount
isone examplein thiscounter category). Possible values are:

ACTUAL The counter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

Datapoint Details : |
Server: secotdwv?, Time: 8192003 6:20:56 FM. WValue: 1.00000 :J
Value : 1 {(Boolean) {(Trus=1, Fal=se=0])

WebAppComponentBuntime CachingDi=ssbled

Frivate property that dimables caching in proEies.

Attribute wvaluses for MBsan:

OpenSe=z=ionsHighCount = 0
Fegistered = false
SezsionsCpenedTotal Count = 0
DpenSez=zionsCurrentCount = 0
Sourcelnfo = exanpleslsbipp
Statuz = DEPLOYED
Cachingli=abled = trus
ConponentHame = ezamnplesiisbipp

ContextBEoot = ~ezampleslisebipp =
Kl b 4
Interval

Recommended minimum is5 minutes.

WebLogic Web Server Runtime

The WebLogic Web Server Runtime category includesthe counterslisted in the following table. Some of
the counterslisted in the table may not be available on your system. WebLogic counter categories, counter
names, and parameters are dynamically discovered by processing the set of MBeansin the WebLogic MM X
Server. Which counters are discovered isdetermined by the WebLogic version you are running and how

WebLogic is configured.

Counters

Description
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Private property that disables caching in

. Boolean Yes Yes
proxies.

CachingDisabled

DefaultWebServer Return_swhether it isthe defaultWebServer Boolean No Yes
or aVirtualHost.

Returnsfalse if the MBean represented by

thisobject has been unregistered. Boolean ves ves

Registered

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. This allows you to select
between the multiple parametersand always end up with avalid combination of parameters. This
parameter dependency information isenforced by the task creation wizard in the VantageView Web
Console Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domains for monitoring. In any combination, select values from the discovered
list, or enter values manually.

Location

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, or enter values
manually.

Data Point
For each counter that you haveincluded in atask:

! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The PDP and IDP for a counter are displayed together in the following example. When parameters are
defined by multiple values, a PDP and IDP are returned for each discovered combination of parameters.

Datapoint Details 2 |
Server: secotdvZ., Time: B8-19-°2003 6:20:56 PFH., Value: 1.00000 :J
Value : 1 (Boolean) (Trus=1, Fal=es=0)

WebServerRBuntime CachingDi=zabled

Private property that disables caching in proxies.

Attribute walues for MBsan:

CachinglDi=zabled = trus
Fegiztered = false
WebServerHame = sxamnplesssrver

il 2

Interval

Recommended minimum is5 minutes.
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WebLogic9 Counters

WebLogic9 Counters

ServerVantage providesthe following dynamically discovered WebLogic9 remote counter categories. Each
category provides countersthat extend the monitoring of your WebLogic system. The categories, counters
names, and parameters are all dynamically discovered by processing the set of MBeans availablein the

WebLogic M X Server.

WebLogic App Client Component Runtime
WebLogic Application Runtime

WebLogic Cluster Runtime

WebLogic Component Runtime

WebLogic Connector Component Runtime
WebLogic Connector Connection Pool Runtime
WebLogic Connector Connection Runtime
WebLogic Connector Service Runtime
WeblLogic EB Cache Runtime

WebLogic EB Component Runtime
WebLogic EB Locking Runtime

WebLogic EB Pool Runtime

WebLogic EB Timer Runtime

WebLogic EB Transaction Runtime
WebLogic Entity Cache Cumulative Runtime
WebLogic Entity Cache Current State Runtime
WebLogic Execute Queue Runtime
WebLogic Interception Component Runtime
WebLogic IDBC Data Source Runtime
WebLogic DBC Data Source Task Runtime
WebLogic MSComponent Runtime
WebLogic MSConnection Runtime
WebLogic MSConsumer Runtime
WebLogic M SDestination Runtime
WebLogic M SDurable Subscriber Runtime
WebLogic MSPooled Connection Runtime
WebLogic M SProducer Runtime

WebLogic MSRemote Endpoint Runtime
WebLogic MSRuntime

WeblLogic M S Server Runtime
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WebLogic WM Runtime

WebLogic Library Runtime

WebLogic Log Broadcaster Runtime
WebLogic Max Threads Constraint Runtime
WebLogic Message Driven EB Runtime
WebLogic Min Threads Constraint Runtime
WebLogic NonXA Resource Runtime
WebLogic Persistent Sore Connection Runtime
WebLogic Persistent Sore Runtime
WebLogic Query Cache Runtime

WebLogic Request Class Runtime
WebLogic SAF Agent Runtime

WebLogic SAF Remote Endpoint Runtime
WebLogic Server Channel Runtime
WebLogic Server Life Cycle Runtime
WebLogic Server Life Cycle Task Runtime
WebLogic Server Runtime

WebLogic Server Security Runtime
WebLogic Servlet Runtime

WebLogic Task Runtime

WebLogic Thread Pool Runtime

WebLogic Transaction Name Runtime
WebLogic Transaction Resource Runtime
WebLogic User Lockout Manager Runtime
WebLogic WAN Replication Runtime
WebLogic Web App Component Runtime
WebLogic Web Server Runtime

WebLogic WLDF Archive Runtime
WebLogic WLDF Data Access Runtime
WebLogic WLDF Dbstore Archive Runtime
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WebLogic M S Session Pool Runtime WebLogic WLDF File Archive Runtime
WebLogic M S Session Runtime WebLogic WLDF Harvester Runtime

WebLogic Jolt Connection Pool Runtime WebLogic WLDF Image Creation Task Runtime
WebLogic Jolt Connection Service Runtime WebLogic WLDF Instrumentation Runtime
WebLogic JRockit Runtime WebLogic WLDF Watch Notification Runtime
WebLogic JTA Recovery Runtime WebLogic WLDF Wilstore ArchiveRuntime
WebLogic JTA Runtime WebLogic Work Manager Runtime

WebLogic Wsee Operation Runtime
WebLogic WSRM Remote Endpoint Runtime

WebLogic ApplicationRuntime

An application represents a 2EE Enterprise application packaged in an EARfile or EAR exploded directory.
The EARfile or directory contains a set of componentssuch as WAR, EJB, and RAR connector components,
each of which can be deployed on one or more targets. A target isa server or a cluster.

ApplicationRuntime MBean encapsulatesruntime information about a deployed Enterprise application.

The WebLogic_ApplicationRuntime category includesthe counterslisted in the following table. Some of
these counters may not be available on your system. ServerVantage dynamically discovers WebLogic
counter categories, counter names, and parameters by processing the set of managed beans (MBeans) in the
WebLogic Java Management Extensions (M X) Server. Which counters are discovered isdetermined by the
WebLogic version you arerunning and how WeblLogic is configured.

Counters

Counter Description Data Point Type

ActiveVersionSate | An application can bethe only version Integer
currently deployed, or it can have more than
oneversion currently deployed, using the
side-by-side deployment feature. If more than
oneversion isdeployed, only one version can
be active. Thisattribute specifiesthe statein
which the current application version isin.
An application can bein an INACTIVE state,
which meansthat it hasnot been activated
yet or that thereismore than one version of
the application deployed (using side-by-side
deployment) and thisoneisretiring. An
application can bein ACTIVE ADMIN state,
which meansthat it isthe currently active
version for administrative channel requests.
An application can bein ACTIVE state, which
meansthat it isthe currently active version
for normal (non-administrative) channel
requests. See
weblogic.deploy.version.AppActiveVersionSa
te for state values.
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EAR Returnstrueif the application deployment Boolean
unit isan EARfile; returnsfalse for
WAR/JAR/RAR etc. deployments.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. This allows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.

Application
The application name. You can specify one or more applications for monitoring. In any combination,
select values from the discovered list, enter values manually, or enter wildcard patterns.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.

? Question mark, represents any one individual character asa
wildcard.

n Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.
Interval
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Recommended minimum is5 minutes.

WebLogic AppClientComponentRuntime
Thisclass representsa component runtime managed bean (MBean) for 2EE Application Client Containers.

The WebLogic AppClientComponentRuntime category includesthe counter listed in the following table.
Thiscounter may not be available on your system. ServerVantage dynamically discovers WebLogic counter
categories, counter names, and parameters by processing the set of MBeansin the WebLogic Java
Management Extensions (MM X) Server. Which counters are discovered is determined by the WebLogic
version you arerunning and how WebLogic is configured.

Counters
Counter Description Data Point Type
DeploymentSate | Returnsthe Integer
current

deployment state
of the module.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. This allows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server
WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.
Application
The application name. You can specify one or more applications for monitoring. In any combination,
select values from the discovered list, enter values manually, or enter wildcard patterns.
AppClientComponent

The name of the application client component. You can specify one or more application client
componentsfor monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.
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? Question mark, represents any one individual character asa
wildcard.

A Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.

Interval

Recommended minimum is5 minutes.

WebLogic ClusterRuntime

Use this class for monitoring a server's view of the members of a WebLogic cluster within a WebLogic
domain.

The WebLogic_ClusterRuntime category includesthe counterslisted in the following table. Some of these
counters may not be available on your system. ServerVantage dynamically discovers WebLogic counter
categories, counter names, and parameters by processing the set of managed beans (MBeans) in the
WebLogic Java Management Extensions (M X) Server. Which counters are discovered isdetermined by the
WebLogic version you arerunning and how WebLogic is configured.

Counters
Counter ‘ Description ‘ DataPointType‘

AliveServerCount Returnsthe Integer
current total
number of alive
serversin this
cluster.

ForeignFragmentsDroppedCount | Returnsthe Long
number of
fragmentsthat
originated in
foreign domains
or clusters, using
the same multi-
cast address.

FragmentsReceivedCount Returnsthetotal | Long
number of multi-
cast messages
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received on this
server from the
cluster.

FragmentsSentCount Returnsthetotal | Long
number of multi-
cast fragments
sent from this
server into the
cluster.

MulticastM essagesLostCount Returnsthetotal | Long
number of
incoming multi-
cast messages lost
according to this
server.

PrimaryCount Returnsthe Long
number of
objectsthat the
local server hosts
asprimaries.

ResendRequestsCount Returnsthe Long
number of state-
delta messages
resent because a
receiving server
in the cluster
missed a message.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.

Cluster

The cluster name. You can specify one or more clustersfor monitoring. In any combination, select
values from the discovered list, enter values manually, or enter wildcard patterns.
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StatType

This parameter appliesonly to countersreturning a count or total (ResendRequestsCount isone
examplein thiscounter category). Possible values are:

ACTUAL The counter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw data value of the counter in the
last task interval and the raw data value of the counter in the current task interval.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.

? Question mark, represents any one individual character asa
wildcard.

A Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.
Interval

Recommended minimum is5 minutes.

WebLogic ComponentRuntime
Thisinterface isthe base class for all runtime MBeansthat provide status of running modules.

The WebLogic ComponentRuntime category includesthe counterslisted in the following table. Some of
these counters may not be available on your system. ServerVantage dynamically discovers WebLogic
counter categories, counter names, and parameters by processing the set of managed beans (MBeans) in the
WebLogic Java Management Extensions (M X) Server. Which counters are discovered isdetermined by the
WebLogic version you arerunning and how WeblLogic is configured.

Counters
Counter Description Data Point Type
DeploymentSate | Returnsthe Integer
current

deployment state
of the module.
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Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.

? Question mark, represents any one individual character as a
wildcard.

A Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.
Interval

Recommended minimum is5 minutes.

W ebLogic_ConnectorComponentRuntime

Thisinterface generates notifications about the deployment state of resource adapters. (Each resource
adapter isrepresented by an instance of ConnectorComponentMBean .)

In two-phase deployment, if a resource adapter's state is PREPARED then it has achieved the first phase of
deployment (everythingisset up and all that remainsisto enable areference to the adapter). When the
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resource adapter isin an ACTI VATED state, it has achieved the second phase of deployment, in which

applications can obtain areference to the adapter.

A server instance creates an instance of thisinterface when it creates an instance of
webl ogi c. managenent . confi gur ati on. Connect or Conponent MBean.

The WebLogic_ConnectorComponentRuntime category includesthe counterslisted in the following table.
Some of these counters may not be available on your system. ServerVantage dynamically discovers
WebLogic counter categories, counter names, and parameters by processing the set of managed beans
(MBeans) in the WebLogic Java Management Extensions (M X) Server. Which counters are discovered is
determined by the WebLogic version you arerunning and how WebLogic is configured.

Data Point Type

Counters

Counter

ActiveVersion

Description

Returnstrueif this
version isthe
active version.
Returnstrueif this
resource adapter is
not versioned.

Boolean

AppDeploymentM Bean

Returnsthe
application
deployment
MBean for the
connector
component.

ConnectionPoolCount

Returnsthe
number of
connection pools.

Integer

ConnectorComponentM Bean

Returnsthe
connector
component
MBean for the
connector
component.

Integer

DeploymentSate

Returnsthe
current
deployment state
of the module.

Integer

InboundConnectionsCount

Returnsthe
number of
inbound
connectionsfor
the resource
adapter.

Integer

SuspendedSate

Returnsresource
adapter suspended
state information.
If getSate()
returns

Integer
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SUSPENDED, then
getSuspendedSate
() returnsan
integer describing
which functions
of the resource
adapter are
suspended: One or
more of
INBOUND,
OUTBOUND, or
WORK (or ALL) or
0 for nothing
suspended.

Versioned Returnstrueif the | Boolean
resource adapter is
versioned.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.
Application
The application name. You can specify one or more applications for monitoring. In any combination,
select values from the discovered list, enter values manually, or enter wildcard patterns.
ConnectorComponent

The name of the connector component. You can specify one or more connector components for
monitoring. In any combination, select values from the discovered list, enter values manually, or enter
wildcard patterns.

StatType

This parameter appliesonly to countersreturning a count or total (InboundConnectionsCount isone
examplein thiscounter category). Possible values are:

ACTUAL The counter returnsthe raw data value.
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INTERVAL The counter returnsthe difference between the raw data value of the counter in the
last task interval and the raw data value of the counter in the current task interval.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.

? Question mark, represents any one individual character as a
wildcard.

A Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.
Interval

Recommended minimum is5 minutes.

W ebLogic_ConnectorConnectionPool Runtime

Use this class for monitoring a WebLogic connector connection pool.

The WebLogic_ConnectorConnectionPoolRuntime category includesthe counterslisted in the following
table. Some of these counters may not be available on your system. ServerVantage dynamically discovers
WebLogic counter categories, counter names, and parameters by processing the set of managed beans
(MBeans) in the WebLogic Java Management Extensions (MM X) Server. Which counters are discovered is
determined by the WebLogic version you are running and how WebLogic is configured.

Counters
Counter Description Data Point Type
ActiveConnectionsCurrentCount Returnsthe Integer
current total
active

connections.

ActiveConnectionsHighCount Returnsthe high- | Integer
water mark of
active

connectionsin
this connector
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AverageActiveUsage

Returnsthe
running average
usage of created
connections
activein the
connector pool
since the pool
last shrunk.

Integer

Capacitylncrement

Returnsthe
initial capacity
configured for
this connector
connection pool.

Integer

CloseCount

Returnsthe
number of
connections
closed for the
connection pool.

Long

ConnectionldleProfile Count

Returnsthe
number of idle
connection
profiles stored for
thispool.
Deprecated.

Integer

ConnectionLeakProfileCount

Returnsthe
number of leak
connection
profiles stored for
thispool.
Deprecated.

Integer

ConnectionProfilingEnabled

Indicateswhether
connection
profilingis
enabled for this
pool. Deprecated.

Boolean

ConnectionsCreatedTotalCount

Returnsthe total
number of
connector
connections
created in this
connector pool
since pool
instantiation.

Integer

ConnectionsDestroyedByErrorTotalCount

Returnsthe
number of
connections
destroyed

Integer
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because of a
received error
event.

ConnectionsDestroyedByShrinkingTotalCount

Returnsthe
number of
connections
destroyed
because of
shrinking.

Integer

ConnectionsDestroyedTotalCount

Returnsthe total
number of
connector
connections
destroyed in this
connector pool
since pool
instantiation.

Integer

ConnectionsMatchedTotalCount

Returnsthe total
number of times
arequest for a
connector
connectionswas
satisfied by using
an existing
created
connection since
pool
instantiation.

Integer

ConnectionsRejectedTotalCount

Returnsthe total
number of
rejected requests
for aconnector
connectionsin
thisconnector
pool since pool
instantiation.

Integer

CurrentCapacity

Returnsthe pool
size of this
connector
connection pool.

Long

FreeConnectionsCurrentCount

Returnsthe
current total free
connections.

Integer

FreeConnectionsHighCount

Returnsthe high-
water mark of
free connections
in thisconnector
pool since pool
instantiation.

Integer
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water mark of
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FreePoolSzeLowW aterM ark

Returnsthe free
pool size low-
water mark of
this connector
connection pool.

Long

HighestNumWaiters

Returnsthe
highest number
of waiters.

Long

InitialCapacity

Returnsthe
initial capacity
configured for
thisconnector
connection pool.

Integer

LastShrinkTime

Returnsthe last
time the pool was
shrunk.

Long

LoggingEnabled

Indicateswhether
loggingis
enabled for this
connector
connection pool.

Boolean

MaxCapacity

Returnsthe
maximum
capacity
configured for
this connector
connection pool.

Integer

MaxldleTime

Returnsthe
configured
maximum idle
time for this
pool.

Integer

NumberDetectedldle

Returnsthe total
number of idle
connections
detected in the
lifetime of this
pool. Deprecated.

Integer

NumberDetectedLeaks

Returnsthe total
number of leaked
connections
detected in the

Integer
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lifetime of this

pool. Deprecated.

NumUnavailableCurrentCount

Returnsthe
number of
unavailable
connections.

Integer

NumUnavailableHighCount

Returnsthe
highest number
of connections
unavailable at
any given time.

Integer

NumWaiters

Returnsthe
current number
of waiters.

Long

NumWaitersCurrentCount

Returnsthe
number of
waiters.

Integer

PoolSzeHighWaterMark

Returnsthe pool
size high-water
mark of this
connector
connection pool.

Long

PoolSzeLowW aterM ark

Returnsthe pool
size low-water
mark of this
connector
connection pool.

Long

ProxyOn

Returnsatrue
flag if the proxy
ison.

Boolean

RecycledTotal

Returnsthetotal
number of
connector
connections
recycled in this
connector
connection pool
since pool
instantiation.

Integer

ShrinkCountDownTime

Returnsthe
amount of time
left (in minutes)
until an attempt
to shrink the
pool ismade.

Integer

ShrinkingEnabled

Fecifieswhether
shrinking of this

Boolean
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connector
connection pool
isenabled.

ShrinkPeriodMinutes Returnsthe Integer
shrink period (in
minutes) of this
connector

connection pool.

Testable Indicates whether | Boolean
the connector

connection pool
istestable or not.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. This allows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.
Application
The application name. You can specify one or more applications for monitoring. In any combination,
select values from the discovered list, enter values manually, or enter wildcard patterns.
ConnectorComponent

The name of the connector component. You can specify one or more connector components for
monitoring. In any combination, select values from the discovered list, enter values manually, or enter
wildcard patterns.

ConnectorConnectionPool

The name connector connection pool. You can specify one or more connector connection pools for
monitoring. In any combination, select values from the discovered list, enter values manually, or enter
wildcard patterns.

StatType

This parameter appliesonly to countersreturning a count or total (NumUnavailableHighCount isone
examplein thiscounter category). Possible values are:
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ACTUAL Thecounter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw data value of the counter in the
last task interval and the raw data value of the counter in the current task interval.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.

? Question mark, represents any one individual character as a
wildcard.

n Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.

Interval

Recommended minimum is5 minutes.

WebLogic_ConnectorConnectionRuntime
Use thisclass for monitoring individual WebLogic connector connections.

The WebLogic_ConnectorConnectionRuntime category includesthe counterslisted in the following table.
Some of these counters may not be available on your system. ServerVantage dynamically discovers
WebLogic counter categories, counter names, and parameters by processing the set of managed beans
(MBeans) in the WebLogic Java Management Extensions (M X) Server. Which counters are discovered is
determined by the WebLogic version you are running and how WebLogic is configured.

Counters
Counter Description ‘ Data Point Type ‘

ActiveHandlesCurrentCount | Returnsthe Integer
current total
number of active
connection
handlesfor this
connection.
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ActiveHandlesHighCount

Returnsthe high-
water mark of
active connection
handlesfor this
connection since
connection
creation.

Integer

CreationDurationTime

Returnsthetime
taken to create
the connection.

Long

CurrentlylnUse

Indicates whether
the connection is
currently in use.

Boolean

Deletable

Indicates whether
the connection
can be closed
manually
through the
console.

Boolean

HandlesCreatedTotalCount

Returnsthe total
number of
connection
handles created
for this
connection since
the connection
creation.

Integer

Idle

Indicates whether
the connection
has been idle for
a period
extending
beyond the
configured
maximum.
Deprecated.

Boolean

InTransaction

Indicates whether
the connection is
currently in use
in atransaction.

Boolean

LastUsage

Returnsthe last
usage time stamp
for the
connection in
milliseconds.
Deprecated.

Long

ReserveDurationTime

Returnsthetime
taken (in

Long

QALoad Online Help
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seconds) to
reserve this
connection.

ReserveTime Returnsthe last Long
timethe
connection was
reserved.

Shared Indicateswhether | Boolean
the connection is
currently being
shared by more
than oneinvoker.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. This allows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.

ConnectorService

The name of the connector service. You can specify one or more connector services for monitoring. In
any combination, select values from the discovered list, enter values manually, or enter wildcard
patterns.

ConnectionPools

The name of the connection pools. You can specify one or more connection poolsfor monitoring. In
any combination, select values from the discovered list, enter values manually, or enter wildcard
patterns.

ConnectorConnection

The name of the connector connection. You can specify one or more connector connections for
monitoring. In any combination, select values from the discovered list, enter values manually, or enter
wildcard patterns.

StatType

This parameter appliesonly to countersreturning a count or total (HandlesCreatedTotalCount isone
examplein thiscounter category). Possible values are:
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ACTUAL Thecounter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw data value of the counter in the
last task interval and the raw data value of the counter in the current task interval.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.

? Question mark, represents any one individual character as a
wildcard.

n Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.
Interval

Recommended minimum is5 minutes.

WebLogic_ConnectorServiceRuntime

The counterscontain runtimeinformation that you can access at a connector service level, at a per
resource adapter level, or at an overall level.

The WebLogic_ConnectorServiceRuntime category includesthe counterslisted in the following table.
Some of these counters may not be available on your system. ServerVantage dynamically discovers
WebLogic counter categories, counter names, and parameters by processing the set of managed beans
(MBeans) in the WebLogic Java Management Extensions (M X) Server. Which counters are discovered is
determined by the WebLogic version you are running and how WebLogic is configured.

Counters

Counter Description Data Point Type

ActiveRACount Returnsthe Integer
number of active
resource adapters.

ConnectionPoolCurrentCount | Returnsthe Integer
number of
connection pools
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in all active
resource adapters.
Deprecated.

ConnectionPoolsTotalCount Returnsthetotal | Integer
number of
deployed and re-
deployed
connection pools
instantiated since
the server
startup.
Deprecated.

RACount Returnsthe Integer
number of
resource adapters
deployed in the
server. This count
includes active
and non-active
resource adapters
(in the case of
versioned
resource adapters
being replaced by
anew version).

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.

ConnectorService

The name of the connector service. You can specify one or more connector services for monitoring. In
any combination, select values from the discovered list, enter values manually, or enter wildcard
patterns.

StatType
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This parameter appliesonly to countersreturning a count or total (ConnectionPoolsTotalCount isone
examplein thiscounter category). Possible values are:
ACTUAL Thecounter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw data value of the counter in the
last task interval and the raw data value of the counter in the current task interval.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.

? Question mark, represents any one individual character asa
wildcard.

n Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.
Interval

Recommended minimum is5 minutes.

WebLogic EBCacheRuntime

Thisinterface contains accessor methods for all cache runtime information collected for an Enterprise
JavaBean (EB).

The WebLogic EBCacheRuntime category includesthe counterslisted in the following table. Some of
these counters may not be available on your system. ServerVantage dynamically discovers WebLogic
counter categories, counter names, and parameters by processing the set of managed beans (MBeans) in the
WebLogic Java Management Extensions (M X) Server. Which counters are discovered is determined by the
WebLogic version you arerunning and how WebLogic is configured.

Counters

Counter Description Data Point Type

ActivationCount Returnsthetotal | Long
number of
activated beans
from thisEB
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home.

CacheAccessCount

Returnsthe total
number of
attemptsto
access a bean
from the cache.

The sum of the
Cache Hit Count
and Cache Miss
Count may not
add up to the
cacheAccessCoun
tin arunning
server because
these metrics are
retrieved using
multiple callsand
the countscould
change between
the calls.

Long

CachedBeansCurrentCount

Returnsthe total
number of beans
from thisEB
home currently
in the EBB cache.

Integer

CacheHitCount

Returnsthe total
number of times
an attempt to
access a bean
from the cache
succeeded.

The sum of the
Cache Hit Count
and Cache Miss
Count may not
add up to the
CacheAccessCou
ntin arunning
server because
these metrics are
retrieved using
multiple callsand
the counts could
change between
the calls.

Deprecated. 28-
Aug-2002. You
may calculate the
cache hit count
by subtracting

Long
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the cache miss
count from the
cache access
count.

CacheMissCount Returnsthetotal | Long
number of times
an attempt to
access a bean
from the cache
failed.

The sum of the
Cache Hit Count
and Cache Miss
Count may not
add up to the
CacheAccessCou
ntin arunning
server because
these metrics are
retrieved using
multiple callsand
the countscould
change between
the calls.

PassivationCount Returnsthetotal | Long
number of
passivated beans
from thisEB
home.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.

Application
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The application name. You can specify one or more applications for monitoring. In any combination,
select values from the discovered list, enter values manually, or enter wildcard patterns.

EJBComponent

The name of the EJB component. You can specify one or more EBB componentsfor monitoring. In any
combination, select values from the discovered list, enter values manually, or enter wildcard patterns.

EntityEJB

The name of the entity EB. You can specify one or more entity EJBs for monitoring. In any
combination, select values from the discovered list, enter values manually, or enter wildcard patterns.

EJBCache

The name of the EIB cache. You can specify one or more EBB caches for monitoring. In any
combination, select values from the discovered list, enter values manually, or enter wildcard patterns.

StatType

This parameter appliesonly to countersreturning a count or total (PassivationCount isone examplein
thiscounter category). Possible values are;

ACTUAL The counter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw data value of the counter in the
last task interval and the raw data value of the counter in the current task interval.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.

? Question mark, represents any one individual character asa
wildcard.

n Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.

Interval

Recommended minimum is5 minutes.
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WebLogic EBComponentRuntime

Thisinterface isthetop-level interface for all runtime information collected for an Enterprise JavaBean
(EB) module.

The WebLogic EBComponentRuntime category includesthe counterslisted in the following table. Some
of these counters may not be available on your system. ServerVantage dynamically discovers WebLogic
counter categories, counter names, and parameters by processing the set of managed beans (MBeans) in the
WebLogic Java Management Extensions (M X) Server. Which counters are discovered isdetermined by the
WebLogic version you arerunning and how WebLogic is configured.

Counters
Counter Description Data Point Type
DeploymentSate | Returnsthe Integer
current

deployment state
of the module.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. This allows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.

Application

The application name. You can specify one or more applications for monitoring. In any combination,
select values from the discovered list, enter values manually, or enter wildcard patterns.

EJBComponent

The name of the EJB component. You can specify one or more EBB componentsfor monitoring. In any
combination, select values from the discovered list, enter values manually, or enter wildcard patterns.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:
* Asterisk, represents zero or more characters as a wildcard.

? Question mark, represents any one individual character asa
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wildcard.
n Caret, excludes all valuesthat match the specified pattern.
\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
I Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.

Interval

Recommended minimum is5 minutes.

WebLogic EBLockingRuntime

Thisinterface contains accessor methods for all lock manager runtime information collected for an
Enterprise JavaBean (EJB).

The WebLogic EBLockingRuntime category includesthe counterslisted in the following table. Some of
these counters may not be available on your system. ServerVantage dynamically discovers WebLogic
counter categories, counter names, and parameters by processing the set of managed beans (MBeans) in the
WebLogic Java Management Extensions (M X) Server. Which counters are discovered isdetermined by the
WebLogic version you arerunning and how WebLogic is configured.

Counter Description Data Point Type

LockEntriesCurrentCount | Returnsthe Integer
number of beans
currently locked.

Counters

LockManagerAccessCount | Returnsthetotal | Long
number of
attemptsto
obtain alock on
abean, including
attemptsto
obtain alock on
a bean already
locked on behalf
of the client.

TimeoutTotalCount Returnsthe Long
current number
of threads that
timed out
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waiting for alock
on abean.

WaiterCurrentCount Returnsthe Integer
current number
of threadsthat
waited for alock
on abean.

WaiterTotalCount Returnsthetotal | Long
number of
threadsthat
waited for a lock
on abean.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.
Application
The application name. You can specify one or more applications for monitoring. In any combination,
select values from the discovered list, enter values manually, or enter wildcard patterns.
EJBComponent

The name of the EJB component. You can specify one or more EBB componentsfor monitoring. In any
combination, select values from the discovered list, enter values manually, or enter wildcard patterns.

StatefulEJB

The name of the stateful EB. You can specify one or more stateful EJBs for monitoring. In any
combination, select values from the discovered list, enter values manually, or enter wildcard patterns.

EJBLocking

The name of the EBB lock. You can specify one or more EB locks for monitoring. In any combination,
select values from the discovered list, enter values manually, or enter wildcard patterns.

StatType
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This parameter appliesonly to countersreturning a count or total (WaiterTotalCount isone examplein
thiscounter category). Possible values are;

ACTUAL The counter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw data value of the counter in the
last task interval and the raw data value of the counter in the current task interval.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.

? Question mark, represents any one individual character asa
wildcard.

n Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.
Interval

Recommended minimum is5 minutes.

W ebLogic EBPoolRuntime

Thisinterface contains accessor methods for all free pool runtime information collected for an Enterprise
JavaBean (EB).

The WebLogic EBPoolRuntime category includesthe counterslisted in the following table. Some of these
counters may not be available on your system. ServerVantage dynamically discovers WebLogic counter
categories, counter names, and parameters by processing the set of managed beans (MBeans) in the
WebLogic Java Management Extensions (M X) Server. Which counters are discovered is determined by the
WebLogic version you arerunning and how WebLogic is configured.

Counters

Counter Description Data Point Type

AccessTotalCount Returnsthetotal number of Long
times an attempt was made to
get an instance from the free
pool.
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BeansinUseCount

Returnsthetotal number of
bean instances currently in
use from the free pool.

Deprecated. 28-Aug-2002. Use
getBeansinUseCurrentCount()

Integer

BeansinUseCurrentCount

Returnsthe number of bean
instances currently in use
from the free pool.

Integer

DestroyedTotalCount

Returnsthe total number of
times abean instance from
this pool was destroyed
because of a nonapplication
exception being thrown from
it.

Long

IdleBeansCount

Returnsthe total number of
available bean instancesin the
free pool.

Deprecated. 28-Aug-2002. Use
getPooledBeansCurrentCount(

).

Integer

MissTotalCount

Returnsthetotal number of
times a failed attempt was
made to get an instance from
the free pool. An attempt to
get a bean from the pool fails
if there are no available
instancesin the pool.

Long

PooledBeansCurrentCount

Returnsthe current number of
available bean instancesin the
free pool.

Integer

TimeoutTotalCount

Returnsthe total number of
threadsthat timed out waiting
for an available bean instance
from the free pool.

Long

WaiterCurrentCount

Returnsthe number of threads
currently waiting for an
available bean instance from
the free pool.

Integer

WaiterTotalCount

Returnsthe total number of
threads currently waiting for
an available bean instance
from the free pool.

Deprecated. 28-Aug-2002. Use
getWaiterCurrentCount().

Long
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Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server where the instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.
Application
The application name. You can specify one or more applications for monitoring. In any combination,
select values from the discovered list, enter values manually, or enter wildcard patterns.
EJBComponent
The name of the EJB component. You can specify one or more EBB componentsfor monitoring. In any
combination, select values from the discovered list, enter values manually, or enter wildcard patterns.
StatelessEJB
The name of the stateless EJB. You can specify one or more stateless EBs for monitoring. In any
combination, select values from the discovered list, enter values manually, or enter wildcard patterns.
EJBPool
The name of the EBB pool. You can specify one or more EBs poolsfor monitoring. In any combination,
select values from the discovered list, enter values manually, or enter wildcard patterns.
StatType

This parameter appliesonly to countersreturning a count or total (WaiterTotalCount isone examplein
thiscounter category). Possible values are;

ACTUAL The counter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw data value of the counter in the
last task interval and the raw data value of the counter in the current task interval.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.
? Question mark, represents any one individual character asa
wildcard.
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A Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to
represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.
Interval

Recommended minimum is5 minutes.

WebLogic EBTimerRuntime

Thisinterface contains accessor methods for all Enterprise JavaBean (EJB) timer runtimeinformation
collected for an EJB.

The WebLogic EBTimerRuntime category includesthe counterslisted in the following table. Some of
these counters may not be available on your system. ServerVantage dynamically discovers WebLogic
counter categories, counter names, and parameters by processing the set of managed beans (MBeans) in the
WebLogic Java Management Extensions (M X) Server. Which counters are discovered isdetermined by the
WebLogic version you arerunning and how WebLogic is configured.

Counters
Counter ‘ Description ‘ Data Point Type ‘
ActiveTimeCount Returnsthe Integer

current number
of active timers
for this EB.

CancelledTimerCount | Returnsthetotal | Long
number of timers
that explicitly
cancelled for this
EB.

DisabledTimerCount | Returnsthe Integer
current number
of timers
temporarily
disabled for this
EB.

TimeoutCount Returnsthetotal | Long
number of
successful time-
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out notifications
made for this EJB.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domains for monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.
Application
The application name. You can specify one or more applications for monitoring. In any combination,
select values from the discovered list, enter values manually, or enter wildcard patterns.
EJBComponent
The name of the EJB component. You can specify one or more EB components for monitoring. In any
combination, select values from the discovered list, enter values manually, or enter wildcard patterns.
StatelesseJB
The name of the stateless EJB. You can specify one or more stateless EJBs for monitoring. In any
combination, select values from the discovered list, enter values manually, or enter wildcard patterns.
EJBTimer
The name of the EB timer. You can specify one or more EB timersfor monitoring. In any
combination, select values from the discovered list, enter values manually, or enter wildcard patterns.
StatType

This parameter appliesonly to countersreturning a count or total (TimeoutCount isone examplein
thiscounter category). Possible values are:

ACTUAL The counter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw data value of the counter in the
last task interval and the raw data value of the counter in the current task interval.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:
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* Asterisk, represents zero or more characters as a wildcard.

? Question mark, represents any one individual character as a
wildcard.

A Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.

Interval

Recommended minimum is5 minutes.

WebLogic EBTransactionRuntime

Thisinterface contains accessor methods for all transaction runtime information collected for an Enterprise
JavaBean (EB).

The WebLogic EBTransactionRuntime category includesthe counterslisted in the following table. Some
of these counters may not be available on your system. ServerVantage dynamically discovers WebLogic
counter categories, counter names, and parameters by processing the set of managed beans (MBeans) in the
WebLogic Java Management Extensions (M X) Server. Which counters are discovered isdetermined by the
WebLogic version you are running and how WebLogic is configured.

Counters

Counter Description Data Point Type

TransactionsCommittedTotalCount | Returnsthetotal | Long
number of
transactions
committed for
this EB.

TransactionsRolledBackTotalCount | Returnsthetotal | Long
number of
transactions
rolled back for
this EB.

TransactionsTimedOutTotalCount | Returnsthetotal | Long
number of timed-
out transactions
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for this EB.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domains for monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.
Application
The application name. You can specify one or more applications for monitoring. In any combination,
select values from the discovered list, enter values manually, or enter wildcard patterns.
EJBComponent
The name of the EIB component. You can specify one or more EBB componentsfor monitoring. In any
combination, select values from the discovered list, enter values manually, or enter wildcard patterns.
EntityEJB
The name of the entity EJB. You can specify one or more entity EJBs for monitoring. In any
combination, select values from the discovered list, enter values manually, or enter wildcard patterns.
EJBTransaction
The name of the EB transaction. You can specify one or more EB transactions for monitoring. In any
combination, select values from the discovered list, enter values manually, or enter wildcard patterns.
StatType

This parameter appliesonly to countersreturning a count or total (TransactionsTimedOutTotalCount
isone examplein thiscounter category). Possible values are:

ACTUAL The counter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw data value of the counter in the
last task interval and the raw data value of the counter in the current task interval.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:
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* Asterisk, represents zero or more characters as a wildcard.

? Question mark, represents any one individual character as a
wildcard.

A Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.

Interval

Recommended minimum is5 minutes.

WebLogic EntityCacheCumulativeRuntime
Use this class for monitoring an EXtensible Markup Language (XML) cache.

The WebLogic_EntityCacheCumulativeRuntime category includesthe counterslisted in the following
table. Some of these counters may not be available on your system. ServerVantage dynamically discovers
WebLogic counter categories, counter names, and parameters by processing the set of managed beans
(MBeans) in the WebLogic Java Management Extensions (M X) Server. Which counters are discovered is
determined by the WebLogic version you are running and how WebLogic is configured.

Counters
Counter Description ‘ Data Point Type ‘

AvgEntrySzeDiskPurged Returnsthe Double
cumulative
average size of
entries purged
from the disk
cache.

AvgEntrySzeMemoryPurged | Returnsthe Double
average size of all
entries purged
from the
memory.

AvgPercentPersistent Returnsthe Double
current average
percentage of
entriesin the
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entity cache
persisted to the
disk cache.

AvgPercentTransient

Returnsthe
current average
percentage of
entriesin the
entity cache that
are transient or
have not been
persisted.

Double

AvgPer EntryDiskSze

Returnsthe
current average
size of the entries
in the entity disk
cache.

Double

AvgPerEntryMemorySze

Returnsthe
current average
size of the entries
in the entity
memory cache.

Double

AvgTimeout

Returnsthe
average amount
of timethat the
entity cache has
timed-out when
trying to retrieve
an entity.

Double

DiskPurgesPerHour

Returnsthe
cumulative
average number
of purges from
the disk cache
per hour.

Double

MaxEntryMemorySze

Returnsthe
current
maximum size of
the entriesin the
entity memory
cache.

Long

MaxEntryTimeout

Returnsthe
largest time-out
value for any
current entry in
the entity cache.

Double

MemoryPurgesPerHour

Returnsthe
cumulative
average number
of entries purged

Double
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from the entity
cache.

MinEntryMemorySze

Returnsthe
current
minimum size of
the entriesin the
entity memory
cache.

Long

MinEntryTimeout

Returnsthe
smallest time-out
value for any
current entry in
the entity cache.

Double

PercentRejected

Returnsthe
cumulative
percent of the
potential entries
rejected to the
entity cache.

Double

TotalCurrentEntries

Returnsthe total
current number
of entriesin the
entity cache.

Long

TotalltemsDiskPurged

Returnsthe total
number of items
purged from the
disk cache.

Long

TotalltemsMemoryPurged

Returnsthe
cumulative
number of items
purged from the
entity cache.

Long

TotalNumberDiskPurges

Returnsthe total
number of entries
purged from the
disk cache.

Long

TotalNumberMemoryPurges

Returnsthe
cumulative total
number of entries
purged from the
entity cache.

Long

TotalNumberOfRejections

Returnsthe
cumulative total
number of entries
rejected from the
entity cache for
the current
session.

Long
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TotalNumberOfRenewals Returnsthe Long
cumulative total
number of entries
refreshed in the
entity cache.

TotalPersistentCurrentEntries| Returnsthetotal | Long
current number
of entriesin the
cache having
been persisted to
disk.

TotalSzeOfRejections Returnsthe Long
cumulative total
size of the
rejections from
the entity cache.

TotalTransientCurrentEntries | Returnsthetotal | Long
current number
of transient (not
yet persisted to
disk) entriesin
the entity cache.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. This allows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domains for monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.

Application
The application name. You can specify one or more applications for monitoring. In any combination,
select values from the discovered list, enter values manually, or enter wildcard patterns.

EntityCacheCumulative

The name of the entity cache cumulative. You can specify one or more entity cache cumulatives for
monitoring. In any combination, select values from the discovered list, enter values manually, or enter
wildcard patterns.
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Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.

? Question mark, represents any one individual character as a
wildcard.

n Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.

Interval

Recommended minimum is5 minutes.

WebLogic EntityCacheCurrentSateRuntime
Use this class for monitoring the size and usage of an EXtensible Markup Language (XML) cache.

The WebLogic_EntityCacheCurrentSateRuntime category includesthe counterslisted in the following
table. Some of these counters may not be available on your system. ServerVantage dynamically discovers
WebLogic counter categories, counter names, and parameters by processing the set of managed beans
(MBeans) in the WebLogic Java Management Extensions (M X) Server. Which counters are discovered is
determined by the WebLogic version you are running and how WebLogic is configured.

Counters
Counter Description ‘ Data Point Type ‘

AvgPercent Persistent Returnsthe Double
current average
percentage of
entriesin the
entity cache
persisted to the
disk cache.

AvgPercentTransient Returnsthe Double
current average
percentage of
entriesin the
entity cache that
are transient (not
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yet persisted).

AvgPer EntryDiskSize

Returnsthe
current average
size of the entries
in the entity disk
cache.

Double

AvgPerEntryMemorySze

Returnsthe
current average
size of the entries
in the entity
memory cache.

Double

AvgTimeout

Returnsthe
average amount
of timethat the
entity cache has
timed-out when
trying to retrieve
an entity.

Double

DiskUsage

Returnsthe
current size of
the entity disk
cache.

Long

MaxEntryMemorySze

Returnsthe
current
maximum size of
the entriesin the
entity memory
cache.

Long

MaxEntryTimeout

Returnsthe
largest time-out
value for any
current entry in
the entity cache.

Double

MemoryUsage

Returnsthe
current size of
the entity
memory cache.

Long

MinEntryMemorySze

Returnsthe
current
minimum size of
the entriesin the
entity memory
cache.

Long

MinEntryTimeout

Returnsthe
smallest time-out
value for any
current entry in

Double
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the entity cache.

TotalCurrentEntries Returnsthetotal | Long
current number
of entriesin the
entity cache.

TotalPersistentCurrentEntries| Returnsthetotal | Long
current number
of entriesin the
cache persisted to
disk.

TotalTransientCurrentEntries | Returnsthetotal | Long
current number
of transient
entriesin the
entity cache.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. This allows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.
Application
The application name. You can specify one or more applications for monitoring. In any combination,
select values from the discovered list, enter values manually, or enter wildcard patterns.
EntityCacheCurrentState

The name of the entity cache current state. You can specify one or more entity cache current states for
monitoring. In any combination, select values from the discovered list, enter values manually, or enter
wildcard patterns.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.
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? Question mark, represents any one individual character asa
wildcard.

A Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.

Interval

Recommended minimum is5 minutes.

WebLogic ExecuteQueueRuntime
Use thisbean to monitor an execute queue and its associated thread pool.

The WebLogic_ExecuteQueueRuntime category includesthe counterslisted in the following table. Some of
these counters may not be available on your system. ServerVantage dynamically discovers WebLogic
counter categories, counter names, and parameters by processing the set of managed beans (MBeans) in the
WebLogic Java Management Extensions (M X) Server. Which counters are discovered isdetermined by the
WebLogic version you arerunning and how WebLogic is configured.

Counter Description Data Point Type

ExecuteThreadCurrentldleCount | Returnsthe Integer
number of idle
threads assigned
to the queue.

Counters

ExecuteThreadTotalCount Returnsthetotal | Integer
number of
execute threads
assigned to the
queue.

PendingRequestCurrentCount Returnsthe Integer
number of
waiting requests
in the queue.

PendingRequestOldestTime Returnsthetime | Long
that the longest
waiting request

234



QALoad Online Help

was placed in the
queue.

ServicedRequestTotalCount Returnsthe Integer
number of
requests
processed by the
gqueue.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. This allows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domains for monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.

ExecuteQueue

The name of the execute queue. You can specify one or more execute queues for monitoring. In any
combination, select values from the discovered list, enter values manually, or enter wildcard patterns.

StatType

This parameter appliesonly to countersreturning a count or total (ServicedRequestTotalCount isone
examplein thiscounter category). Possible values are:

ACTUAL Thecounter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw data value of the counter in the
last task interval and the raw data value of the counter in the current task interval.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.

? Question mark, represents any one individual character as a
wildcard.

A Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to
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represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
I Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.
Interval

Recommended minimum is5 minutes.

WebLogic_InterceptionComponentRuntime
Thisclassisthe top-level interface for all runtime information collected for an Interception module.

The WebLogic_InterceptionComponentRuntime category includesthe counter listed in the following
table. Thiscounter may not be available on your system. ServerVantage dynamically discovers WebLogic
counter categories, counter names, and parameters by processing the set of managed beans (MBeans) in the
WebLogic Java Management Extensions (M X) Server. Which counters are discovered isdetermined by the
WebLogic version you are running and how WebLogic is configured.

Counters
Counter Description Data Point Type
DeploymentSate| Returnsthe Integer
current

deployment state
of the module.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.
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Application

The application name. You can specify one or more applications for monitoring. In any combination,
select values from the discovered list, enter values manually, or enter wildcard patterns.

InterceptionComponent
The name of the interception component. You can specify one or more interception componentsfor
monitoring. In any combination, select values from the discovered list, enter values manually, or enter
wildcard patterns.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.

? Question mark, represents any one individual character asa
wildcard.

A Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.
Interval

Recommended minimum is5 minutes.

WebLogic JDBCDataSourceRuntime

Use this class for monitoring a WeblLogic Java DataBase Connectivity (JDBC) data source and its associated
connection pool.

The WebLogic_ IDBCDataSourceRuntime category includesthe counterslisted in the following table. Some
of these counters may not be available on your system. ServerVantage dynamically discovers WeblLogic
counter categories, counter names, and parameters by processing the set of managed beans (MBeans) in the
WebLogic Java Management Extensions (M X) Server. Which counters are discovered isdetermined by the
WebLogic version you arerunning and how WebLogic is configured.

Counters

Counter ——— DataPoint
Description Type

ActiveConnectionsAverageCount Returnsthe Integer
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average number of
active connections
in thisinstance of
the data source.
Active connections
are connectionsin
use by an
application.

ActiveConnectionsCurrentCount

Returnsthe
number of
connections
currently in use by
applications.

Integer

ActiveConnectionsHighCount

Returnsthe
highest number of
active database
connectionsin this
instance of the
data source since
data source
instantiation.
Active connections
are connectionsin
use by an
application.

Integer

ConnectionDelayTime

Returnsthe
average time (in
milliseconds)
needed to create a
physical
connection to the
database. The
valueiscalculated
asasummary of all
timesto connect
divided by the
total number of
connections.

Integer

ConnectionsTotalCount

Returnsthe
cumulative total
number of
database
connections
created in thisdata
source since data
source
deployment.

Integer

CurrCapacity

Returnsthe
current count of
JDBC connections
in the connection

Integer
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pool in the data
source.

CurrCapacityHighCount

Returnsthe
highest number of
database
connections
available or in use
(current capacity)
in thisinstance of
the data source
since data source
deployment.

Integer

DeploymentSate

Returnsthe
current
deployment state
of the module.

Integer

Enabled

Indicateswhether
the data sourceis
enabled or
disabled: Returns
trueif the data
sourceisenabled;
returnsfalseif the
data sourceis
disabled.

Boolean

FailedReserveRequestCount

Returnsthe
cumulative,
running count of
requests for a
connection from
this data source
that could not be
fulfilled.

Long

FailuresToReconnectCount

Returnsthe
number of times
that the data
source attem pted
to refresh a
database
connection and
failed. Failures may
occur when the
database is
unavailable or
when the network
connection to the
databaseis
interrupted.

Integer

HighestNumAuvailable

Returnsthe
highest number of

Integer
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database
connections
available at any
timein this
instance of the
data source since
data source
deployment.

HighestNumUnavailable

Returnsthe
highest number of
database
connections
unavailable (in use
or being tested by
the system) in this
instance of the
data source since
data source
deployment.

Integer

LeakedConnectionCount

Returnsthe
number of leaked
connections. A
leaked connection
isaconnection
reserved from the
data source but not
returned to the
data source by
calling close().

Integer

NumAvailable

Returnsthe
number of
database
connections
currently available
(not in use) in this
data source.

Integer

NumUnavailable

Returnsthe
number of
database
connections
currently
unavailable (in use
or being tested by
the system) in this
instance of the
data source.

Integer

PrepSmtCacheAccessCount

Returnsthe
cumulative,
running count of
the number of
timesthat the

Long
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statement cache
was accessed.

PrepSmtCacheAddCount

Returnsthe
cumulative,
running count of
the number of
statements added
to the statement
cache. Each
connection in the
connection pool
hasitsown cache
of statements. This
number isthe sum
of the number of
statements added
to the cachesfor
all connectionsin
the connection
pool.

Long

PrepSmtCacheCurrentSze

Returnsthe
number of
prepared and
callable statements
currently cached
in the statement
cache. Each
connection in the
connection pool
hasitsown cache
of statements. This
number isthe sum
of the number of
statementsin the
cachesfor all
connectionsin the
connection pool.

Integer

PrepSmtCacheDeleteCount

Returnsthe
cumulative,
running count of
statements
discarded from the
cache. Each
connection in the
connection pool
hasitsown cache
of statements. This
number isthe sum
of the number of
statementsthat
were discarded
from the caches for
all connectionsin

Long
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the connection
pool.

PrepSmtCacheHitCount

Returnsthe
cumulative,
running count of
the number of
timesthat
statementsfrom
the cache were
used.

Integer

PrepSmtCacheMissCount

Returnsthe
number of times
that a statement
request could not
be satisfied with a
statement from the
cache.

Integer

ReserveRequestCount

Returnsthe
cumulative,
running count of
requests for a
connection from
this data source.

Long

WaitingForConnectionCurrentCount

Returnsthe
number of
connection
requests waiting
for a database
connection.

Integer

WaitingForConnectionFailureTotal

Returnsthe
cumulative,
running count of
requests for a
connection from
this data source
that waited before
getting a
connection and
eventually failed to
get a connection.

Long

WaitingForConnectionHighCount

Returnsthe
highest number of
application
requests
concurrently
waiting for a
connection from
thisinstance of the
data source.

Integer
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WaitingForConnection SuccessTotal Returnsthe Long
cumulative,
running count of
requests for a
connection from
this data source
that had to wait
before getting a
connection and
eventually
succeeded in
getting a
connection.

WaitingForConnectionTotal Returnsthe Long
cumulative,
running count of
requests for a
connection from
this data source
that had to wait
before getting a
connection,
including those
that eventually got
aconnection and
those that did not
get a connection.

WaitSecondsHighCount Returnsthelongest | Integer
connection reserve
wait timein
seconds.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domains for monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.

Application
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The application name. You can specify one or more applications for monitoring. In any combination,
select values from the discovered list, enter values manually, or enter wildcard patterns.

JDBCDataSource

The name of the JDBC data source. You can specify one or more JDBC data sources for monitoring. In
any combination, select values from the discovered list, enter values manually, or enter wildcard
patterns.

StatType

This parameter appliesonly to countersreturning a count or total (ReserveRequestCount isone
examplein thiscounter category). Possible values are:

ACTUAL The counter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw data value of the counter in the
last task interval and the raw data value of the counter in the current task interval.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.

? Question mark, represents any one individual character asa
wildcard.

A Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.
Interval

Recommended minimum is5 minutes.

WebLogic DBCDataSourceTaskRuntime

Information for thisWebLogic_ JDBCDataSourceTaskRuntime (Java Data Base Connectivity) category is
available only at runtime. To view information about this MBean, start the host WebLogic server
instance,and then use WebLogic Scripting Tool in interactive mode. Or, you may use some other category
browser.

The WebLogic_ IDBCDataSourceTaskRuntime category includesthe counterslisted in the following list.
Some of these counters may not be available on your system. ServerVantage dynamically discovers
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WebLogic counter categories, counter names, and parameters by processing the set of managed beans
(MBeans) in the WebLogic Java Management Extensions (M X) Server. Which counters are discovered is
determined by the WebLogic version you are running and how WebLogic is configured.

Counters

Counter Description Data Point Type

BeginTime Returnsthe task Long
start time.

EndTime Returnsthe task Long
completion time.
Avalue of -1
indicatesthat the
task iscurrently
running.

Running Indicateswhether | Boolean
the task is still
running.

System Task Indicateswhether | Boolean
thistask was
initiated by the
Server versus a
user.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.

JDBCService

The name of the JDBC service. You can specify one or more JDBC services for monitoring. In any
combination, select values from the discovered list, enter values manually, or enter wildcard patterns.

JDBCDataSource
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The name of the JDBC data source. You can specify one or more JDBC data sources for monitoring. In
any combination, select values from the discovered list, enter values manually, or enter wildcard
patterns.

JDBCDataSourceTask
The name of the JDBC data source task. You can specify one or more JDBC data source tasks for
monitoring. In any combination, select values from the discovered list, enter values manually, or enter
wildcard patterns.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.

? Question mark, represents any one individual character asa
wildcard.

A Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.
Interval

Recommended minimum is5 minutes.

W ebLogic MSComponentRuntime

Thisclassisthe top-level interface for all runtime information collected for a Java M essaging Service (M S)
module.

The WebLogic M SComponentRuntime category includesthe counter listed in the following table. This
counter may not be available on your system. ServerVantage dynamically discovers WebLogic counter
categories, counter names, and parameters by processing the set of managed beans (MBeans) in the
WebLogic Java Management Extensions (M X) Server. Which counters are discovered isdetermined by the
WebLogic version you are running and how WebLogic is configured.

Counters
Counter Description Data Point Type
DeploymentSate | Returnsthe Integer
current

deployment state
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of the module.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domains for monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.

Application
The application name. You can specify one or more applications for monitoring. In any combination,
select values from the discovered list, enter values manually, or enter wildcard patterns.

JMSComponent
The name of the M Scomponent. You can specify one or more MScomponentsfor monitoring. In
any combination, select values from the discovered list, enter values manually, or enter wildcard
patterns.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.

? Question mark, represents any one individual character asa
wildcard.

n Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.
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The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.
Interval

Recommended minimum is5 minutes.

WebLogic MSConnectionRuntime
Use this class for monitoring a WebLogic Java Messaging Service (M S) connection.

The WebLogic_ MM SConnectionRuntime category includesthe counterslisted in the following table. Some
of these counters may not be available on your system. ServerVantage dynamically discovers WebLogic
counter categories, counter names, and parameters by processing the set of managed beans (MBeans) in the
WebLogic Java Management Extensions (M X) Server. Which counters are discovered isdetermined by the
WebLogic version you arerunning and how WebLogic is configured.

Counters

Counter Description Data Point Type

SessionsCurrentCount | Returnsthe Long
current number
of sessions for

thisconnection.

SessionsHighCount Returnsthe peak | Long
number of
sessionsfor this
connection since
the last reset.

SessionsTotalCount Returnsthetotal | Long
number of
sessionsfor this
connection since
the last reset.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. This allows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.
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JMS

The M Sname. You can specify one or more M Ssfor monitoring. In any combination, select values
from the discovered list, enter values manually, or enter wildcard patterns.

JMSConnection

The name of the M Sconnection. You can specify one or more M Sconnectionsfor monitoring. In any
combination, select values from the discovered list, enter values manually, or enter wildcard patterns.

StatType

This parameter appliesonly to countersreturning a count or total (SessionsTotalCount isone example
in thiscounter category). Possible values are:

ACTUAL The counter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw data value of the counter in the
last task interval and the raw data value of the counter in the current task interval.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.

? Question mark, represents any one individual character asa
wildcard.

A Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.
Interval

Recommended minimum is5 minutes.

WebLogic MSConsumerRuntime
Use this class for monitoring a WebLogic Java Messaging Service (M S) consumer.

The WebLogic M SConsumerRuntime category includesthe counterslisted in the following table. Some of
these counters may not be available on your system. ServerVantage dynamically discovers WebLogic
counter categories, counter names, and parameters by processing the set of managed beans (MBeans) in the
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WebLogic Java Management Extensions (M X) Server. Which counters are discovered isdetermined by the
WebLogic version you arerunning and how WebLogic is configured.

Counters
Counter ‘ Description ‘ DEF:] PointType‘

Active Indicateswhether | Boolean
the consumer is
active. A
consumer is
activeif it hasa
message listener
set up or a
synchronous
receivein
progress.

BytesPendingCount Returnsthe Long
number of bytes
pending
(uncommitted
and
unacknowledged)
by thisconsumer.

BytesReceivedCount Returnsthe Long
number of bytes
received by this
consumer since
the last reset.

Durable Indicates whether | Boolean
the consumer is
durable.

M essagesPendingCount | Returnsthe Long
number of
messages pending
(uncommitted
and
unacknowledged)
by thisconsumer.

M essagesReceivedCount | Returnsthe Long
number of

m essages received
by thisconsumer
since the last
reset.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
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dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domains for monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.

JMS

The Java Messaging Service (MM S) name. You can specify one or more M Ssfor monitoring. In any
combination, select values from the discovered list, enter values manually, or enter wildcard patterns.

JMSConnection

The name of the M Sconnection. You can specify one or more M Sconnectionsfor monitoring. In any
combination, select values from the discovered list, enter values manually, or enter wildcard patterns.

JMSSession

The name of the M Ssession. You can specify one or more MSsessions for monitoring. In any
combination, select values from the discovered list, enter values manually, or enter wildcard patterns.

JMSConsumer

The name of the M Sconsumer. You can specify one or more MSconsumers for monitoring. In any
combination, select values from the discovered list, enter values manually, or enter wildcard patterns.

StatType

This parameter appliesonly to countersreturning a count or total (MessagesReceivedCount isone
examplein thiscounter category). Possible values are:

ACTUAL The counter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw data value of the counter in the
last task interval and the raw data value of the counter in the current task interval.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.

? Question mark, represents any one individual character asa
wildcard.

A Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to
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represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
I Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.
Interval

Recommended minimum is5 minutes.

WebLogic MPestinationRuntime
Use this class for monitoring a WebLogic Java Messaging Service (M S) destination (topic or queue).

The WebLogic M SDestinationRuntime category includesthe counterslisted in the following table. Some
of these counters may not be available on your system. ServerVantage dynamically discovers WebLogic
counter categories, counter names, and parameters by processing the set of managed beans (MBeans) in the
WebLogic Java Management Extensions (M X) Server. Which counters are discovered isdetermined by the
WebLogic version you are running and how WebLogic is configured.

Counter Data Point
Description Type

BytesCurrentCount Returnsthe current number of bytes stored (not Long
pending bytes) in the destination.

Counters

BytesHighCount Returnsthe peak number of bytes stored in the Long
destination since the last reset.

BytesPendingCount Returnsthe number of pending bytes stored in the Long
destination. Pending bytes are over and above the
current number of bytes.

BytesReceivedCount Returnsthe number of bytesreceived in this Long
destination since the last reset.

BytesThresholdTime Returnsthe amount of timein the threshold Long
condition sincethe last reset.

ConsumersCurrentCount Returnsthe current number of consumers accessing Long
thisdestination.

ConsumersHighCount Returnsthe peak number of consumers accessing this | Long
destination sincethe last reset.

ConsumersTotalCount Returnsthetotal number of consumers accessing this | Long
destination since the last reset.
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ConsumptionPaused Indicatesthe consumption pause state of the Boolean
destination.

Insertion Paused Returnstheinsertion pause state of the destination. Boolean

M essagesCurrentCount Returnsthe current number of messages (not pending | Long

messages) in the destination.

M essagesHighCount Returnsthe peak number of messagesin the Long
destination since the last reset.

MessagesMovedCurrentCount | Returnsthe number of messages moved from the Long
destination.
M essagesPendingCount Returnsthe number of pending messagesin the Long

destination. Pending messages are over and above the
current number of messages. A pending message is
one sent in atransaction and not committed or one
forwarded but not acknowledged.

M essagesReceivedCount Returnsthe number of messages received in this Long
destination since the last reset.

MessagesThresholdTime The amount of time (in seconds) in the threshold Long
condition since the last reset.

Paused Indicateswhether the destination is paused at the Boolean
current time. Deprecated. 9.0.0.0. Replaced by
JM SDestinationRuntimeM Bean#isProductionPaused.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.

JMSServer
The name of the M Sserver. You can specify one or more M Sservers for monitoring. In any
combination, select values from the discovered list, enter values manually, or enter wildcard patterns.

JMSDestination
253



Using the Conductor

The name of the M Sdestination You can specify one or more MSdestinations for monitoring. In any
combination, select values from the discovered list, enter values manually, or enter wildcard patterns.

StatType

This parameter appliesonly to countersreturning a count or total (MessagesReceivedCount isone
examplein thiscounter category). Possible values are:

ACTUAL The counter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw data value of the counter in the
last task interval and the raw data value of the counter in the current task interval.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.

? Question mark, represents any one individual character asa
wildcard.

n Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.
Interval

Recommended minimum is5 minutes.

WebLogic MDurableSubscriberRuntime
Use this class for monitoring a WebLogic Java Messaging Service (M S) durable subscriber.

The WebLogic_ M SDurableSubscriberRuntime category includesthe counterslisted in the following table.
Some of these counters may not be available on your system. ServerVantage dynamically discovers
WebLogic counter categories, counter names, and parameters by processing the set of managed beans
(MBeans) in the WebLogic Java Management Extensions (M X) Server. Which counters are discovered is
determined by the WebLogic version you are running and how WebLogic is configured.

Counters

Counter Description Data Point Type
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Active

Indicates whether
this subscription
isbeing used by a
durable
subscriber.

Boolean

BytesCurrentCount

Returnsthe
number of bytes
received by this
durable
subscriber.

Long

BytesPendingCount

Returnsthe
number of bytes
pending by this
durable
subscriber.

Long

MessagesCurrentCount

Returnsthe
number of

m essages still
available by this
durable
subscriber.

Long

M essagesDeletedCurrentCount

Returnsthe
number of
messages deleted
from the
destination.

Long

M essagesHighCount

Returnsthe peak
number of
messages for this
durable
subscriber since
the last reset.

Long

M essagesM ovedCurrentCount

Returnsthe
number of
messages moved
from the
destination.

Long

M essagesPendingCount

Returnsthe
number of
messages pending
(uncommitted
and
unacknowledged)
by thisdurable
subscriber.

Long

M essagesReceivedCount

Returnsthe
number of
m essages received

Long

QALoad Online Help
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by thisdurable
subscriber since
the last reset.

NoLocal Indicatesthe Boolean
value of the
nolLocal Boolean
for thisdurable
subscriber.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. This allows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.
JMS
The M Sname. You can specify one or more M Ssfor monitoring. In any combination, select values
from the discovered list, enter values manually, or enter wildcard patterns.
JMSServers
The name of the M Sserver. You can specify one or more MSservers for monitoring. In any
combination, select values from the discovered list, enter values manually, or enter wildcard patterns.
JMSDestinations
The M Sdestination name. You can specify one or more MSdestinations for monitoring. In any
combination, select values from the discovered list, enter values manually, or enter wildcard patterns.
JMSDurableSubscribers

The name of the M Sdurable subscriber. You can specify one or more M Sdurable subscribers for
monitoring. In any combination, select values from the discovered list, enter values manually, or enter
wildcard patterns.

StatType

This parameter appliesonly to countersreturning a count or total (BytesCurrentCount isone example
in thiscounter category). Possible values are:

ACTUAL The counter returnsthe raw data value.
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INTERVAL The counter returnsthe difference between the raw data value of the counter in the
last task interval and the raw data value of the counter in the current task interval.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.

? Question mark, represents any one individual character as a
wildcard.

A Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.

Interval

Recommended minimum is5 minutes.

W ebLogic M SPooledConnectionRuntime

Use this class for monitoring pooled Java Messaging Service (M S) connections. A pooled M Sconnection is
a session pool used by Enterprise JavaBeans (EJBs) and servletsthat use a resource-reference element in
their EJB or Servlet deployment descriptor to define their M Sconnection factories.

The WebLogic_ M SPooledConnectionRuntime category includesthe counterslisted in the following table.
Some of these counters may not be available on your system. ServerVantage dynamically discovers
WebLogic counter categories, counter names, and parameters by processing the set of managed beans
(MBeans) in the WebLogic Java Management Extensions (M X) Server. Which counters are discovered is
determined by the WebLogic version you arerunning and how WebLogic is configured.

Counters

Counter Description Data Point Type

AverageReserved Returnsthe Integer
average number
of MSsessionsin
usein this
instance of the
session pool since
itsinstantiation,
which generally
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occurswhen an
EB or servlet is
deployed that
requiresthe
session pool.

CreationDelayTime

Returnsthe
average amount
of time needed to
create each M S
session in the
session pool.

Integer

CurrCapacity

Returnsthe
current capacity
of the session
pool, which is
always less than
or equal to the
maximum
capacity of MS
sessions.

Integer

HighestNumAuvailable

Returnsthe peak
number of
available M S
sessionsin this
instance of the
session pool since
itsinstantiation.

Integer

HighestNumReserved

Returnsthe peak
number of
concurrent MS
sessions reserved
for thisinstance
of the session
pool since its
instantiation.

Integer

HighestNumUnavailable

Returnsthe peak
number of
unusable MS
sessionsin this
instance of the
session pool since
itsinstantiation.

Integer

HighestNumWaiters

Returnsthe peak
number of
threads waiting
to retrievea M S
session in this
instance of the
session pool since
itsinstantiation.

Integer
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HighestWaitSeconds

Returnsthe peak
number of
secondsthat an
application
waited to retrieve
aJMSsession in
thisinstance of
the session pool
since its
instantiation.

Integer

MaxCapacity

Returnsthe
maximum
number of MS
sessionsthat may
be allocated
using the session
pool.

Integer

NumAvailable

Returnsthe
number of
available M S
sessionsin the
session pool not
currently in use.

Integer

NumConnectionObjects

Returnsthe
number of MS
connectionsthat
back this session
pool. Thisvalue
may be greater
than oneif
different sessions
were created
using different
combinations of
auser name and
password to
contact the M S
server.

Integer

Num FailuresToRefresh

Returnsthe
number of failed
attemptsto create
aJMSsession in
the session pool.

Integer

Num Leaked

Returnsthe
number of MS
sessionsremoved
from the session
pool but not
returned.

Integer
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259



Using the Conductor

NumReserved Returnsthe Integer
number of MS
sessions currently
in use.

NumUnavailable Returnsthe Integer
number of MS
sessionsin the

session pool not
currently usable
for an unknown
reason.

NumWaiters Returnsthe Integer
number of
threads waiting
to retrieveaMS
session from the
session pool.

TotalNumAllocated Returnsthetotal | Integer
number of MS
sessions allocated
by this session
pool in this
instance of the
session pool since
itsinstantiation.

TotalNumDestroyed Returnsthetotal | Integer
number of MS
sessions created
and then
destroyed in this
instance of the
session pool since
itsinstantiation.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server
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WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.

? Question mark, represents any one individual character as a
wildcard.

n Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.

Interval

Recommended minimum is5 minutes.

WebLogic MSProducerRuntime
Use this class for monitoring a WebLogic Java Messaging Service (M S) producer.

The WebLogic_ M SProducerRuntime category includesthe counterslisted in the following table. Some of
these counters may not be available on your system. ServerVantage dynamically discovers WebLogic
counter categories, counter names, and parameters by processing the set of managed beans (MBeans) in the
WebLogic Java Management Extensions (M X) Server. Which counters are discovered isdetermined by the
WebLogic version you arerunning and how WebLogic is configured.

Counters

Counter Description Data Point Type

BytesPendingCount Returnsthe Long
number of bytes
pending
(uncommitted
and
unacknowledged)
by this producer.

BytesSentCount Returnsthe Long
number of bytes
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sent by this
producer since
the last reset.

MessagesPendingCount | Returnsthe Long
number of
messages pending
(uncommitted
and
unacknowledged)
by this producer.

M essagesSentCount Returnsthe Long
number of
messages sent by
this producer
sincethelast
reset.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.

JMS

The M Sname. You can specify one or more M Ssfor monitoring. In any combination, select values
from the discovered list, enter values manually, or enter wildcard patterns.

JMSServers

The name of the M Sserver. You can specify one or more MSserver for monitoring. In any
combination, select values from the discovered list, enter values manually, or enter wildcard patterns.

JMSSessionPool

The name of the M Ssession pool. You can specify one or more M Ssession poolsfor monitoring. In
any combination, select values from the discovered list, enter values manually, or enter wildcard
patterns.

StatType
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This parameter appliesonly to countersreturning a count or total (MessagesSentCount isone example
in thiscounter category). Possible values are;

ACTUAL The counter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw data value of the counter in the
last task interval and the raw data value of the counter in the current task interval.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.

? Question mark, represents any one individual character asa
wildcard.

n Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.
Interval

Recommended minimum is5 minutes.

W ebLogic MSRemoteEndpointRuntime

Use this class for monitoring a WeblLogic Sore-and-Forward (SAF) remote endpoint for a Java M essaging
Service (M S) imported destination.

The WebLogic_ M SRemoteEndpointRuntime category includesthe counterslisted in the following table.
Some of these counters may not be available on your system. ServerVantage dynamically discovers
WebLogic counter categories, counter names, and parameters by processing the set of managed beans
(MBeans) in the WebLogic Java Management Extensions (M X) Server. Which counters are discovered is
determined by the WebLogic version you are running and how WebLogic is configured.

Counters
Counter Description Data Point Type
BytesCurrentCount Returnsthe Long
current number
of bytes,
excluding
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pending bytes.

BytesHighCount

Returnsthe peak
number of bytes
since the last
reset.

Long

BytesPendingCount

Returnsthe
number of
pending bytes.
Pending bytes are
over and above
the current
number of bytes.

Long

BytesReceivedCount

Returnsthe
number of bytes
received sincethe
last reset.

Long

BytesThresholdTime

Returnsthe
amount of time
(in seconds) in
the threshold
condition since
the last reset.

Long

DowntimeHigh

Returnsthe
longest time (in
seconds) that the
remote endpoint
has not been
available since
the last reset.

Long

DowntimeTotal

Returnsthe total
time (in seconds)
that the remote
endpoint has not
been available
sincethe last
reset.

Long

FailedM essagesTotal

Returnsthe total
number of
messages that
have failed to be
forwarded since
the last reset.

Long

MessagesCurrentCount

Returnsthe
current number
of messages,
including
pending

Long
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messages.

M essagesHighCount

Returnsthe peak
number of
messages since
the last reset.

Long

M essagesPendingCount

Returnsthe
number of
pending

m essages.
Pending messages
are over and
abovethe current
number of
messages. A
pending message
isonesentin a
transaction and
not committed or
one forwarded
but not
acknowledged.

Long

M essagesReceivedCount

Returnsthe
number of

m essages received
sincethe last
reset.

Long

MessagesThresholdTime

Returnsthe
amount of time
(in seconds) in
thethreshold
condition since
the last reset.

Long

PausedForForwarding

Indicates whether
theremote
endpoint isnot
forwarding
messages at the
current time.

Boolean

PausedForlncoming

Indicateswhether
aremote
endpoint isnot
accepting new
messages at the
current time.

Boolean

UptimeHigh

Returnsthe
longest time (in
seconds) that the
remote endpoint
has been

Long
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available since
the last reset.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domains for monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.
SAF
The SAFname. You can specify one or more SAFs for monitoring. In any combination, select values
from the discovered list, enter values manually, or enter wildcard patterns.
SAFAgent
The name of the SAF agent. You can specify one or more SAF agents for monitoring. In any
combination, select values from the discovered list, enter values manually, or enter wildcard patterns.
JMSRemoteEndpoint

The name of the M Sremote endpoint. You can specify one or more M Sremote endpointsfor
monitoring. In any combination, select values from the discovered list, enter values manually, or enter
wildcard patterns.

StatType

This parameter appliesonly to countersreturning a count or total (FailedM essageTotal isone example
in thiscounter category). Possible values are:

ACTUAL Thecounter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw data value of the counter in the
last task interval and the raw data value of the counter in the current task interval.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.
? Question mark, represents any one individual character as a
wildcard.
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A Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to
represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.

Interval

Recommended minimum is5 minutes.

WebLogic MSRuntime
Use this class for monitoring a WebLogic Java Messaging Service (M S) service.

The WebLogic M SRuntime category includesthe counterslisted in the following table. Some of these
counters may not be available on your system. ServerVantage dynamically discovers WebLogic counter
categories, counter names, and parameters by processing the set of managed beans (MBeans) in the
WebLogic Java Management Extensions (M X) Server. Which counters are discovered isdetermined by the
WebLogic version you arerunning and how WeblLogic is configured.

Counters

Counter Description Data Point Type

ConnectionsCurrentCount | Returnsthe Long
current number
of connectionsto
thisWebLogic
Server.

ConnectionsHighCount Returnsthe peak | Long
number of
connectionsto
thisWebLogic
Server sincethe
last reset.

ConnectionsTotalCount Returnsthetotal | Long
number of
connections
made to this
WebLogic Server
since the last
reset.
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IM SServersCurrentCount Returnsthe Long
current number
of MSservers
deployed on this
WebLogic Server
instance.

JM SServersHighCount Returnsthe peak | Long
number of MS
servers deployed
on thisWebLogic
Server instance
since this server
was started.

JM SServersTotalCount Returnsthetotal | Long
number of MS
servers deployed
on thisWebLogic
Server instance
since this server
was started.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. This allows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.

JMS

The M Sname. You can specify one or more M Ssfor monitoring. In any combination, select values
from the discovered list, enter values manually, or enter wildcard patterns.

StatType

This parameter appliesonly to countersreturning a count or total (M SServersCurrentCount isone
examplein thiscounter category). Possible values are:

ACTUAL Thecounter returnsthe raw data value.
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INTERVAL The counter returnsthe difference between the raw data value of the counter in the
last task interval and the raw data value of the counter in the current task interval.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.

? Question mark, represents any one individual character as a
wildcard.

A Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.
Interval

Recommended minimum is5 minutes.

WebLogic MSServerRuntime
Use this class for monitoring a WebLogic Java Messaging Service (M S) server.

The WebLogic_ M SServerRuntime category includesthe counterslisted in the following table. Some of
these counters may not be available on your system. ServerVantage dynamically discovers WebLogic
counter categories, counter names, and parameters by processing the set of managed beans (MBeans) in the
WebLogic Java Management Extensions (M X) Server. Which counters are discovered isdetermined by the
WebLogic version you arerunning and how WebLogic is configured.

Counters
Counter Description ’ Data Point Type

BytesCurrentCount Returnsthe current Long
number of bytes (excluding
pending bytes) stored on
this M Sserver.

BytesHighCount Returnsthe peak number Long
of bytes stored on thisJM'S
server since the last reset.
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BytesPageableCurrentCount

Returnsthetotal number
of bytesin all the messages
that are currently available
to be paged out but which
have not yet been paged
out. The M Sserver
attemptsto keep this
number smaller than the
"M essageBufferSze"
parameter.

Long

BytesPagedInTotalCount

Return thetotal number of
bytesread from the paging
directory sincethe MS
server was started.

Long

BytesPagedOutTotalCount

Returnsthe total number
of byteswritten to the
paging directory since the
JM S server was started.

Long

BytesPendingCount

Returnsthe current
number of bytes pending
(unacknowledged or
uncommitted) stored on
thisMSserver. Pending
bytes are over and above
the current number of
bytes.

Long

BytesReceivedCount

Returnsthe number of
bytesreceived on thisIMS
server since the last reset.

Long

BytesThresholdTime

Returnsthe amount of
time (in seconds) in the
threshold condition since
the last reset.

Long

ConsumptionPaused

Returnsthe current
consumption paused state
of the M Sserver.

Boolean

DestinationsCurrentCount

Returnsthe current
number of destinations for
this M Sserver.

Long

DestinationsHighCount

Returnsthe peak number
of destinationson thisIMS
server since the last reset.

Long

DestinationsTotalCount

Returnsthe total number
of destinationsinstantiated
on thisMSserver sincethe
last reset.

Long
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Insertion Paused

Returnsthe current
insertion paused state of
the M Sserver as a Boolean
value.

Boolean

MessagesCurrentCount

Returnsthe current
number of messages stored
on thisMSserver. This
number doesnot include
pending messages.

Long

M essagesHighCount

Returnsthe peak number
of messages stored on this
JM Sserver sincethe last
reset.

Long

M essagesPageableCurrentCount

Returnsthe number of
messages currently
available for paging in this
JM Sserver but not yet
paged out. Because of
internal implementation
details, thiscount may be
zero even if
"PageableByteCurrentCoun
t" is zero.

Integer

M essagesPagedIn TotalCount

Returnsthetotal number
of messagesread from the
paging directory since the
JM S server was started.

Integer

M essagesPagedOutTotalCount

Returnsthetotal number
of messages written to the
paging directory since the
JM Sserver was started.

Integer

M essagesPendingCount

Returnsthe current
number of messages
pending (unacknowledged
or uncommitted) stored on
thisMSserver. Pending
messages are over and
above the current number
of messages.

Long

M essagesReceivedCount

Returnsthe number of
messages received on this
destination since the last
reset.

Long

MessagesThresholdTime

Returnsthe amount of
time (in seconds) in the
threshold condition since
the last reset.

Long
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ProductionPaused Returnsthe current Boolean
production paused state of
the M Sserver as a Boolean
value.

SessionPoolsCurrentCount Returnsthe current Long
number of session pools
instantiated on thisdMS
server.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.

JMSServer

The name of the M Sserver. You can specify one or more MSservers for monitoring. In any
combination, select values from the discovered list, enter values manually, or enter wildcard patterns.

StatType

This parameter appliesonly to countersreturning a count or total (BytesCurrentCount isone example
in thiscounter category). Possible values are:

ACTUAL Thecounter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw data value of the counter in the
last task interval and the raw data value of the counter in the current task interval.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.

? Question mark, represents any one individual character as a
wildcard.

A Caret, excludes all valuesthat match the specified pattern.

272



QALoad Online Help

\ Backslash, precede a wildcard character with a backslash to
represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
I Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.

Interval

Recommended minimum is5 minutes.

W ebLogic M SSessionPool Runtime
Use this class for monitoring a WebLogic Java Messaging Service (M) session pool.

The WebLogic M SSessionPoolRuntime category includesthe counterslisted in the following table. Some
of these counters may not be available on your system. ServerVantage dynamically discovers WebLogic
counter categories, counter names, and parameters by processing the set of managed beans (MBeans) in the
WebLogic Java Management Extensions (M X) Server. Which counters are discovered isdetermined by the
WebLogic version you arerunning and how WeblLogic is configured.

Counters

Counter Description Data Point Type

ConnectionConsumersCurrentCount | Returnsthe Long
current number
of connection
consumersfor
this session pool.

ConnectionConsumersHighCount Returnsthe peak | Long
number of
simultaneous
connection
consumers for
this session pool.

ConnectionConsumersTotalCount Returnsthetotal | Long
number of
connection
consumers made
by this session
pool sincethe
last reset.

Parameters

273



Using the Conductor

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. This allows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.
JMS
The M Sname. You can specify one or more M Ssfor monitoring. In any combination, select values
from the discovered list, enter values manually, or enter wildcard patterns.
JMSServers
The name of the M Sserver. You can specify one or more MSservers for monitoring. In any
combination, select values from the discovered list, enter values manually, or enter wildcard patterns.
JMSSessionPool

The name of the M Ssession pool. You can specify one or more M Ssession poolsfor monitoring. In
any combination, select values from the discovered list, enter values manually, or enter wildcard
patterns.

StatType

This parameter appliesonly to countersreturning a count or total (ConnectionConsumersHighCount
isone examplein thiscounter category). Possible values are:

ACTUAL Thecounter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw data value of the counter in the
last task interval and the raw data value of the counter in the current task interval.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.

? Question mark, represents any one individual character asa
wildcard.

n Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.
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For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.

Interval

Recommended minimum is5 minutes.

WebLogic MSSessionRuntime
Use this class for monitoring a WeblLogic Java Messaging Service (MM S) session.

The WebLogic M SSessionRuntime category includesthe counterslisted in the following table. Some of
these counters may not be available on your system. ServerVantage dynamically discovers WebLogic
counter categories, counter names, and parameters by processing the set of managed beans (MBeans) in the
WebLogic Java Management Extensions (M X) Server. Which counters are discovered isdetermined by the
WebLogic version you arerunning and how WeblLogic is configured.

Counters

Counter Description Data Point Type

BytesPendingCount Returnsthe Long
number of bytes
pending
(uncommitted
and
unacknowledged)
for this session.

BytesReceivedCount Returnsthe Long
number of bytes
received by this
session since the
last reset.

BytesSentCount Returnsthe Long
number of bytes
sent by this
session sincethe
last reset.

ConsumersCurrentCount | Returnsthe Long
current number
of consumers for
this session.

ConsumersHighCount Returnsthe peak | Long
number of
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consumers for
this session since
the last reset.

ConsumersTotalCount Returnsthe Long
number of
consumers
instantiated by
this session since
the last reset.

M essagesPendingCount Returnsthe Long
number of
messages pending
(uncommitted
and
unacknowledged)
for this session.

M essagesReceivedCount | Returnsthe Long
number of

m essages received
by this session
since the last
reset.

M essagesSentCount Returnsthe Long
number of bytes
sent by this
session since the
last reset.

ProducersCurrentCount | Returnsthe Long
current number
of producers for
this session.

ProducersHighCount Returnsthe peak | Long
number of
producersfor this
session since the
last reset.

ProducersTotalCount Returnsthe Long
number of
producersfor this
session since the
last reset.

Transacted Returnswhether Boolean
the session is
transacted.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
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between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain
Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domains for monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.

JMS

The M Sname. You can specify one or more M Ssfor monitoring. In any combination, select values
from the discovered list, enter values manually, or enter wildcard patterns.

JMSConnection

The name of the M Sconnection. You can specify one or more M Sconnectionsfor monitoring. In any
combination, select values from the discovered list, enter values manually, or enter wildcard patterns.

JMSSession

The name of the M Ssession. You can specify one or more MSsessions for monitoring. In any
combination, select values from the discovered list, enter values manually, or enter wildcard patterns.

StatType

This parameter appliesonly to countersreturning a count or total (BytesSentCount isone examplein
thiscounter category). Possible values are:

ACTUAL Thecounter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw data value of the counter in the
last task interval and the raw data value of the counter in the current task interval.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.

? Question mark, represents any one individual character as a
wildcard.

n Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.
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Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.
Interval

Recommended minimum is5 minutes.

WebLogic JltConnectionPoolRuntime
Use this class for monitoring a WebLogic Jolt connection pool.

The WebLogic_JltConnectionPoolRuntime category includesthe counterslisted in the following table.
Some of these counters may not be available on your system. ServerVantage dynamically discovers
WebLogic counter categories, counter names, and parameters by processing the set of managed beans
(MBeans) in the WebLogic Java Management Extensions (M X) Server. Which counters are discovered is
determined by the WebLogic version you are running and how WebLogic is configured.

Counters

Counter Description Data Point Type

MaxCapacity Returnsthe Integer
maximum
number of
connections
configured for
this Jolt pool.

SecurityContextPropagation | Indicateswhether | Boolean
the security
context is
propagated.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server
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WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.
Jolt
Thejolt name. You can specify one or more joltsfor monitoring. In any combination, select values
from the discovered list, enter values manually, or enter wildcard patterns.
JoltConnectionService
The name of the Jolt connection service. You can specify one or more joltsfor monitoring. In any
combination, select values from the discovered list, enter values manually, or enter wildcard patterns.
JoltConnectionPool
The name of the Jolt connection pool. You can specify one or more joltsfor monitoring. In any
combination, select values from the discovered list, enter values manually, or enter wildcard patterns.
Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.

? Question mark, represents any one individual character asa
wildcard.

n Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.
Interval

Recommended minimum is5 minutes.

WebLogic JltConnectionServiceRuntime
Use this class for monitoring a WebLogic Jolt component.

The WebLogic_JltConnectionServiceRuntime category includesthe counter listed in the following table.
Thiscounter may not be available on your system. ServerVantage dynamically discovers WebLogic counter
categories, counter names, and parameters by processing the set of managed beans (MBeans) in the
WebLogic Java Management Extensions (M X) Server. Which counters are discovered is determined by the
WebLogic version you arerunning and how WebLogic is configured.
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Counters
Counter Description Data Point Type
ConnectionPoolCount | Returnsthe Integer

number of
configured Jolt
connection
pools.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain
Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.

Jolt

The Jolt name. You can specify one or more Joltsfor monitoring. In any combination, select values
from the discovered list, enter values manually, or enter wildcard patterns.

JoltConnectionService

The name of the Jolt connection service. You can specify one or more Jolt connection services for
monitoring. In any combination, select values from the discovered list, enter values manually, or enter
wildcard patterns.

StatType

This parameter appliesonly to countersreturning a count or total (ConnectionPoolCount isone
examplein thiscounter category). Possible values are:

ACTUAL The counter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw data value of the counter in the
last task interval and the raw data value of the counter in the current task interval.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as awildcard.
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? Question mark, represents any one individual character asa
wildcard.

A Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.

Interval

Recommended minimum is5 minutes.

WebLogic JRockitRuntime

Use thisclassto expose runtime data about the JRockit virtual machine (VM) that isrunning the current
WebLogic server instance. You cannot change the VM's operating parameters whilethe VM is active.
Instead, use the start-up options described in the JRockit documentation.

The WebLogic_JRockitRuntime category includesthe counterslisted in the following table. Some of these
counters may not be available on your system. ServerVantage dynamically discovers WebLogic counter
categories, counter names, and parameters by processing the set of managed beans (MBeans) in the
WebLogic Java Management Extensions (M X) Server. Which counters are discovered is determined by the
WebLogic version you arerunning and how WebLogic is configured.

Counters

Counter Description Data Point Type

AllProcessorsAveragel.oad Returnsasnapshot of Double
the average load of all
processorsin the host
computer. If the
computer hasonly one
processor, this method
returnsthe same value
as
getvmProcessorLoad(0
). The valueisreturned
asadouble, where 1.0
represents 100% load
(noidletime), and 0.0
represents 0% load
(pureidle time).
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Concurrent

Indicateswhether the
VM's garbage collector
(GC) runsin aseparate
Javathread
concurrently with
other Java threads.

Boolean

FreeHeap

Returnsthe amount

(in bytes) of Java heap
memory currently free
in the virtual machine.

Long

FreePhysicalMemory

Returnsthe amount
(in bytes) of physical
memory currently free
on the host computer.

Long

GcAlgorithm

Indicatesthe type of
GC that the virtual
machine isusing.

JRockit providesthe
following types of
GCs:

I Generational
Copying:
Suitable for
testing
applicationson
a desktop
machine with a
small (lessthan
128 MB) heap.

I Sngle Saced
Concurrent:
Reduces or
eliminates
pausesin the
VM that are due
to garbage
collection.
Because it trades
memory
throughput for
reduced pause
time, you
generally need a
larger heap size
than with other
GC types. If your
ordinary Java
threads create
more garbage
than this GC can
collect, the VM

Boolean
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will pause while
the Java threads
wait for the
garbage
collection to
finish.
Generational
Concurrent:
Creates a
"nursery" space
within the heap.
New objects are
created within
the nursery.
When the
nursery isfull,
JRockit "stops
theworld,"
removesthe
dead objects
from the
nursery, and
moveslive
objectsto a
different space
within the heap.
Another thread
runsin the
background to
remove dead
objects from the
non-nursery
space. ThisGC
type hasa
higher memory
throughput than
asingle spaced
concurrent GC.

Parallel:
Allocates all
objectsto a
single spaced
heap. When the
heap isfull, all
Javathreads are
stopped and
every CPU is
used to perform
acomplete
garbage
collection of the
entire heap. This
behavior causes
longer pause
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timesthan for
the concurrent
collectors but
maximizes
memory
throughput.

GCHandlesCompaction

Indicateswhether the
VM's garbage collector
compactsthe Java
heap. Usually the heap
is scattered throughout
available memory. A
garbage collector that
compactsthe heap
defragmentsthe
memory spacein
addition to deleting
unused objects.

Boolean

Generational

Indicateswhether the
VM's garbage collector
uses a nursery space. A
nursery isthe area of
the Java heap that the
VM allocatesto most
objects. Instead of
garbage collecting the
entire heap,
generational garbage
collectorsfocuson the
nursery. Because most
objectsdie young,
most of thetimeitis
sufficient to garbage
collect only the
nursery and not the
entire heap.

Boolean

HeapFreeCurrent

Returnsthe current
amount of memory (in
bytes) that isavailable
in the WYM heap.

Long

HeapFreePercent

Returnsthe percentage
of the maximum
memory that isfree.

Integer

HeapSzeCurrent

Returnsthe current
size (in bytes) of the
VM heap.

Long

HeapSzeM ax

Returnsthe maximum
free memory (in bytes)
configured for this
NM.

Long
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Incremental

Indicateswhether the
VM's garbage collector
collects (increments)
garbage as it scansthe
memory space and
dumpsthe garbage at
theend of itscycle.
With a
nonincremental
garbage collector,
garbage isdumped as
soon asit is
encountered.

Boolean

JvmProcessorLoad

Returnsasnapshot of
theload that the
virtual machineis
placing on all
processorsin the host
computer. If the host
contains multiple
processors, the value
represents a snapshot
of the average load.

Thevalueisreturned
asadouble, where 1.0
represents 100% load
(no idletime), and 0.0
represents 0% load
(pureidle time).

Double

LastGCEnd

Returnsthetime at
which the last garbage
collection run ended.

Long

LastGCSart

Returnsthetime at
which the last garbage
collection run started.

Long

NumberOfDaemonThreads

Returnsthe number of
daemon Javathreads
currently runningin
the virtual machine
across all processors.

Integer

NumberOfProcessors

Returnsthe number of
processorson the
virtual machine's host
computer. If thisisnot
a Symmetric Multi
Processor (SMP)
system, the valueis 1.

Integer

Parallel

Indicateswhether the
VM's garbage collector

Boolean
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isableto run in
parallel on multiple
processorsif multiple
processors are
available.

TotalGarbageCollectionCount

Returnsthe number of
garbage collection runs
having occurred since
thevirtual machine
was started.

Long

TotalGarbageCollectionTime

Returnsamount of
time (in milliseconds)
that the virtual
machine has spent on
all garbage collection
runssince the VM was
started.

Long

TotalHeap

Returnsthe total
amount (in bytes) of
memory currently
allocated to the virtual
machine's Java heap.
Thisvalue, which is
also known asthe
"heap size," may grow
up to the specified
maximum heap size.

Long

TotalNumberOfThreads

Returnsthetotal
number of Javathreads
(daemon and non-
daemon) currently
running in thevirtual
machine across all
Processors.

Integer

TotalNurserySze

Returnsthetotal
amount (in bytes) of
memory currently
allocated to the
nursery, which isthe
area of the Java heap
that the VM allocates
to most objects.
Instead of garbage
collecting the entire
heap, generational
garbage collectors
focuson the nursery.
Because most objects
dieyoung, most of the
timeit issufficient to
garbage collect only

Long
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the nursery and not
the entire heap. If you
arenot using a
generational garbage
collector, the nursery
sizeisO.

TotalPhysicalMemory

Returnsthetotal
amount (in bytes) of
physical memory on
the host computer.
The value does not
include memory that
an operating system
makes available
through swap space on
adisk or other types of
virtual memory.

Long

Uptime

Returnsthe amount of
time (in milliseconds)
that the virtual
machine has been
running.

Long

UsedHeap

Returnsthe amount
(in bytes) of Java heap
memory that is
currently being used
by the virtual
machine.

Long

UsedPhysicalMemory

Returnsthe amount
(in bytes) of physical
memory that is
currently being used
on the host computer.
Thevalue describesthe
memory being used by
all processeson the
computer, not just by
the Virtual Machine.

Long

Parameters
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The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console

Management function.

The following parameters are valid for this counter category.

Domain
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Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.

JRockit

The name of the JRockit virtual machine. You can specify one or more JRockit virtual machines for
monitoring. In any combination, select values from the discovered list, enter values manually, or enter
wildcard patterns.

StatType

This parameter appliesonly to countersreturning a count or total (TotalGarbageCollectionCount is
one examplein thiscounter category). Possible values are:

ACTUAL The counter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw data value of the counter in the
last task interval and the raw data value of the counter in the current task interval.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.

? Question mark, represents any one individual character asa
wildcard.

A Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.

Interval

Recommended minimum is5 minutes.
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W ebLogic JTARecoveryRuntime

Use thisinterface for accessing transaction runtime characteristics for recovered transactionsthat are
associated with a particular transaction recovery service.

The WebLogic_JTARecoveryRuntime (Java Transaction API) category includesthe counterslisted in the
following table. Some of these counters may not be available on your system. ServerVantage dynamically
discovers WebLogic counter categories, counter names, and parameters by processing the set of managed
beans (MBeans) in the WebLogic Java Management Extensions (M X) Server. Which counters are
discovered isdetermined by the WebLogic version you are running and how WebLogic is configured.

Counters

Counter Description Data Point Type

Active Indicateswhether | Boolean
the transaction
recovery service
iscurrently
activated on this
server.

InitialRecoveredTransaction TotalCount Returnsthetotal | Integer
number of
transactions
recovered from
the transaction
log initially.

RecoveredTransactionCompletionPercent | Returnsthe Integer
percentage of
transactions
recovered from
the transaction
log initially.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.

JTA
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The JTA name. You can specify one or more JTAs for monitoring. In any combination, select values
from the discovered list, enter values manually, or enter wildcard patterns.

JTARecovery

The name of the JTA recovery. You can specify one or more JTA recoveries for monitoring. In any
combination, select values from the discovered list, enter values manually, or enter wildcard patterns.

StatType

This parameter appliesonly to the countersthat are returning a count or total
(InitialRecoveredTransactionTotalCount isone example in thiscounter category). Possible values are;

ACTUAL The counter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.

? Question mark, represents any one individual character asa
wildcard.

n Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.
Interval

Recommended minimum is5 minutes.

WebLogic JTARuntime

Use thisWebLogic Java Transaction (JTA) API runtime interface for accessing transaction runtime
characteristicswithin a WebLogic server.

The WebLogic JTARuntime category includesthe counterslisted in the following table. Some of these
counters may not be available on your system. ServerVantage dynamically discovers WebLogic counter
categories, counter names, and parameters by processing the set of managed beans (MBeans) in the
WebLogic Java Management Extensions (M X) Server. Which counters are discovered is determined by the
WebLogic version you arerunning and how WebLogic is configured.
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Counter

ActiveTransactionsTotalCount

Returnsthe
number of active
transactionson
the server.

Description Data Point Type

Integer

SecondsActiveTotalCount

Returnsthe total
number of
secondsthat
transactions were
active for all
committed
transactions.

Long

TransactionAbandonedTotalCount

Returnsthe total
number of
transactions
abandoned since
the server was
started.

Long

TransactionCommittedTotalCount

Returnsthe total
number of
transactions
committed since
the server was
started.

Long

TransactionHeuristicsTotalCount

Returnsthe
number of
transactions
completed with a
heuristic status
sincethe server
was started.

Long

TransactionRolledBackAppTotalCount

Returnsthe
number of
transactionsthat
were rolled back
dueto an
application error.

Long

TransactionRolledBackResourceTotalCount

Returnsthe total
number of rolled
back transactions
because of a
resource error.

Long

TransactionRolledBackSystem TotalCount

Returnsthe total
number of rolled
back transactions
because of an
internal system

Long
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error.

TransactionRolledBackTimeoutTotalCount | Returnsthetotal | Long
number of rolled

back transactions
because of atime-
out expiration.

TransactionRolledBackTotalCount Returnsthetotal | Long
number of rolled
back transactions
since the server
was started.

TransactionTotalCount Returnsthetotal | Long
number of
processed
transactions. This
total includes all
committed,
rolled back, and
heuristic
transaction
completions
sincethe server
was started.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. This allows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain
Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domains for monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.

JTA

The JTA name. You can specify one or more JTAs for monitoring. In any combination, select values
from the discovered list, enter values manually, or enter wildcard patterns.

StatType
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This parameter appliesonly to countersreturning a count or total (TransactionTotalCount isone
examplein thiscounter category). Possible values are:
ACTUAL Thecounter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw data value of the counter in the
last task interval and the raw data value of the counter in the current task interval.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.

? Question mark, represents any one individual character asa
wildcard.

n Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.

Interval

Recommended minimum is5 minutes.

WebLogic VMRuntime

Thisinterface provides methods for retrieving information about the Java Virtual Machine (VM) within
which the current server instance isrunning. You cannot change the WVM's operating parameterswhile the
VM isactive. Instead, use the startup optionsdescribed in the WVM'sdocumentation. You may use these
methodsfor any type of VM that WeblLogic Server supports.

The WebLogic WMRuntime category includesthe counterslisted in the following table. Some of these
counters may not be available on your system. ServerVantage dynamically discovers WebLogic counter
categories, counter names, and parameters by processing the set of managed beans (MBeans) in the
WebLogic Java Management Extensions (M X) Server. Which counters are discovered isdetermined by the
WebLogic version you arerunning and how WeblLogic is configured.

Counters

Counter Description Data Point Type

HeapFreeCurrent | Returnsthe Long
current amount
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of memory (in
bytes) available
in the WM heap.

HeapFreePercent | Returnsthe Integer
percentage of the
maximum
memory that is
free.

HeapSzeCurrent | Returnsthe Long
current size (in
bytes) of the WM

heap.

HeapSzeM ax Returnsthe Long
maximum free
memory
configured for
this VM.

Uptime Returnsthe Long
number of
milliseconds that
the virtual
machine has
been running.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. This allows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.

JVM

The WM name. You can specify one or more WVMs for monitoring. In any combination, select values
from the discovered list, enter values manually, or enter wildcard patterns.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:
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* Asterisk, represents zero or more characters as a wildcard.

? Question mark, represents any one individual character as a
wildcard.

A Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.
Interval

Recommended minimum is5 minutes.

WebLogic LibraryRuntime

If you use the getMBeanInfo operation in MBean TypeServiceM Bean, supply the following value asthis
MBean's fully qualified interface name: webl ogi c. managenent . runti ne. Li brar yRunt i neMBean

The WebLogic_LibraryRuntime category includesthe counter listed in the following table. This counter
may not be available on your system. ServerVantage dynamically discovers WebLogic counter categories,
counter names, and parameters by processing the set of managed beans (MBeans) in the WebLogic Java
Management Extensions (M X) Server. Which counters are discovered isdetermined by the WebLogic
version you arerunning and how WebLogic is configured.

Counters

Counter Description Data Point Type

Referen ced Returnstrue if Boolean
thislibrary is
referenced by one
or more
referencers.
Typically a
library referencer
isadeployed
application.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
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dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domains for monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.

Library

The library name. You can specify one or more libraries for monitoring. In any combination, select
values from the discovered list, enter values manually, or enter wildcard patterns.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.

? Question mark, represents any one individual character as a
wildcard.

n Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.
Interval

Recommended minimum is5 minutes.

WebLogic LogBroadcasterRuntime

Thismanaged bean (MBean) broadcasts Java Management Extensions (M X) notifications for each log
message generated in the local WLSserver. Thereis exactly one implementation of this MBean in each
WLSserver. MX listeners can register to this MBean and receive log notifications. The type of the
notification generated isWebLogi cLogNot i fi cati on.

296



QALoad Online Help

The WebLogic_LogBroadcasterRuntime category includesthe counter listed in the following table. This
counter may not be available on your system. ServerVantage dynamically discovers WebLogic counter
categories, counter names, and parameters by processing the set of MBeansin the WebLogic Java
Management Extensions (M X) Server. Which counters are discovered isdetermined by the WebLogic
version you arerunning and how WebLogic is configured.

Counters

Counter Description Data Point Type

M essagesLogged Returnsthetotal | Long
number of log
messages that

thisWebLogic
Server instance
has generated.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.

LogBroadcaster

The name of the log broadcaster. You can specify one or more log broadcasters for monitoring. In any
combination, select values from the discovered list, enter values manually, or enter wildcard patterns.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.

? Question mark, represents any one individual character as a
wildcard.

A Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.
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Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.

Interval

Recommended minimum is5 minutes.

WebLogic MaxThreadsConstraintRuntime
Thisinterface providesruntime information for maximum threads constraint.

The WebLogic MaxThreadsConstraintRuntime category includesthe counterslisted in the following table.
Some of these counters may not be available on your system. ServerVantage dynamically discovers
WebLogic counter categories, counter names, and parameters by processing the set of managed beans
(MBeans) in the WebLogic Java Management Extensions (M X) Server. Which counters are discovered is
determined by the WebLogic version you are running and how WebLogic is configured.

Counters

Counter Description Data Point Type

DeferredRequests | Returnsthe Integer
number of
requeststhat are
denied athread
for execution
because the
constraint is
exceeded.

ExecutingRequests| Returnsthe Integer
number of
requeststhat are
currently
executing.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.
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Server
WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.

MaxThreadsConstraint

The name of the maximum threads constraint. You can specify one or more maximum threads
constraints for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.

? Question mark, represents any one individual character as a
wildcard.

A Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.
Interval

Recommended minimum is5 minutes.

WebLogic MessageDrivenEBRuntime

Thisinterface contains accessor methods for all Enterprise JavaBean (EJB) runtime information collected
for a message-driven bean.

The WebLogic_MessageDrivenEJBRuntime category includesthe counterslisted in the following table.
Some of these counters may not be available on your system. ServerVantage dynamically discovers
WebLogic counter categories, counter names, and parameters by processing the set of managed beans
(MBeans) in the WebLogic Java Management Extensions (M X) Server. Which counters are discovered is
determined by the WebLogic version you are running and how WebLogic is configured.

Counters

Counter Description Data Point Type

M SConnectionAlive Returnswhether Boolean
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the message-
driven bean is
currently
connected to the
JMSdestination
to which it is
mapped.

ProcessedM essageCount | Returnsthetotal | Long
number of

m essages
processed by this
message-driven
bean.

SuspendCount Returnsthetotal | Integer
number of times
this message-
driven bean is
suspended by the
user or the EBB
container.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. This allows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.

Application
The application name. You can specify one or more servers for monitoring. In any combination, select
values from the discovered list, enter values manually, or enter wildcard patterns.

EJBComponent
The name of the EIB component. You can specify one or more EBB componentsfor monitoring. In any

combination, select values from the discovered list, enter values manually, or enter wildcard patterns.

MessageDrivenEJB
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The name of the message-driven EJB. You can specify one or more message-driven EJBs for monitoring.
In any combination, select values from the discovered list, enter values manually, or enter wildcard
patterns.

StatType

This parameter appliesonly to countersreturning a count or total (SuspendCount isone examplein
this counter category). Possible values are:

ACTUAL The counter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw data value of the counter in the
last task interval and the raw data value of the counter in the current task interval.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.

? Question mark, represents any one individual character asa
wildcard.

A Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.
Interval

Recommended minimum is5 minutes.

WebLogic MinThreadsConstraintRuntime
Thisinterface provides monitoring information for minimum threads constraint.

The WebLogic MinThreadsConstraintRuntime category includesthe counterslisted in the following table.
Some of these counters may not be available on your system. ServerVantage dynamically discovers
WebLogic counter categories, counter names, and parameters by processing the set of managed beans
(MBeans) in the WebLogic Java Management Extensions (M X) Server. Which counters are discovered is
determined by the WebLogic version you are running and how WebLogic is configured.

Counters

Counter Description Data Point Type
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CompletedRequests Returnsthe Long
number of
completed
requests.
CurrentWaitTime Returnsthe last Long

measured time a
request had to
wait for athread.
Only requests
whose execution
isneeded to
satisfy the
constraint are
considered.

ExecutingRequests Returnsthe Integer
number of
requeststhat are
currently
executing.

MaxWaitTime Returnsthe Long
maximum timea
request had to
wait for athread.
Only requests
whose execution
isneeded to
satisfy the
constraint are
considered.

MustRunCount Returnsthe Integer
number of
requests that
must be executed
to satisfy the
constraint.

OutOfOrderExecutionCount | Returnsthe Long
number of
requests executed
out of turn to
satisfy this
constraint.

PendingRequests Returnsthe Integer
pending requests
waiting for an

available thread.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. This allows you to select
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between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domains for monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.

MinThreadsConstraint

The name of the minimum threads constraint. You can specify one or more minimum threads
constraints for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.

StatType

This parameter appliesonly to countersreturning a count or total (MustRunCount isone examplein
thiscounter category). Possible values are;

ACTUAL The counter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw data value of the counter in the
last task interval and the raw data value of the counter in the current task interval.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.

? Question mark, represents any one individual character asa
wildcard.

n Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.
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The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.
Interval

Recommended minimum is5 minutes.

WebLogic NonXAResourceRuntime
Use thisinterface for accessing runtime statistical information about a non-XA resource.

The WebLogic_ NonXAResourceRuntime category includesthe counterslisted in the following table. Some
of these counters may not be available on your system. ServerVantage dynamically discovers WebLogic
counter categories, counter names, and parameters by processing the set of managed beans (MBeans) in the
WebLogic Java Management Extensions (M X) Server. Which counters are discovered isdetermined by the
WebLogic version you arerunning and how WebLogic is configured.

Counters
Counter ‘ Description ‘ Data Point Type
TransactionCommittedTotalCount | Returnsthetotal | Long
number of
committed

transactions since
the server was
started.

TransactionHeuristicsTotalCount | Returnsthe Long
number of
transactionsthat
completed with a
heuristic status
since the server
was started.

TransactionRolledBackTotalCount | Returnsthe Long
number of rolled
back transactions
since the server
was started.

TransactionTotalCount Returnsthetotal | Long
number of
processed
transactions. This
total includes all
committed,
rolled back, and
heuristic
transaction
completions
since the server
was started.

Parameters
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The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. This allows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.

JTA

The JTA name. You can specify one or more JTAs for monitoring. In any combination, select values
from the discovered list, enter values manually, or enter wildcard patterns.

NonXAResource

The name of the non-XA resource. You can specify one or more non-XA resources for monitoring. In
any combination, select values from the discovered list, enter values manually, or enter wildcard
patterns.

StatType

This parameter appliesonly to countersreturning a count or total (TransactionTotalCount isone
examplein thiscounter category). Possible values are:

ACTUAL Thecounter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw data value of the counter in the
last task interval and the raw data value of the counter in the current task interval.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.

? Question mark, represents any one individual character as a
wildcard.

n Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
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For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.
Interval

Recommended minimum is5 minutes.

WebLogic PersistentSoreConnectionRuntime

The WebLogic_PersistentSoreConnectionRuntime category includesthe counterslisted in the following
table. Some of these counters may not be available on your system. ServerVantage dynamically discovers
WebLogic counter categories, counter names, and parameters by processing the set of managed beans
(MBeans) in the WebLogic Java Management Extensions (M X) Server. Which counters are discovered is
determined by the WebLogic version you are running and how WebLogic is configured.

Counters
Counter Description Data Point Type
CreateCount Returnsthe Long
count of

persistent store
connections
created.

DeleteCount Returnsthe Long
count of
persistent store
connections
deleted

ObjectCount Returnsthe Long
count of
persistent store
connections.

ReadCount Returnsthe Long
count of
persistent store
connectionsread.

UpdateCount Returnsthe Long
count of
persistent store
connections
updated.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
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between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domains for monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.

PersistentStore

The name of the persistent store. You can specify one or more persistent store connectionsfor
monitoring. In any combination, select values from the discovered list, enter values manually, or enter
wildcard patterns.

PersistentStoreConnection

The name of the persistent store connection. You can specify one or more persistent store connections
for monitoring. In any combination, select values from the discovered list, enter values manually, or
enter wildcard patterns.

StatType

This parameter appliesonly to countersreturning a count or total (UpdateCount isone examplein this
counter category). Possible values are:

ACTUAL The counter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw data value of the counter in the
last task interval and the raw data value of the counter in the current task interval.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.

? Question mark, represents any one individual character asa
wildcard.

A Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point

For each counter that you haveincluded in atask:
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I Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.
Interval

Recommended minimum is5 minutes.

WebLogic PersistentSoreRuntime

The WebLogic PersistentSoreRuntime category includesthe counterslisted in the following table. Some of
these counters may not be available on your system. ServerVantage dynamically discovers WebLogic
counter categories, counter names, and parameters by processing the set of managed beans (MBeans) in the
WebLogic Java Management Extensions (M X) Server. Which counters are discovered isdetermined by the
WebLogic version you arerunning and how WebLogic is configured.

Counters
Counter ‘ Description ‘ DataPointType‘

CreateCount Returnsthe Long
count of
persistent stores
created.

DeleteCount Returnsthe Long
count of
persistent stores
deleted.

ObjectCount Returnsthe Long
count of
persistent stores.

PhysicalWriteCount | Returnsthe Long
count of

persistent store
physical writes.

ReadCount Returnsthe Long
count of
persistent stores
read.

UpdateCount Returnsthe Long
count of
persistent stores
updated.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
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dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domains for monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.

PersistentStore

The name of the persistent store. You can specify one or more persistent stores for monitoring. In any
combination, select values from the discovered list, enter values manually, or enter wildcard patterns.

StatType

This parameter appliesonly to countersreturning a count or total (UpdateCount isone examplein this
counter category). Possible values are:

ACTUAL The counter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw data value of the counter in the
last task interval and the raw data value of the counter in the current task interval.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as awildcard.

? Question mark, represents any one individual character asa
wildcard.

A Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.
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Interval

Recommended minimum is5 minutes.

WebLogic QueryCacheRuntime

Thisinterface contains accessor methods for all query cache runtime information collected for an
Enterprise JavaBean (EJB). A query cache miss can occur due to one of fivereasons: 1) The query result was
not found in the query cache; 2) The query result hastimed out; 3) A bean, satisfying the query was not
found in the entity cache; 4) A query with relationship-caching turned on did not find the related-beans
query result; or, 5) A query which loads multiple EBs could not load one or more of them. To better aid
tuning, there are separate counters provided for each of the last four causes listed above. The fifth counter
isatotal cache miss counter, which takesinto account all five causes of a cache miss.

The WebLogic_QueryCacheRuntime category includesthe counterslisted in the following table. Some of
these counters may not be available on your system. ServerVantage dynamically discovers WebLogic
counter categories, counter names, and parameters by processing the set of managed beans (MBeans) in the
WebLogic Java Management Extensions (M X) Server. Which counters are discovered isdetermined by the
WebLogic version you arerunning and how WebLogic is configured.

Counters

Counter Description Data Point Type

CacheAccessCount Returnsthe Long
number of
accesses of the
guery cache for
this EB.

CacheHitCount Returnsthe Long
number of cache
hits of the query
cache for this
EJB.

CacheMissByBeanEvictionCount Returnsthe Long
number of times
acache miss
occurred for this
EJB because
corresponding
beans were not
found in the
entity cache.

CacheMissByDependentQueryMissCount | Returnsthe Long
number of times
a cache miss
occurred for this
EJB because a
dependent query
was not found in
another EB's
guery cache.

CacheMissByRelatedQueryMissCount Returnsthe Long
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number of times
acache miss
occurred for this
EJB because a
related query was
not found in
another EB's
query cache.

CacheMissByTimeoutCount Returnsthe Long
number of cache
misses due to
query result time-
out for this EB.

TotalCachedQueriesCount Returnsthetotal | Integer
number of query
resultsfor this
EB currently in
the EB cache.

TotalCacheMissCount Returnsthetotal | Long
number of cache
misses of the
guery cache for
this EB.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server where the instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.
Application
The application name. You can specify one or more applications for monitoring. In any combination,
select values from the discovered list, enter values manually, or enter wildcard patterns.
EJBComponent
The name of the EJB component. You can specify one or more EBB componentsfor monitoring. In any

combination, select values from the discovered list, enter values manually, or enter wildcard patterns.
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EntityEJB

The name of the entity EB. You can specify one or more entity EJBs for monitoring. In any
combination, select values from the discovered list, enter values manually, or enter wildcard patterns.

QueryCache

The name of the query cache. You can specify one or more query caches for monitoring. In any
combination, select values from the discovered list, enter values manually, or enter wildcard patterns.

StatType

This parameter appliesonly to countersreturning a count or total (TotalCacheMissCount isone
examplein thiscounter category). Possible values are:

ACTUAL The counter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw data value of the counter in the
last task interval and the raw data value of the counter in the current task interval.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.

? Question mark, represents any one individual character asa
wildcard.

A Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.
Interval

Recommended minimum is5 minutes.

WebLogic RequestClassRuntime

Thisinterface presentsruntime information about request classes, each of which represents a class of work.
Work that usesthe same request class sharesthe same priority.

The WebLogic_RequestClassRuntime category includesthe counterslisted in the following table. Some of
these counters may not be available on your system. ServerVantage dynamically discovers WebLogic
counter categories, counter names, and parameters by processing the set of managed beans (MBeans) in the
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WebLogic Java Management Extensions (M X) Server. Which counters are discovered isdetermined by the
WebLogic version you arerunning and how WebLogic is configured.

Counters
Counter ‘ Description ‘ Data Point Type ‘

CompletedCount Returnsthetotal number | Long
of completionssincethe
server was started.

DeltaFirst Returnsthe Long
undocumented attribute
that exposes a value used
in determining priority.

DeltaRepeat Returnsthe Long
undocumented attribute
that exposes a value used
in determining priority.

Interval Returnsthe Double
undocumented attribute
that exposes a value used
in determining priority.
Thisattribute is applicable
only for
ResponseTimeRequestClas
s. For
FairShareRequestClasses, a
-lisreturned.

MyLast Returnsthe Long
undocumented attribute
that exposes a value used
in determining priority.

PendingRequestCount | Returnsthe number of Integer
requests waiting for a
thread to become
available.

ThreadUseSguares Returnsthe Long
undocumented attribute
that exposes a value used
in determining priority.

TotalThreadUse Returnsthetotal amount | Long
of thread-use time (in
milliseconds) used by the
request classsince the
server was started.

VirtualTimelncrement | Returnsthe current Long
priority of the request
class. The priority is
relative to other request
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class priorities, is
dynamically calculated
frequently, and can
change.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.

Application
The application name. You can specify one or more applications for monitoring. In any combination,
select values from the discovered list, enter values manually, or enter wildcard patterns.

WorkManager

The name of the work manager. You can specify one or more work managers for monitoring. In any
combination, select values from the discovered list, enter values manually, or enter wildcard patterns.

RequestClass

The name of the request class. You can specify one or more request classes for monitoring. In any
combination, select values from the discovered list, enter values manually, or enter wildcard patterns.

StatType

This parameter appliesonly to countersreturning a count or total (CompletedCount isone example in
thiscounter category). Possible values are;

ACTUAL Thecounter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw data value of the counter in the
last task interval and the raw data value of the counter in the current task interval.

Valid Wildcard Characters
For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:
* Asterisk, represents zero or more characters as awildcard.

? Question mark, represents any one individual character as a
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wildcard.
n Caret, excludes all valuesthat match the specified pattern.
\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
I Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.
Interval

Recommended minimum is5 minutes.

WebLogic SAFAgentRuntime
Use this class for monitoring a WebLogic Sore-and-Forward (SAF) agent.

The WebLogic_SAFAgentRuntime category includes the counterslisted in the following table. Some of
these counters may not be available on your system. ServerVantage dynamically discovers WebLogic
counter categories, counter names, and parameters by processing the set of managed beans (MBeans) in the
WebLogic Java Management Extensions (M X) Server. Which counters are discovered isdetermined by the
WebLogic version you arerunning and how WebLogic is configured.

Counters
Counter Description ‘ Data Point Type ‘

BytesCurrentCount Returnsthe Long
current number
of bytes,
excluding
pending bytes.

BytesHighCount Returnsthe peak | Long
number of bytes
since the last
reset.

BytesPendingCount Returnsthe Long
number of
pending bytes.
Pending bytes are
over and above
the current
number of bytes.

BytesReceivedCount Returnsthe Long
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number of bytes
received since the
last reset.

BytesThresholdTime Returnsthe Long
amount of time
(in seconds) in
the threshold
condition since
the last reset.

ConversationsCurrentCount Returnsthe Long
current number
of conversations.

ConversationsHighCount Returnsthe peak | Long
number of
conversations
sincethe last
reset.

ConversationsTotalCount Returnsthetotal | Long
number of
conversations
since the last
reset.

FailedM essagesTotal Returnsthetotal | Long
number of
messages that
failed to be
forwarded since
the last reset.

MessagesCurrentCount Returnsthe Long
current number
of messages,
including
pending

m essages.

M essagesHighCount Returnsthe peak | Long
number of
messages since
the last reset.

M essagesPendingCount Returnsthe Long
number of
pending

m essages.
Pending messages
are over and
abovethe current
number of
messages. A
pending message
isonesentin a
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transaction and
not committed or
one forwarded
but not
acknowledged.

M essagesReceivedCount

Returnsthe
number of

m essages received
sincethe last
reset.

Long

MessagesThresholdTime

Returnsthe
amount of time
(in seconds) in
the threshold
condition since
the last reset.

Long

PausedForForwarding

Indicates whether
or not the
sending agent is
paused for
forwarding at the
current time.

Boolean

PausedForincoming

Indicates whether
or not the
sending agent is
paused for
incoming
messages at the
current time.

Boolean

PausedForReceiving

Indicates whether
or not the
receiving agent is
paused for
receiving at the
current time.

Boolean

RemoteEndpointsCurrentCount

Returnsthe
current number
of remote
endpointsto
which this SAF
agent has been
storing and
forwarding

m essages.

Long

RemoteEndpointsHighCount

Returnsthe peak
number of
remote endpoints
to which this SAF
agent has been
storing and

Long

QALoad Online Help
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forwarding
messages since
last reset.

RemoteEndpointsTotalCount Returnsthe Long
number of
remote endpoints
to which this SAF
agent has been
storing and
forwarding
messages since
last reset.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.

JMSServer

The name of the Java Messaging Service (MM S) server. You can specify one or more M S servers for
monitoring. In any combination, select values from the discovered list, enter values manually, or enter
wildcard patterns.

SAFAgent

The name of the SAF agent. You can specify one or more SAF agents for monitoring. In any
combination, select values from the discovered list, enter values manually, or enter wildcard patterns.

StatType

This parameter appliesonly to countersreturning a count or total (FailedM essagesTotal isone example
in thiscounter category). Possible values are:

ACTUAL Thecounter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw data value of the counter in the
last task interval and the raw data value of the counter in the current task interval.

Valid Wildcard Characters
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For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.

? Question mark, represents any one individual character as a
wildcard.

A Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.

Interval

Recommended minimum is5 minutes.

W ebLogic SAFRemoteEndpointRuntime
Use this class for monitoring a WebLogic Sore-and-Forward (SAF) remote endpoint.

The WebLogic SAFRemoteEndpointRuntime category includesthe counterslisted in the following table.
Some of these counters may not be available on your system. ServerVantage dynamically discovers
WebLogic counter categories, counter names, and parameters by processing the set of managed beans
(MBeans) in the WebLogic Java Management Extensions (M X) Server. Which counters are discovered is
determined by the WebLogic version you arerunning and how WebLogic is configured.

Counters

Counter Description Data Point Type

BytesCurrentCount Returnsthe Long
current number
of bytes,
excluding
pending bytes.

BytesHighCount Returnsthe peak | Long
number of bytes
since the last
reset.

BytesPendingCount Returnsthe Long
number of
pending bytes.
Pending bytes are
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over and above
the current
number of bytes.

BytesReceivedCount

Returnsthe
number of bytes
received since the
last reset.

Long

BytesThresholdTime

Returnsthe
amount of time
(in seconds) in
the threshold
condition since
the last reset.

Long

DowntimeHigh

Returnsthe
longest time (in
seconds) that the
remote endpoint
has not been
available since
the last reset.

Long

DowntimeTotal

Returnsthe total
time (in seconds)
that the remote
endpoint has not
been available
sincethe last
reset.

Long

FailedM essagesTotal

Returnsthe total
number of
messages that
failed to be
forwarded since
the last reset.

Long

MessagesCurrentCount

Returnsthe
current number
of messages,
including
pending

m essages.

Long

M essagesHighCount

Returnsthe peak
number of
messages since
the last reset.

Long

M essagesPendingCount

Returnsthe
number of
pending

m essages.
Pending messages
are over and

Long
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abovethe current
number of

m essages. A
pending message
isonesentin a
transaction and
not committed or
one forwarded
but not
acknowledged.

M essagesReceivedCount

Returnsthe
number of

m essages received
sincethe last
reset.

Long

MessagesThresholdTime

Returnsthe
amount of time
(in seconds) in
the threshold
condition since
the last reset.

Long

PausedForForwarding

Indicateswhether
theremote
endpoint is
currently not
forwarding

m essages.

Boolean

PausedForincoming

Indicateswhether
aremote
endpoint is
currently not
accepting new

m essages.

Boolean

UptimeHigh

Returnsthe
longest time (in
seconds) that the
remote endpoint
has been
available since
the last reset.

Long

UptimeTotal

Returnsthe total
time (in seconds)
that the remote
endpoint has
been available
sincethe last
reset.

Long

Parameters
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The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. This allows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.

SAF

The SAFname. You can specify one or more SAFs for monitoring. In any combination, select values
from the discovered list, enter values manually, or enter wildcard patterns.

SAFRemoteEndpoint

The name of the SAFremote endpoint. You can specify one or more SAFremote endpoints for
monitoring. In any combination, select values from the discovered list, enter values manually, or enter
wildcard patterns.

StatType

This parameter appliesonly to countersreturning a count or total (DowntimeTotal isone examplein
thiscounter category). Possible values are:

ACTUAL Thecounter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw data value of the counter in the
last task interval and the raw data value of the counter in the current task interval.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.

? Question mark, represents any one individual character as a
wildcard.

n Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
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For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.

Interval

Recommended minimum is5 minutes.

WebLogic_ServerChanne Runtime
Use this class for monitoring runtime information for network access pointsor "channels.”

The WebLogic_ServerChannelRuntime category includesthe counterslisted in the following table. Some of
these counters may not be available on your system. ServerVantage dynamically discovers WebLogic
counter categories, counter names, and parameters by processing the set of managed beans (MBeans) in the
WebLogic Java Management Extensions (M X) Server. Which counters are discovered isdetermined by the
WebLogic version you arerunning and how WeblLogic is configured.

Counters

Counter Description Data Point Type

AcceptCount Returnsthe Long
number of past
and present
sockets accepted
on thischannel,
thereby
providing the
connection rate
to the server.

BytesReceivedCount Returnsthetotal | Long
number of bytes
received on this
channel.

BytesSentCount Returnsthetotal | Long
number of bytes
sent on this
channel.

ConnectionsCount Returnsthe Long
number of active
connectionsand
sockets associated
with this
channel.

M essagesReceivedCount | Returnsthe Long
number of
m essages received
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on thischannel.

M essagesSentCount Returnsthe Long
number of
messages sent on
thischannel.
Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.

ServerChannel

The name of the server channel. You can specify one or more server channelsfor monitoring. In any
combination, select values from the discovered list, enter values manually, or enter wildcard patterns.

StatType

This parameter appliesonly to countersreturning a count or total (MessagesSentCount isone example
in thiscounter category). Possible values are;

ACTUAL The counter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw data value of the counter in the
last task interval and the raw data value of the counter in the current task interval.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as awildcard.

? Question mark, represents any one individual character asa
wildcard.

n Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.
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For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.

Interval

Recommended minimum is5 minutes.

WebLogic ServerLifeCycleRuntime

Thisclass provides methodsthat transition serversfrom one stateto another. Thisclassisinstantiated only
on theadministration server, but you can use it to transition the states of managed servers as well as
administration servers.

You cannot usethisclassto start an administration server. If you want to use it to start managed servers,
you must first set up anode manager on each managed server host machine.

If you want to use the methodsthat transition a server into the ADMIN state, you must first set up an
administration channel for that server.

The WebLogic_ServerLifeCycleRuntime category includesthe counter listed in the following table. This
counter may not be available on your system. ServerVantage dynamically discovers WebLogic counter
categories, counter names, and parameters by processing the set of managed beans (MBeans) in the
WebLogic Java Management Extensions (M X) Server. Which counters are discovered isdetermined by the
WebLogic version you arerunning and how WebLogic is configured.

Counters
Counter ‘ Description ‘ Data Point Type

NodeManagerRestartCount | Returnsthe Integer
number of times
the server has
been restarted
using the node
manager since
creation. Thefirst
start does not
count. The count
isvalid only if
the node
manager is used
to start and
restart the server
every time.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
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between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domains for monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.

ServerLifeCycle

The name of the server life cycle. You can specify one or more server life cycles for monitoring. In any
combination, select values from the discovered list, enter values manually, or enter wildcard patterns.

StatType

This parameter appliesonly to countersreturning a count or total (NodeManagerRestartCount isone
examplein thiscounter category). Possible values are:

ACTUAL Thecounter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw data value of the counter in the
last task interval and the raw data value of the counter in the current task interval.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.

? Question mark, represents any one individual character as a
wildcard.

A Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.
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Interval

Recommended minimum is5 minutes.

WebLogic ServerLifeCycleTaskRuntime

This class exposes monitoring information about a server'slife cycle. Remote clientsaswell asclients
running within a server may accessthisinformation.

An operation (task) to change a server's state forks a separate thread to perform the actual work and
immediately return an instance of this MBean to the caller. The caller may then use this MBean to track
thetask's progress.

The WebLogic_ServerLifeCycleTaskRuntime category includesthe counterslisted in the following table.
Some of these counters may not be available on your system. ServerVantage dynamically discovers
WebLogic counter categories, counter names, and parameters by processing the set of managed beans
(MBeans) in the WebLogic Java Management Extensions (M X) Server. Which counters are discovered is
determined by the WebLogic version you arerunning and how WebLogic is configured.

Counters

Counter Description Data Point Type

BeginTime Returnsthetask's | Long
start time.

EndTime Returnsthetask's | Long
completion time.
A value of -1
indicatesthat the
task iscurrently
running.

Running Indicateswhether | Boolean
the task is still
running.

System Task Indicateswhether | Boolean
thistask was

initiated by the
server or a user.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain
Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

ServerLifeCycle
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The name of the server life cycle. You can specify one or more server life cycles for monitoring. In any
combination, select values from the discovered list, enter values manually, or enter wildcard patterns.

Tasks

Thetask name. You can specify one or more tasks for monitoring. In any combination, select values
from the discovered list, enter values manually, or enter wildcard patterns.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.

? Question mark, represents any one individual character as a
wildcard.

A Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.
Interval

Recommended minimum is5 minutes.

WebLogic ServerRuntime

Thisinterface provides methods for retrieving runtime information about a server instance and for
transitioning a server from one state to another.

The WebLogic_ServerRuntime category includesthe counterslisted in the following table. Some of these
counters may not be available on your system. ServerVantage dynamically discovers WebLogic counter
categories, counter names, and parameters by processing the set of managed beans (MBeans) in the
WebLogic Java Management Extensions (M X) Server. Which counters are discovered isdetermined by the
WebLogic version you are running and how WebLogic is configured.

Counters
Counter Description Data Point Type
ActivationTime Returnsthe server | Long
start time.
AdministrationPort Returnsthe port
on which this
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server islistening
for administrative
request.
Deprecated.
9.0.0.0. Replaced
by
AdministrationUR
L.

AdministrationPortEnabled

Indicateswhether
the administration
port isenabled on
the server.

Boolean

AdminServer

Indicateswhether
the server isan
administration
server.

Boolean

AdminServerListenPort

Returnsthe port
on which the
administration
server islistening
for connections.

Integer

AdminServerListenPortSecure

Indicateswhether
the port that the
server uses for
administrative
trafficis
configured to use
a secure protocol.

Boolean

ListenPort

Returnsthe port
on which this
server islistening
for connections.
Deprecated.
9.0.0.0. Replaced
by URL.

ListenPPortEnabled

Indicateswhether
the default listen

port isenabled on
the server.

Boolean

OpenSocketsCurrentCount

Returnsthe
current number of
sockets registered
for socket muxing
on this server.

Integer

RestartRequired

Indicateswhether
the server must be
restarted in order
to activate
configuration

Boolean

QALoad Online Help
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changes.

RestartsTotalCount Returnsthetotal Integer
number of restarts
for this server
sincethecluster
was last started.

SocketsOpenedTotalCount Returnsthetotal Long
number of
registrations for
socket muxing on
this sever.

SS ListenPort Returnsthe port Integer
on which this
server islistening
for S
connections.
Deprecated.
9.0.0.0. Replaced
by URL.

SS ListenPortEnabled Indicateswhether | Boolean
the default SSL
listen port is
enabled on the
server.

SateVal Returnsthe Integer
current state of
the server as an
integer.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domains for monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.

StatType

330



QALoad Online Help

This parameter appliesonly to countersreturning a count or total (SocketsOpenedTotalCount isone
examplein thiscounter category). Possible values are:
ACTUAL Thecounter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw data value of the counter in the
last task interval and the raw data value of the counter in the current task interval.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.

? Question mark, represents any one individual character asa
wildcard.

n Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.
Interval

Recommended minimum is5 minutes.

WebLogic ServerSecurityRuntime
Use this class for monitoring WebLogic security information.

The WebLogic_ServerSecurityRuntime category includesthe counter listed in the following table. This
counter may not be available on your system. ServerVantage dynamically discovers WebLogic counter
categories, counter names, and parameters by processing the set of managed beans (MBeans) in the
WebLogic Java Management Extensions (M X) Server. Which counters are discovered is determined by the
WebLogic version you are running and how WebLogic is configured.

Counters
Counter Description Data Point Type
JACCEnabled Indicates whether | Boolean
Java

Authorization
Contract for
Containers

331



Using the Conductor

(JACC) was
enabled on the
command line
for the Java
Virtual Machine
hosting this
server.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server
WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.
ServerSecurity
The name of the server security. You can specify one or more server securities for monitoring. In any
combination, select values from the discovered list, enter values manually, or enter wildcard patterns.
Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.

? Question mark, represents any one individual character asa
wildcard.

A Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.
For more information, see Entering Wildcard Parameters.
Data Point
For each counter that you haveincluded in atask:

! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.
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The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.
Interval

Recommended minimum is5 minutes.

WebLogic ServietRuntime
Thisinterface describes servlet activity.

The WebLogic_ServletRuntime category includesthe counterslisted in the following table. Some of these
counters may not be available on your system. ServerVantage dynamically discovers WebLogic counter
categories, counter names, and parameters by processing the set of managed beans (MBeans) in the
WebLogic Java Management Extensions (M X) Server. Which counters are discovered isdetermined by the
WebLogic version you arerunning and how WebLogic is configured.

Counters
Counter Description Data Point Type
ExecutionTimeAverage | Returnsthe Integer
average amount
of time all

invocations of
the servlet have
executed since
created.

ExecutionTimeHigh Returnsthe Integer
amount of time
thesingle longest
invocation of the
servlet has
executed since
created.

ExecutionTimelLow Returnsthe Integer
amount of time
thesingle
shortest
invocation of the
servlet has
executed since
created.

ExecutionTimeTotal Returnsthetotal | Integer
amount of time
all invocations of
the servlet has
executed since
created.

InvocationTotalCount | Returnsatotal Integer
count of the
timesthis servlet
has been
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invoked.

PoolMaxCapacity Returnsthe Integer
maximum
capacity of this
servlet for single
thread model
servlets.

ReloadTotalCount Returnsthetotal | Integer
count of the
number of times
this servlet has
been reloaded.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.

Application
The application name. You can specify one or more applications for monitoring. In any combination,
select values from the discovered list, enter values manually, or enter wildcard patterns.

WebAppComponent
The name of the Web application component. You can specify one or more Web application
componentsfor monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.

Servlet
Servlet name. You can specify one or more servlets for monitoring. In any combination, select values
from the discovered list, enter values manually, or enter wildcard patterns.

StatType

This parameter appliesonly to the countersthat are returning a count or total (ExecutionTimeTotal is
one examplein thiscounter category). Possible values are:
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ACTUAL Thecounter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.

? Question mark, represents any one individual character as a
wildcard.

n Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.

Interval

Recommended minimum is5 minutes.

WebLogic TaskRuntime

Thisinterface exposes monitoring information about an ongoing and potentially long-running
administrative process. Thismeans, at minimum, any OA&M operation involving I/O. Examplesinclude
starting and stopping servers, deploying and undeploying applications, or migrating services.

A managed bean (MBean) operation of thissort should fork a separate thread to perform the actual work
and immediately return an instance of TaskRuntimeMBean to the caller. The caller can then use thisto
track the task's progress as desired. Users can also query for all instances of TaskRuntimeM Bean to get a
summary of both currently running and recently completed tasks.

An instance of TaskRuntimeMBean continuesto exist in the MBeanServer after the completion of the work
they describe. They will eventually either be explicitly deregistered by the user or removed by a scavenger
process, which periodically purges TaskRuntimeMBeansthat have been completed for some time.

The WebLogic_TaskRuntime category includesthe counterslisted in the following table. Some of these
counters may not be available on your system. ServerVantage dynamically discovers WebLogic counter
categories, counter names, and parameters by processing the set of managed beans (MBeans) in the
WebLogic Java Management Extensions (M X) Server. Which counters are discovered is determined by the
WebLogic version you arerunning and how WeblLogic is configured.

Counters
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Counter Description Data Point Type

BeginTime Returnsthe start | Long
time for thistask.

EndTime Returnsthe Long
completion time
for thistask. A
value of -1 means
that the task is
currently
running.

Running Indicateswhether | Boolean
the task is still
running

System Task Indicateswhether | Boolean
thistask was

initiated by the
Server or a user.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

ServerLifeCycle

The name of the server life cycle. You can specify one or more server life cycles for monitoring. In any
combination, select values from the discovered list, enter values manually, or enter wildcard patterns.

Tasks

The task name. You can specify one or more servers for monitoring. In any combination, select values
from the discovered list, enter values manually, or enter wildcard patterns.

SubTasks

The name of the subtask. You can specify one or more subtasks for monitoring. In any combination,
select values from the discovered list, enter values manually, or enter wildcard patterns.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.
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? Question mark, represents any one individual character asa
wildcard.

A Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.

Interval

Recommended minimum is5 minutes.

WebLogic ThreadPoolRuntime
Use thisbean to monitor the self-tuning queue.

The WebLogic_ThreadPoolRuntime category includesthe counterslisted in the following table. Some of
these counters may not be available on your system. ServerVantage dynamically discovers WebLogic
counter categories, counter names, and parameters by processing the set of managed beans (MBeans) in the
WebLogic Java Management Extensions (M X) Server. Which counters are discovered isdetermined by the
WebLogic version you arerunning and how WebLogic is configured.

Counters

Counter Description Data Point Type

CompletedRequestCount Returnsthe Long
number of
completed
requestsin the
priority queue.

ExecuteThreadldleCount Returnsthe Integer
number of idle
threadsin the
pool.

ExecuteThreadTotalCount Returnsthetotal | Integer
number of
threadsin the
pool.

HoggingThreadCount Returnsthe Integer
threadsthat are
being hogged by
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arequest right
now. These
threads will
either be declared
as stuck after the
configured
timeout or will
return to the pool
beforethat. The
self-tuning
mechanism will
backfill if
necessary.

MinThreadsConstraintsCompleted

Returnsthe
number of
requests with
minimum
threads
constraint picked
up out of order
for execution
immediately
sincetheir min
threads
requirement was
not met. This
number does not
includea
situation where
threads areidle
during schedule.

Long

MinThreadsConstraintsPending

Returnsthe
number of
requests that
should be
executed now to
satisfy the
minimum
threads
requirement.

Integer

PendingUserRequestCount

Returnsthe
number of
pending user
requestsin the
priority queue.
The priority
gueue contains
requests from
internal
subsystems and
users. This
number
representsthe

Integer
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count of all user
requests.

QueuelLength

Returnsthe
number of
pending requests
in the priority
gueue. Thisisthe
total of internal
system requests
and user requests.

Integer

SharedCapacityForWorkManagers

Returnsthe
maximum
amount of
requeststhat can
be accepted in
the priority
gueue. A request
with higher
priority is
accepted in place
of alower-
priority request
already in the
gueue even after
thethreshold is
reached. The
lower priority
request is kept
waiting in the
queue until all
high-priority
requests are
executed. Further
enqueues of the
low priority
requests are
rejected
immediately.

Integer

SandbyThreadCount

Returnsthe
number of
threadsin the
standby pool.
Surplusthreads
that are not
needed to handle
the present
workload are
designated as
standby and
added to the
standby pool.
These threads are
activated when

Integer
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more threads are
needed.

Suspended Indicatesif the Boolean
RequestM anager
issuspended. A
suspended
manager will not
dequeue work
and dispatch
threads until it is
resumed.

Throughput Returnsthe mean | Double
number of
requests
completed per
second.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. This allows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.

ThreadPool

The name of the thread pool. You can specify one or more thread poolsfor monitoring. In any
combination, select values from the discovered list, enter values manually, or enter wildcard patterns.

StatType

This parameter appliesonly to the countersthat are returning a count or total
(ExecuteThreadTotalCount isone example in thiscounter category). Possible values are;

ACTUAL The counter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Valid Wildcard Characters

340



QALoad Online Help

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.

? Question mark, represents any one individual character as a
wildcard.

A Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.

Interval

Recommended minimum is5 minutes.

WebLogic TransactionNameRuntime
Thisinterface representsruntime statistics for a transaction name category.

The WebLogic_TransactionNameRuntime category includesthe counterslisted in the following table.
Some of these counters may not be available on your system. ServerVantage dynamically discovers
WebLogic counter categories, counter names, and parameters by processing the set of managed beans
(MBeans) in the WebLogic Java Management Extensions (M X) Server. Which counters are discovered is
determined by the WebLogic version you arerunning and how WebLogic is configured.

Counters

Counter Description Data Point Type

SecondsActiveTotalCount Returnsthetotal | Long
number of
seconds for all
committed,
active
transactions.

TransactionAbandonedTotalCount Returnsthetotal | Long
number of
abandoned
transactionssince
the server was
started.

TransactionCommittedTotalCount Returnsthetotal | Long
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number of
committed
transactionssince
the server was
started.

TransactionHeuristicsTotalCount

Returnsthe total
number of
completed
transactions with
a heuristic status
since the server
was started.

Long

TransactionRolledBackAppTotalCount

Returnsthe total
number of rolled-
back transactions
because of an
application error.

Long

TransactionRolledBackResourceTotalCount

Returnsthe total
number of rolled
back transactions
because of a
resource error.

Long

TransactionRolledBackSystem TotalCount

Returnsthe
number of rolled-
back transaction
because of an
internal system
error.

Long

TransactionRolledBackTimeoutTotalCount

Returnsthe
number of rolled-
back transactions
because of a
timeout
expiration.

Long

TransactionRolledBackTotalCount

Returnsthe
number of rolled-
back transactions
since the server
was started.

Long

TransactionTotalCount

Returnsthe total
number of
processed
transactions,
including all
committed,
rolled-back, and
heuristic
transaction
completions
since the server

Long
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was started.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domains for monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.

Application
The application name. You can specify one or more applications for monitoring. In any combination,
select values from the discovered list, enter values manually, or enter wildcard patterns.

JTA
The JTA name. You can specify one or more JTAs for monitoring. In any combination, select values
from the discovered list, enter values manually, or enter wildcard patterns.

TransactionResource

The name of the transaction resource. You can specify one or more transaction resources for
monitoring. In any combination, select values from the discovered list, enter values manually, or enter
wildcard patterns.

StatType

This parameter appliesonly to the countersthat are returning a count or total
(SecondsActiveTotalCount isone examplein this counter category). Possible values are:

ACTUAL Thecounter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.
? Question mark, represents any one individual character as a
wildcard.
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A Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to
represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.
Interval

Recommended minimum is5 minutes.

W ebLogic TransactionResourceRuntime
Thisinterface representsruntime statistics for a transactional resource.

The WebLogic_TransactionResourceRuntime category includesthe counterslisted in the following table.
Some of these counters may not be available on your system. ServerVantage dynamically discovers
WebLogic counter categories, counter names, and parameters by processing the set of managed beans
(MBeans) in the WebLogic Java Management Extensions (M X) Server. Which counters are discovered is
determined by the WebLogic version you are running and how WebLogic is configured.

Counters
Counter Description Data Point Type
TransactionCommittedTotalCount Returnsthetotal | Long

number of
transactions
committed since
the server was
started.

TransactionHeuristicCommitTotalCount | Returnsthetotal | Long
number of
transactions for
which this
resource has
returned a
heuristic commit
decision.

TransactionHeuristicHazardTotalCount | Returnsthetotal | Long
number of
transactionsfor
which this
resource has
reported a
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heuristic hazard
decision.

TransactionHeuristicMixedTotalCount

Returnsthe total
number of
transactions for
which this
resource has
reported a
heuristic mixed
decision.

Long

TransactionHeuristicRollbackTotalCount

Returnsthe total
number of
transactions for
which this
resource has
returned a
heuristic rollback
decision.

Long

TransactionHeuristicsTotalCount

Returnsthe total
number of
transactionsthat
completed with a
heuristic status
since the server
was started.

Long

TransactionRolledBackTotalCount

Returnsthe total
number of
transactionsthat
were rolled back
sincethe server
was started.

Long

TransactionTotalCount

Returnsthe total
number of
processed
transactions,
including all
committed,
rolled back, and
heuristic
transaction
completions
sincethe server
was started.

Long

Parameters
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The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. This allows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console

Management function.
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The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.

JTA

The Java Transaction APl (JTA) name. You can specify one or more JTAsfor monitoring. In any
combination, select values from the discovered list, enter values manually, or enter wildcard patterns.

TransactionResource

The name of the transaction resource. You can specify one or more transaction resources for
monitoring. In any combination, select values from the discovered list, enter values manually, or enter
wildcard patterns.

StatType

This parameter appliesonly to the countersthat are returning a count or total (TransactionTotalCount
isone examplein thiscounter category). Possible values are:

ACTUAL Thecounter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.

? Question mark, represents any one individual character as a
wildcard.

n Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.
For more information, see Entering Wildcard Parameters.
Data Point
For each counter that you haveincluded in atask:

! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.
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The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.

Interval

Recommended minimum is5 minutes.

WebLogic UserLockoutManagerRuntime
Use thisclassto monitor and manage per security realm user lockout information.

The WebLogic_UserLockoutManagerRuntime category includesthe counterslisted in the following table.
Some of these counters may not be available on your system. ServerVantage dynamically discovers
WebLogic counter categories, counter names, and parameters by processing the set of managed beans
(MBeans) in the WebLogic Java Management Extensions (M X) Server. Which counters are discovered is
determined by the WebLogic version you are running and how WebLogic is configured.

Counters
Counter ‘ Description ‘ Data Point Type ‘

InvalidLoginAttemptsTotalCount Returnsthe total Long
number of invalid
logins attempted
sincethis server
started and lockouts
enabled. In acluster,
thismethod returns
the number of
invalid logins
attempted that have
occurred since the
cluster started
because all servers
share login failure
information.

InvalidLoginUsersHighCount Returnsthe highest Long
number of userswith
concurrent unexpired
or uncleared invalid
login attempts.
Invalid log in
attempts expire as
specified by
LockoutResetDuratio
n. Usethiscount to
determine whether
you need to modify
the
LockoutCacheSze.

LockedUsersCurrentCount Returnsthe number Long
of users currently
locked out of this
server.
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LoginAttemptsWhileLockedTotalCount | Returnsthe total Long
number of invalid
logins attempted
since this server
started and lockouts
enabled.

UnlockedUsersTotalCount Returnsthetotal Long
number times users
have been unlocked
since this server
started.

UserLockoutTotalCount Returnsthetotal Long
number of user
lockoutsthat
occurred since this
server started. In a
cluster, thismethod
returnsthe number
of user lockoutsthat
occurred since the
cluster started
because all servers
sharelogin failure
information.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.

ServerSecurity
The name of the server security. You can specify one or more server securities for monitoring. In any
combination, select values from the discovered list, enter values manually, or enter wildcard patterns.

Realm

Therealm name. You can specify one or more realmsfor monitoring. In any combination, select values
from the discovered list, enter values manually, or enter wildcard patterns.
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UserLockoutManager
The name of the user lockout manager. You can specify one or more user lockout managers for
monitoring. In any combination, select values from the discovered list, enter values manually, or enter
wildcard patterns.

StatType

This parameter appliesonly to the countersthat are returning a count or total (UserLockoutTotalCount
isone examplein thiscounter category). Possible values are:

ACTUAL Thecounter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.

? Question mark, represents any one individual character as a
wildcard.

A Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.
Interval

Recommended minimum is5 minutes.

WebLogic WANReplicationRuntime

The WebLogic WANReplicationRuntime category includesthe counterslisted in the following table. Some
of these counters may not be available on your system. ServerVantage dynamically discovers WebLogic
counter categories, counter names, and parameters by processing the set of managed beans (MBeans) in the
WebLogic Java Management Extensions (M X) Server. Which counters are discovered isdetermined by the
WebLogic version you arerunning and how WeblLogic is configured.

Counters

Counter Description Data Point Type
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NumberOfSessionsHushedToTheDatabase Returnsthe Long
number of
sessions emptied
to the database.

NumberOfSessionsRetrievedFrom TheDatabase | Returnsthe Long
number of
sessions called up
from the
database.

PrimaryCount Returnsthe Long
number of
objectsthat the
local server hosts
asprimaries.

RemoteClusterReachable Indicateswhether | Boolean
theremote
cluster is

reachable.

SecondaryCount Returnsthe Long
number of
objectsthat the
local server hosts
as secondaries.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. This allows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.

WANReplication

The name of the WAN replication. You can specify one or more WAN replications for monitoring. In
any combination, select values from the discovered list, enter values manually, or enter wildcard
patterns.

StatType
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This parameter appliesonly to the countersthat are returning a count or total (SecondaryCount isone
examplein thiscounter category). Possible values are:

ACTUAL The counter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.

? Question mark, represents any one individual character asa
wildcard.

n Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.
Interval

Recommended minimum is5 minutes.

WebLogic WebAppComponentRuntime
Thisinterface describes a servlet component (servlet context).

The WebLogic WebAppComponentRuntime category includesthe counterslisted in the following table.
Some of these counters may not be available on your system. ServerVantage dynamically discovers
WebLogic counter categories, counter names, and parameters by processing the set of managed beans
(MBeans) in the WebLogic Java Management Extensions (M X) Server. Which counters are discovered is
determined by the WebLogic version you are running and how WebLogic is configured.

Counters

Counter Description Data Point Type

DeploymentSate Returnsthe Integer
current
deployment state
of the module.
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FlterDispatchedRequestsEnabled

Indicates whether
the dispatched
requests are
filtered as
configured in
weblogic.xml.

Boolean

IndexDirectoryEnabled

Indicateswhether
the current
directory
indexing
indicator is
configured in
weblogic.xml.

Boolean

JSPDebug

Returnsthe Java
Server Page debug
or linenumbers
parameter value
asit isconfigured
in weblogic.xml.

Boolean

JSPKeepGenerated

Returnsthe Java
Server Page keep
generated
parameter value
asit isconfigured
in weblogic.xml.

Boolean

JSPPageCheck Secs

Returnsthe Java
Server Page page
check seconds as
it isconfigured in
weblogic.xml.

Long

JSPVerbose

Returnsthe Java
Server Page
verbose
parameter value
asit isconfigured
in weblogic.xml.

Boolean

Open SessionsCurrentCount

Returnsthe
current total
number of open
sessionsin this
component.

Integer

Open SessionsHighCount

Returnsthe peak
watermark of the
total number of
open sessionsin
thisserver. The
count startsat
zero each time
the server is

Integer
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activated. Thisis
an optimization
method for a
highly useful
statistic that
could be
implemented less
efficiently using
change
notification.

ServletReloadCheckSecs

Returnsthe
servlet reload
check seconds as
it isconfigured in
weblogic.xml.

Integer

SessionCookieM axAgeSecs

Returnsthelife
span of the
session cookie (in
seconds) after
which it expires
on theclient. If
thevalueis zero,
the cookie
expires
immediately. If
set to -1, the
cookie expires
when the user
exitsthe browser.

Integer

SessionIDLength

Returnsthe
session identifier
length configured
for HTTP
sessions.

Integer

SessionInvalidationInterval Secs

Returnsthe
invalidation
check timer
interval
configured for
HTTP sessions.

Integer

SessionMonitoringEnabled

Returnsthe
session
monitoring
indicator asit is
configured in
weblogic.xml.

Boolean

SessionsOpenedTotalCount

Returns a count
of thetotal
number of
sessions opened.

Integer
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Session TimeoutSecs Returnsthe Integer
timeout

configured for
HTTP sessions.

SngleThreadedServletPoolSze Returnsthe Integer
single threaded
servlet pool size
asit isconfigured
in weblogic.xml.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.

Application
The application name. You can specify one or more applications for monitoring. In any combination,
select values from the discovered list, enter values manually, or enter wildcard patterns.

WebAppComponent

The name of the Web application component. You can specify one or more Web application
componentsfor monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.

StatType

This parameter appliesonly to the countersthat are returning a count or total
(OpenSessionsHighCount isone examplein this counter category). Possible values are:

ACTUAL The counter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:
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* Asterisk, represents zero or more characters as a wildcard.

? Question mark, represents any one individual character as a
wildcard.

A Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.
Interval

Recommended minimum is5 minutes.

WebLogic WebServerRuntime
Thisinterface describesa Web server (HTTP server).

The WebLogic WebServerRuntime category includesthe counter listed in the following table. This counter
may not be available on your system. ServerVantage dynamically discovers WebLogic counter categories,
counter names, and parameters by processing the set of managed beans (MBeans) in the WebLogic Java
Management Extensions (M X) Server. Which counters are discovered isdetermined by the WebLogic
version you arerunning and how WebLogic is configured.

Counters

Counter Description Data Point Type

DefaultWebServer | Indicateswhether | Boolean
the server isthe
default Web
server or avirtual
host.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. This allows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain
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Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.

WebServer

The name of the Web server. You can specify one or more Web servers for monitoring. In any
combination, select values from the discovered list, enter values manually, or enter wildcard patterns.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.

? Question mark, represents any one individual character asa
wildcard.

A Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.
Interval

Recommended minimum is5 minutes.

WebLogic WLDFArchiveRuntime

Use thisinterface to collect statistical information about the data archives maintained by WLDF.
Information provided by thisinterfaceiscommon to all WLDF data archives.

The WebLogic WLDFArchiveRuntime category includesthe counterslisted in the following table. Some of
these counters may not be available on your system. ServerVantage dynamically discovers WebLogic
counter categories, counter names, and parameters by processing the set of managed beans (MBeans) in the
WebLogic Java Management Extensions (M X) Server. Which counters are discovered isdetermined by the
WebLogic version you arerunning and how WebLogic is configured.

Counters
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Counter Description Data Point Type ‘

RecordRetrievalTime | Returnsthetime | Long
(in milliseconds)
spent retrieving
records from the
archive sincethe
server was
started.

RecordSeekCount Returnsthe Long
number of seek
operations
performed on the
archive sincethe
server was
started.

RecordSeekTime Returnsthetime | Long
(in milliseconds)
spent locating
thefirst record
during a query
operation since
the server was
started.

RetrievedRecordCount | Returnsthe Long
number of
recordsretrieved
from the archive
sincethe server
was started.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. This allows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.

WLDF
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The WLDFname. You can specify one or more WLDFs for monitoring. In any combination, select
values from the discovered list, enter values manually, or enter wildcard patterns.

WLDFArchive

The WLDFname. You can specify one or more WLDFs for monitoring. In any combination, select
values from the discovered list, enter values manually, or enter wildcard patterns.

StatType

This parameter appliesonly to the countersthat are returning a count or total (RecordSeekCount isone
examplein thiscounter category). Possible values are:

ACTUAL The counter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.

? Question mark, represents any one individual character asa
wildcard.

n Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.
Interval

Recommended minimum is5 minutes.

WebLogic WLDFDataAccessRuntime

Use thisinterface to access the specific type of diagnostic data from an underlying log for which this
instanceis created.

The WebLogic WLDFDataAccessRuntime category includesthe counterslisted in the following table. Some
of these counters may not be available on your system. ServerVantage dynamically discovers WebLogic
counter categories, counter names, and parameters by processing the set of managed beans (MBeans) in the
WebLogic Java Management Extensions (M X) Server. Which counters are discovered is determined by the
WebLogic version you arerunning and how WebLogic is configured.
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Counters

Counter Description Data Point Type

EarliestAvailableTimestamp | Returnsthe Long
timestamp (in
milliseconds)
since Jan 1, 1970
AD, 00:00:00
GMT for the
earliest record in
the diagnostic
datalog.

LatestAvailableTimestamp | Returnsthe Long
timestamp (in
milliseconds)
since Jan 1, 1970
AD, 00:00:00
GMT for the
newest record in
the diagnostic
datalog.

LatestRecordld Returnsthelatest | Long
known record
identifier for the
underlying
archive.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domains for monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.

WLDF

The WLDFname. You can specify one or more servers for monitoring. In any combination, select
values from the discovered list, enter values manually, or enter wildcard patterns.

WLDFAccess
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The name of the WLDF access. You can specify one or more WLDF accesses for monitoring. In any
combination, select values from the discovered list, enter values manually, or enter wildcard patterns.
WLDFDataAccess
The name of the WLDF data access. You can specify one or more WLDF data accesses for monitoring.
In any combination, select values from the discovered list, enter values manually, or enter wildcard
patterns.
Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.

? Question mark, represents any one individual character as a
wildcard.

n Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.
Interval

Recommended minimum is5 minutes.

WebLogic WLDFDbstoreArchiveRuntime

Use thisinterface to retrieve statistical information associated with the WLDF archivesthat use databases
for storage.

The WebLogic WLDFDbstoreArchiveRuntime category includesthe counterslisted in the following table.
Some of these counters may not be available on your system. ServerVantage dynamically discovers
WebLogic counter categories, counter names, and parameters by processing the set of managed beans
(MBeans) in the WebLogic Java Management Extensions (M X) Server. Which counters are discovered is
determined by the WebLogic version you are running and how WebLogic is configured.

Counters
Counter Description Data Point Type
DeletionCount Returnsthe Long
number of

records deleted

from the archive
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since this server
was started.

DeletionTime

Returnsthetime
(in milliseconds)
spent deleting
records from the
archive since this
server was
started.

Long

InsertionCount

Returnsthe
number of new
recordsinserted
in the archive
since this server
was started.

Long

InsertionTime

Returnsthetime
(in milliseconds)
spent inserting
recordsinto the
archive since this
server was
started.

Long

RecordRetrieval Time

Returnsthetime
(in milliseconds)
spent retrieving
records from the
archive sincethe
server was
started.

Long

RecordSeekCount

Returnsthe
number of seek
operations
performed on the
archive sincethe
server was
started.

Long

RecordSeekTime

Returnsthetime
(in milliseconds)
spent locating
the first record
during a query
operation since
the server was
started.

Long

RetrievedRecordCount

Returnsthe
number of
recordsretrieved
from the archive
since the server

Long
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was started.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domains for monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.
WLDF
The WLDFname. You can specify one or more WLDFs for monitoring. In any combination, select
values from the discovered list, enter values manually, or enter wildcard patterns.
WLDFDbstoreArchive

The name of the WLDF database store archive. You can specify one or more WLDF database store
archives for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.

StatType

This parameter appliesonly to the countersthat are returning a count or total (RecordSeekCount isone
examplein thiscounter category). Possible values are:

ACTUAL Thecounter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.

? Question mark, represents any one individual character as a
wildcard.

A Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.
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For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.

Interval

Recommended minimum is5 minutes.

WebLogic WLDFFileArchiveRuntime

Use thisinterface to collect statistical information about file-based WebLogic Diagnostic Framework
(WLDF) archives.

The WebLogic WLDFFleArchiveRuntime category includesthe counterslisted in the following table. Some
of these counters may not be available on your system. ServerVantage dynamically discovers WebLogic
counter categories, counter names, and parameters by processing the set of managed beans (MBeans) in the
WebLogic Java Management Extensions (M X) Server. Which counters are discovered isdetermined by the
WebLogic version you arerunning and how WebLogic is configured.

Counters
Counter Description ‘ Data Point Type ‘

IncrementalindexCycleCount | Returnsthe Integer
number of times
incremental
indexing cycles
were executed
sincethe server
was started.

IncrementallndexTime Returnsthe Long
cumulativetime
(in milliseconds)
spent performing
incremental
indexing since
the server was
started.

IndexCycleCount Returnsthe Integer
number of times
indexing cycles
were executed
since the server
was started.

IndexTime Returnsthe Long
cumulative
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indexing time (in
milliseconds)
since the server
was started.

RecordRetrieval Time Returnsthetime | Long
(in
milliseconds)spen
t retrieving
records from the
archive sincethe
server was
started.

RecordSeekCount Returnsthe Long
number of seek
operations
performed on the
archive sincethe
server was
started.

RecordSeekTime Returnsthetime | Long
(in milliseconds)
spent locating
thefirst record
during a query
operation since
the server was
started.

RetrievedRecordCount Returnsthe Long
number of
recordsretrieved
from the archive
since the server
was started.

RotatedFilesCount Returnsthe Integer
number of
rotated log file
fragments.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain
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Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.

WLDF

The WLDFname. You can specify one or more WLDFs for monitoring. In any combination, select
values from the discovered list, enter values manually, or enter wildcard patterns.

WLDFFileArchive

The name of the WLDFfile archive. You can specify one or more WLDF file archives for monitoring. In
any combination, select values from the discovered list, enter values manually, or enter wildcard
patterns.

StatType

This parameter appliesonly to the countersthat are returning a count or total (RotatedFilesCount is
one examplein thiscounter category). Possible values are:

ACTUAL The counter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.

? Question mark, represents any one individual character asa
wildcard.

A Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.

Interval
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Recommended minimum is5 minutes.

WebLogic WLDFHarvesterRuntime

The WebLogic Diagnostic Framework (WLDF) category providesinformation about harvestable and
harvested attributes, types, and instances. "Harvestable" means potentially available for harvesting;
"harvested" means explicitly designated for harvesting. These terms apply to types, instances, and the
attributeswithin those types. In addition, the interface provides accessto sampling and snapshot statistics.
All statistics are based on data collected during the current server session.

The WebLogic WLDFHarvesterRuntime category includesthe counterslisted in the following table. Some
of these counters may not be available on your system. ServerVantage dynamically discovers WebLogic
counter categories, counter names, and parameters by processing the set of managed beans (MBeans) in the
WebLogic Java Management Extensions (M X) Server. Which counters are discovered isdetermined by the
WebLogic version you arerunning and how WebLogic is configured.

Counters
Counter ‘ Description ‘ DataPointType‘

AverageSamplingTime Returnsthe Long
average amount
of time (in
nanoseconds)
spent in
sampling cycles.

CurrentDataSampleCount Returnsthe Long
number of
collected data
samplesin the
current snapshot.

CurrentSampleTimeAnQutlier Indicateswhether | Boolean
the sampling
time for the most
recent data
sample differed
significantly
enough from the
average to be
considered a
statistical outlier.

CurrentSnapshotElapsedTime Returnsthe Long
elapsed time (in
nanoseconds) of
a snapshot.

CurrentSnapshotSartTime Returnsthe start | Long
time (in
nanoseconds) of
a snapshot.

MaximumSamplingTime Returnsthe Long
maximum
sampling time (in
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nanoseconds).

MinimumSamplingTime

Returnsthe
minimum
sampling time (in
nanoseconds).

Long

OutlierDetectionFactor

Returnsthe
multiplicative
factor used to
determinea
statistical outlier.
If the actual
sampling time
exceedsthis, the
session average
multiplied by the
outlier detection
factor, then the
samplingtimeis
considered a
statistical outlier.

Hoat

SamplePeriod

Returnsthe
current global
sample period (in
nanoseconds).

Long

TotalDataSampleCount

Returnsthe
number of
configured data
samples collected
so far in this
server session.

Long

TotalSamplingCycles

Returnsthe total
number of
sampling cycles
taken so far.

Long

TotalSamplingTime

Returnsthe total
amount of time
(in nanoseconds)
spent in
sampling cycles.

Long

TotalSamplingTimeOutlierCount

Returnsthe
number of times
within this server
session that the
sampling time
differed
significantly
enough from the
average to be
considered a

Long
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statistical outlier.
The harvester
removesthese
values from the
ongoing averages.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.

WLDF

The WLDFname. You can specify one or more WLDFs for monitoring. In any combination, select
values from the discovered list, enter values manually, or enter wildcard patterns.

WLDFHarvester

The name of WLDF harvester. You can specify one or more WLDF harvesters for monitoring. In any
combination, select values from the discovered list, enter values manually, or enter wildcard patterns.

StatType

This parameter appliesonly to the countersthat are returning a count or total (TotalDataSampleCount
isone examplein thiscounter category). Possible values are:

ACTUAL The counter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.

? Question mark, represents any one individual character as a
wildcard.

A Caret, excludes all valuesthat match the specified pattern.
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\ Backslash, precede a wildcard character with a backslash to
represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
I Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.

Interval

Recommended minimum is5 minutes.

WebLogic WLDFImageCreationTaskRuntime

Thisinterface exposes monitoring information about a potentially long-running request for the generation
of adiagnosticimage. Remote clients, aswell as clientsrunning within a server, can accessthis
information.

WebLogic Diagnostic Framework (WLDF) Image Runtime supports operationsto request the generation of
adiagnosticimage for capturing arunning server'sinternal state information. These operationswill fork a
separate thread to perform the actual work and immediately return an instance of this MBean to the caller.
The caller can then usethat instance to track the task's progress.

The WebLogic WLDFImageCreationTaskRuntime category includesthe counterslisted in the following
table. Some of these counters may not be available on your system. ServerVantage dynamically discovers
WebLogic counter categories, counter names, and parameters by processing the set of managed beans
(MBeans) in the WebLogic Java Management Extensions (M X) Server. Which counters are discovered is
determined by the WebLogic version you are running and how WebLogic is configured.

Counters

Counter Description Data Point Type

BeginTime Returnsthe task Long
start time.

EndTime Returnsthe task Long
completion time.
A value of -1
indicatesthat the
task iscurrently
running.

Running Indicateswhether | Boolean
the task is still
running.

System Task Indicateswhether | Boolean
thistask was
initiated by the
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Server versus a
user.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domains for monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Location
WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.

? Question mark, represents any one individual character as a
wildcard.

n Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.

Interval

Recommended minimum is5 minutes.

WebLogic WLDFInstrumentationRuntime
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ThisWebLogic DiagnosticFramework (WLDF) interface defines various methods for accessing runtime
information about the diagnostic instrumentation system.

The WebLogic WLDFInstrumentationRuntime category includesthe counterslisted in the following table.
Some of these counters may not be available on your system. ServerVantage dynamically discovers
WebLogic counter categories, counter names, and parameters by processing the set of managed beans
(MBeans) in the WebLogic Java Management Extensions (MM X)Server. Which counters are discovered is
determined by the WebLogic version you are running and how WebLogic is configured.

Counters
Counter ‘ Description ‘ DataPointType‘

CallJinpointCount Returnsthe Integer
number of
affected CALL
join pointsfor all
inspected classes.
(CALL join points
are on thecaller
side.)

ExecutionJinpointCount | Returnsthe Integer
number of
affected
EXECUTION join
pointsfor all
inspected classes.
(EXECUTION
join pointsare on
the callee side.)

InspectedClassesCount Returnsthe Integer
number of classes
inspected for
weaving.
(Weaving isthe
insertion of
diagnostic code.)

MaxWeavingTime For all classes, Long
returnsthe
weaving time (in
nanoseconds) for
the classthat
required the most
time to process,
including the
time spent for
inspection and
for modification.

MinWeavingTime For all classes, Long
returnsthe
weaving time (in
nanoseconds) for
the classthat
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required the least
time to process,
including the
time spent for
inspection and
for modification.

ModifiedClassesCount Returnsthe Integer
number of
modified classes
(i.e., classes
where diagnostic
code has been
inserted).

TotalWeavingTime For all classes, Long
returnsthe total
weaving time (in
nanoseconds) for
processing,
including the
time spent for
inspection and
for modification.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. This allows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.

WLDF

The WLDFname. You can specify one or more WLDFs for monitoring. In any combination, select
values from the discovered list, enter values manually, or enter wildcard patterns.

WLDFInstrumentation

The name of the WLDFinstrumentation. You can specify one or more servers for monitoring. In any
combination, select values from the discovered list, enter values manually, or enter wildcard patterns.

StatType
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This parameter appliesonly to the countersthat are returning a count or total (ModifiedClassesCount
isone examplein thiscounter category). Possible values are:
ACTUAL Thecounter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.

? Question mark, represents any one individual character asa
wildcard.

n Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.
Interval

Recommended minimum is5 minutes.

WebLogic WLDFW atchNatificationRuntime

ThisWebLogic Diagnostic Framework (WLDF) Watch Notification Runtime interface provides access to
watch and notification statistical data for the current instance of this server.

The WebLogic WLDFWatchNotificationRuntime category includesthe counterslisted in the following
table. Some of these counters may not be available on your system. ServerVantage dynamically discovers
WebLogic counter categories, counter names, and parameters by processing the set of managed beans
(MBeans) in the WebLogic Java Management Extensions (M X) Server. Which counters are discovered is
determined by the WebLogic version you are running and how WebLogic is configured.

Counters
Counter Description Data Point Type
AverageEventDataWatchEvaluationTime Returnsthe Long
average
instrumentation
event data
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evaluation cycle
time (in
milliseconds).

AverageHarvesterWatchEvaluationTime

Returnsthe
average harvester
evaluation cycle
time (in
milliseconds).

Long

AverageLogWatchEvaluationTime

Returnsthe
average log
evaluation cycle
time (in
milliseconds).

Long

CurrentActiveAlarmsCount

Returnsthe
number of active
alarms of any

type.

Integer

MaximumActiveAlarmsCount

Returnsthe
maximum
number of active
alarmsat any one
time.

Integer

MaximumEventDataW atchEvaluationTime

Returnsthe
maximum time
spent evaluating
event data
watches.

Long

MaximumHarvesterWatchEvaluationTime

Returnsthe
maximum time
spent evaluating
harvester
watches.

Long

MaximumLogWatchEvaluationTime

Returnsthe
maximum time
spent evaluating
log watches.

Long

MinimumEventDataWatchEvaluationTime

Returnsthe
minimum time
spent evaluating
log watches.

Long

MinimumHarvesterWatchEvaluationTime

Returnsthe
minimum time
spent evaluating
harvester
watches.

Long

MinimumLogWatchEvaluationTime

Returnsthe
minimum time

Long
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spent evaluating
log watches.

TotalActiveAutomaticResetAlarms

Returnsthe total
number of active
automatically
reset alarms.

Long

TotalActiveM anualResetAlarms

Returnsthe total
number of active
manually reset
alarms.

Long

TotalDIM GNotificationsPerformed

Returnsthetotal
number of
diagnostic image
notifications
fired. Diagnostic
image files are
not true
notifications, but
thiscomponent
recordsthe
number of image
captures
requested by the
watch
component.

Long

TotalEventDataEvaluationCycles

Returnsthe total
number of times
instrumentation
event data watch
rules have been
evaluated.

Long

TotalEventDataW atchesTriggered

Returnsthe total
number of
instrumentation
event data watch
rulesthat
evaluated to true
and triggered
notifications.

Long

TotalEventDataW atchEvaluations

Returnsthe total
number of
evaluated
instrumentation
event data watch
rules. For each
cycle, the watch
and notification
component
evaluates all of
the enabled

Long
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instrumentation
event data
watches.

TotalFailedDIM GNotifications

Returnsthe total
number of failed
diagnostic image
notification
requests.

Long

TotalFailedJM SNotifications

Returnsthe total
number of failed
Java M essage
Service (M)
notification
attempts.

Long

TotalFailedJV XNotifications

Returnsthe total
number of failed
JMX notification
attempts.

Long

TotalFailedNotifications

Returnsthe total
number of failed
notification
requests.

Long

TotalFailedSM TPNotifications

Returnsthe total
number of failed
Smple Mail
Transfer Protocol
(SMTP)
notification
attempts.

Long

TotalFailedSNM PNotifications

Returnsthe total
number of failed
Smple Network
Management
Protocol (SNMP)
notification
attempts.

Long

TotalHarvesterEvaluationCycles

Returnsthe total
number of times
the harvester
invoked the
watch and
notification
component to
evaluate
harvester watch
rules. (This
number
correspondsto
the number of

Long
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sampling cycles.)

TotalHarvesterWatchesTriggered

Returnsthe total
number of
harvester watch
rulesthat
evaluated to true
and triggered
notifications.

Long

TotalHarvesterWatchEvaluations

Returnsthe total
number of
evaluated
harvester watch
rules. For each
cycle, the watch
and notification
component
evaluates all of
the enabled
harvester
watches.

Long

TotalIM SNotificationsPerformed

Returnsthe total
number of Java
M essage Service
(M9
notifications
successfully fired.

Long

TotalIM XNotificationsPerformed

Returnsthe total
number of M X
notifications
successfully fired.

Long

TotalLogEvaluationCycles

Returnsthe total
number of times
log watch rules
have been
evaluated.

Long

TotalLogWatchesTriggered

Returnsthe total
number of log
watch rulesthat
evaluated to true
and triggered
notifications.

Long

TotalLogWatchEvaluations

Returnsthe total
number of
evaluated log
watch rules. For
each cycle, the
watch and
notification
component

Long
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evaluates all of
the enabled log
watches.

TotalNotificationsPerformed Returnsthetotal | Long
number of
notifications
performed.

TotalSM TPNotificationsPerformed Returnsthetotal | Long
number of SMTP
notifications

successfully fired.

TotalSNMPNotificationsPerformed Returnsthetotal | Long
number of
Smple Network
Management
Protocol (SNMP)
notifications
successfully fired.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.
WLDF
The WLDFname. You can specify one or more WLDFs for monitoring. In any combination, select
values from the discovered list, enter values manually, or enter wildcard patterns.
WLDFWatchNotification

The name of the WLDFwatch notification. You can specify one or more WLDF watch notifications for
monitoring. In any combination, select values from the discovered list, enter values manually, or enter
wildcard patterns.

StatType

This parameter appliesonly to the countersthat are returning a count or total
(CurrentActiveAlarmsCount isone examplein this counter category). Possible values are:
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ACTUAL Thecounter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.

? Question mark, represents any one individual character as a
wildcard.

n Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.
Interval

Recommended minimum is5 minutes.

WebLogic WLDFW IstoreArchiveRuntime

Usethisinterface to retrieve statistical information associated with WebLogic Diagnostic Framework
(WLDF) archivesthat use WebLogic Sore for data storage.

The WebLogic WLDFWIstoreArchiveRuntime category includesthe counterslisted in the following table.
Some of these counters may not be available on your system. ServerVantage dynamically discovers
WebLogic counter categories, counter names, and parameters by processing the set of managed beans
(MBeans) in the WebLogic Java Management Extensions (M X) Server. Which counters are discovered is
determined by the WebLogic version you are running and how WebLogic is configured.

Counters
Counter Description Data Point Type
DeletionCount Returnsthe Long
number of

records deleted
since the server
was started.
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DeletionTime

Returnsthe
cumulativetime
(in milliseconds)
spent to delete
recordssincethe
server was
started.

Long

IndexPageCount

Returnsthe
number of index
pages.

Integer

InsertionCount

Returnsthe
number of
records created
sincethe server
was started.

Long

InsertionTime

Returnsthe
cumulativetime
(in milliseconds)
spent to insert
recordssincethe
server was
started.

Long

RecordRetrieval Time

Returnsthetime
(in milliseconds)
spent retrieving
records from the
archive sincethe
server was
started.

Long

RecordSeekCount

Returnsthe
number of seek
operations
performed on the
archive sincethe
server was
started.

Long

RecordSeekTime

Returnsthetime
(in milliseconds)
spent locating
the first record
during a query
operation since
the server was
started.

Long

RetrievedRecordCount

Returnsthe
number of
recordsretrieved
from the archive
sincethe server

Long
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was started.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain
Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domains for monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.

StatType

This parameter appliesonly to the countersthat are returning a count or total (DeletionCount isone
examplein thiscounter category). Possible values are:

ACTUAL The counter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.

? Question mark, represents any one individual character asa
wildcard.

A Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.
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The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.
Interval

Recommended minimum is5 minutes.

WebLogic WorkManagerRuntime
Use thisinterface for monitoring work manager runtime information.

The WebLogic WorkManagerRuntime category includesthe counterslisted in the following table. Some of
these counters may not be available on your system. ServerVantage dynamically discovers WebLogic
counter categories, counter names, and parameters by processing the set of managed beans (MBeans) in the
WebLogic Java Management Extensions (M X) Server. Which counters are discovered isdetermined by the
WebLogic version you arerunning and how WebLogic is configured.

Counters

Counter Description Data Point Type

CompletedRequests| Returnsthe Long
number of
processed
requests.

PendingRequests Returnsthe Integer
number of
waiting requests
in the queue.

SuckThreadCount | Returnsthe Integer
number of stuck
threads based on
any stuck thread
constraints.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domains for monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.
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WorkManager

Name of the work manager. You can specify one or more work managers for monitoring. In any
combination, select values from the discovered list, enter values manually, or enter wildcard patterns.

StatType

This parameter appliesonly to the countersthat are returning a count or total (SuckThreadCount is
one examplein thiscounter category). Possible values are:

ACTUAL The counter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.

? Question mark, represents any one individual character asa
wildcard.

A Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.
Interval

Recommended minimum is5 minutes.

W ebLogic W see Operation Runtime

Thisinterface describesthe state of a particular Web service operation, such as deployment state and
runtime statistics about the execution of the operation.

The WebLogic_ WseeOperationRuntimeOperationRuntime (Web Services Execution Engine) category
includesthe counterslisted in the following table. Some of these counters may not be available on your
system. ServerVantage dynamically discovers WebLogic counter categories, counter names, and parameters
by processing the set of managed beans (MBeans) in the WebLogic Java Management Extensions (JM X)
Server. Which counters are discovered isdetermined by the WebLogic version you are running and how
WebLogic is configured.

Counters
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Counter

Description

Data Point Type

DispatchTimeAverage

Returnsthe
average dispatch
time for the
current
measurement
period. Dispatch
timerefersto the
time for
WebLogic server
to processthe
invocation. The
measurement
period typically
startswhen the
WebLogic Server
was first started.

Long

DispatchTimeHigh

Returnsthe
longest dispatch
time for the
current
measurement
period. Dispatch
timerefersto the
time for the
WebLogic Server
to processthe
invocation. The
measurement
period typically
startswhen the
WebLogic server
was first started.

Long

DispatchTimelLow

Returnsthe
lowest dispatch
timefor the
current
measurement
period. Dispatch
timerefersto the
timefor the
WebLogic Server
to processthe
invocation. The
measurement
period typically
startswhen the
WebLogic server
was first started.

Long

DispatchTimeTotal

Returnsthe total
time for all

Long
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dispatches of this
operation in the
current
measurement
period.
Dispatches refer
to thetime for
the WebLogic
Server to process
theinvocation.
The
measurement
period typically
startswhen the
WebLogic Server
was first started.

ExecutionTimeAverage

Returnsthe
average
execution time of
thisoperation.

Long

ExecutionTimeHigh

Returnsthe
longest execution
time of this
operation.

Long

ExecutionTimeLow

Returnsthe
lowest execution
time of this
operation.

Long

ExecutionTimeTotal

Returnsthe total
time for all
executions of this
operation.

Long

InvocationCount

Returnsthe total
number of times
that this
operation has
been invoked in
the current
measurement
period. The
measurement
period typically
startswhen the
WebLogic server
was first started.

Integer

ResponseCount

Returnsthe total
number of
responses
generated from
invocations of

Integer
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this operation.

ResponseErrorCount

Returnsthe total
number of errors
from responses
generated from
invocations of
thisoperation.

Integer

ResponseTimeAverage

Returnsthe
average response
time from the
responses
generated from
invocations of
thisoperation.

Long

ResponseTimeHigh

Returnsthe
longest response
time based on
responses
generated from
invocations of
thisoperation.

Long

ResponseTimelLow

Returnsthe
lowest response
time based on
responses
generated from
invocations of
thisoperation.

Long

ResponseTimeTotal

Returnsthe total
time for all
responses
generated from
invocations of
thisoperation.

Long

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. This allows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console

Management function.

The following parameters are valid for this counter category.

Domain

Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.
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Server
WebLogic Application Server where the instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.
Application
The application name. You can specify one or more applications for monitoring. In any combination,
select values from the discovered list, enter values manually, or enter wildcard patterns.
Wsee
The Web Services Execution Engine (Wsee) name. You can specify one or more Wsees for monitoring.
In any combination, select values from the discovered list, enter values manually, or enter wildcard
patterns.
WseePort
The name of the Wsee port. You can specify one or more Wsee portsfor monitoring. In any
combination, select values from the discovered list, enter values manually, or enter wildcard patterns.
WseeOperation
The name of the Wsee operation. You can specify one or more Wsee operations for monitoring. In any
combination, select values from the discovered list, enter values manually, or enter wildcard patterns.
StatType

This parameter appliesonly to the countersthat are returning a count or total (ResponseTimeTotal is
one examplein thiscounter category). Possible values are:

ACTUAL The counter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.

? Question mark, represents any one individual character as a
wildcard.

A Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:

! Theprimary data point (PDP) isthe value returned for that counter.
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I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.

The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.

Interval

Recommended minimum is5 minutes.

WebLogic W SRMRemoteEndpointRuntime

Use this class for monitoring a WebLogic Sore-and-Forward (SAF) remote endpoint for Web services
reliable messaging.

The WebLogic WSRMRemoteEndpointRuntime category includesthe counterslisted in the following
table. Some of these counters may not be available on your system. ServerVantage dynamically discovers
WebLogic counter categories, counter names, and parameters by processing the set of managed beans
(MBeans) in the WebLogic Java Management Extensions (M X) Server. Which counters are discovered is
determined by the WebLogic version you are running and how WebLogic is configured.

Counters
Counter Description ‘ Data Point Type ‘

BytesCurrentCount Returnsthe Long
current number
of bytes,
excluding
pending bytes.

BytesHighCount Returnsthe peak | Long
number of bytes
since the last
reset.

BytesPendingCount Returnsthe Long
number of
pending bytes.
Pending bytes are
over and above
the current
number of bytes.

BytesReceivedCount Returnsthe Long
number of bytes
received since the
last reset.

BytesThresholdTime Returnsthe Long
amount of time
in thethreshold
condition since
the last reset.

ConversationsCurrentCount | Returnsthe Long
current number
of conversations.
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ConversationsHighCount

Returnsthe peak
number of
conversations
since the last
reset.

Long

ConversationsTotalCount

Returnsthe total
number of
conversations
sincethe last
reset.

Long

DowntimeHigh

Soecifiesthe
longest time (in
seconds) that the
remote endpoint
has not been
available since
the last reset.

Long

DowntimeTotal

Soecifiesthe total
time (in seconds)
that the remote
endpoint hasnot
been available
sincethe last
reset.

Long

FailedM essagesTotal

Returnsthe total
number of failed
messages to be
forwarded since
the last reset.

Long

MessagesCurrentCount

Returnsthe
current number
of messages,
including
pending

m essages.

Long

M essagesHighCount

Returnsthe peak
number of
messages since
the last reset.

Long

M essagesPendingCount

Returnsthe
number of
pending
messages, which
are over and
abovethe current
number of

m essages. A
pending message
isonesentin a

Long
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transaction and
not committed or
forwarded but
not
acknowledged.

M essagesReceivedCount Returnsthe Long
number of

m essages received
sincethe last
reset.

MessagesThresholdTime Returnsthe Long
amount of time
in thethreshold
condition since
the last reset.

PausedForForwarding Indicatesif the Boolean
remote endpoint
iscurrently not
forwarding

m essages.

PausedForlncoming Indicatesif a Boolean
remote endpoint
iscurrently not
accepting new

m essages.

UptimeHigh Returnsthe Long
longest time (in
seconds) that the
remote endpoint
has been
available since
the last reset.

UptimeTotal Returnsthetotal | Long
time (in seconds)
that the remote
endpoint has
been available
sincethe last
reset.

Parameters

The parameters for aWebLogic counter category are derived from the MBean name. The parametersvalues
are analyzed and displayed according to their parameter dependency structure. Thisallows you to select
between multiple parameters and always end up with avalid combination of parameters. This parameter
dependency information isenforced by the task creation wizard in the VantageView Web Console
Management function.

The following parameters are valid for this counter category.

Domain
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Domain in which the WebLogic Application Admin server and its managed serversreside. You can
specify one or more domainsfor monitoring. In any combination, select values from the discovered
list, enter values manually, or enter wildcard patterns.

Server

WebLogic Application Server wherethe instance you want to monitor resides. You can specify one or
more servers for monitoring. In any combination, select values from the discovered list, enter values
manually, or enter wildcard patterns.
SAF
The SAFname. You can specify one or more SAFs for monitoring. In any combination, select values
from the discovered list, enter values manually, or enter wildcard patterns.
SAFAgent
The name of the SAF agent. You can specify one or more SAF agents for monitoring. In any
combination, select values from the discovered list, enter values manually, or enter wildcard patterns.
WSRMRemoteEndpoint

The name of the WSRM remote endpoint. You can specify one or more WSRM remote endpoints for
monitoring. In any combination, select values from the discovered list, enter values manually, or enter
wildcard patterns.

StatType

This parameter appliesonly to the countersthat are returning a count or total (FailedMessagesTotal is
one examplein thiscounter category). Possible values are:

ACTUAL The counter returnsthe raw data value.

INTERVAL The counter returnsthe difference between the raw value of the counter in the last
task interval and the raw data value of the counter in the current task interval.

Valid Wildcard Characters

For parametersthat can be defined with wildcard patterns, the valid wildcard characters are:

* Asterisk, represents zero or more characters as a wildcard.

? Question mark, represents any one individual character asa
wildcard.

A Caret, excludes all valuesthat match the specified pattern.

\ Backslash, precede a wildcard character with a backslash to

represent the wildcard character as part of the actual value.

For more information, see Entering Wildcard Parameters.

Data Point
For each counter that you haveincluded in atask:
! Theprimary data point (PDP) isthe value returned for that counter.

I Theintelligent data point (IDP) isthe set of valuesreturned for all countersin the counter
category.
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The data point type and the parameters specified in the task determine your data point. See WebLogic Data
Points for detail.
Interval

Recommended minimum is5 minutes.

WebSphere Counters

W ebShere Remote Extended Counters

The following dynamically discovered WebSphere remote extended counter categories are provided in
QALoad. Each category provides countersthat extend the monitoring of your WebSphere system. The
categories, counter names, and parameters are all dynamically discovered by processing data available from
the WebSphere Performance Monitoring Infrastructure.

Remote monitoring supports WebSphere versions: 4.0+, 5.0, and 6.0. The counters supported vary by
version.

WebSphere Alarm Manager Counters WebSphere ORB Perf Module
WebSphere Bean Module WebSphere Scheduler Module
WebSphere Cache Module WebSphere Servlet Sessions Module
WebSphere Connection Pool Module WebSphere System Module
WebSphere DCS Sack Counters WebSphere Thread Pool Module
WebSphere High Availability Manager Counters WebSphere Transaction Module
WebShere 2C Module WebSphere Web App Module
WebShere VM Runtime Module WebSphere Web Services Counters

W ebJphere Alarm Manager Counters

The counters discovered for the WebSphere Alarm Manger category are determined by the level of metrics
you set in WebSphere. The WebShere Alarm Manager data counters may include the following counters:

Counter Name (6.0 Counter Name Descrintion WebSphere | Level of
and greater) (5.0 or earlier) P Version Metrics

Total number of alarms
AlarmsCreatedCount created by all 5.0and High Long
asynchronous scopes for | above
this .WorkManager.
Number of alarms 5.0 and
AlarmsCancelledCount cancelled by the ; High Long
L above
application.
AlarmsFredCount Number of alarmsfired. ;%\?gd High Long

392



QALoad Online Help

AlarmLatencyDuration !_atency of alarms fired 5.0 and High Load
in milliseconds. above

AlarmsPendingSze Nu'm' ber of glarms 5.0 and High Load
waiting to fire. above

AlarmRate Number of alarmsfiring | 5.0 and High Load
per second. above

Parameters

The following parameters are valid for this counter category:

Node Name

Node or machine name to monitor. Select the node that you want to monitor from thelist of available
nodes. The default valueisthe first node in thelist of available nodes.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Server Name

Application server to monitor. Select the server name that you want to monitor from the list of
available servers. The default value isthe first application server in thelist.

You can specify one or more servers for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Instance Name

Instance name to monitor. Select the Instance name that you want to monitor from thelist of available
instances. The default valueisthefirst instancein thelist.

You can specify one or moreinstancesfor monitoring. In any combination, select values from the
discovered list, or enter values manually.
Primary Data Point
The datapoint type and the parameters specified in the task determine your datapoint. See WebSphere
IDPs (Intelligent Data Points): Long.
Interval

Recommended minimum is5 minutes.

W ebFphere Bean Module Counters

The counters discovered for the WebSphere Bean category are determined by the level of metricsyou set in
WebSphere. The WebSphere Bean data counters may include the following counters:

Counter Name (6.0 and Counter Name (5.0 o WebSphere Level of
———————~————| Description : :
greater) or earlier) Version Metrics

Number of
CreateCount creates times beans Low Long

3.5.5and

above
were created.
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RemoveCount

removes

Number of
times beans
were removed.

3.5.5 and
above

Low

Long

PassivateCount

passivates

Number of
times beans
were
passivated
(entity and
stateful).

3.5.5and
above

Low

Long

ActivateCount

activates

Number of
times beans
were activated
(entity and
stateful).

3.5.5 and
above

Low

Long

LoadCount

persistence loads

Number of
times bean
data was
loaded from
persistent
storage
(entity).

3.5.5 and
above

Low

Long

SoreCount

persistence stores

Number of
times bean
data was
stored in
persistent
storage
(entity).

3.5.5and
above

Low

Long

InstantiateCount

instantiations

Number of
times bean
objects were
instantiated.

3.5.5 and
above

Low

Long

FreedCount

destroys

Number of
times bean
objects were
freed.

3.5.5 and
above

Low

Long

Ready Count

Num Ready Beans

Number of
concurrently
ready beans
(entity and
session). This
counter was
called
concurrent
activein
Versions
3.5.5+ and 4.0.

3.5.5and
above

High

Load

394




QALoad Online Help

LiveCount

concurrent live

Number of
concurrently
live beans.

3.5.5 and
above

High Load

MethodResponseTime

avg method rsp time

Average
responsetime
in
milliseconds
on the bean
methods
(home,
remote, local).

3.5.5 and
above

High Long

CreateTime

avg method rsp time
for create

Average time
in
milliseconds a
bean create
call takes,
including the
timefor the
load, if any.

5.0

Medium | Long

LoadTime

avg method rsp time
for load

Average time
in
milliseconds
for loading the
bean data from
persistent
storage
(entity).

5.0

Medium | Long

SoreTime

avg method rsp time
for store

Average time
in
milliseconds
for storing the
bean datato
persistent
storage
(entity).

5.0

Medium | Long

RemoveTime

avg method rsp time
for remove

Average time
in
milliseconds a
bean entry call
takes,
including the
timeat the
database, if
any.

5.0

Medium | Long

MethodCallCount

total method calls

Total number
of method
calls.

3.5.5 and
above

High Long
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ActivationTime

avg method rsp time
for activation

Average time
in
milliseconds a
beanActivate
call takes,
including the
timeat the
database, if
any.

5.0

Medium

Long

PassivationTime

avg method rsp time
for passivation

Average time
in
milliseconds a
beanPassivate
call takes,
including the
timeat the
database, if
any.

5.0

Medium

Long

ActiveMethodCount

active methods

Number of
concurrently
active methods
- number of
methods called
at the same
time.

3.5.5 and
above

High

Long

RetrieveFromPoolCount

Per method
invocations

Number of
callsto the
bean methods
(home,
remote, local).

3.5.5and
above

Long

RetrieveFrom PoolSuccessCount

Per method rsp time

Average
responsetime
in
milliseconds
on the bean
methods
(home,
remote, local).

3.5.5 and
above

M ax

Long

ReturnsToPoolCount

Per method
concurrent
invocations

Number of
concurrent
invocationsto
call amethod.

5.0

Load

RetrieveFromPoolCount

getsFrom Pool

Number of
callsretrieving
an object from
the pool
(entity and
stateless).

3.5.5and
above

Low

Long
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RetrieveFrom PoolSuccessCount

getsFound

Number of
timesa
retrieve found
an object
availablein
the pool
(entity and
stateless).

3.5.5and
above

Low

Long

ReturnsToPoolCount

returnsToPool

Number of
callsreturning
an object to
the pool
(entity and
stateless).

3.5.5and
above

Low

Long

ReturnsDiscardCount

returnsDiscarded

Number of
timesthe
returning
object was
discarded
because the
pool was full
(entity and
stateless).

3.5.5 and
above

Low

Long

DrainsFromPoolCount

drainsFrom Pool

Number of
timesthe
daemon found
the pool was
idle and
attempted to
clean it (entity
and stateless).

3.5.5 and
above

Low

Long

DrainSze

avgDrainSze

Average
number of
objects
discarded in
each drain
(entity and
stateless).

3.5.5and
above

Medium

Long

PooledCount

avgPoolSze

Number of
objectsin the
pool (entity
and stateless).

3.5.5 and
above

High

Load

MessageCount

messageCount

Number of
m essages
delivered to
the bean on
M essage
method
(message

5.0

Low

Long
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driven beans).

M essageBackoutCount

m essageBackoutCount

Number of

m essages failed
to be delivered
to the bean on
M essage
method
(message
driven beans).

5.0

Low

Long

WaitTime

serverSession W ait

Average time
to obtain a
Server Session
from the pool
(message drive
bean).

5.0

Medium

Long

ServerSessionPoolUsage

serverSessionUsage

Percentage of
Server Session
pool in use
(message
driven).

5.0

High

Load

Parameters

The following parameters are valid for this counter category:

Enterprise Beans (WebSphere Versions 3 and 4)

Node Name

Node or machine nameto monitor. Select the node that you want to monitor from thelist of available
nodes. The default valueisthefirst nodein the list of available nodes.

You can specify one or more names for monitoring. In any combination, select values from the

discovered list, or enter values manually.

Server Name

Application server to monitor. Select the server name that you want to monitor from the list of

available servers. The default value isthe first application server in thelist.

You can specify one or more servers for monitoring. In any combination, select values from the

discovered list, or enter values manually.

Container

Name of bean container to monitor.

You can specify one or more names for monitoring. In any combination, select values from the

discovered list, or enter values manually.

Bean

Name of Enterprise JavaBeans (EB) to monitor.
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You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.

Enterprise Beans (WebSphere Version 5)

Node Name

Node or machine nameto monitor. Select the node that you want to monitor from thelist of available
nodes. The default valueisthe first node in the list of available nodes.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Server Name

Application server to monitor. Select the server name that you want to monitor from the list of
available servers. The default value isthe first application server in thelist.

You can specify one or more servers for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Application
Name of application to monitor.
You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Jar File
Name of jar fileto monitor.
You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.
EJB Type
Type of Enterprise JavaBeans (EJB) to monitor.
You can specify one or more types for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Bean
Name of Enterprise JavaBeans (EJB) to monitor.
You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Primary Data Point
The datapoint type and the parameters specified in the task determine your datapoint. See WebSphere
IDPs (Intelligent Data Points): Long or Load.
Interval

Recommended minimum is5 minutes.

Information presented in the table on thispageis:
Reprinted Courtesy of International Business Machines Corporation copyright (2005) (c) International Business Machines
Corporation.
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W ebFhere Cache Module Counters

The countersdiscovered for the Cache category are determined by the level of metricsyou set in
WebSphere. The Cache data counters may include the following counters:

Counter Name (6.0 and Counter Name (5.0 or _
——— .~ Description
greater) earlier)

Maximum
MaxInMemoryCacheEntryCou number of in- | 5.0 and Lon

maxinMemoryCacheSze Low
memory cache | above g

entries.

nt

Current
InMemoryCacheEntryCount inMemoryCacheSze number of in- | 5.0 and Low Lon
memory cache | above g

entries.

Aggregate of
template 5.0 and Low Lon
timeouts and above g

disk timeouts.

TimeoutlnvalidationCount totalTimeoutinvalidation

Requests for
HitsstnMemoryCount hitssnMemory g:aljzgfgzsa:c:e ;%id Low ;On

from memory.

Requests for

HitsOnDiskCount hitsOnDisk th|'s cacheable | 5.0 and Low Lon
object served above g

from disk.

Total explicit
ExplicitinvalidationCount explicitinvalidations !nvalldanon_ 5.0 and Low Lon
issued for this | above g

template.

Cacheentries
evicted from
memory by a
Least Recently
Used 5.0 and Lon
LrulnvalidationCount Irulnvalidations algorithm. ) Low
. above g
These entries
are passivated
to disk if disk
overflow is
enabled.

TimeoutinvalidationCount???? | .. L Cacheentries |5 g gng Lon
» timeoutlnvalidations evicted from Low

above g
memory
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and/or disk
because their
timeout has
expired.

InMemoryAndDiskCacheEntry
Count

Entries

Current
number of
cache entries
created from
thistemplate.
Refersto the
per-template
equivalent of
totalCacheSze

5.0 and
above

Low

Lon

MissCount

Misses

Requests for
this cacheable
object that
were not
found in the
cache.

5.0 and
above

Low

Lon

ClientRequestCount

RequestFrom Client

Requests for
this cacheable
object
generated by
applications
running on
the
application
server.

5.0 and
above

Low

Lon

DistributedRequestCount

requestsfFfom VM

Requests for
this cacheable
object
generated by
cooperating
cachesin this
cluster.

5.0 and
above

Low

Lon

ExplicitMemorylnvalidationCo
unt

explicitinvalidationsFromMe
mory

Explicit
invalidations
resulting in an
entry being
removed from
memory.

5.0 and
above

Low

Lon

ExplicitDisklnvalidationCount

explicitinvalidationsFromDis
k

Explicit
invalidations
resulting in an
entry being
removed from
disk.

5.0 and
above

Low

Lon

ExplicitinvalidationCount

explicitinvalidationsNoOp

Explicit

5.0 and

Low

Lon
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invalidations | above g
received for
thistemplate
whereno
corresponding
entry exists.

Explicit
invalidations
generated 50 and Lon
LocalExplicitinvalidationCount | explicitinvalidationsLocal locally, either above Low g
programmatic

ally or by a
cache policy.

Explicit
invalidations
RemoteExplicitinvalidationCou - - received from | 5.0 and Lon
explicitinvalidationsRemote . Low
nt acooperating | above g
MM in this

cluster.

Entries
received from 50 and Lon
RemoteCreationCount remoteCreations cooperating ) Low

. above g
dynamic

caches.

Parameters

The following parameters are valid for this counter category:
Dynamic Cache (WebSphere Version 5)

Node Name

Node or machine nameto monitor. Select the node that you want to monitor from thelist of available
nodes. The default value isthe first nodein thelist of available nodes.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Server Name

Application server to monitor. Select the server name that you want to monitor from the list of
available servers. The default value isthe first application server in thelist.

You can specify one or more servers for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Instance Name

Instance name to monitor. Select the instance name that you want to monitor from the list of available
instances. The default valueisthefirst instancein thelist.

You can specify one or more instances for monitoring. In any combination, select valuesfrom the
discovered list, or enter values manually.
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Primary Data Point

The datapoint type and the parameters specified in the task determine your datapoint. See WebSphere
IDPs (Intelligent Data Points): Long.

Interval

Recommended minimum is5 minutes.

Information presented in thetable on thispageis:
Reprinted Courtesy of International Business Machines Corporation copyright (2005) (c) International Business Machines
Corporation.

W ebFphere Connection Pool Module Counters

The counters discovered for the DBC Connection Pool category are determined by the level of metrics you
set in WebShere. The IDBC Connection Pool data counters may include the following listed counters.

Performance Monitoring Infrastructure (PM1) collects performance data for 4.0 and 5.0 JDBC data sources.
For a 4.0 data source, the data source name isused. For a 5.0 data source, the Java Naming and Directory
Interface (INDI) nameisused.

Counter Name (6.0 and Counter Name o WebSphere | Level of %
: Description . . Point
greater) (5.0 or earlier) | _ ——™ "= Version Metrics W

Total number of 355 and
CreateCount Creates connections - Low Long
above
created.
Bounded
PoolSze Avg Pool Sze Average pool size. 3.5.5 and High Range
above e
Satistic
Average free pool Bounded
FreePoolSze Free Pool Sze . 9 P 5.0 High Range
size. A
Satistic
Total number of
AllocateCount Allocates connections 3.5.5and Low Long
above
allocated.
Total number of 4.0 and
ReturnCount Returns connections ) Low Long
above
returned.
Number of threads
WaitingThreadCount Avg Waiting tha_lt_are currently | 3.5.5 and High Sat
Threads waiting for a above
connection.
Total number of
Connection Pool | faults, such as, 3.5.5and
FaultCount ; . Low Long
Faults timeouts, in above
connection pool.
Number of times 3.5.5 and
CloseCount Destroys bean objectswere o Low Long
freed. above
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Average waiting
timein

WaitTime Avg Wait Time millisecondsuntil |5.0 Medium | Long
aconnection is
granted.
Averagetime a
UseTime Avg Timein Use |connection is 5.0 Medium | Long
used.
Average percent of 355 and
PercentUsed Percent Used the pool that isin abo've High Sat
use.
Average percent of
PercentMaxed Percent Maxed thetlmgthat aII. 3.5.5 and High Sat
connectionsarein | above
use
Total number of
statements
: Satement Cache | discarded by the 4.0 and
PrepStmtCacheDiscardCount discard count LRU algorithm of | above Low Long
the statement
cache.
Number of
ManagedConnectionCount Number _Managed Manageq 5.0 Low Long
Connections Connection
objectsin use.
Number Current number of
ConnectionHandleCount . connection objects | 5.0 Low Long
Connections .
in use
Amount of timein
DBCTime JDBC Operation | milliseconds spent | ¢ Medium | Long
Timer executingin the
JDBC driver.
Concurrent
Waiters
Parameters

The following parameters are valid for this counter category:

JDBC Connection Pools (Versions 3 and 4)

Node Name

Node or machine nameto monitor. Select the node that you want to monitor from thelist of available

nodes. The default valueisthe first nodein thelist of available nodes.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.
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Server Name

Application server to monitor. Select the server name that you want to monitor from the list of
available servers. The default value isthe first application server in thelist.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, enter values manually, or enter wildcard patterns.

Data Source
Name of data source.
You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.

JDBC Connection Pools (Version 5)

Node Name

Node or machine nameto monitor. Select the node that you want to monitor from thelist of available
nodes. The default value isthe first nodein the list of available nodes.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Server Name

Application server to monitor. Select the server name that you want to monitor from the list of
available servers. The default value isthe first application server in thelist.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.

Provider
Name of data source provider to monitor.
You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.

Data Source
Name of data source to monitor.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.

Primary Data Point

The datapoint type and the parameters specified in the task determine your datapoint. See WebSphere
IDPs (Intelligent Data Points): Long, Sat, or Bounded Range Satistic.

Interval

Recommended minimum is5 minutes.

Information presented in the table on thispageis:
Reprinted Courtesy of International Business Machines Corporation copyright (2005) (c) International Business Machines

Corporation.
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W ebFhere DCS Sack Counters

The countersdiscovered for the WebSphere DCS Sack category are determined by the level of metrics you
set in WebSphere. The WebShere DCS Sack data counters may include the following counters:

Counter Name

(6.0 and greater)

Counter Name
(5.0 or earlier)

Description

WebSphere | Level of

Version

Metrics

Data Point Type

Number of message
buffer reallocations
dueto inadequate
buffer size. If this

Number of :
message buffer number is larger 6.0 and Medium | Long
. than 20 percent of | above
reallocations
the number of sent
m essages, you may
want to contact
IBM Support.
Minimal, maximal,
and average size (in
Qutgomg message bytes) of the 6.0 and High (AverageSatistic)
size messages that were | above
sent through the
DCS stack.
Number of
Number of sent messages sent 6.0 and High Lon
m essages through the DCS above 9 9
stack.
Minimal, maximal
and average size (in
I_ncomlng message bytes) of the 6.0 and High (AverageSatistic)
size messages that were | above
received by the
DCSstack.
Number of Number of 6.0 and .
received m essages m essages received above High Long
by the DCSstack.
Amount of time Amount of time
needed for the needed to 6.0 and
synchronization guarantee that all ) High Sat
. above
procedure to view members are
complete synchronized.
Number of
Number of messages that were
m essages retransmitted o
retransmitted by during the view 6.0 and . (AverageStatistic)
High
local member changeto ensure above

during the view
change

synchronization
with other
members.
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elp

Number of times
that the

Number of times
that the

synchronization synchronization 6.0 and Medium | Long
. : above
procedure timed procedure timed
out out.
Number_oft|mes Number of times
that ahigh . .
. that a high severity
severity )
. congestion event 6.0 and .
congestion event : Medium | Long
: for outgoing above
for outgoing
messages was
messages was .
. raised.
raised
Measuresthe
Coalesce Time amount of timeit | 6.0 and Medium Stat
actually takesto above
coalesce a view.
Measuresthetime
o to do amerge view Sat
ﬁ'r:e\“ew Change change. The DCS gb%\?gd High
stack is blocked
during thistime.
Measuresthetime
: to do a split view
Remove V.'eW change. DCSstack 6.0 and High Sat
Change Time . . above
isblocked during
thistime.
Measuresthe
number of times
Num.b.er of that the local 6.0 and High Long
suspicions above
member suspected
other members.
Number of times
Number of view that thismember 6.0 and .
. Medium | Long
changes underwent view above
changes.
Measuresthe size
. . of the group the 6.0 and : I
View group size local member above Medium | (AverageSatistic)

belongsto.

Parameters

The following parameters are valid for this counter category:

Node Name

Node or machine nameto monitor. Select the node that you want to monitor from thelist of available

nodes. The default valueisthefirst nodein thelist of available nodes.
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You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Server Name

Application server to monitor. Select the server name that you want to monitor from the list of
available servers. The default value isthe first application server in thelist.

You can specify one or more serversfor monitoring. In any combination, select valuesfrom the
discovered list, or enter values manually.
Instance Name

Instance name to monitor. Select the Instance name that you want to monitor from thelist of available
instances. The default valueisthe first instancein thelist.

You can specify one or more instances for monitoring. In any combination, select valuesfrom the
discovered list, or enter values manually.
Primary Data Point
The datapoint type and the parameters specified in the task determine your datapoint. See WebSphere
IDPs (Intelligent Data Points): Long.
Interval

Recommended minimum is5 minutes.

W ebSphere High Availability Manager Counters

The countersdiscovered for the WebSphere High Availability Manager category are determined by the level
of metricsyou set in WebSphere. The WebSphere High Availability Manager data counters may include the
following counters:

Counter Name (6.0 || Counter Name (5.0 . WebSphere| Level of Da_ta
g Description : : Point
and greater) or earlier) Version Metrics Type

Number of local Total number of local 6.0 and
groups groups. above

High Load

Timetaken in
millisecondsto rebuild
the global group state.
During the rebuild
time, no fail-over can
happen. If thistimeis
too high and is
unacceptable for the

desired availability, | o0 31¢
you may want to
increase the number
of coordinators. For
proper operation of
this counter, you must
host the active
coordinator in an
application server

Group state rebuild

time High Sat

above
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other than the
deployment manager.

Number of bulletin-
board subjects

Total number of
subjects managed.

6.0 and
above

High Load

Number of bulletin-
board subscriptions

Total number of
bulletin-board
subscriptions.

6.0 and
above

High Load

Bulletin-board rebuild
time

Time taken in
millisecondsto rebuild
the global state of the
bulletin-board. During
thistime no messages
will bereceived by the
subscribers. If this
timeistoo high, and
isunacceptable, you
may want to increase
the number of
coordinators. For
proper operation of
thiscounter, you must
host the active
coordinator in an
application server
other than the
deployment manager.

6.0 and
above

High Sat

Number of local
bulletin-board
subjects

Total number of
subjects being posted
to locally. The number
includesthe proxy
postings (if any) done
by the core group
bridge service on
behalf of servers
belonging to different
WebSphere cells.

6.0 and
above

High Load

Number of local
bulletin-board
subscriptions

Total number of local
subject subscriptions.
The number includes
the proxy
subscriptions (if any)
done by the core
group bridge service
on behalf of servers
belonging to different
WebSphere cells.

6.0 and
above

High Sat

Parameters

The following parameters are valid for this counter category:
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Node Name

Node or machine nameto monitor. Select the node that you want to monitor from thelist of available
nodes. The default valueisthe first node in thelist of available nodes.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Server Name

Application server to monitor. Select the server name that you want to monitor from the list of
available servers. The default value isthe first application server in thelist.

You can specify one or more serversfor monitoring. In any combination, select valuesfrom the
discovered list, or enter values manually.
Instance Name

Instance name to monitor. Select the Instance name that you want to monitor from thelist of available
instances. The default valueisthefirst instancein the list.

You can specify one or more instances for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Primary Data Point
The datapoint type and the parameters specified in the task determine your datapoint. See WebSphere
IDPs (Intelligent Data Points): Long.
Interval

Recommended minimum is5 minutes.

W ebSphere 2C Connection Pool Module Counters

The counters discovered for the 2C Connection Pool category are determined by the level of metricsyou
set in WebSphere. The 2C Connection Pool data counters may include the following counters:

Counter Name (6.0 and CORIET . WebSphere Level of
Name (5.0 Description : :
greater) : Version Metrics
or earlier)
. Number Number of Managed 5.0 and
ManagedConnectionCount | managed . . . Low Long
X Connection objectsin use. above
connections
ConnectionHandleCount Number' Current'numbgr of . 5.0 and Low Long
connections | connection objectsin use. above
Number
CreateCount manageq Total num ber of 5.0 and Low Long
connections | connections created. above
created
Number
CloseCount manageq Total num ber of 5.0 and Low Long
connections | connections destroyed. above
destroyed
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Number
AllocateCount manage(_j Total num ber of 5.0 and Low Long
connections | connectionsallocated. above
allocated
Number
FreedCount manage(_j Total num ber of 5.0 and Low Long
connections | connectionsfreed. above
freed
Number of faults, such as 50 and
FaultCount faults timeouts, in the connection ) Low Long
above
pool.
FreePoolSze free pool size Number of free connections | 5.0 and High Sat
in the pool. above
PoolSze pool size Pool size. 5.0 and High Sat
above
concurrent Average number of threads 50 and
WaitingThreadCount : concurrently waiting for a ) High Load
waiters : above
connection.
PercentUsed Percent used Avergg_e percent of the pool | 5.0 and High Load
that isin use. above
Average percent of thetime
PercentMaxed Percent that all connectionsarein 5.0 and High Load
maxed above
use.
Average wait Average waiting timein 50 and
WaitTime . 9 milliseconds until a ) Medium | Long
time S above
connection isgranted.
Average use Average time in 5.0 and
UseTime . g millisecondsthat ’ Medium | Long
time : ) above
connectionsarein use.
Parameters

The following parameters are valid for this counter category:

J2C Connection Pools (WebSphere Version 5)

Node Name

Node or machine nameto monitor. Select the node that you want to monitor from thelist of available

nodes. The default valueisthefirst nodein thelist of available nodes.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.

Server Name

Application server to monitor. Select the server name that you want to monitor from the list of

available servers. The default value isthe first application server in thelist.
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You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Instance Name

Instance name to monitor. Select the instance name that you want to monitor from the list of available
instances. The default valueisthefirst instancein the list.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.

Primary Data Point

The datapoint type and the parameters specified in the task determine your datapoint. See WebSphere
IDPs (Intelligent Data Points): Long, Load, or Sat.

Interval

Recommended minimum is5 minutes.

Information presented in thetable on thispageis:
Reprinted Courtesy of International Business Machines Corporation copyright (2005) (c) International Business Machines
Corporation.

W ebShere Java Virtual Machine (M) Runtime Module Counters

The countersdiscovered for the Java Virtual Machine (VM) category are determined by the level of metrics
you set in WebSphere. The WM data counters may include the following counters:

Counter Level
Counter Name (6.0 Name (5.0 Description WebSphere of
and greater) ; Version P p—
or earlier) ___~ " Metrics
FreeMemory Free Free memory in VM run time. 3.5.5 and Low Long
memory above
UsedMemory Used Used memory in VM run time. 3.5.5 and Low Long
memory above
HeapSze Total Total memory in VM run time. 3.5.5 and High Long
memory above
UpTime Up time Thea}mount of timethe WM is 5.0 and Low Long
running. above
Number Number of garbage collection calls.
GCCount garbage This cour'mter |spot avgllablg unless | 4.0 and M ax Long
collection - Xrunpm Jvnpi Profil er isset above
calls when starting the WM.
Aver Average garbage collection in
timeeage seconds between two garbage
. collection. This counter isnot 4.0 and
GClintervalTime between available unless - above M ax Long
garbage . . . .
collection Xrunpm Jvnpi Profil er isset
when starting the VM.
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Average duration of a garbage
Average . . .
collection. This counter isnot
. garbage , 4.0 and
GCTime . available unless - M ax Long
collection . . : : above
duration Xrunpm Jvnpi Profil er isset
when starting the VM.
Number of timesthat athread waits
Aum waits for alock.This counter isnot 4.0 and
W aitsForLockCount available unless - ) M ax Long
for alock . . : : above
Xrunpm Jvnpi Profil er isset
when starting the VM.
avg time Average time that athread waits for
WaitForLockTime waiting for alock. This counter |s.not avgulablg 4.0 and M ax Long
lock unless- Xrunpm Jvnpi Profil er is | above
set when starting the WM.
Number of objects allocated in heap.
Number of . . )

: . Thiscounter isnot availableunless | 4.0 and
ObjectAllocateCount | objects ) : ) : M ax Long
allocated - Xrunpm Jvnpi Profil er isset above

when starting the WM.
ObjectMovedCount
Number of objectsin heap. This
Number of . .

. counter isnot available unless - 4.0 and
objects : : . : M ax Long
found Xrunpm Jvnpi Profil er isset above

when starting the VM.
Number of objectsfreed in heap.
Number of : X )
. . Thiscounter isnot availableunless | 4.0 and
ObjectFreedCount objects ) . . : M ax Long
freed - Xrunpm Jvnpi Profil er isset above
when starting the WM.
Number of threads started. This
counter isnot availableunlessthe- | 4.0 and
ThreadStartedCount XrunpmidmpiProfiler option isset | above
when starting the WM.
Number of failed threads. This
counter isnot availableunlessthe- | 4.0 and
ThreadEndedCount XrunpmidmpiProfiler option isset | above
when starting the WM.
Parameters

The following parameters are valid for this counter category:

JVM Runtime (WebSphere All Versions)

Node Name

Node or machine nameto monitor. Select the node that you want to monitor from thelist of available
nodes. The default value isthe first nodein thelist of available nodes.
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You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Server Name

Application server to monitor. Select the server name that you want to monitor from the list of
available servers. The default value isthe first application server in thelist.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Primary Data Point
The datapoint type and the parameters specified in the task determine your datapoint. See WebSphere
IDPs (Intelligent Data Points): Long.
Interval

Recommended minimum is5 minutes.

Information presented in thetable on thispageis:
Reprinted Courtesy of International Business Machines Corporation copyright (2005) (c) International Business Machines

Corporation.

W ebSphere Object Pool Counters

The counters discovered for the WebSphere Object Pool category are determined by the level of metrics
you set in WebSphere. The WebSphere Object Pool data counters may include the following counters:

Counter Name (6.0 Counter Name (5.0 . WebSphere | Level of Da_lta
- = : Description — : Point
and greater) or earlier) Version Metrics Type

. Total number of 5.0 and .
ObjectsCreatedCoun objects created. above High Long
Number of objects 5.0 and
ObjectsAllocatedCount requested from the ab High Long
ove
pool.
. Number of objects 5.0 and .
ObjectsReturnedCount returned to the pool. | above High Long
Average number of 50 and
IdleObjectsSze idle object instances ) High Load
. above
in the pool.
Parameters

The following parameters are valid for this counter category:

Node Name

Node or machine name to monitor. Select the node that you want to monitor from thelist of available
nodes. The default value isthe first nodein thelist of available nodes.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.

Server Name
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Application server to monitor. Select the server name that you want to monitor from thelist of
available servers. The default value isthe first application server in thelist.

You can specify one or more serversfor monitoring. In any combination, select valuesfrom the
discovered list, or enter values manually.
Instance Name

Instance name to monitor. Select the Instance name that you want to monitor from thelist of available
instances. The default valueisthe first instancein thelist.

You can specify one or more instances for monitoring. In any combination, select valuesfrom the
discovered list, or enter values manually.
Primary Data Point
The datapoint type and the parameters specified in the task determine your datapoint. See WebSphere
IDPs (Intelligent Data Points): Long.
Interval

Recommended minimum is5 minutes.

W ebSphere ORB Perf Module Counters

The counters discovered for the Object Request Broker (ORB) category are determined by the level of
metricsyou set in WebSphere. The ORB data counters may include the following counters:

Counter Name (6.0 and| Counter Name (5.0
greater) or earlier)

Description

WebSphere Level of
Version Metrics

Thetime (in
milliseconds) to look
up an object reference | 5.0 and

LookupTime referenceLookupTime before method above Medium | Long
dispatch can be
carried out.
Thetotal number of 50 and
RequestCount num Request requests sent to the ) Low Long
above
ORB.
The number of
requeststhat are 50 and
ConcurrentRequestCount | concurrentRequests concurrently above High Load

processed by the
ORB.

Thetime (in
milliseconds) it takes | 5.0 and
aregistered portable | above

interceptor to run.

ProcessingTime processingTime Medium | Long

Parameters

The following parameters are valid for this counter category:
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Object Request Broker (WebSphere Version 5)

Node Name

Node or machine nameto monitor. Select the node that you want to monitor from thelist of available
nodes. The default value isthe first nodein the list of available nodes.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Server Name

Application server to monitor. Select the server name that you want to monitor from the list of
available servers. The default value isthe first application server in thelist.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Instance Name

Instance name to monitor. Select the instance name that you want to monitor from thelist of available
instances. The default valueisthefirst instancein the list.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Primary Data Point
The datapoint type and the parameters specified in the task determine your datapoint. See WebSphere
IDPs (Intelligent Data Points): Long or Load.
Interval

Recommended minimum is5 minutes.

Information presented in thetable on thispageis:
Reprinted Courtesy of International Business Machines Corporation copyright (2005) (c) International Business Machines
Corporation.

W ebShere Scheduler Module Counters

The countersdiscovered for the WebSphere Scheduler category are determined by the level of metrics you
set in WebSphere. The WebSphere Scheduler data counters may include the following counters:

Counter Name (6.0 || Counter Name (5.0 . WebSphere| Level of Da}ta
- = Description : : Point
and greater) or earlier) Version Metrics Type

. Number of tasks that 5.0 and .
TaskFailureCount failed to run. above High Long
. Number of tasks that 5.0 and .
TaskFinishCount ran successfully. above High Long
Number of poll cycles 50 and '
PollCount completed for all High Long
above
daemon threads.
TaskEinishRate Number of tasksrun 5.0 and High Load
per second. above
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Number of collisions
encountered per 50 and
TaskCollisionRate second between ; High Load
: above
competing poll
daemons.
Sart timein
. milliseconds for each 5.0 and .
PollQueryDuration poll daemon thread's | above High Load
database poll query.

. Timein milliseconds | 5.0 and .
RunDuration taken to run atask.. above High Load
TaskExpirationRate Number of tasksin a 5.0 and High Load

poll query. above
Period of timein 50 and
TaskDelayDuration secondsthat the task ) High Load
. above
isdelayed.
PollDuration Number of seconds 5.0 and High Load
between poll cycles. above
Number of tasksrun
by each poll daemon
thread. (Multiply this 50 and
TaskRunRate by the number of poll ) High Load
above
daemon threadsto get
the tasksrun per
effective poll cycle.)
Parameters

The following parameters are valid for this counter category:

Node Name

Node or machine nameto monitor. Select the node that you want to monitor from thelist of available
nodes. The default value isthe first node in thelist of available nodes.

You can specify one or more names for monitoring. In any combination, select values from the

discovered list, or enter values manually.

Server Name

Application server to monitor. Select the server name that you want to monitor from the list of
available servers. The default value isthe first application server in thelist.

You can specify one or more servers for monitoring. In any combination, select values from the

discovered list, or enter values manually.

Instance Name

Instance name to monitor. Select the instance name that you want to monitor from the list of available
instances. The default valueisthe first instancein thelist.
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You can specify one or moreinstancesfor monitoring. In any combination, select values from the

discovered list, or enter values manually.

Primary Data Point

The datapoint type and the parameters specified in the task determine your datapoint. See WebSphere
IDPs (Intelligent Data Points): Long.

Interval

Recommended minimum is5 minutes.

Information presented in thetable on thispageis:
Reprinted Courtesy of International Business Machines Corporation copyright (2005) (c) International Business Machines

Corporation.

W ebFhere Servlet Sessions Module Counters

The countersdiscovered for the Servlet Sessions category are determined by the level of metricsyou set in
WebSphere. The Servlet Sessions data counters may include the following counters:

Counter Name (6.0 and
greater)

Counter Name (5.0

or earlier)

Description ‘ WebSp_her
e Version

Number of sessions

3.5.5and

CreateCount createdSessions created. above Low Long
InvalidateCount invalidatedSessions !\lumper of sessions | 3.5.5 and Low Long
invalidated. above
LifeTime sessionLifeTime A.VGrage session 3.5.5 and Mediu Long
lifetime. above m
Number of
concurrently active
sessions. A session is
ActiveCount activeSessions gctlve It WebSphere | 3.5.5 and High Load
iscurrently above
processing arequest
that usesthat
session.
Number of sessions 50 and
LiveCount liveSession that are currently ) High Load
. above
cached in memory.
Appliesonly to
session in memory
with
_ | AllowOverflow=fals
NoRoomForNewSessionCoun | NoRoomForNewSessio g_ The number of 50 Low Long
t n timesthat arequest

for anew session
cannot be handled
because it would
exceed the
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maximum session
count.

CacheDiscardCount

cacheDiscards

Number of session
objectsthat have
been forced out of
the cache. (An LRU
algorithm removes
old entriesto make
room for new
sessions and cache
misses). Applicable
only for persistent
sessions.

5.0

Low Long

ExternalReadTime

externalReadTime

Time (in
milliseconds) taken
in reading the
session data from
persistent store. For
multi-row sessions,
the metrics are for
the attribute; for
single-row sessions,
the metrics are for
the whole session.
Applicable only for
persistent sessions.
When usingaJMS
persistent store, you
have the choice of
whether to serialize
the data being
replicated. If you
choose not to
serialize the data,
the counter isnot
available.

504

Mediu Long

ExternalReadSze

externalReadSze

Sze of session data
read from persistent
store. Applicable
only for (serialized)
persistent sessions;
similar to
externalReadTime
above.

5.0

Mediu Lon

ExternalWriteTime

externalWriteTime

Time (milliseconds)
taken to writethe
session data from
the persistent store.
Applicable only for
(serialized)
persistent sessions.
Smilar to

5.0

Mediu Lon
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externalReadTime
described above.

ExternalWriteSze

externalWriteSze

Sze of session data
written to persistent
store. Applicable
only for (serialized)
persistent sessions.
Smilar to
externalReadTime
described above.

5.0

Mediu

Lon

AffinityBreakCount

affinityBreaks

The number of
requests received for
sessionsthat were
last accessed from
another Web
application. This
can indicate failover
processing or a
corrupt plug-in
configuration.

5.0

Low

Long

SessionObjectSze

serializableSessObjSze

The size in bytes of
(the attributesthat
can be serialized)
in-memory sessions.
Only count session
objectsthat contain
at least one
attribute object that
can be serialized.
Note that a session
may contain some
attributesthat can
be serialized and
some that are not.
Thesizein bytesis
at a session level.

5.0

Long

TimeSncelLastActivated

timeSnceLastActivate
d

Thetimedifference
in milliseconds
between previous
and current access
time stamps. Does
not include session
time out.

5.0

Mediu

Long

TimeoutlnvalidationCount

invalidatedViaTimeou
t

The number of
requests for a
session that no
CountSatistic
exists, presumably
because the session
timed out.

5.0

Low

Long

420




QALoad Online Help

Number of requests
for a session that no
longer exists,
presumably because
the session timed 5.0 Low Long
out. Use this
counter to help
determineif the
timeout istoo short.

ActivateNonExistSessionCou | attemptToActivateNot
nt ExistentSession

Parameters

The following parameters are valid for this counter category:
Servlet Sessions (WebSphere Versions 3 and 4)

Node Name

Node or machine nameto monitor. Select the node that you want to monitor from thelist of available
nodes. The default valueisthefirst nodein the list of available nodes.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Server Name

Application server to monitor. Select the server name that you want to monitor from the list of
available servers. The default value isthe first application server in thelist.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.

Servlet Sessions (WebSphere Version 5)

Node Name

Node or machine nameto monitor. Select the node that you want to monitor from thelist of available
nodes. The default valueisthefirst nodein the list of available nodes.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Server Name

Application server to monitor. Select the server name that you want to monitor from the list of
available servers. The default value isthe first application server in thelist.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.

Application
Name of application to monitor.
You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.

War File
Name of war fileto monitor.
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You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Primary Data Point
The datapoint type and the parameters specified in the task determine your datapoint. See WebSphere
IDPs (Intelligent Data Points): Long or Load.
Interval

Recommended minimum is5 minutes.

Information presented in thetable on thispageis:
Reprinted Courtesy of International Business Machines Corporation copyright (2005) (c) International Business Machines
Corporation.

W ebFphere System Module Counters

The countersdiscovered for the System category are determined by the level of metricsyou set in
WebSphere. The System data counters may include the following counters:

Data
Counter Name (6.0 and greater) ARG AN Description UEDESNCTE Iﬁ;ﬁligsf Point

(5.0 or earlier) Version

Type

Average system
CPU utilization
taken over the
timeinterval
sincethelast
reading. Because
thefirst call is
required to
perform
initialization, an
CPUUsageSncelLastMeasurement percentCpuUsage invalid va_lue 5.0 Low Long

such asOis
returned. All
subsequent calls
return the
expected value.
On SMP
machines, the
valuereturned is
the utilization
averaged over all
CPUs.

The amount of
real free memory
available on the
system. Real
memory that is 50
not allocated is
only alower
bound on
available real
memory, since

FreeMemory freeMemory Low Long
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many operating
systems take
some of the
otherwise
unallocated
memory and use
it for additional
I/O buffering.
The exact
amount of buffer
memory that can
be freed up is
dependent on
both the
platform and the
application(s)
running on it.

The average
percentCpuUsage
CPUUsageSnceServerSarted avgCpuUtilization | that isbusy after | 5.0 Medium | Long
the server is
started.

Parameters

The following parameters are valid for this counter category:
System Performance (WebSphere Version 5)

Node Name

Node or machine nameto monitor. Select the node that you want to monitor from thelist of available

nodes. The default valueisthefirst nodein thelist of available nodes.
You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.

Server Name

Application server to monitor. Select the server name that you want to monitor from the list of
available servers. The default value isthe first application server in thelist.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.

Primary Data Point

The datapoint type and the parameters specified in the task determine your datapoint. See WebSphere
IDPs (Intelligent Data Points): Long.

Interval

Recommended minimum is5 minutes.

Information presented in the table on thispageis:
Reprinted Courtesy of International Business Machines Corporation copyright (2005) (c) International Business Machines
Corporation.
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W ebSphere Thread Pool Module Counters

The counters discovered for the Thread Pool category are determined by the level of metricsyou set in
WebShere. The Thread Pool data counters may include the following counters:

Counter Counter

Name (6.0 Description WebSpher Level_of
“and greater) i - Version Metrics| ————
and greater) or earlier)

CreateCount Thread Total number of threads created. 3.5.5 and Low Long
creates above

DestroyCount Thread Total number of threads destroyed. 3.5.5and Low Long
destroys above

ActiveCount Active Number of concurrently active 3.5.5and High Load
threads threads. above

PoolSze Pool size Average number of threadsin pool. 25563eand High Load

PercentM axed Percent Average per_cent of thetime that all 3.5.5and High Load
maxed threadsarein use. above

Parameters

The following parameters are valid for this counter category:
Thread Pools (WebSphere All Versions)

Node Name

Node or machine name to monitor. Select the node that you want to monitor from thelist of available
nodes. The default value isthe first node in thelist of available nodes.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Server Name

Application server to monitor. Select the server name that you want to monitor from the list of
available servers. The default value isthe first application server in thelist.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Pool
Name of thread pool to monitor.
You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Primary Data Point
The datapoint type and the parameters specified in the task determine your datapoint. See WebSphere
IDPs (Intelligent Data Points): Long or Load.
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Recommended minimum is5 minutes.

Information presented in thetable on thispageis:
Reprinted Courtesy of International Business Machines Corporation copyright (2005) (c) International Business Machines

Corporation.

W ebSphere Transaction Module Counters

QALoad Online Help

The countersdiscovered for the Transaction category are determined by thelevel of metricsyou set in
WebShere. The Transaction data counters may include the following counters:

Counter Name (6.0 and

Counter Name Description
(5.0 or earlier) _ bescription

WebSphere Level of
Version Metrics

greater)
Number global Total number of 4.0 and
GlobalBegunCount transactions global transactions above Low Long
begun begun on server.
Total number of
Number global global transactions 4.0 and
GloballnvolvedCount transactions involved on server ’ Low Long
. above
involved (for example, begun
and imported).
Number local Total number of
. . 4.0 and
LocalBegunCount transactions local transactions above Low Long
begun begun on server.
. Number of
ActiveCount Active g]obal concurrently active 3.5.5 and Low Load
transactions ) above
global transactions.
. Active local Number of . 4.0 and
LocalActiveCount . concurrently active Low Load
transactions . above
local transactions.
Global .
GlobalTranTime transactions Average durat|9n of |3.5.5and Medium | Sat
. global transactions. | above
duration
LocalTranTime Local'transactlon Average durat'lon of | 4.0 and Medium | stat
duration local transactions. above
Local transactions | LUEEICCIR D ) o and
GlobalBeforeCompletionTime | before_completion —comp i Medium | Stat
. for local above
time .
transactions.
. Average duration of
GlobalCommitTime Global'trgnsacnon commit for global 4.0 and Medium | Sat
commit time . above
transactions.
GlobalPrepareTime Global transaction | Average duration of | 4.0 and Medium | Stat
prepare time prepare for global above
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transactions.
Local transaction | pBRECTERAE | 0 and
LocalBeforeCompletionTime before_completion — P ) Medium | Sat
. for local above
time .
transactions.
. Average duration of
LocalCommitTime Local t_ran_sactlon commit for local 4.0 and Medium | Stat
commit time : above
transactions.
Number global Total number of
: . ; 3.5.5and
CommittedCount transactions global transactions Low Long
. . above
committed committed.
Number of global | Total number of 355 and
RolledbackCount transactionsrolled | global transactions o Low Long
above
back rolled back.
Number of global
Number global transactions
S . . 4.0 and
OptimizationCount transactions converted to single Low Long
T above
optimized phase for
optimization.
Number of local Number of local 4.0 and
LocalCommittedCount transactions transactions ) Low Long
. . above
committed committed.
Number of local Number of local 4.0 and
LocalRolledbackCount transactionsrolled | transactionsrolled ) Low Long
above
back back.
Number of global | Number of global 4.0 and
GlobalTimeoutCount transactionstimed | transactionstimed above Low Long
out out.
Number of local Number of local 4.0 and
LocalTimeoutCount transactionstimed | transactionstimed above Low Long
out out.

Parameters

The following parameters are valid for this counter category:

Transactions (All Versions)

Node Name

Node or machine nameto monitor. Select the node that you want to monitor from thelist of available
nodes. The default value isthe first node in thelist of available nodes.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.

Server Name
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Application server to monitor. Select the server name that you want to monitor from thelist of
available servers. The default value isthe first application server in thelist.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Primary Data Point
The datapoint type and the parameters specified in the task determine your datapoint. See WebSphere
IDPs (Intelligent Data Points): Long, Load, or Sat.
Interval

Recommended minimum is5 minutes.

Information presented in thetable on thispageis:
Reprinted Courtesy of International Business Machines Corporation copyright (2005) (c) International Business Machines
Corporation.

W ebSphere W eb App Module Counters

The countersdiscovered for the Web Application category are determined by the level of metricsyou set in
WebSphere. The Web Application data counters may include the following counters:

Counter Name (6.0 Counter Name Description WebSphere Level of
and greater) (5.0 or earlier) P Version Metrics

Number of servletsthat were | 3.5.5 and

LoadedServietCount | numLoadedServiets Low Long
loaded. above

ReloadCount numReloads Number of servletsthat were | 3.5.5 and Low Load
reloaded. above

RequestCount totalRequests Total number of requests a 3.5.5and Low Long
servlet processed. above

ConcurrentRequests | concurrentRequests Number of requests that are | 3.5.5 and High Sat
concurrently processed. above
Responsetime, in 355 and

ServiceTime responseTime milliseconds, of a servlet abc;ve Medium | Long
request.
Total number of errorsin a 3.5.5 and

ErrorCount numErrors servlet or Java Server Page allao.ve Low Long

(JSP).

Parameters

The following parameters are valid for this counter category:
Web Applications (Versions 3 and 4)

Node Name

Node or machine nameto monitor. Select the node that you want to monitor from thelist of available
nodes. The default value isthe first nodein the list of available nodes.
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You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Server Name

Application server to monitor. Select the server name that you want to monitor from the list of
available servers. The default value isthe first application server in thelist.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.

Application
Name of application to monitor.
You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.

Servlet
Name of servlet to monitor.
You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.

Web Applications (Version 5)

Node Name

Node or machine nameto monitor. Select the node that you want to monitor from thelist of available
nodes. The default value isthe first node in thelist of available nodes.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Server Name

Application server to monitor. Select the server name that you want to monitor from the list of
available servers. The default value isthe first application server in thelist.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.

Application
Name of application to monitor.
You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.

War File
Name of war file to monitor.
You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.

Servlet
Name of servlet to monitor.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.
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Primary Data Point

The datapoint type and the parameters specified in the task determine your datapoint. See WebSphere
IDPs (Intelligent Data Points): Long, Load, or Sat.

Interval

Recommended minimum is5 minutes.

Information presented in thetable on thispageis:
Reprinted Courtesy of International Business Machines Corporation copyright (2005) (c) International Business Machines
Corporation.

W ebFphere W eb Services Module Counters

The countersdiscovered for the WebSphere Web Service category are determined by the level of metrics
you set in WebSphere. The WebShere Web Service data counters may include the following counters:

Counter
Counter Name (6.0 and Name (5.0 or Description WebSphere LeveI' of
greater) carlier) Version Metrics

LoadedWebServiceCount Number of loaded Web | 5.02 and Low Long

Services. above

Number of requeststhe |5.02 and

ReceivedRequestCount service received. above Low Long
. Number of requeststhe |5.02 and
DispatchedRequestCount service dispatched. above Low Long
Number of requeststhe 502 and
ProcessedRequestCount service successfully ) Low Sat
above
processed.
Average response time,
ResponseTime in milliseconds, for a 5.02 and High Sat
above
successful request.
Average response time,
RequestResponseTime in milliseconds, to 5.02 and Medium | Sat
prepare arequest for above
dispatch.
Average response time, 5.02 and

DispatchResponseTime in milliseconds, to Medium | Sat
. above
dispatch arequest.

Average response time,

ReplyResponseTime in milliseconds, to 5.02 and Medium | Sat
prepare areply after above
dispatch.

PayloadSze Average paylogd sizein | 5.02 and Medium | Sat
bytes of a received above
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request or reply.

Average payload sizein | 5.02 and

bytes of arequest. above Medium | Sat

RequestPayloadSze

Average payload sizein | 5.02 and

bytes of areply. above Medium | Sat

ReplyPayloadSze

Parameters

The following parameters are valid for this counter category:

Node Name

Node or machine nameto monitor. Select the node that you want to monitor from thelist of available
nodes. The default valueisthefirst nodein the list of available nodes.

You can specify one or more names for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Server Name

Application server to monitor. Select the server name that you want to monitor from the list of
available servers. The default value isthe first application server in thelist.

You can specify one or more servers for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Instance Name

Instance name to monitor. Select the instance name that you want to monitor from the list of available
instances. The default valueisthefirst instancein the list.

You can specify one or more instances for monitoring. In any combination, select values from the
discovered list, or enter values manually.
Primary Data Point
The datapoint type and the parameters specified in the task determine your datapoint. See WebSphere IDPs
(Intelligent Data Points): Long.
Interval

Recommended minimum is5 minutes.

Information presented in thetable on thispageis:
Reprinted Courtesy of International Business Machines Corporation copyright (2005) (c) International Business Machines
Corporation.

WebSphere MQ Counters

W ebShere MQ Remote Extended Counters

The following extended WebShere MQ remote countersare provided in QALoad. These counters extend
the monitoring of your WebSphere MQ system:

Channel Events Queue Manager Connections
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Channel Satus
Error Log Entries
Percent Queue Depth
Performance Events

Queue Depth
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Queue Manager Events
Queue Manager Satistics
Queue Manager Up/Down

Queue Satistics

WebShere MQ Channd Events

Thiscounter reportsthe number of channel events for the current interval.

Parameters

Queue Manager

Queue manager you are monitoring.

Event Name

Fecify the name(s) of the event(s) you want to monitor. All eventson the queue are monitored unless
event name(s) are selected.

Event Name

Description

Channel Activated

Thiscondition isdetected when achannel that has been waiting
to become active,and for which a Channel Not Activated event
has been generated, isnow able to become active, because an
active slot has been released by another channel.

Channel Auto-
Definition Error

Automatic channel definition failed.

Channel Auto-
Definition OK

Automatic channel definition succeeded.

Channel Conversion

This condition isdetected when achannel isunableto carry out

Error data conversion.
Channel Not The channel isunable to establish the connection because the
Activated limit on the number of active channels has been reached.

Channel Sarted

An instance of achannel has been successfully established

Channel Sopped

The channel was stopped.

User

Channel Sopped By

The channel has been stopped by the operator.

Primary Data Point

The primary data point is the number of channel events for the specified queue for the current interval.

Intelligent Data Point
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The intelligent data point displaysthe number of channel events, description of individual events
(event name, date & time that the message was put on the event queue, name of the queue manager
that put the message, queue associated with the event, and reason code).

Channel eventsarereported by channels as aresult of conditions detected during their operation. For
example, when achannel instance is stopped. Channel events are generated:

Interval

Recommended

By acommand to start or stop achannel
When achannel instance starts or stops
When achannel receives a conversion error warning when getting a message.

When an attempt ismade to create a channel automatically; the event is generated whether
the attempt succeeds or fails.

minimum is5 minutes.

W ebSphere MQ Channd Satus

Thiscounter reportstherunning state of achannel. Thiscounter cannot be used for client-connection

channels.

Parameters

Queue Manager

Queue manager you are monitoring.

Channel

Channel you are monitoring.

Primary Data Point

The primary data point is the running state of a channel.

"1" if the channel is active.
"0"if the channel isnot active.
"-1" if an error occurred.

Intelligent Data Point

The intelligent data point liststhe queue manager, channel name, and status, or if an error occurred.

Interval

Recommended minimum is5 minutes.

WebSPhere MQ

Error Log Entries

This counter reportsthe number of errorsin the MQ error log file for the current interval. It uses standard
Java file processing API functionsto gather the information.

El Note: This counter does not appear in the discovery dataif the MQ instance was configured as
remotein the agent manager.

Parameters

Error Number
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Joecify All Errors, asingle error number, or an error number range to monitor.

Error Number Range Description
AMQ3500-AM Q3999 WebSphere MQ for Windows
m essages.
AMQ4000-AM Q4999 WebSphere MQ for Windows NT
User Interface messages.
AMQ5000-AM Q5999 Installable services messages.
AMQ6000-AM Q6999 Common services messages.
AMQ7000-AM Q7999 WebSphere MQ product messages.
AMQ8000-AM Q8999 WebSphere MQ administration
m essages.
AMQ9000-AM Q9999 Rem ote messages.

Primary Data Point

The primary data point is the number of errorsin the error log file for the current interval.

Intelligent Data Point

There are three alternatives for what isreturned for the intelligent data point. It depends on what you
selected for the Error Number parameter.

The data point detail lists each error and the number of timesit occurred within theinterval.

One error chosen:
! Number of errorsin interval that match the error number.
! Each error range and count for the range.
I Total errorsduring theinterval.
Error range chosen:
I Number of errorsin interval that are within chosen range.
I Top 10 errorsin range.
I FError range and count for the range.
I Total errorsduring theinterval.
All errorschosen:
I Number of errorsin interval.
I Top 10 errors.
! Error and count.
I FError range and count for the range.
I Total errorsduring theinterval.

Interval

Recommended minimum is5 minutes.
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W ebSphere MQ Percent Queue Depth

This counter reportsthe current queue depth as a percentage of the defined maximum.

Parameters

Queue Manager

Queue manager you are monitoring.

Queue

Name of the queue you are monitoring.

Primary Data Point

The primary data point is the current queue depth as a percentage of the defined maximum.

Intelligent Data Point

The intelligent data point liststhe queue manager, queue, current queue depth, and percent queue

depth.

Interval

Recommended minimum is5 minutes.

W ebSphere MQ Performance Events

Thiscounter reportsthe number of performance events for the current interval.

Parameters

Queue Manager

Queue manager you are monitoring.

Performance Event Queue

Name of the performance event queue that you are monitoring. The default valueis
SYSTEM.ADMIN.PERFM .EVENT.

Event Name

Foecify the name(s) of the event(s) you want to monitor. All eventson the queue are monitored unless
event name(s) are selected.

Event Name Description

Queue Depth High Queue depth high limit reached or exceeded.

Queue Depth Low Queue depth low limit reached or exceeded.

Queue Full Queue already contains maximum number of
m essages.

Queue Service Interval No successful gets or putshave been detected
High within an interval greater than the limit
specified in the Q Service Interval attribute.
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Queue Service Interval | A successful get has been detected within an
OK interval lessthan or equal to the limit specified
in the Q Service Interval attribute.

Primary Data Point

The primary data point is the number of performance events for the specified queue during the current
interval.

Intelligent Data Point

Theintelligent data point displaysthe number of performance events, description of individual events
(performance event type, event name, date & time that the message was put on the event queue, name
of the queue manager that put the message, queue associated with the event, time since reset, high
gueue depth, message enqueue count, message dequeue count and reason code).

Performance events are notificationsthat athreshold condition has been reached by aresource. The
conditions can affect the performance of applicationsthat use a specified queue. Performance event
types are:

! Queue Depth High

I Queue Depth Low

I Queue Full

I Queue Service Interval High
I Queue Service Interval OK

Performance event statistics are reset when a performance event occurs or a queue manager stops and
restarts.

Interval

Recommended minimum is5 minutes.

W ebFPhere MQ Queue Depth

Thiscounter monitorsthe current depth of the specified queue.

Parameters

Queue Manager

Queue manager you are monitoring.

Queue

Name of the queue you are monitoring.

Primary Data Point

The primary data point is the number of messages on queue.

Intelligent Data Point

Theintelligent data point liststhe queue manager, queue, and queue depth.

Interval

Recommended minimum is5 minutes.
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W ebSPhere MQ Queue Manager Connections

Thiscounter reportsthe current number of connectionsto a queue manager.
Parameters

Queue Manager

Queue manager you are monitoring.

Primary Data Point

The primary data point is the positive integer representing the number of connectionsor "-1" if an error
occurred.

Intelligent Data Point

The intelligent data point liststhe queue manager, the number of active connections, and the
connection names. If an error occurred, then it displaysthe error number and description.

Interval

Recommended minimum is5 minutes.

WebShere MQ Queue Manager Events

This counter reportsthe number of queue manager events for the current interval.
Parameters

Queue Manager

Queue manager you are monitoring.

Queue Manager Event Queue
Name of the queue manager event queue you are monitoring. The default valueis
SYSTEM.ADMIN.QMGR.EVENT.

Event Name

Foecify the name(s) of the event(s) to monitor. All eventson the queue are monitored unless event
name(s) are selected.

Event Name Description

Alias Base Queue Type The Base Q Name in the alias queue definition resolvesto a queue

Error that isnot alocal queue, or local definition of aremote queue.
Default Transmission Either alocal definition of the remote queue was specified, or a
Queue Type Error gueue-manager aliaswas being resolved, but in either case the

XmitQName attributein the local definition isblank.

Default Transmission The queue defined by the DefXmitQNamequeue-manager attribute
Queue Usage Error doesnot have a Usage attribute of MQUS TRANSMISSION.
Get Inhibited Getsinhibited for the queue.
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Not Authorized The user isnot authorized for access.

Put Inhibited Put callsinhibited for the queue.

Queue Manager Active | Queue manager created.

Queue Manager Not Queue manager unavailable.

Active

Queue Type Error Queuetypenot valid.

Remote Queue Name Remote queue name not valid.

Error

Transmission Queue Transmission queue not local.

Type Error

Transmission Queue Transmission queue with wrong usage.

Usage Error

Unknown Alias Base The BaseQName in the alias queue attributesis not recognized as a
Queue gueue name.

Unknown Default The XmitQName attribute in the local definition isblank.

Transmission Queue

Unknown Object Name | The Object Name in the object descriptor isnot recognized for the
specified object type.

Unknown Remote An error occurred with the queue-name resolution.
Queue Manager

Unknown Transmission | The XmitQName attribute of the definition isnot blank and not
Queue the name of alocally-defined queue.

Primary Data Point

The primary data point is the number of queue manager eventsfor the current interval.

Intelligent Data Point

Theintelligent data point displaysthe number of queue manager events, description of individual
events (Queue manager event type, event name, date & time that the message was put on the event
gueue, name of the queue manager that put the message, and reason code).

Queue manager events are eventsthat are related to the definitions of resources within queue
managers. For example, an application attemptsto put a message to a queue that does not exist.
Queue manager event types are: authority, inhibit, local, remote, and start/stop.

Event Type Reason Code

I Not Authorized (type 1)
I Not Authorized (type 2)
I Not Authorized (type 3)
I Not Authorized (type 4)
I Get Inhibited

Authority Events

Inhibit Events

437



Using the Conductor

I Put Inhibited

Local Events

I Alias Base Queue Type Error
I Unknown Alias Base Queue
I Unknown Object Name

Remote Events

! Default Transmission Queue Type
Error

! Default Transmission Queue Usage
Error

I Queue Type Error

I Remote Queue Name Error

I Transmission Queue Type Error
I Transmission Queue Usage Error

I Unknown Default Transmission
Queue

I Unknown Remote Queue Manager
I Unknown Transmission Queue

Sart and Stop
Events

I Queue Manager Active

I Queue Manager Not Active

Interval

Recommended minimum is5 minutes.

W ebFphere MQ Queue Manager Satistics

This counter reports statistics describing a queue manager.

Parameters

Queue Manager

Queue manager you are monitoring.

Statistic
Foecify the statistic to

use asthe primary data point.:

Authority Events

Reportsthe on/off value of Authority events. Authority eventsindicate
that an authorization violation has been detected.

Automatic Channel
Definition Events

Reportsthe on/off value of Automatic Channel Definition events.
Automatic channel definition eventsindicate whether an automatic
definition of achannel fails or succeeds.

Inhibit Events

Reportsthe on/off value of Inhibit events. Inhibit eventsindicate that
an MQPUT or MQGET operation has been attempted against a queue,
wherethe queueisinhibited for putsor getsrespectively.

Local Events

Reportsthe on/off value of Local events. Local eventsindicate that an
application (or the queue manager) has not been ableto accessalocal
queue, or other local object.
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Performance Events

Reportsthe on/off value of Performance events. Performance events are
notificationsthat athreshold condition has been reached by a resource.
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Remote Events

on another queue manager.

Reportsthe on/off value of Remote events. Remote eventsindicate that
an application (or the queue manager) cannot access a (remote) queue

Start Stop Events

quiesce.

Reportsthe on/off value of these events. Sart and stop eventsindicate
that a queue manager has been started or has been requested to stop or

Primary Data Point

The primary data point is the one of the following statistics as specified by the Statistics parameter:

! Authority Events

I Automatic Channel Definition Events
! Inhibit Events
! Local Events

! Performance Events

I Authority Events

I Automatic Channel Definition Events

Intelligent Data Point

The intelligent data point liststhe queue manager and queue manager statistics. Thiscounter reports
the current state of the statistics, it does not report the statistics values asthey progressthrough time.
For dynamic information, monitor with the Queue Manager Event counter. Asappropriate, any of the
following information may be included:

Data

Description

Authority Events

Variable that storesthe on/off value of

= <integer> these events. Authority eventsindicate
that an authorization violation has
been detected.

Automatic Variable that storesthe on/off value of

Channel these events. Automatic channel

Definition Events | definition eventsindicate whether an

= <integer> automatic definition of a channel fails

or succeeds.

Inhibit Events =
<integer>

Variable that storesthe on/off value of
these events. Inhibit eventsindicate
that an MQPUT or MQGET operation
has been attempted against a queue,
where the queueisinhibited for putsor
getsrespectively.

Local Events =
<integer>

Variable that storesthe on/off value of
these events. Local eventsindicate
that an application (or the queue
manager) hasnot been able to access a
local queue, or other local object.
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Performance Variable that storesthe on/off value of

Events = these events. Performance events are

<integer> notificationsthat athreshold
condition has been reached by a
resource.

Remote Events= | Variable that storesthe on/off value of
<integer> these events. Remote eventsindicate
that an application (or the queue
manager) cannot access a (remote)
gueue on another queue manager.

Sart Sop Events | Variable that storesthe on/off value of
= <integer> these events. Sart and stop events
indicate that a queue manager has
been started or has been requested to
stop or quiesce.

Cluster Workload | Cluster workload exit data.
Data = <wstring>

Command Level | Level of system control commands
= <integer> supported by the queue manager.

Interval

Recommended minimum is5 minutes.

W ebFPphere MQ Queue Manager Up/Down

Thiscounter monitorstherunning state of a queue manager.
Parameters

Queue Manager

Queue manager you are monitoring.

Primary Data Point

The primary data point is the running state of queue manager.
I "1"if the queue manager isrunning.
I "0"if the queue manager isnot running.
I "-1"if an error occurred.

Intelligent Data Point

Theintelligent data point liststhe queue manager and whether the queue manager isup, down, or an
error occurred.

Interval

Recommended minimum is5 minutes.
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W ebFphere MQ Queue Satistics

This counter reports statistics describing a queue.

Parameters

Queue Manager

Queue manager you are monitoring.

Queue

Name of the queue you are monitoring.

Statistic

Foecify the statistic to use asthe primary data point.

Current Depth

Reportsthe current number of messages on queue.

Queue Depth High
Event

Reportsthe on/off value of these events. Queue depth high events
indicate that the queue depth hasincreased to a predefined threshold.

Queue Depth Low
Event

Reportsthe on/off value of these events. Queue depth low events

indicate that the queue depth has decreased to a predefined threshold.

Queue Depth Max
Event

Reportsthe on/off value of these events. Queue depth max events
indicate that the queue hasreached itsmaximum depth, that is, the
queue isfull.

Queue Service
Interval Event

Reportsthe on/off value of these events. Queue service interval events
arerelated to whether messages are processed within a user-specified
timeinterval.

Primary Data Point

The primary data point is the one of the following statistics as specified by the Statistics parameter:
I Current Depth
I Queue Depth High Event
! Queue Depth Low Event

! Queue Depth Max Event

I Queue Service Interval Event

Intelligent Data Point

Theintelligent data point liststhe queue manager, queue, and queue statistics. This counter reportsthe
current state of the statistics, it does not report the statistics values asthey progressthrough time. For
dynamic information, use the Queue Manger Events counter. Asappropriate, any of the following

information may beincluded:

Data

Description

Inhibit Get = <integer>

Indicateswhether get operations are allowed on the queue.

Inhibit Put = <integer>

Indicateswhether put operations are allowed on the queue.
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Current Queue Depth =
<integer>

Current number of messages on the queue.

Maximum Queue Depth
= <integer>

Maximum number of messages allowed on the queue.

Queue Depth High
Event = <integer>

Variable that storesthe on/off value of these events. Queue depth
high eventsindicate that the queue depth hasincreased to a
predefined threshold.

Queue Depth High Limit
= <integer>

Valuethat triggersan event if it isreached.

Queue Depth Low Event
= <integer>

Variable that storesthe on/off value of these events. Queue depth low
eventsindicate that the queue depth has decreased to a predefined
threshold.

Queue Depth Low Limit
= <integer>

Value that triggers an event if it isreached.

Queue Depth Max Event
= <integer>

Variable that storesthe on/off value of these events. Queue depth
max eventsindicate that the queue hasreached its maximum depth,
that is, the queueisfull.

Queue Service Interval
Event = <integer>

Variable that storesthe on/off value of these events. Queue service
interval eventsarerelated to whether messages are processed within a
user-specified time interval.

Queue Service Interval =
<integer>

Queue service interval time.

Trigger Data = <wstring>

Free-format datathat iswritten into atrigger message.

Trigger Depth =
<integer>

Number of messagesthat have to be on the queue before a trigger
message is written.

Trigger Control =
<integer>

Controlswhether or not trigger messages are written to an initiation
queue.

Interval

Recommended minimum is5 minutes.

WMI Counters

W MI Remote Extended Counters

The following extended WMI (Windows Management Instrument) remote counters are provided in
QALoad. To display and use the extended countersin task configuration, you must configure user access
with the MM C (Microsoft Management Console) and configurethe WMI agent using the ServerVantage
Agent Console (Reconfigure Agent). These procedures are described in the topic Configuring WMI in the
ServerVantage Agent Configuration online help. Once configuration iscomplete, and you select WMI

collector asyour Server Type during task configuration on the Select Counters page, ServerVantage

discoversthe Windows registry counters and the extended counters for each WMI-configured server.

These counters extend the monitoring of your WMI system:
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WMI WQL WMI Top Ten Counters:

I CPU Utilization % - Top Ten
I Memory Utilization % - Top Ten
I 1/O Utilization % - Top Ten

WMI Top Ten Counters
I Top Ten CPU
I Top Ten Memory
I Top Ten I/O

CPU Utilization % - Top Ten

The CPU Utilization % - Top Ten counter provides data for the Load Characterization Report. It returnsa
numeric value for each of the top ten processes that utilize the most machine CPU or all processes for
which CPU utilization is greater than 0.01% at a particular moment of time.

Thiscounter does not generate events.

Parameter

The Process parameter is not modifiable. Itsvalue isan * (asterisk), which monitorsall processes.

DataPoints

The datapoints are viewable (see above counter description).

Memory Utilization % - Top Ten

The Memory Utilization % - Top Ten provides data for Load Characterization Report. It returnsanumeric
value for each of the top ten processesthat utilize the most machine Memory or all processes for which
Memory utilization is greater than 0.01% at a particular moment of time.

Thiscounter does not generate events.

Parameter

The Process parameter is not modifiable. Itsvalue isan * (asterisk), which monitorsall processes.

DataPoints

The datapoints are viewable (see above counter description).

I/O Utilization % - Top Ten

The I/O Utilization % - Top Ten provides data for Load Characterization Report. It returnsanumeric value
for each of the top ten processesthat utilize the most machine I/O or all processes for which 1/0O utilization
isgreater than 0.01% at a particular moment of time.

Thiscounter does not generate events.

Parameter

The Process parameter is not modifiable. Itsvalue isan * (asterisk), which monitorsall processes.

DataPoints

The datapoints are viewable (see above counter description).
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WMI WQL
The WMI WQL (Windows Query Language) counter monitorsthe object (s) specified by the WQL
statement. Users may select predefined WQL templates.

Parameters

WQL Statement
Enter avalid WQL (WMI Query Language) statement.

Data Point

Primary Data Point
The primary data point returns 0 if the WMI system executed query is successful. If the query fails, the
graph displays DATA_NOT_FOUND asthe data point. If you click on the data point, the actual error is
provided in the error description.

Intelligent Data Point
Theintelligent data point (IDP) istheresponse from the query.

Interval

Recommended minimum interval 5 minutes.

Oracle Application Server Counters

Oracle AS Counters

ServerVantage providesthe following dynamically discovered Oracle Application Server (AS) remote
extended counter categories for remote monitoring of Oraclel0g Application Server performance metrics.
Each category provides countersand parametersthat extend the monitoring of your Oracle ASsystem. The
Oracle ASagent dynamically discoversall available counters and parameter values. The available categories
and metricsvary by installation. The Oracle ASagent supports wild-carded parameters and resource
blackouts.

Supported platformsfor Oracle ASinclude:

I Solaris ! Microsoft Windows 2000 with Service Pack 3 or above

I AIX I Microsoft Windows Server 2003 (32-bit)

I HP I Microsoft Windows XP (not all components are supported)
I Linux

Oracle AS Counter Categories

Oracle ASEBB Method Metrics Oracle ASIM S Session Metrics

Oracle ASEntity Bean Metrics Oracle ASIM S Sore Metrics

Oracle ASHTTP OC4JMetrics Oracle ASIMSTemp Destination Metrics
Oracle ASHTTP Server Metrics Oracle AS JServ JSP Metrics

Oracle ASHTTP Server Module Metrics Oracle AS JServ Metrics
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Oracle ASHTTP Server Response Metrics
Oracle ASHTTP Server Virtual Host Metrics
Oracle ASIDBC Connection Metrics
Oracle ASIDBC Connection Source Metrics
Oracle ASIDBC Metrics

Oracle ASIDBC Statement Metrics

Oracle ASIM S Browser Metrics
Oracle ASIM S Connection Metrics

Oracle ASIMSConsumer Metrics

Oracle ASIMSDurable Subscription Metrics
Oracle ASIMSMetrics

Oracle ASIM S Persistence Metrics

Oracle ASIM S Producer Metrics

10g Release 2 Counter Categories

Oracle ASPortal Cache Metrics
Oracle ASPortal Cache Summary Metrics
Oracle ASPortal DB Provider Metrics

Oracle Application Server Entity Bean Metrics

QALoad Online Help

Oracle AS JServ Servlet Metrics
Oracle AS JServ Zone Metrics

Oracle ASJSP Metrics

Oracle ASIVM Metrics

Oracle ASNotification Server Metrics
Oracle ASOC4JTransaction Manager Metrics
Oracle ASPLSQL Metrics

Oracle AS Portal Engine Metrics
Oracle ASProcess Manager Metrics
Oracle AS Serviet Metrics

Oracle ASTask Manager Metrics
Oracle ASWeb Module Metrics

Oracle AS Portal Page Metrics
Oracle ASPortal DB Repository Metrics
Oracle ASPortal Web Provider Metrics

The Oracle Application Server (AS) Entity Bean Metrics category includesthe counterslisted in the

following table.

Counters

Description

exclusive-write-access | Possible values: true or false. Value

Oracle Application Server HTTP OC4JMetrics

The Oracle Application Server (AS HTTP OC4JMetrics category includesthe counterslisted in the

following table.

Counters

to routeto an OC4J

Foecifiesthe total number of requests, both
ErrReq session and non-session, that mod_oc4j failed | Count | Operations

Description

Fecifiesthe total number of non-session

ErrReqNon Sess requeststhat mod_oc4j failed to routeto an Count | Operations
OC4Jprocess.
Secifiesthe total number of session requests

ErrReqSess that mod_oc4j failed to routeto an OC4J Count | Operations
process.
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Failover

Soecifiesthe total number of failoversfor both
non-session and session requests.

Count

Operations

VMCnt

Secifiesthe total number of routed OC4J
NMMsthat belong to thisdestination.

Value

Number of
NMs

Non SessFailover

Secifiesthe total number of failoversfor non-
session requests.

Count

Operations

SessFailover

Secifiesthe total number of failovers.

Count

Operations

SucReq

Soecifiesthe total number of requests, both
session and non-session, that mod_oc4j
successfully routed to an OC4J.

Count

Operations

SucRegNon Sess

Secifiesthe total number of non-session
requeststhat mod_oc4j successfully routed to
an OC4Jprocess.

Count

Operations

SucReqSess

Secifiesthe total number of session requests
that mod_oc4j successfully routed to an OC4J
process.

Count

Operations

ErrReq

Soecifiesthe total number of requests, both
session and non-session, that mod_oc4j failed
to routeto an OC4J.

Count

Operations

ErrReqNon Sess

Secifiesthe total number of non-session
requeststhat mod_oc4j failed to route to an
oc4j process.

Count

Operations

ErrReqSess

Soecifiesthe total number of session requests
that mod_oc4j failed to routeto an OC4J
process.

Count

Operations

Failover

Soecifiesthe total number of failoversfor both
non-session and session requests.

Count

Operations

Non SessFailover

Soecifiesthe total number of failoversfor non-
session requests. For example, assume that
thismount point was serviced by an OC4J
Island with three ¥M's (WM 1, WM2 and
JVM3). A new non-session request isrouted to
VM1, WM1 failsto service the request, and
therequest isfailed over to WM2. VM2 fails
to service the request, and so the request is
failed over to WM 3. At thispoint the

Non SessFailover.Count isincremented by 2.

Operations

SessFailover

Soecifiesthe total number of failovers for
session requests. For example, assume that
thismount point was serviced by an OC4J
Island with three ¥M's (WM 1, WM2 and
JVM3). A session request isrouted to WM 1.
VM1 failsto service the request. So, the
request isfailed over to WM?2. At this point

Count

Operations
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the SessFailover.Count isincremented by 1.
VM2 failsto service the request, and so the
request isfailed over to WM 3. At this point
the SessFailover.Count isincremented by 2.

Soecifiesthe total number of requests, both

process.

SucRegNon Sess session and non-session, that mod_oc4j Count | Operations
successfully routed to an OC4Jinstance.
Secifiesthe total number of session requests

SucReqSess that mod_oc4j successfully routed to an OC4J | Count | Operations

IncorrectReqlnit

Total number of times an internal error
occurred. There could be anumber of reasons,
including mod_oc4j not finding a connection
endpoint and configuration errors.

Count | Operations

Oc4jUnavailable

Total number of timesthat an oc4j VM could
not be found to service requests.

Count | Operations

UnableToHandleReq

Total number of times mod_oc4j declined to
handle arequest.

Count | Operations

Oracle Application Server HTTP Server Metrics

The Oracle Application Server (AS) HTTP Server Metrics category includesthe counterslisted in the

following table.

Counters Description
busyChildren Number of child processes active. Value
childFinish Number of child processesthat finish. | Count
childSart Number of child processesthat start. Count

connection.active

Number of connections currently open. | Number

Threads

Average time spent servicing HTTP

connection.avg . Value Microseconds
connections.

connection.maxTime Maximum tlm_e spent servicing any Microseconds
HTTP connection.

connection.minTime Minimum t|m_espent servicing any Microseconds
HTTP connection.

. . Total time spent servicing HTTP .

connection.time . Microseconds
connections.

error Count

get Count

handle.active

Child servers currently in the handle

Threads

447



Using the Conductor

processing phase.

handle.avg Average time spent in module handler. Microseconds

handle.completed Number of timesthe handle processing Operations
phase has completed.

handlemaxTime Maximum time spent in module Microseconds
handler.

handleminTime Minimum time spent in module Microseconds
handler.

handle.time Total time spent in module handler. Microseconds

internalRedirect Number of t|mesgmodulered|rected 2 | count Operations
request to anew, internal URI.

lastConfigChange Value

numChildren Number of child processes. Value

numMods Number of loaded modules. Value Operations

post Count

readyChildren Value

request.active Child servers currently in the request Threads
processing phase.

request.av Average time required to service an Microseconds

q -avg HTTP request.
request.completed Number of HTTP request completed. Operations
. Maximum time required to service an .
request. maxTime HTTP request. Microseconds
- Minimum time required to service an .

request.minTime HTTP request. Microseconds

request.time Total timerequired to service HTTP Microseconds
requests.

responseSze Value

Oracle Application Server HTTP Server Module Metrics

The Oracle Application Server (AS HTTP Server Module Metrics category includesthe counterslisted in the

following table.

Counters

Description ‘ Type ‘

decline Number of requests declined. Count Operations
handle.active Number of requests currently being Active | Requests
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handled by thismodule.

handle.avg

Average time required for thismodule.

Microseconds

handle.completed

Number of requests handled by this
module.

Operations

handleemaxTime

Maximum time required for this
module.

Microseconds

handleeminTime

Minimum time required for this
module.

Microseconds

handle.time

Total time required for thismodule.

Microseconds

Oracle Application Server HTTP Server Responses Metrics

The Oracle Application Server (AS) HTTP Server Responses Metrics category includesthe counterslisted in

the following table.

Counters

Response

Description

Number of timesthe response was
generated for each HTTP response

type.

Count

Oracle ASHTTP Server Virtual Host Metrics

The Oracle Application Server (AS) HTTP Server Virtual Host Metrics category includesthe counterslisted
in thefollowing table.

‘ Type

Counters Description Units
request.active Active requests. Threads
request.avg Average time for request processing. Microseconds
request.completed | Number of completed requests. Operations
request.maxTime | Maximum timeto complete arequest. Microseconds
request. minTime | Minimum time to complete arequest. Microseconds
request.time Microseconds
responseSze Value Bytes
vhostType Value

Oracle Application Server DBC Connection Metrics

The Oracle Application Server (AS) JDBC Connection Metrics category includesthe counterslisted in the

following table.

The parent parameter you select for these counters determines whether you get totals or data source-

specific metrics.
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Average time spent creating a new
statement.

CreateNewStatement.avg Milliseconds

Number of timesarequest for a
CreateNewSatement.completed | statement failed to be satisfied from Operations
the cache.

Maximum time spent creating a

new statement. Milliseconds

CreateNewSatement.maxTime

Minimum time spent creating a

new statement. Milliseconds

CreateNewSatement.minTime

Time spent creating a new
statement (thisdoesnot include the
time required to parsethe
statement).

CreateNewSatement.time Milliseconds

Average time spent getting a
CreateSatement.avg statement from the statement Milliseconds
cache.

Number of timesarequest for a
CreateStatement.completed statement was satisfied from the Operations
cache.

Maximum time spent getting a
CreateSatement.maxTime statement from the statement Milliseconds
cache.

Minimum time spent getting a
CreateSatement.minTime statement from the statement Milliseconds
cache.

Time spent getting a statement

from the statement cache. Milliseconds

CreateSatement.time

SatementCacheHit Satement found in cache. Count | Operations

SatementCacheMiss Satement not found in cache. Count | Operations

Oracle Application Server DBC Connection Source Metrics

The Oracle Application Server (AS) JDBC Connection Source Metrics category includesthe counterslisted
in the following table.

Counters Description Type

CacheFreeSze Number. of free dlotsin the Operations
connection cache.

! Maximum number of fr tsin .
CacheFreeSze.maxValue aximu _u ber of free slots Connections
the connection cache.
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CacheFreeSze.minValue Minimum n_umber of free slotsin Connections
the connection cache.

CacheFreeSze Number_of free dotsin the Connections
connection cache.

CacheGetConnection.active Threads

Average time spent getting a

. Milliseconds
connection from the cache.

CacheGetConnection.avg

Number of times this PhaseEvent

CacheGetConnection.completed has started and ended.

Operations

Maximum time spent getting a

. Milliseconds
connection from the cache.

CacheGetConnection.maxTime

Minimum time spent getting a

. Milliseconds
connection from the cache.

CacheGetConnection.minTime

Time spent getting a connection

from the cache or not. Milliseconds

CacheGetConnection.time

Number of timesarequest for a
CacheHit connection hasbeen satisfied from | Count
the cache.

Number of timesarequest for a
CacheMiss connection failed to be satisfied Count
from the cache.

CacheSze Total size of the connection cache. | Value

Oracle Application Server DBC Metrics

The Oracle Application Server (AS) JDBC Metrics category includesthe counterslisted in the following
table.

JDBC data source metrics are only available for non-emulated data sources. You are only able to access
JDBC data source metrics if the data source you created isfor anon-emulated data source, including
OrionCMTDataSource and OracleXADataSource.

Counters Description

ConnectionCloseCount Total number of connections Count | Operations
that have been closed.

. . Current number of threads .
ConnectionCreate.active ; . Operations
creating connections.

Average time spent creating

. Milliseconds
connections.

ConnectionCreate.avg

Number of timesthis PhaseEvent

ConnectionCreate.completed has started and ended.

Operations
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Maximum time spent creating

. Milliseconds
connections.

ConnectionCreate.maxTime

Minimum time spent creating

. Milliseconds
connections.

ConnectionCreate.minTime

ConnectionCreate.time Time spent creating connections. Milliseconds

ConnectionOpenCount Total number of connections Count | Operations
that have been opened.

Oracle Application Server DBC Satement Metrics

The Oracle Application Server (AS) JDBC Satement Metrics category includesthe counterslisted in the
following table.

The JDBC Satement Metrics are only available for DBC connectionsthat have enabled statement caching
and set the property or acl e. j dbc. DMSSt at erent Cachi ngMetri cs to thevalue true. When JDBC
statement caching isdisabled, you can make the JDBC statement metrics available by setting the property
oracl e. jdbc. DMSSt at enent Metri ¢s to true. To improve performance and to avoid collecting expensive
metrics, by default these properties are both set to false.

The parent parameter you select for these counters determineswhether you get totals or data source-
specific metrics.

Counters ‘ Description Type ‘ Units

Thetimethisstatement has spent
executing the SQL including the first

Execute fetch and thetime required to parsethe Time Milliseconds
statement.
Fetch Thetimethisstatement has spent in Time Milliseconds

other fetches.

Oracle Application Server M S Browser Metrics

The Oracle Application Server (AS) JM SBrowser Metrics category includesthe counterslisted in the
following table.

Counters Description Type

System.currentTimeMillis() when this
browser was created.

startTime ctor Milliseconds

Interval timer metric (PhaseEvent Sensor)
for every major method call in thisbrowser
object; callsto hasMoreElement and
nextElement are made on individual
method-name enumeration objects, but counted as Normal
PhaseEventsin the browser object to
simplify data collection. Multiple
enumerations can be active on the same
browser.
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Oracle Application Server MS Connection Metrics

The Oracle ASIMS Connection Metrics category includesthe counterslisted in the following table.

Counters Description

ValueisTruewhen the MS
isLocal connection islocal tothe OC4J Value Boolean
M Sserver in the same WM.

iSXA ye}luelsTruewhen the connection value Boolean
isin XA mode.

Remote M Sserver port for this
port connection; set only for non-local | Value Integer
connections.

System.currentTimeMillis() when

: . Value Milliseconds
thisconnection was created.

startTime

Interval timer metric (PhaseEvent
method-name Sensor) for every major method Normal
call in thisconnection object.

Oracle Application Server MS Consumer Metrics
The Oracle Application Server (AS) M SConsumer Metrics category includesthe counterslisted in the
following table.

Counters ‘ Description Type Units

The nolLocal setting of a
nolLocal subscription; set only for topic Value Boolean
consumers.

System.currentTimeMillis() when

: Value Milliseconds
thisconsumer was created.

startTime

Interval timer metric (PhaseEvent
method-name Sensor) for every major method Normal
call in thisconsumer object.

Oracle Application Server M S Durable Subscription Metrics

The Oracle Application Server (AS) M SDurable Subscription Metrics category includesthe counterslisted
in the following table.

Counters Description

Valueis True when the durable
isActive subscription iscurrently active Value Boolean
(being used by a consumer).
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nolLocal

The noLocal flag for thisdurable
subscription.

Value

Boolean

Oracle Application Server MS Metrics

The Oracle Application Server (AS) M SMetrics category includesthe counterslisted in the following table.

Number of M Sconnections (local and

OC4JIM S server was started.

connections remote) created by the M Sserver. Normal | Operations

debug ocdj.jms.debug OC4JIM Scontrol knob ctor Boolean
value.
ocdj.jms.forceRecovery OC4JIMS

forceRecovery ctor Boolean
control knob value.

listenerAttempts ocdj.jms.listenerAttempts OC4JIMS ctor Integer
control knob value.

maxOpenFiles ocdj.jms.maxOpenFilesOC4JM S ctor Integer
control knob value.

maxOpenFiles ocdj.jms.maxOpenFilesOC4JMS ctor Integer
control knob value.
ocdj.jms.messagePoll OC4JIM Scontrol

m essagePoll ctor Boolean
knob value.
ocdj.jms.noDms OC4JIM Scontrol

noDms ctor Boolean
knob value.

saveAllExpired ocdj.jms.saveAllExpired OC4JMS ctor Milliseconds
control knob value.
ocdj.jms.serverPoll OC4JJIM Scontrol

serverPoll ctor Integer
knob value.

socketBufsize ocdj.jms.socketBufsize OC4JIM S ctor Boolean
control knob value.

. ocdj.jms.usePersistence OC4JIMS

usePersistence ctor Boolean
control knob value.

useUUID ocdj.jms.useUUID OC4JIM Scontrol ctor Integer
knob value.
TCP/IP port on which the JM Sserver

port : . ) . ctor Integer
listensfor incoming connections.

requestHandlers.count Number of request handlers created by Normal | Integer
the M Sserver.

startTime.value System.currentTimeMillis() when the ctor Milliseconds
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Scheduling interval of the OC4Jtask

taskManagerinterval manager (and the scheduling interval ctor Milliseconds
for the OC4JJIM Sexpiration task).
Interval timer metric (PhaseEvent

method-name Sensor) for every major method call in | Normal

the OC4J M S server.

Oracle Application Server MS Persistence Metrics

The Oracle Application Server (AS) M S Persistence Metrics category includesthe counterslisted in the

following table.

Counters ‘

Description Type Units
holePageCount Num_ber c_)f 5.12b pages currently Normal Integer
freein thisfile.
Valueis Truewhen the persistence
isOpen file descriptor is currently open (for | Normal Boolean
LRU caching).
System.currentTimeMillis() when
lastUsed this persistence file was last used Normal Milliseconds
(for LRUcaching).
usedPageCount N“”.‘ber .Of .512b pages currently in Normal Integer
usein thisfile.
Interval timer metric (PhaseEvent
method-name Sensor) for every major method Normal
call in the persistence file object.

Oracle Application Server MS Producer Metrics

The Oracle Application Server (AS M SProducer Metrics category includesthe counterslisted in the

following table.

Counters

Description

Valueistrue when message IDs

disableM essagel D are disabled for the producer. Normal | Boolean
Valueistrue when message

disableMessageTimestamp | timestamps are disabled for the Normal | Boolean
producer.

priority Current priority of thisproducer. | Normal |Integer

startTime a/_stem currentTimeMillis() when ctor Milliseconds
this producer was created.

timeToLive Current timeToLive of this Normal | Milliseconds

producer.
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Phase timer (PhaseEvent Sensor)
method-name metric for every major method Normal
call in thisproducer object.

Oracle Application Server M S Session Metrics

The Oracle Application Server (AS) M S Session Metrics category includesthe counterslisted in the
following table.

Counters Description

iSXA Valueis True when the session isin ctor Boolean
XA mode.

System.currentTimeMillis() when

startTime . . ctor Milliseconds
this session was created.
Valueis True when the session is

transacted ctor Boolean
transacted.
Integer count of the current local
transaction associated with this

txid session; the counter isincremented Normal Integer

each time alocal transaction is
committed or rolledback. Not set
for non-transacted session.

Interval timer metric (PhaseEvent
method-name Sensor) for every major method Normal
call in this session object.

Oracle Application Server MS Sore Metrics

The Oracle Application Server (AS M S Sore Metrics category includesthe counterslisted in the following
table.

Total number of messages

messageCount contained in this store. Value Integer

messageDequeued Total number of message dequeues Count Operations
(transacted or otherwise).
Total number of messages

messageDiscarded discarded after the rollback of an Count Operations
enqueue.

m essageEn queued Total number of MesSage enqueUes | count Operations
(transacted or otherwise).

m essageExpired TO@ n_umber of message Count Operations
expirations.

messagePaged|n Total number of message bodies Count Operations
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paged in.

m essagePagedOut Total number of message bodies Count Operations
paged out.
Total number of messages

m essageRecovered recovered (either from a persistence Count Operations

file, or after the rollback of a
dequeue).

Total number of messagesthat are
pendingMessageCount | part of an enqueue or dequeue of Value Integer
an active transaction.

Total size, in bytes, of the message

storeSze store.

Value Bytes

Interval timer metric (PhaseEvent
method-name Sensor) for every major method Normal
call in the message store object.

Oracle Application Server MS Temp Destination Metrics

The Oracle Application Server (AS MSTemp Destination Metrics category includesthe counterslisted in
the following table.

Counters Description

Interval timer metric (PhaseEvent
method-name Sensor) for every major method Normal
call in the destination object.

Oracle Application Server JServ JSP Metrics

The Oracle Application Server (AS) JServ JSP Metrics category includesthe counterslisted in the following
table.

| Counters Description

Threads currently in the

processRequest.active processRequest processing phase. Integer
Average time to completely process
processRequest.avg servlet (including JServ engine Milliseconds

overhead).

Maximum time to completely
processRequest.maxTime process servlet (including JServ Milliseconds
engine overhead).

Minimum timeto completely
processRequest.minTime process servlet (including JServ Milliseconds
engine overhead).

processRequest.completed Number of times the processRequest Operations
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processing phase has completed.

processRequest.time

Total timeto completely process
servlet (including JServ engine
overhead).

Milliseconds

serviceRequest.active

Average time for service method
implementing this application
(excluding JServ engine overhead).

Integer

serviceRequest.avg

Average time for service method
implementing thisapplication
(excluding Jserv engine overhead).

Milliseconds

serviceRequest.maxTime

Maximum time for service method
implementing this application
(excluding Jserv engine overhead).

Milliseconds

serviceRequest.minTime

Minimum time for service method
implementing this application
(excluding JServ engine overhead).

Milliseconds

serviceRequest.completed

Number of timesthe serviceRequest
processing phase has completed.

Operations

serviceRequest.time

Total time for service method
implementing thisapplication
(excluding Jserv engine overhead).

Milliseconds

local Servlet.avg

Average time to load servlet (from
cache or file).

Milliseconds

localServliet.maxTime

Maximum time to load servlet (from
cache or file).

Milliseconds

localServliet.minTime

Minimum time to load servlet (from
cache or file).

Milliseconds

local Servlet.completed

Number of timesthe loadServiet
processing phase has completed.

Operations

localServlet.time

Total timeto load serviet (from
cache or file).

Milliseconds

local ServletClasses.active

Threads currently in the
loadServietClasses processing phase.

Count

local ServletClasses.avg

Average time to load servlet classes
from file.

Milliseconds

localServiletClasses. maxTime

Maximum time to load servlet
classes from file.

Milliseconds

localServiletClasses.minTime

Minimum time to load servlet
classes from file.

Milliseconds

local ServletClasses.completed

Number of timesthe

Operations
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loadServletClasses processing phase
has completed. For most classes, this
value isusually one (1).

local ServletClasses.time

Total time to load servlet classes
from file.

Milliseconds

loadServiet.avg

Average time to load servlet (from
cache or file).

Milliseconds

createSession.active

Threads currently in the
createSession processing phase.

Count

createSession.avg

Average time to create a session.

Milliseconds

createSession.maxTime

Maximum time to create a session.

Milliseconds

createSession.minTime

Minimum time to create a session.

Milliseconds

createSession.completed

Number of timesthe createSession
processing phase has completed.
Number of sessionsthat have been
created for thisapplication.

Operations

createSession.time

Total time to create a session.

Milliseconds

Total number of instances available

maxSTMInstances.value for this SngleThreadModel servlet. Instances
Maximum number of instances

activeSTMInstances.maxValue | concurrently servicing requests for Instances
this SngleThreadM odel.

activeSTMInstances.value Tota number of instances available Instances

for this SngleThreadModel servlet.

Oracle Application Server JServ Metrics

The Oracle Application Server (AS) JServ Metrics category includesthe counterslisted in the following

table.

Counters

readRequest.active

Description

Threads currently in the
readRequest processing phase.

 Type |

Count

readRequest.avg

Average timeto read and parse
requests.

Milliseconds

readRequest.maxTime

Maximum time to read and parse
requests.

Milliseconds

readRequest.minTime

Minimum timeto read and parse
requests.

Milliseconds

readRequest.completed

Number of timesthe readRequest

Operations
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processing phase has completed.

readRequest.time

Total timeto read and parsethe
request.

Milliseconds

maxConnections

Number of requeststhat can be
handled concurrently in the
JServ process.

Value

Threads

activeConnections.maxValue

Maximum number of requests
being processed simultaneously.

Threads

activeConnections

Number of requests being
processed simultaneously.

Value

Threads

idlePeriod.maxTime

Maximum time process was not
handling any requests.

Milliseconds

idlePeriod.minTime

Number of timesno requests
were being serviced.

Milliseconds

idlePeriod.completed

Number of timesno requests
were being serviced.

Operations

idlePeriod.time

Total time process was not
handling any requests.

Milliseconds

maxBacklog

Maximum number of backlog
requeststhat may be queued in
the OSwaiting for this JServ.

Value

Integer

Oracle Application Server JServ Servliet Metrics

The Oracle Application Server (AS) JServ Serviet Metrics category includesthe counterslisted in the

following table.

Counters

processRequest.active

Description

Threads currently in the
processRequest processing phase.

Type

Units

Integer

processRequest.avg

Average time to completely process
servlet (including JServ engine
overhead).

Milliseconds

processRequest.maxTime

Maximum time to completely
process servlet (including JServ
engine overhead).

Milliseconds

processRequest.minTime

Minimum timeto completely
process servlet (including JServ
engine overhead).

Milliseconds

processRequest.completed

Number of timesthe processRequest
processing phase has completed.

Operations
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processRequest.time

Total timeto completely process
servlet (including JServ engine
overhead).

Milliseconds

serviceRequest.active

Threads currently in the
serviceRequest processing phase.

Integer

serviceRequest.avg

Average time for service method
implementing thisapplication
(excluding Jserv engine overhead).

Milliseconds

serviceRequest.maxTime

Maximum time for service method
implementing thisapplication
(excluding JServ engine overhead).

Milliseconds

serviceRequest.minTime

Minimum time for service method
implementing thisapplication
(excluding JServ engine overhead).

Milliseconds

serviceRequest.completed

Number of timesthe serviceRequest
processing phase has completed.

Operations

serviceRequest.time

Total time for service method
implementing thisapplication
(excluding Jserv engine overhead).

Milliseconds

loadServiet.avg

Average time to load servlet (from
cache or file).

Milliseconds

loadServliet.maxTime

Maximum time to load servlet (from
cache or file).

Milliseconds

loadServliet.minTime

Minimum time to load servlet (from
cache or file).

Milliseconds

loadServiet.completed

Number of timesthe loadServiet
processing phase has completed.

Operations

loadServlet.time

Total timeto load servlet (from
cache or file).

Milliseconds

loadServletClasses.active

Threads currently in the
loadServietClasses processing phase.

Integer

loadServletClasses.avg

Average time to load servlet classes
from file.

Milliseconds

loadServiletClassesmaxTime

Maximum time to load servlet
classes from file.

Milliseconds

loadServiletClassesminTime

Minimum time to load servlet
classes from file.

Milliseconds

loadServiletClasses.completed

Number of timesthe
loadServiletClasses processing phase
has completed. For most classes, this

Operations
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value isusually one (1).

loadServletClasses.time

Total timeto load servlet classes
from file.

Milliseconds

loadServiet.avg

Average time to load servlet (from
cache or file).

Milliseconds

createSession.active

Threads currently in the
createSession processing phase.

Count

createSession.avg

Average time to create a session.

Milliseconds

createSession.maxTime

Maximum time to create a session.

Milliseconds

createSession.minTime

Minimum time to create a session.

Milliseconds

createSession.completed

Number of timesthe createSession
processing phase has completed.
Number of sessionsthat have been
created for thisapplication.

Operations

createSession.time

Total time to create a session.

Milliseconds

Total number of instances available

maxSTMInstances.value for this SngleThreadModel servlet. Integer
Maximum number of instances

activeSTMInstances.maxValue | concurrently servicing requests for Integer
this SngleThreadModel.

activeSTMInstances.value Total number of instances available Instances

for this SngleThreadModel servlet.

Oracle Application Server JServ Zone Metrics

The Oracle Application Server (AS) JServ Zone Metrics category includesthe counterslisted in the following

table.

Counters

checkReload.active

Threads currently in the checkReload
processing phase.

Description

‘ Type

Units

Integer

checkReload.avg

Average timeto check if the zone must
be reloaded.

Milliseconds

checkReload.maxTime

Maximum timeto check if the zone
must be reloaded.

Milliseconds

checkReload.minTime

Minimum timeto check if the zone
must be reloaded.

Milliseconds

checkReload.completed

Number of times the checkReload
processing phase has completed.

Operations
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checkReload.time

Total timeto check if the zone must
be reloaded.

Milliseconds

activeSessions

Number of times session data has been
read with HttpSession.getValuein this
zone.

Value

Sessions

readSession

Number of times session data has been
read with HttpSession.getValuein this
zone.

Count

Operations

writeSession

Number of times session data has been
written with HttpSession.putValuein
this zone.

Count

Operations

loadFailed

Number of times Oracle failed to load
therequested application (does not
work for OJSPs).

Count

Operations

Oracle Application Server JSP Metrics

The Oracle Application Server (AS) JSP Metrics category includesthe counterslisted in the following table.

Counters

processRequest.time

Description

Time spent processing requests for
JSPs.

Milliseconds

processRequest.completed

by this application.

Number of requests for JSPs processed

Operations

processRequest.minTime

Minimum time spent processing
requests for JSPs.

Milliseconds

processRequest.maxTime

Maximum time spent processing
requests for JSPs.

Milliseconds

processRequest.avg

Average time spent processing
requests for JSPs.

Milliseconds

Current number of active requests for

processRequest.active IPs. Operations
activelnstances.value Number of active mstitnces. Only Count | Instances
used when threadsafe=fal se.
availablelnstances.value _Number of available (that is, created) Count | Instances
instances.
. . Current number of active requests for
service.active Count

the JSP.

service.avg

Average time spent servicing the JSP.

Milliseconds

service.completed

by this JP.

Number of requests for JSPs processed

Operations
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Maximum time spent servicing the

1P Milliseconds

service.maxTime

Minimum time spent servicing the

1P Milliseconds

service.minTime

Timeto serve a J3P (that is, actual

execution time of the JSP). Milliseconds

service.time

Oracle Application Server VM Metrics

The Oracle Application Server (AS VM Method Metrics category includesthe counterslisted in the
following table.

Counters Description
. Number of active thread groupsin

activeThreadGroups the VM. Integer

activeThreadGroups.minValue M|n|mqm number of active thread Integer
groupsin the WM.

activeThreadGroupsmaxValue MaX|QO number of active thread Integer
groupsin the WM.

activeThreads Number of active threadsin the Threads
NM.

activeThreads.minValue Mlnlmum number of active threads Threads
inthe WM.

activeThreads.maxValue _NIaX|mum number of active threads Threads
inthe WM.
Amount of heap space freein the .

freeMemory Kilobytes
NM.

freeMemory.minValue Minimum amount of heap space Kilobytes

Y- freein the WM. y

Maximum amount of heap space .

freeMemory.maxValue free in the VM. Kilobytes

totalMemory Total amount of heap spacein the Kilobytes
NM.

. Minimum amount of total heap .

totalMemory.minValue space in the VM. Kilobytes
Maximum amount of total heap .

totalMemory.maxValue space in the VM. Kilobytes
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The Oracle Application Server (AS) Notification Server Metrics category includesthe counterslisted in the

following table.

Counters

Description

Number of notifications processed

receive queue.

notifProcessed by ONS. Value Operations
notifProcessQueue Number of notificationsin the Value Operations
process queue.
. . Number of notificationsreceived .
notifReceived by ONS. Value Operations
notifReceiveQueue Number of notificationsin the Value Operations

Oracle Application Server OC4J Transaction Manager Metrics

The Oracle Application Server (AS) OC4JTransaction Metrics category includesthe counterslisted in the

following table.

| Counters

Description
aborted_transactions Number of aborted transactions. Value Integer
committed_transactions Number' of committed Value Integer
transactions.
open_transactions Number of open transactions. Value Integer

Oracle Application Server PLSQL Metrics

The Oracle Application Server (AS) PLSQL Metrics category includesthe counterslisted in the following
table.

| Counters Description Type

newMisses Number of new session cache misses. Count | Operations
staleMisses Number of stale session cache misses. Count | Operations
hits Number of session cache hits. Count | Operations
requests Number of requeststo the session Count | Operations
cache.
newMisses Number of new content cache misses. Count | Operations
staleMisses Number of stale content cache misses. | Count | Operations
hits Number of content cache hits. Count | Operations
requests lglaté?:er of requeststo the content Count | Operations
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Number of errorsthat have occurred .

error S Count | Operations
within the group

connFetch maxTime Maximum time to fetch a connection Microseconds
from the pool.

connFetch minTime Minimum time to fetch a connection Microseconds
from the pool.

connFetch.avg Average time to fetch a connection Microseconds
from the pool.

connFetch active Child serverscurrently in the pool Threads
fetch phase.

connFetch time Total time spent fetching connections Microseconds
from the pool.

connFetch.completed Number of times a connection has Operations
been requested from the pool.

newMisses NL_meer of new connection pool Count | Operations
misses.

staleMisses NL_meer of stale connection pool Count | Operations
misses.

hits Number of connection pool hits. Count | Operations

Oracle Application Server Portal Cache Metrics

The Oracle Application Server (AS) Portal Cache Metrics category includesthe counterslisted in the

following table.

cleaned up.

cacheSze Overall size of the cache. Value Megabytes
dataCleanedUp.max uMpf;\leum amount of cache data clean Megabytes
dataCleanedUp.min uMplnlmum amount of cache data clean Megabytes
dataCleanedUp.avg | Average amount of cache data clean up. Megabytes
dataCleanedUp Amount of cache d_ata cleaned up in the Megabytes

last cleanup operation.

Number of timesthe cache has been .
cleanup Count | Operations

cleanupTime.min

Minimum timeto clean up the cache.

Milliseconds

cleanupTime.max

Maximum time to clean up the cache.

Milliseconds
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cleanupTime.avg

Average timeto clean up the cache.

Milliseconds

cleanupTime

Timeto clean up the cachein thelast
cleanup operation.

Milliseconds

cacheTime.max

Maximum time to serve content from
the cache.

Milliseconds

cacheTime.min

Minimum time to serve content from
the cache.

Milliseconds

cacheTime.avg

cache.

Average time to serve content from the

Milliseconds

openTime

Number of times cached content has
been opened.

Operations

openTime.avg

Average time to open cached content.

Milliseconds

openTime.max

Maximum time to open cached
content.

Milliseconds

readTime

Number of times cached content has
been read.

Operations

readTime.avg

Average time to read cached content.

Milliseconds

readTime.max

Maximum time to read cached content.

Milliseconds

writeTime

Number of times cached content has
been written.

Operations

writeTime.avg

Average time to write cached content.

Milliseconds

writeTime.max

Maximum timeto write cached
content.

Milliseconds

Oracle Application Sever Portal Cache Summary Metrics

The Oracle Application Sever (AS) Portal Cache Summary Metrics category includesthe counterslisted in
the following table for the user and system level content cache.

Counters

newM isses

Description

Number of new session cache misses.

Operations

newMisses.avg

Average time to process a new cache
miss.

Milliseconds

newM isses.max

Maximum time to process a new cache
miss.

Milliseconds

staleM isses

Number of stale session cache misses.

Operations

staleMisses.avg

Average timeto process a stale cache
miss.

Milliseconds
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staleMisses.max

Maximum time to process a stale cache
miss.

Milliseconds

expireHits

Number of session expire cache hits.

Operations

expireHits.avg

Average time to process an expire cache
hit.

Milliseconds

expireHits.max

Maximum time to process an expire
cache hit.

Milliseconds

requests

Number of requeststo the session cache.

Operations

Oracle Application Server Portal DB Provider Metrics

The Oracle Application Server (AS) Portal DB Provider Metrics category includesthe counterslisted in the
following table for the Portal Servlet Database provider requests and Portal Servliet PL/SQL portlet requests.

| Counters

for thisrequest.

Description
cacheHits Number of cache hitsfor thisrequest. | Value
httpXX X Count of specific HTTP response codes Value | Operations

executeTime.maxTime

Maximum time to make the request.

Microseconds

executeTime.minTime

Minimum timeto make the request.

Microseconds

executeTime.avg

Average time to make the request.

Microseconds

executeTime.active

Threads currently in the make request
phase.

Threads

executeTime.time

Total time spent making requests.

Microseconds

Oracle Application Server Portal DB Repository Metrics

The Oracle Application Server (AS) Portal DB Repository Metrics category includesthe counterslisted in the

following table.

Counters

connFetch.maxTime

Description

Maximum timeto fetch a connection
from the pool.

Milliseconds

connFetch.minTime

Minimum timeto fetch aconnection
from the pool.

Milliseconds

connFetch.avg

Average timeto fetch a connection
from the pool.

Milliseconds

connFetch.time

Total time spent fetching connections
from the pool.

Milliseconds
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Number of timesaconnection has

connFetch been requested from the pool. Operations
. Number of new connection pool .
newMisses : Operations
misses.
ctaleMisses NL_Jm ber of stale connection pool Operations
misses.
hits Number of connection pool hits. Operations
openConn Num ber_ of currently open Operations
connections.
Maximum number of open .
openConn.max . Operations
connections.
openConn.avg Average number of open connections. Operations
requestTime Number of requests. Operations

requestTime.minValue

Minimum time to service arequest.

Milliseconds

requestTime.maxValue

Maximum time to service arequest.

Milliseconds

requestTime.

time

Accumulative time of all requests.

Milliseconds

Oracle Application Server Portal Engine Metrics

The Oracle Application Server (AS) Portal Engine Metrics category includesthe counterslisted in the
following table.

Counters

pageRequests

‘ Description

Total number of requests for Portal pages.

_Tye

Value

Units

Count

cachePageHits

cache hit.

Number of requests for cacheable fully
assembled pagesthat have resulted in a

Value

Count

cachePageRequests

assembled pages

Number of requests for cacheable fully

Value

Count

Average time spent in the PPE internal
request queue waiting for page metadata,

pageM etadataW aitTimeAvg.value

for all requests. To obtain the average,
divide the value metric by the count
metric. The value isthe accumulative time
for all requestsand the count isthe number
of requests made.

Value

Milliseconds

pageM etadataW ait TimeAvg.count

Number of requests made for page
metadata. Thismetric should be used in
conjunction with

pageM etadataw aitTimeAvg.value to
calculate the average time spent in the PPE

Count

Operations
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internal request queue.

pageMetadataWaitTime.value

Timethe last page metadata request spent
in the PPE internal request queue.

Value

Milliseconds

pageM etadataWaitTime.count

Number of requests for page metadata.

Count

Operations

pageMetadataWaitTime.minValue

Minimum time spent in the PPEinternal
request queue waiting for page metadatato
be requested.

Milliseconds

pageMetadataWaitTime.maxValue

Maximum time spent in the PPE internal
request queue waiting for page metadatato
be requested.

Milliseconds

pageElapsedTimeAvg.value

Average time to generate pages, including
fetching the page metadata. To obtain the
average, divide the value metric by the
count metric. The value isthe accumulative
time for all requestsand the count isthe
number of requests made

Value

Milliseconds

Number of pagesthat had to be generated
(that is, not cached). use thismetricin
conjunction with

pageElapsedTimeAvg.count pageElapsedTimeAvg.value to calculate the Count | Operations
average timeto generate pages, including
fetching the page metadata.

pageElapsedTime.value Timeto generate the |ast page requested, Value | Milliseconds

including fetching the page metadata.

pageElapsedTime.count

Number of pagesthat had to be generated
(that is, not cached).

Count

Operations

pageElapsedTime.minValue

Minimum timeto generate a page,
including fetching the page metadata.

Milliseconds

pageElapsedTime.maxValue

Maximum time to generate a page,
including fetching the page metadata.

Milliseconds

pageM etadataFetchTimeAvg

Average time to fetch page metadata, for all
requests. To obtain the average, divide the
value metric by the count metric. The value
isthe accumulative time for all requests
and the count isthe number of requests
made.

Value

Milliseconds

Number of requests for page metadata. Use
thismetricin conjunction with

pageM etadataFetchTimeAvg pageM etadataFetchTimeAvg.value to Count | Operations
calculate the average time to fetch page
metadata.

pageM etadataFetchTime.value Time to fetch page metadata, for the |ast Value | Milliseconds

request.

470




QALoad Online Help

pageM etadataFetchTime.count

Number of requests for page metadata.

Count

Operations

pageM etadataFetchTime.minValue

Minimum time to fetch page metadata.

Milliseconds

pageM etadataFetchTime.maxValue

Maximum time to fetch page metadata.

Milliseconds

queueTimeout

Number of requests for Portal data that
have timed out in the PPE internal request
queue.

Value

Milliseconds

queueStayAvg.value

Average time all internal PPE requests spent
in the PPEinternal request queue. To
obtain the average, divide the valueisthe
accumulative time for all requestsand the
count isthe number of requests made.

Value

Milliseconds

Number of requests added to the internal
PPE request queue. Use thismetricin

gqueueStayAvg.count conjunction with queueStayAvg.value to Count | Operations
calculate the average time requests spent in
theinternal PPE request queue.

queueStay.value Timethelast internal PPErequest spent in value | Milliseconds

the PPE internal request queue.

queueStay.count

Number of requests added to the internal
PPE request queue.

Count

Operations

queueSay.minValue

Minimum time arequest spent in the
internal PPE request queue.

Milliseconds

queueStay.maxValue

Average length of the PPE internal request
queue. To obtain the average, divide the
value metric by the count metric.

Milliseconds

queuelLengthAvg.value

Average length of the PPE internal request
gqueue. To obtain the average, divide the
value metric by the count metric.

Value

Milliseconds

queuelLength Avg.count

Number of requests added to the PPE
internal request queue. Use thismetricin
conjunction with queueLengthAvg.value to
calculate the average length of the PPE
internal request queue.

Count

Operations

queuelLength.value

Current length of the PPEinternal request
queue.

Milliseconds

queuelLength.count

Number of requests added to the PPE
internal request queue.

Count

Operations

queueLength.minValue

Minimum number of requestsin the PPE
internal request queue.

Milliseconds

queuelLength.maxValue

Maximum number of requestsin the PPE
internal request queue.

Milliseconds
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cacheHits

Number of cache hitsfor thisrequest.

Value

Operations

httpX XX

Count of specific HTTP response codes for
thisrequest.

Value

Operations

executeTime.maxTime

Maximum time to make the request.

Microseconds

executeTime.minTime

Minimum timeto make the request.

Microseconds

executeTime.avg

Average time to make the request.

Microseconds

executeTime.active

Threads currently being processed.

Threads

executeTime.time

Total time spent making requests.

Microseconds

connFetch.completed

Number of requests made.

Operations

Oracle Application Server Portal Page Metrics

The Oracle Application Server (AS) Portal Page Metrics category includesthe counterslisted in the

following table.

Counters

pageRequests

Total number of requests for Portal pages.

Description

Value

Count

cachePageHits

Number of requests for cacheable fully
assembled pagesthat have resulted in a
cache hit.

Value

Count

cachePageRequests

Number of requests for cacheable fully
assembled pages.

Value

Count

pageM etadataW aitTimeAvg.value

Average time spent in the PPE internal
request queue waiting for page metadata, for
all requests. To obtain the average, divide
the value metric by the count metric. The
valueisthe accumulative time for all
requests and the count isthe number of
requests made.

Milliseconds

pageM etadataW ait TimeAvg.count

Number of requests made for page metadata.

Use thismetric in conjunction with

pageM etadataw aitTimeAvg.value to
calculate the average time spent in the PPE
internal request queue.

Operations

pageMetadataWaitTime.value

Timethe last page metadata request spent in
the PPE internal request queue.

Value

Milliseconds

pageM etadataWaitTime.count

Number of requests for page metadata.

Count

Operations

pageMetadataWaitTime.minValue

Minimum time spent in the PPEinternal
request queue waiting for page metadatato
be requested.

Milliseconds
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pageMetadataWaitTime.maxValue

Maximum time spent in the PPE internal
request queue waiting for page metadatato
be requested.

Milliseconds

pageElapsedTimeAvg.value

Average timeto generate pages, including
fetching the page metadata. To obtain the
average, divide the value metric by the
count metric. The valueisthe accumulative
time for all requestsand the count isthe
number of requests made.

Value

Milliseconds

pageElapsedTimeAvg.count

Number of pagesthat had to be generated
(that is, not cached). Use thismetricin
conjunction with
pageElapsedTimeAvg.value to calculate the
average timeto generate pages, including
fetching the page metadata.

Count

Operations

pageElapsedTime.value

Timeto generate the last page requested,
including fetching the page metadata.

Milliseconds

pageElapsedTime.count

Number of pagesthat had to be generated
(that is, not cached).

Operations

pageElapsedTime.minValue

Minimum timeto generate a page, including
fetching the page metadata.

Milliseconds

pageElapsedTime.maxValue

Maximum time to generate a page,
including fetching the page metadata.

Milliseconds

pageM etadataFetchTimeAvg.value

Average time to fetch page metadata, for all
requests. To obtain the average you should
divide the value metric by the count metric.
Thevalue being the accumulative time for
all requestsand the count being the number
of requests made.

Milliseconds

pageM etadataFetch TimeAvg.count

Number of requests for page metadata. This
metric should be used in conjunction with
pageM etadataFetchTimeAvg.value to
calculate the average time to fetch page
metadata.

Operations

pageM etadataFetchTime.value

Timeto fetch page metadata, for the last
request.

Milliseconds

pageM etadataFetchTime.count

Number of requests for page metadata.

Operations

pageM etadataFetchTime.minValue

Minimum time to fetch page metadata.

Milliseconds

pageM etadataFetchTime.maxValue

Maximum time to fetch page metadata.

Milliseconds

queueTimeout

Number of requests for Portal datathat have
timed out in the PPE internal request queue.

Value

Milliseconds

queueSayAvg.value

Average time all internal PPE requests spent

Milliseconds
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in the PPEinternal request queue. To obtain
the average, divide the value metric by the
count metric. The valueisthe accumulative
time for all requestsand the count isthe
number of requests made.

queueSayAvg.count

Number of requests added to the internal
PPE request queue. Use thismetricin
conjunction with queueSayAvg.value to
calculate the average time requests spent in
theinternal PPE request queue.

Operations

gqueueSay.value

Timethelast internal PPErequest spent in
the PPE internal request queue.

Milliseconds

queueSay.count

Number of requests added to the internal
PPE request queue.

Operations

queueStay.minValue

Minimum time arequest spent in the
internal PPE request queue.

Milliseconds

queueStay.maxValue

Maximum time arequest spent in the
internal PPE request queue.

Milliseconds

queuelLengthAvg.value

Average length of the PPE internal request
queue. To obtain the average, divide the
value metric by the count metric.

Milliseconds

queueLengthAvg.count

Number of requests added to the PPE
internal request queue. Use thismetricin
conjunction with queueLengthAvg.value to
calculate the average length of the PPE
internal request queue.

Operations

queueLength.value

Current length of the PPEinternal request
queue.

Milliseconds

queueLength.count

Number of requests added to the PPE
internal request queue.

Operations

queueLength.minValue

Minimum number of requestsin the PPE
internal request queue.

Milliseconds

queueLength.maxValue

Maximum number of requestsin the PPE
internal request queue.

Milliseconds

requests. Number of page requests. Value | Operations

httpXXX Count of specific HTTP response codes. Value | Operations

httpFailure Count of mterngl Parallel P_age Engine errors Value | Operations
encountered whilst requesting portlets.

httpTimeout Count (_)f timeouts encountered whilst Value | Operations
requesting portlets.

httpUnresolvedRedirect Count of requests for portletswhich resulted | Value
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successfully.

in aredirected request not being resolved

Oracle Application Server Portal W eb Provider Metrics

The Oracle Application Server (AS) Portal Web Provider Metrics category includesthe counterslisted in the

following table.

Counters Description Type Units
cacheHits Number of cache hitsfor thisrequest. |Value | Operations
httpXXX Count of specific HTTP response codes Value | Operations

for thisrequest.

executeTime.maxTime | Maximum time to make the request.

Microseconds

executeTime.minTime | Minimum time to make the request.

Microseconds

executeTime.avg

Average time to make the request.

Microseconds

executeTime.active

Threads currently in the make request
phase.

Threads

executeTime.time

Total time spent making requests.

Microseconds

Oracle Application Server Process Manager Metrics

The Oracle Application Server (AS) Process Manager Metrics category includesthe counterslisted in the

following table.

Counters Description ‘ Type Units

Number of jobsin the OPMN worker

OPMN handles.

jobWorkerQueue Value Operations
queue.
Number of local HTTP requests which .

IReq OPMN handles. Count Operations

procDeath Number of processes which die after the Count Operations
process manager startsthem.
Number of processes which are restarted

procDeathReplace | after the process manager detects they Count Operations
are dead.

regFail Number of HTTP requests which fail. Count Operations

regPartial Succ N“”.‘ber of HTTP requests which Count Operations
partially succeed.

reqauce Number of HTTP requests which Count Operations
succeed.

rReq Number of remote HTTP requests which Count Operations
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workerThread Number of worker threads. Value Threads

cpuldle Numl_aer 0f_mHhsecondsth¢CP_U(s) have value Milliseconds
been idle since an unspecified time.

freePhysicalM em Amount Of. free physical memory on the Value Kilobytes
host machine.
Number of processors available on the

numProcessors . Value Integer
host machine.

totalPhysicalMem Total phys!cal memory available on the Value Kilobytes
host machine.

numProcConf Number, or maximum ”“”.‘ber' of Value Integer
processes configured for this process set.

reqFail qu ber of HTTP requests which fail for Count Operations
this process set.

regPartial Succ N“”.‘ber of HTTP reque_stswhlch Count Operations
partially succeed for this process set.

reqauce Numb_er of HTTP requests which succeed Count Operations
for this process set

cpuTime Amount of CPU time used by the Value Cpu Milliseconds
process.

heapSze Heap size of the process. Value Kilobytes

privateMemory Private memory of the process. Value Kilobytes

sharedMemory Shared memory for the process. Value Milliseconds

Oracle Application Server Servlet Metrics

The Oracle Application Server (AS) Servlet Metrics category includesthe counterslisted in the following

table.

service.active

Current number of threads servicing this
servlet.

Threads

service.avg

Average time spent in servicing the
servlet.

Milliseconds

service.completed

Total number of callsto service.

Count

service.maxActive

Maximum number of threads servicing
this servlet.

Threads

service.maxTime

Maximum time spent on a servlet's
service() call.

Operations
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Minimum time spent on a servlet's

, Milliseconds
service() call.

service.minTime

Total time spent on the servlet's service()

Milliseconds
call.

service.time

Oracle Application Server Task Manager Metrics

The Oracle Application Server (AS) Task Manager Metrics category includesthe counterslisted in the
following table.

Counters Description

How often thetask should run. The task

manager executes all the tasksin a
interval round-robin fashion. If theinterval is Value Milliseconds
zero, then the task manager executesthe
task when it is selected in theround

robin.

run().active Number of active threads. Threads

Average time for the task manager to run

the task. Milliseconds

run().avg

Number of timesthe task manager has

run().completed run the task. Operations
run().maxActive | Maximum number of active tasks. Threads
run().maxTime | Maximum time for thetask to run. Milliseconds
run().minTime | Minimum time for the task to run. Milliseconds

Total time spent running the task
manager.

run().time Milliseconds

Oracle Application Server Web Module Metrics

The Oracle Application Server (AS Web Module Metrics category includesthe counterslisted in the
following table.

Counters Description ‘ Type Units

Total time spent to create/locate
servlet instances (within the serviet
context). Thisincludesthetime for
any required authentication.

resolveServlet.time Milliseconds

Total number of lookupsfor a servlet

resolveServlet.completed by OC4J,

Operations

Minimum time spent to create/locate
resolveServiet.minTime the servlet instance (within the Milliseconds
servlet context).
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resolveServlet.maxTime

Maximum time spent to
create/locate the servlet instance
(within the servlet context).

Milliseconds

resolveServlet.avg

Average time spent to create/locate
the servlet instance (within the
servlet context).

Milliseconds

sessionActivation.active

Number of active sessions.

Operations

sessionActivation.time

Total time in which sessions have
been active.

Milliseconds

sessionActivation.completed

Number of session activations.

Operations

sessionActivation.minTime

Minimum time a session was active.

Milliseconds

sessionActivation.maxTime

Maximum time a session was active.

Milliseconds

sessionActivation.avg

Average session lifetime.

Milliseconds

service.time

Total time spent servicing requests.

Milliseconds

service.completed

Total number of requests serviced.

Operations

service.minTime

Minimum time spent servicing
requests.

Milliseconds

service.maxTime

Maximum time spent servicing
requests.

Milliseconds

service.avg

Average time spent in servicing the
servlet.

Milliseconds

service.active

Current number of requests active.

Operations

parseRequest.active

Current number of threadstrying to
read/parse AP or HTTP requests.

parseRequest.avg

Average time spent to read/parse
requests.

Milliseconds

parseRequest.completed

Number of web requeststhat have
been parsed.

Operations

parseRequest.maxActive

Maximum number of threadstrying
to read/parse AJP or HTTP requests.

Threads

parseRequest.maxTime

Maximum time spent to read/parse
requests.

Milliseconds

parseRequest.minTime

Minimum time spent to read/parse
requests.

Milliseconds

parseRequest.time

Total time spent to read/parse
requests from the socket.

Milliseconds
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processRequest.active

Current number of threads servicing
web requests.

processRequest.avg

Average time spent servicing web
requests.

Milliseconds

processRequest.completed

Number of web requests processed
by this application.

Operations

processRequest.maxActive

Maximum number of threads
servicing web requests.

Threads

processRequest.maxTime

Maximum time spent servicing a
web request.

Milliseconds

processRequest.minTime

Minimum time spent servicing a web
request.

Milliseconds

processRequest.time

Total time spent servicing this
application's web requests.

Milliseconds

resolveContext.active

Current number of threadstrying to
create/find the servlet context.

resolveContext.avg

Average time spent to create/find the
servlet context.

Milliseconds

resolveContext.completed

Count of completed context resolves.

Operations

resolveContext.maxActive

Maximum number of threadstrying
to create/find the servlet context.

Threads

resolveContext.maxTime

Maximum time spent to create/find
the servlet context.

Milliseconds

resolveContext.minTime

Minimum time spent to create/find
the servlet context.

Milliseconds

resolveContext.time

Total time spent to create/find the
servlet context. Each web module
(WAR) mapsto a servlet context.

Milliseconds

JVM Counters

VM Counters

ServerVantage providesthe following statically discovered categories for monitoring a Java Virtual Machine
(VM). Each category provides countersthat allow the monitoring of your WM. ServerVantage utilizesthe
Java Monitoring and Management APl which wereintroduced in 2SE 5.0 for counter data.

VM Class Loading
VM Compilation
VM Garbage Collection

Guideline:

MM Memory
VM Operating System
MM Threads
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You must start your VM asa"IM X-enabled WM "by inserting the following properties:

C\...\java -Dcom sun. nanagenent . j nxr enot e. port =1095 -
Dcom sum rmanagenent . j nxr enot e. ssl =fal se -
Dcom sun. nanagenent . j nxr enot e. aut henti cat e=f al se

For more information, see http://java.sun.com/j2se/1.5.0/docs/guide/management/agent.html.

MM Class Loading Counters

The WM Class Loading category includesthe counterslisted in the following table. ServerVantage utilizes
JMX and the Java Monitoring and Management APl which were introduced in the Java Virtual Machine
(VM) 1.5, release 2SE 5.0.

Counters

Type

Description Units
Approximate time (in
Compilation mHhsgco_nds) spentin Number of
Time compilation by the Integer milliseconds
MM during the
sample interval.
Current Number of classes
) Number of
Loaded currently loaded in Integer ol S
Class Count | the WM.
Loaded Number_of classes Number of
loaded since VM Long
Class Count . classes
started execution.
Number of classes
Unloaded unloaded since the Lon Number of
Class Count | WM started 9 classes
execution.
Parameters

The following parameter isvalid for this counter category.

JMX Port

M X port associated with the VM you want to monitor.

Data Point

The primary data point (PDP) isthe value returned for the counter used in the task.

Interval

Recommended minimum is5 minutes.

MM Compilation Counters

The WM Compilation category includesthe counterslisted in the following table. ServerVantage utilizes
JMX and the Java Monitoring and Management APl which were introduced in the Java Virtual Machine
(VM) 1.5, release 2SE 5.0.

Counters Units |

Typ%

Description
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Approximate time (in

Compilation milliseconds) spent in

Time compilation by the Long | Milliseconds
MM during the sample
interval.

Parameters

The following parameter isvalid for this counter category.

JMX Port

JMX port associated with the VM you want to monitor.

Data Point

The primary data point (PDP) isthe value returned for the counter used in the task.

Interval

Recommended minimum is5 minutes.

MM Garbage Collection Counters

The WM Garbage Collection category includesthe counterslisted in the following table. ServerVantage
utilizes M X and the Java Monitoring and Management APl which were introduced in the Java Virtual
Machine (WM) 1.5, release 2SE 5.0.

| Description Typ Units |

Garbage Number of collections
9 that have occurred Number of
Collection . Long )
during the sample collections
Count )
interval.
Approximate time (in
Garbage milliseconds) spent
Collection garbage collecting by Long | Milliseconds
Time the WM during the
sample interval.
Garbage Total number of
9 collectionsthat have Number of
Collection . Long )
occurred during the collections
Count .
sample interval.
Total approximate time
Garbage (in milliseconds) spent
Collection garbage collecting by Long | Milliseconds
Time the WM during the
sample interval.
Parameters

The following parameters are valid for this counter category.

JMX Port
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JMX port associated with the VM you want to monitor.

Collector Name

This parameter is available with some of the garbage collection counters. It providesthe name of the
garbage collector you want to monitor. For the Hotspot WM, the values are Copy and

MarkSwveepCom pact.

Data Point

The primary data point (PDP) isthe value returned for the counter used in the task.

Interval

Recommended minimum is5 minutes.

MM Memory Counters

The WM Memory category includesthe counterslisted in the following table. ServerVantage utilizes M X
and the Java Monitoring and Management APl which wereintroduced in the Java Virtual Machine (VM)

1.5, release 2SE5.0. -

‘ Type ‘ Units

Counters

Description

Number of timesthat the

Collection | M hasdetected that the
Usage memory usage hasreached Integer Number
Threshold or exceeded the collection of times
Count(M) usage threshold for an
identified memory pool.
Amount of heap memory
that iscommitted to the
MM for use. The WM hasa
heap that istheruntime
data area from which
Committed memoryforallclass
Memory mstancesanq arrays are Long Bytes
Heap allocated. It iscreated at
the WM start-up. Heap
memory for objectsis
reclaimed by an automatic
memory management
system which isknown as
a garbage collector.
Amount of memory that is
Committed | guaranteed to be available Long Bytes
Memory(M) | to the WM to use for the
identified memory pool.
Committed Amount of nqn-heap
Non-heap memory f[hat is guaranteed Long Bytes
to be available to the WM
Memory
for use.
Maximum | Maximum amount of heap |Long Bytes
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Heap memory that can be used

Memory for memory management.
Maximum amount of

Maximum | memory that can be used Lon Bytes

Memory(M) | for memory management 9 Y
for thismemory pool.

. Maximum amount of non-

Maximum heap memory that can be

Non-heap ap Y Long Bytes
used for memory

Memory
management.

Obje(_:ts Approximate number of Number

Pending . )

2 objects for which Integer | of
Finalization finalization is pendin objects
Count P g J

Peak amount of memory
(in bytes) that was
Peak guaranteed to be available
Committed | for use by the VM for the |Long Bytes
Memory(M) | identified memory pool
since the VM was started
or sincethe peak was reset.
Peak maximum amount of
memory (in bytes) that was
Peak availableto the VM for
Maximum | theidentified memory Long Bytes
Memory(M) | pool sincethe WM was
started or since the peak
was reset.
Peak used memory (in
Peak Used bytes) for the |qlent|f|ed
Memory (M) memory pool since t_he Long Bytes
MM was started or since
the peak was reset.
Amount of memory (in
bytes) that isguaranteed to
Post be available for use by the
Collection | WM for theidentified Lon Bvtes
Committed | memory pool after the WM 9 Y
Memory(M) | most recently expended
effort in recycling unused
objects.
Maximum amount of
Post memory (in bytes) that is
: availableto the WM for
Collection . e
) theidentified memory Long Bytes
Maximum
pool after the WM most
Memory(M

recently expended effort in
recycling unused objects.
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Used memory (in bytes) for

E(z)ﬁection theidentified memory
Used pool after the WM most . Long Bytes
Memory(M) recently expended effort in
recycling unused objects
Total Total number of timesthat
Collection the WM has detected that
Usage the memory usage has Long Number
Threshold reacheq or exceeded the of times
Count(M) collection usage threshold
for amemory pool.
Total Amount of memory (in
Committed bytes) that isguaranteed to Long Bytes
be available for use by the
Memory(M) MM
Total Maximur? argoun)t of
. memory (in bytes
Maximum availableto the WM for Long Bytes
Memory(M) memory management
Number of timesthat the
MM hasdetected that the
Total Usage | memory usage for a Number
Threshold memory pool hasreached |Long of times
Count(M) or exceeded the usage
threshold for the memory
pool.
Amount of memory (in
Total Used bytes) currently in use by Long Bytes
Memory(M) the VM.
Number of timesthat the
MM hasdetected that the
Usage memory usage for a
Threshold memory pool hasreached |Long glfutTrr?gg
Count(M) or exceeded the usage
threshold for the memory
pool.
Amount of heap memory
(in bytes) currently in use
by the WM. The WM has a
heap that istheruntime
data area from which
Used Heap | memory for all class Long |Bytes
Memory instances and arrays are

allocated. It iscreated at
the WM start-up. Heap
memory for objectsis
reclaimed by an automatic
memory management
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system which isknown as

a garbage collector.
Used Used memory (in bytes) for

theidentified memory Long Bytes
Memory(M)

pool.
Used Non- Amount qf non-heap

memory (in bytes)
heap . Long Bytes
Memor currently in use by the

Yo lm.

Parameters

The following parameters are valid for this counter category.

JMX Port

JMX port associated with the VM you want to monitor.

Memory Pool Name

This parameter is available with some of the memory pool counters. It providesthe name of the
memory pool you want to monitor. For the Hotspot VM, the values are Code Cache and Survivor

Space.
Data Point

The primary data point (PDP) isthe value returned for the counter used in the task.

Interval

Recommended minimum is5 minutes.

MM Operating System Counter

The WM Operating System category includesthe counterslisted in the following table. ServerVantage
utilizes M X and the Java Monitoring and Management APl which were introduced in the Java Virtual
Machine (WM) 1.5, release 2SE 5.0.

Counters Description

Available Number
Number of processors

Processor available to the WM. Integer | of
Count processors
Parameters

The following parameter isvalid for this counter category.

JMX Port

JMX port associated with the VM you want to monitor.

Data Point

The primary data point reportsthe number of processors available to the WM .
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Interval

Recommended minimum is5 minutes.

VM Threads Counters

The WM Threads category includesthe counterslisted in the following table. ServerVantage utilizes M X
and the Java Monitoring and Management APl which wereintroduced in the Java Virtual Machine (VM)
1.5, release 2SE5.0.

Counters Description ‘ Type‘ Units

Live Number
Daemon Number of live daemon Integer | of
Thread threads.
threads
Count
Live Number
Thread Number of live threads. Integer | of
Count threads
Number of threadsthat are
in deadlock waiting to
acquire object monitors. A
thread ismonitor-
deadlocked if it is part of a
Monitor cyclein therelation "is Number
Deadlocked | waiting for an object
. i Integer | of
thread monitor owned by." In the threads
count simplest case, thread A is
blocked waiting for a
monitor owned by thread
B, and thread B is blocked
waiting for a monitor
owned by thread A.
Sarted Number of threads started Number
Thread by the WM during the Integer | of
Count sampleinterval. threads
Parameters

The following parameters are valid for this counter category.

JMX Port

JMX port associated with the VM you want to monitor.

Thread ID

Identifiesthe individual thread in the process you want to monitor.

Data Point

The primary data point (PDP) isthe value returned for the counter used in the task.

Interval
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Recommended minimum is5 minutes.

Managing Counters

Adding Countersto a Task Using New Discovery Data

Add countersto amonitoring task by generating the available counter data and selecting the counters and
instancesto add to the task.

To add countersand instancesto a monitoring task:

1. From the Conductor menu bar, click Tools>Monitor Tasksto open the Manage Monitoring Tasks
dialog window.

Open or create a task.

3. Inthemenu bar, click Actions>Add counter>Use new discovery counters. The Edit Existing
Monitor Wizard appears.

4. Follow theinstructionsfor using the wizard to discover and add countersto the monitoring task.
Notes:

I (WebLogic and WebSphere) When the monitor to which you are adding countersis managed
by an administrative server, the Edit Existing Monitor wizard appears and the counter discovery
process beginsimmediately.

I (SNMP) You can supplement the counter discovery list by creating and specifying a custom
OID file. See Customizing SNMP Counter Discovery for more information.
Adding Countersto a Task Using Cached Discovery Data

It ispossibleto add countersto monitor for amachine and monitor type using cached discovery data. To
add countersto atask using cached discovery, do the following:

Sep 1: Select the counter to add or modify
Sep 2: Choosetheinstances of the counter to monitor
Sep 3: Review the monitor definition

Sep 4: Save the task

Step 1: Select the counter to add or modify:

1. From the Conductor menu bar, click Tools>Monitor Tasksto open the Manage Monitoring Tasks
dialog window.

2. Inthemenu bar, click Actions>Add counter>Use cached discovery counters. This Add/Edit
Countersdialog box appears.

3. From the Available Item s pane, select the Template tab or the Counter tab.

4. To add an item, select atemplate or a counter, and click Add, or double-click the item to display it
in the Selected Items pane. Click Add All to add all theitemson the selected tab to the Selected
Iltems pane.

5. Toremove an item, double-click the item in the Selected Items pane or select theitem and click
Remove. Theitem isreturned to the Available Items pane.

Note: Select multiple counters and templates by doing one of the following:
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I To select nonadjacent counter items, click a counter item, and then hold down Ctrl and click
each additional counter item.

I To select adjacent counter items, click the first counter item in the sequence, and then hold
down Shift and click the last counter item.

6. Click Next. The Choose Instances dialog box displays.

El Note: When you select atemplate, and some of the countersit contains are not present on the
machine you are defining, you receive a message with alist of the countersthat will not be added to the
task.

Step 2: Choose the instances of the counter to monitor:

When clicking Next in the previous dialog box. The Choose Instances dialog box appears.

1. Review the countersselected. When ared dot appears next to a counter, select an instance of the
counter.

Double-click the counter group to display the counters.

Select a counter and click Edit. The Select instance for counter dialog box appears.

In the Available Instance pane, select an instance and click Add.

Repeat until all instances of the counter that you want to apply to the task are selected.
Click Save. The Choose Instances dialog box appears.

Repeat this process for each designated counter.

© N o o A~ DN

Click Next. The Summary dialog box displays.

Step 3: Review the monitor definition:

1. In the Review Monitor Definition dialog box, review the information for the monitoring machine
you defined.

2. Select one of the following:

I Set up another monitor for thistask - returnsto the Enter properties of the monitoring
machine dialog box so you can add another monitor to the monitoring task. When complete,
proceed with Sep 3 below.

I Continuewithout adding any more monitors - continuesin thisdialog box.

El Note: (WebLogic and WebSphere) When you set up another monitor in a managed server
environment, you only can add another monitor using a different administrative server.

! Toadd aWebLogic monitor, you must use the same WebLogic jar filesand WebLogic version
asthe current monitor.

! Toadd aWebShere monitor, you must usethe same WebShere Home, WebSphere client
version, and WebSphere server version asthe current monitor.

3. (Optional) In the Monitors pane, select the monitor type and click Save as Template to create a
template for thismonitoring task.

4. (Optional) In the Monitors pane, select a monitor and click Remove Monitor to delete amonitor
from the task.

5. (Optional) Type anew valuein the Sample Interval field. Thisisthe frequency, in seconds, at
which QALoad requests data during runtime data collection.
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6. Click Next to proceed to the next step, where you review and save your selections.

Step 4: Save the task:

When clicking Next in the previous dialog box, the Summary dialog box appears.

1. OntheSummary dialog box, review the monitors and counters selected for the template. Click
Back to return to adialog box and make changesto the information.

2. Click Finish to add the counters.

Removing a Monitor or a Counter from a Monitoring Task

Remove a monitor or a counter from a monitoring task, by following this procedure.

To remove a counter from a monitoring task:

1. IntheMonitorspane of the Manage Monitoring Tasks window, select the monitor, counter, or
counter family to delete.

2. Click Actions>Remove Monitor/Counter.

3. When the verification dialog box displays, click OK.

Il Note: You cannot remove the last monitor on amachine, the last counter in the family, or the last
family of countersin the task.

Monitoring Templates

About Monitoring Templates

Monitoring templates are designed to facilitate the configuration process. A monitoring templateisa
predefined group of counters not associated with a specific machine. You can create a new template for a
monitoring task, or you can use one of QALoad's pre-defined templates.

When you create a custom template, QALoad's New Monitoring Template wizard guidesyou through the
process of defining the type of template you want to create, configuring the monitor properties, and
adding the counters and instances of countersto the template.

When you use one of QALoad's predefined templates, you select a stored template with the countersyou
want to monitor. The templates have counters grouped by functionality, such as Network Traffic, Response
Time, or System Health. Where appropriate, the templatesinclude the specific instancesto monitor for
each counter.

You can add or edit countersin either custom or pre-defined templates. When you open atemplate to edit
it for thefirst time, Edit Monitoring Template wizard guidesyou through the process of discovering and
adding new countersto atemplate. When you've just completed the counter discovery process for a
template, either by creating a new template or by opening atemplate for editing, you can select counters
from those already available in memory by using the cached discovery.

Custom Templates

You can create templates of the monitoring tasksthat you develop so that all of the countersand instances
for the task are saved. You can create new tasks and incorporate the template you created. Templates are
saved as.xml filesin the Templates directory.
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You can create atemplate when you define a monitoring task, or you can use the New Monitor Template
wizard to create and store atemplate for future use. Custom templates can be modified using either new
discovery data or cached discovery data.

Pre-defined Templates

About Pre-defined Templates

QALoad provides pre-defined templates for each monitor type. Each template includesthe counters most
commonly used for particular task within each monitor type.

QALoad providesthe templates form the following monitor types:
I Oracle Application Server
I VM
I SAP
I SNMP
I WebLogic
I WebSphere
I WebSphere MQ
I Windows Registry
I WMI
El Note: You cannot modify pre-defined templates.

Viewing Pre-defined Templates

QALoad provides pre-defined templates for each monitor type. These include the countersmost commonly
used for particular task.

To access and review pre-defined templates:

1. In the Conductor, select Tools>Monitor Tasksto open the Manage Monitoring Tasks window.

2. In the Manage Monitoring Tasks menu bar, click Templates>Open Existing. The Select a Monitor
Template File dialog box appears and lists pre-defined templates and custom templates you created
and saved.

Double-click a monitor type, then select atemplate file and click Open.

4. Thetemplate namedisplaysin the Manage Monitoring Tasks dialog box.

Oracle Application Server Templates

Oracle Application Server Template Index
QALoad providesthe following pre-defined Oracle Application Server (AS) 10g database templates:
Oracle AS Availability

Oracle AS Performance
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Oracle Application Server Availability
Thistemplate monitorsthe availability of an Oracle Application Server (AS) 10g database.
Note: Thistemplateisonly available if you have Oracle AS10g installed on your monitored server.

Thistemplate includesthe following counters and categories:

Oracle ASHTTP OC4JMetrics OC4XJnavailable Total number of timesthat an oc4j WM could not
be found to service requests.

UnableToHandleReq Total number of timesmod_oc4j declined to
handle arequest.

Oracle ASHTTP Server Metrics readyChildren Number of child processesthat are ready to run.
Oracle AS Process Man ager regFail Number of HTTP requests which fail.
Metrics

Oracle Application Server Performance
Thistemplate monitorsthe availability of an Oracle Application Server (AS) 10g database.
Note: Thistemplateisonly available if you have Oracle AS10g installed on your monitored server.

Thistemplate includesthe following counters and categories:

Oracle ASHTTP OC4JMetrics ErrReqSess Foecifiesthe total number of session requeststhat
mod_oc4j failed to routeto an OC4Jprocess.

SucReqSess Foecifiesthe total number of session requeststhat
mod_oc4j successfully routed to an OC4Jprocess.

Oracle ASHTTP Server Metrics busyChildren Number of child processes active.
connection.avg Average time spent servicing HTTP connections.
request.avg Average time required to service an HTTP request.

SAP Templates

SAP Templates

QALoad providesthe following pre-defined SAP templates:
QALoad-SAP R3 Remote Availability

QALoad-SAP R3 Remote Performance

QALoad-SAP R3 Remote System Errors

QALoad-SAP R3 Remote Availability

Thistemplate monitorsthe availability of an SAP R/3 Instance. The SAP R/3 Availability template returns
critical information about the availability of your SAPinstallation. One metric used to determinethe
availability of an SAP R/3 Instance isthe status of the SAP collector.

491



Using the Conductor

The default event action assigned to thistemplate issuesan alarm if either the specified R/3 Instance or the
collector goesdown. The default instance isthe first SAP Instance configured for monitoring during
installation.

The SAP R/3 Availability template uses the following SAP R/3 extended counters:

Active Servers Returnsthe number of active SAP application serversfor
agiven instance. It detectswhen aremote server is
unavailable.

Rule: IF 'SAP R/3 Remote Extended.Active Servers(SAP
Instance: "**", Server Count: "10")' =0 .

QALoad-SAP R3 Remote Performance
Thistemplate monitorsthe performance of your SAP R/3 Instance.

The default event action for thistemplate raises an event if the number of alerts of critical statusis greater
than O, or if the buffer hit ratio falls below 95%.

All the counters associated with thistemplate require the instance number of your SAP installation. By
default, thistemplate usesthe first instance configured for monitoring during ServerVantage installation. If
you use thetask configuration wizard to change the instance that the template monitors, you must also
change the instance specified in the rule accordingly.

The SAP R/3 Performance template uses the following SAP R/3 extended counters;

Buffer Statistic Returnsdifferent buffer statistics for selected buffer name. This
counter was chosen because buffering datais a key to the
performance of SAP.

Rule: IF 'SAP R/3 Remote Extended.Buffer Satistic(SAP Instance:
"xxt Buffer Name: "TTAB", Satistic Name: "Hit rate SAP
buffer(%%)")' < 95.

Itemized Spool Queue Return number of entriesin the spool queue that match the
specified criteria.
Rule: IF 'SAP R/3 Remote Extended.Spool Queue(SAP Instance:
" Request Status: "Processing”)' > 10.

Memory Usage Returns current memory usage.
Rule: IF 'SAP R/3 Remote Extended.Memory Usage(SAP Instance:
"**" Count: "10", Metrics: "MB")' > 10000.

Page/Roll Area Returns Used Paging Area % statistic. This counter was chosen
because roll memory iscritical for work processes and page
memory iscritical for internal data processing.

Work Processes Counter for monitoring SAP R/3 work processes. Returns number
of stopped work processes.

Rule: IF'SAP R/3 Remote Extended.Work Processes(SAP Instance:
"**" Process Type: "BGDDIAENQSPOUP2UPD", Process Sate:
"Sopped") > 2.
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QALoad-SAP R3 Remote System Errors

Thistemplate monitorsthe errorsand critical situationsthat occur on a SAP R/3 system. Rules and
thresholds are preset to appropriate values for most sites.

The default sampling interval for thistemplateis5 minutes.

The SAP R/3 Performance template uses the following SAP R/3 Remote extended counters:

Alerts Counter for monitoring R/3 alerts. Returns number of alerts
according to the specified criteria. This counter checks all alerts
with error (red) status.

Rule: IF'SAP R/3 Remote Extended.Alerts(SAP Instance: "**",
Monitor Set: "SAP CCMSAdmin Workplace", Monitor:
"Database", Severity: "Error - Red", Pattern: "*", Show Alert Text:
IINOII)I > 0.

Itemized Spool Queue Return number of entriesin the spool queue that match the
specified criteria.

Spool Queue Return number of entriesin the spool queue that match the
specified criteria. This counter checks all spool entries with
“Problem” status.

Rule: IF'SAP R/3 Remote Extended.Spool Queue(SAP Instance:
"**" Request Satus: "Problem")' > 0.

Work Processes Counter for monitoring SAP R/3 work processes. Returns number
of work processes according to the specified criteria. This counter
checks stopped work processes.

Rule: IF'SAP R/3 Remote Extended.Work Processes(SAP Instance:
"**" Process Type: "BGDDIAENQSPOUP2UPD", Process Sate:
"Sopped") > 0.

SNMP Templates

INMP Templates

QALoad providesthe following pre-defined SNMP templates:
QALoad-HP Performance

QALoad-Linux Performance
QALoad-SUN Performance

QALoad-HP Performance

Thistemplate includesthe following counters and categories:

HP System Cpuldle% CpuSys% isthe percentage of idle processor
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time.

CpuSys¥ CpuSys% isthe percentage of non-idle
processor timethat isspent in system mode.

CpuUser% CpuUser% isthe percentage of non-idle
processor timethat isspent in user mode.

FreeMemory KBytes FreeMemory KBytesisthe amount of idle
memory.

FreeSwvap KBytes FreeSwap isthe amount of free swap space on
the system.

MaxUserMem KBytes MaxUserMem isthe amount of maximum user
memory on the system.

Users Usersisthe number of userslogged on to the
machine.
tcp teplnSegs/sec tcplnSegs/sec isthe rate at which segments are

received, including those received in error.

tcpOutSegs/sec tcpOutSegs/sec istherate at which segments
are sent, including those on current
connections but excluding those containing
only retransmitted octets.

udp udplnDatagram s/sec udplnDatagrams/sec isthe rate of UDP
datagrams being delivered to UDP users.

udpOutDatagrams/sec = udpOutDatagrams/sec isthe rate at which UDP
datagrams are sent.

QALoad-Linux Performance

Thistemplate includesthe following counters and categories:

Linux System Cpuldle% CpuSys% isthe percentage of idle processor
time.
CpuSys¥ CpuSys% isthe percentage of non-idle processor

timethat isspent in system mode.

CpuUser% CpuUser% isthe percentage of non-idle
processor timethat isspent in user mode.

Interrupts/sec Interrupts/sec istherate of system interrupts.
Pagesin KBytes/sec Pagesin KBytes/sec isthe rate of pagesread in
from disk.

PagesOut KBytes/sec = PagesOut KBytes/sec isthe rate of pageswritten
to disk.
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udp

Swaplin KBytes/sec

SwvapOut KBytes/sec

tepln Segs/sec

tcpOutSegs/sec

udplnDatagrams/sec

udpOutDatagrams/sec

QALoad-SUN Performance
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Swapln KBytes/sec istherate at which pages are
being swapped in.

SwapOut KBytes/sec istherate at which pages
are being swapped out.

tcplnSegs/sec isthe rate at which segments are
received, including those received in error.

tcpOutSegs/sec istherate at which segments are
sent, including those on current connections but
excluding those containing only retransmitted
octets.

udplnDatagrams/sec isthe rate of UDP
datagrams being delivered to UDP users.

udpOutDatagrams/sec isthe rate at which UDP
datagrams are sent.

Thistemplate includesthe following counters and categories:

Sun System

tcp

Cpuldle%

CpuSys¥

CpuUser%

Interrupts/sec

Pagesin KBytes/sec

PagesOut KBytes/sec

Swaplin KBytes/sec

SwvapOut KBytes/sec

teplnSegs/sec

tcpOutSegs/sec

CpuSys% isthe percentage of idle processor
time.

CpuSys% isthe percentage of non-idle processor
timethat isspent in system mode.

CpuUser% isthe percentage of non-idle
processor timethat isspent in user mode.

Interrupts/sec istherate of system interrupts.

Pagesin KBytes/sec isthe rate of pagesread in
from disk.

PagesOut KBytes/sec istherate of pages written
to disk.

Swapln KBytes/sec isthe rate at which pages are
being swapped in.

SwvapOut KBytes/sec istherate at which pages
are being swapped out.

tcplnSegs/sec isthe rate at which segments are
received, including those received in error.

tcpOutSegs/secistherate at which segments are
sent, including those on current connections but
excluding those containing only retransmitted
octets.
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udp udplnDatagrams/sec udplnDatagrams/sec istherate of UDP
datagrams being delivered to UDP users.

udpOutDatagrams/sec udpOutDatagrams/sec isthe rate at which UDP
datagrams are sent.

WebLogic Templates

W ebLogic Templates

QALoad providesthe following pre-defined WebLogic templates:
QALoad-WebLogic Availability

QALoad-WebLogic EB Performance

QALoad-WebLogic JDBC Performance

QALoad-WebLogic M S Performance

QALoad-WebLogic Performance

QALoad-WebLogic Server Security

QALoad-WebLogic Servlet Performance

QALoad-W ebLogic Availability

Thistemplate monitorsthe availability of a WebLogic server. The WebLogic Availability template returns
critical information about the availability of your WebLogic installation.

The default sampling interval for thistemplateis5 minutes.

The WebLogic Availability template uses the following WebLogic extended counters:

ExecuteQueueRuntime  ExecuteQueueRuntime PendingRequestOldestTime Returnsthetime
that the longest
waiting request
was placed in the
gueue.

Rule: The
Application
Server isnot in
running mode if
this counter value
is>50.

ServerRuntime ServerRuntime_StateVal Returns current
state of the
server. This
counter provides
amore detailed
state than
available or not.

Rule: The
Application
Server isnot in
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running mode if
thiscounter value
is<>2.

ServerSecurityRuntime  ServerSecurityRuntime_LockedUsersCurrentCount Returnsthe
number of
currently locked
userson this
server.

Rule: There are a
high number of
userslocked out if
this counter value
is >5.

QALoad-W ebLogic EB Performance

Thistemplate monitorsthe EB performance of a WebLogic server. The WebLogic EB Performance
template returnscritical information about the performance of your WebLogic installation.

The default sampling interval for thistemplateis5 minutes.

The WebLogic EB Performance template usesthe following WebLogic extended counters:

EJBBCacheRuntime EBCacheRuntime_ActivationCount Returnsthe
total number
of timesthe
EJB was
activated.

Rule: Thereis
inefficient
cache access if
the number
of activations
is> 20.

EJBCacheRuntime_CacheAccessCount Returnsthe
total number
of attemptsto
access a bean
from the
cache.

EBCacheRuntime_CachedBeansCurrentCount Returnsthe
total number
of beans from
this EB
Home
currently in
the EB cache.

EBCacheRuntime_CacheHitCount Returnsthe
total number
of times an

497



Using the Conductor

EJBLockingRuntime

498

EBCacheRuntime_PassivationCount

EBLockingRuntime_LockEntriesCurrentCount

EBLockingRuntime _TimeoutTotalCount

EBLockingRuntime WaiterTotalCount

attempt to
access a bean
from the
cache
succeeded.
The
cacheHitCou
nt value
subtracting
the cache
miss count
from the
cache access
count.

Returnsthe
total number
of beansfrom
this EB
Home that
have been
passivated.

Rule: Thereis
inefficient
cache access if
the number

of
passivationsis
> 20.

Returnsthe
number of
currently
locked users
on thisserver.

Returnsthe
current
number
Threadsthat
have timed
out waiting
for alock on
a bean.

Returnsthe
number of
objects
waiting on
the lock.

Rule: There
are alot of
objects
waiting if the
interval value



EJBPoolRuntime

EJBPoolRuntime_BeanslnUseCurrentCount

EBPoolRuntime_ldleBeansCount

EJBPoolRuntime_TimeoutTotalCount

EBPoolRuntime_WaiterTotalCount
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of this
counter is>
10.

Returnsthe
number of
bean
instances
currently
being used
from the free
pool.

Returnsthe
total number
of available
bean
instancesin
the free pool.

Returnsthe
total number
of Threads
that have
timed out
waiting for an
available bean
instance from
the free pool.

Rule: There
are alot of
objectstiming
out if the
interval value
of this
counter is >
20.

Returnsthe
total number
of Threads
currently
waiting for an
available bean
instance from
the free pool.

Rule: There
are alot of
objects
waiting if the
interval value
of this
counter is>
10.
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EJBTransactionRuntime

MessageDrivenEJBRuntime

500

EBTransactionRuntime_TransactionsCommittedTotalCount

EXBTransactionRuntime_TransactionsRolledBackTotalCount

EBTransactionRuntime _TransactionsTimedOutTotalCount

MessageDrivenEJBBRuntime_JM SConnectionAlive

Returnsthe
total number
of
transactions
that have
been
committed
for this EJB.

Rule: Thereis
high
transaction
overhead if
theinterval
value of this
counter is>
20.

Returnsthe
total number
of
transactions
that have
been rolled
back for this
EJB.

Rule: Thereis
high
transaction
overhead if
theinterval
value of this
counter is>
20.

Returnsthe
total number
of
transactions
that have
timed out for
this EB.

Rule: Thereis
high
transaction
overhead if
theinterval
value of this
counter is>
20.

Returnsa
boolean of
the status of
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the
connection.
Thiscounter
displaysthe
state of aMS
connection.

Rule: The M S
Connection is
down if this
counter value
is=0.

Thistemplate monitorsthe JDBC performance of a WebLogic server. The WebLogic JDBC Performance
template returnscritical information about the performance of your WebLogic installation.

The default sampling interval for thistemplateis5 minutes.

The WebLogic DBC Performance template usesthe following WebLogic extended counters:

JDBC Connection Pool
Runtime

ActiveConnectionsCurrentCount

ActiveConnectionsHighCount

ConnectionDelayTime

ConnectionsTotalCount

FailuresToReconnectCount

LeakedConnectionCount

Returnsthe current number of active
connections.

Returnsthe highest number of active
current connections. The count starts
at zero each timethe
JDBCConnectionPoolRuntimeM Bean
isinstantiated.

Returnsthe number of milliseconds it
takesto get a physical connection
from the database. It is calculated as
summary time to connect divided by
summary number of connections.

Returnsthe total number of JDBC
connectionsin this
DBCConnectionPoolRuntimeM Bean
since the pool wasinstantiated.

Returnsthe number of attemptsto
refresh a connection to a database that
failed. Failure may be dueto the
database being unavailable or a
broken connection to the database.

Rule: There are ahigh number of
connection reconnect failureswhen
thiscounter valueis> 1.

Returnsthe number of connections
that were checked out from the
connection pool but were not
returned to the pool by calling close
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0-

Rule: Thereisalot of connection pool
leakage if this counter valueis > 5.

PoolSate Current state of the connection pool.
Returns True if the pool isenabled,
False if the pool isdisabled.

PrepSmtCacheMissCount Returnsacount of the caseswhen the
cache doesnot have a cached
statement to satisfy arequest.

WaitingForConnectionHighCount The high water mark of waiters for a
connection in this
JDBCConnectionPoolRuntimeM Bean.
The count starts at zero each timethe
JDBCConnectionPoolRuntimeM Bean
isinstantiated.

WaitSecondsHighCount Returnsthe highest number of
seconds a connection waited.

Rule: Thereisalong wait for the
connection pool if thiscounter value
is > 120.

QALoad-W ebLogic MS Performance

Thistemplate monitorsthe MSperformance of a WebLogic server. The WebLogic M SPerformance
template returnscritical information about the performance of your WebLogic installation.

The default sampling interval for thistemplateis5 minutes.

The WebLogic M S Performance template usesthe following WebLogic extended counters:

JMSConnectionRuntime SessionsCurrentCount Returnsthe current number of
sessions for thisconnection.

SessionsTotalCount Returnsthe number of sessions
on thisconnection since the last
reset.

JMSRuntime ConnectionsCurrentCount Returnsthe current number of
connectionsto thisWebLogic
Server.

ConnectionsTotalCount Returnsthe total number of
connections made to this
WebLogic Server sincethe last
reset.

JM SServerRuntime M essagesPendingCount Returnsthe current number of
messages pending
(unacknowledged or
uncommitted) stored on this
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JM Sserver. Pending messages
are over and above the current
number of messages.

Rule: There are alarge number
of pending messages if this
counter valueis > 50.

M essagesReceivedCount Returnsthe number of messages
received on thisdestination
sincethe last reset.

M SSessionRuntime ConsumersCurrentCount Returnsthe current number of
consumers for this session.

M essagesPendingCount Returnsthe number of messages
pending (uncommitted and
unacknowledged) for this
session.

Rule: There are alarge number
of pending JM S Session messages
if thiscounter valueis> 50.

M essagesReceivedCount Returnsthe number of messages
received on thisdestination
sincethelast reset.

M essagesSentCount Returnsthe number of bytes
sent by thissession since the last
reset.

QALoad-W ebLogic Performance

Thistemplate monitorsthe performance of aWebLogic server. The WebLogic Performance template
returnscritical information about the performance of your WebLogic installation.

The default sampling interval for thistemplateis5 minutes.

The WebLogic Performance template usesthe following WebLogic extended counters:

ConnectorServiceRuntime ConnectionPoolCurrentCount Returnsthe number of
currently deployed
connection pools.

ExecuteQueueRuntime ExecuteThreadCurrentldleCount Returnsthe number of idle
threads assigned to the
gqueue.

PendingRequestCurrentCount Returnsthe number of

waiting requestsin the queue.

Rule: There are alarge
number of pending requestsif
this counter value is > 50.
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ServicedRequestTotalCount Returnsthe number of
requeststhat have been
processed by this queue.

JMSRuntime ConnectionsCurrentCount Returnsthe current number
of connectionsto this
WebLogic Server.

Rule: There are alarge
number of MSconnectionsif
this counter value is > 20.

JTARuntime ActiveTransactionsTotalCount Returnsthe number of active
transactions on the server.

SecondsActiveTotalCount Returnsthe total number of
seconds for all committed
transactions.

TransactionRolledBackResourceTotalCount Returnsthe number of
transactionsthat were rolled
back dueto aresource error.

TransactionTotalCount Returnsthe total number of
transactions processed. This
total includes all committed,
rolled back and heuristic
transaction completions.

JVMRuntime HeapFreeCurrent Returnsthe current amount
of free memory (in bytes) in
the WM heap.

TimeServiceRuntime ExceptionCount Returnsthetotal number of

exceptionsthrown while
executing scheduled triggers.

Rule: There are alarge
number of exceptionsif the
interval value of this counter
is> 20.

ExecutionsPerMinute Returnsthe average number
of triggers executed per
minute.

QALoad-W ebLogic Server Security

Thistemplate monitorsthe security of a WebLogic server. The WebLogic Server Security template returns
critical information about the security status of your WebLogic installation.

The default sampling interval for thistemplateis5 minutes.

The WebLogic Server Security template usesthe following WebLogic extended counters:;

504



QALoad Online Help

ServerSecurityRuntime | InvalidLoginAttemptsTotalCount Returnsthe cumulative number of
invalid login attempts made on this
server.

Rule: Multipleinvalid login attempts
have occurred when theinterval
value of thiscounter is> 5.

LockedUsersCurrentCount Returnsthe number of currently
locked userson this server.

Rule: There are multiple locked users
if thiscounter valueis> 5.

LoginAttemptsWhileLockedTotalCount  Returnsthe cumulative number of
invalid login attempts made on this
server while the user was locked.

UnlockedUsersTotalCount Returnsthe number times users have
been unlocked on this server.

QALoad-W ebLogic Servlet Performance

Thistemplate monitorsthe performance of your WebLogic servliet. The WebLogic Servlet Performance
template returnscritical information about the serviet performance of your WebLogic installation.

The default sampling interval for thistemplateis5 minutes.

The WebLogic Servlet Performance template usesthe following WebLogic extended counters:

ServletRuntime ExecutionTimeAverage Returnsthe average time all invocations of the
servlet that has executed since the task was
created.

Rule: The servilet isaveraging high execution
timesif thiscounter value average is > 10.

ExecutionTimeHigh Returnsthe amount of timethe single longest
invocation of the servlet that has executed
since the task was created.

ExecutionTimeTotal Returnsthe total amount of time all
invocations of the servlet that has executed
since the task was created.

Internal Servlet whether thisisan Internal Servlet or not

InvocationTotalCount Returnsthe total number of timesthe servlet
has been invoked. Getsthe
invocationTotalCount attribute of the
ServletRuntimeM Bean object.

ReloadTotalCount Returnsthe total number of timesthe servlet is
reloaded. Getsthe reloadTotalCount attribute
of the ServletRuntimeM Bean object.
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WebSphere Templates

W ebSphere Templates

QALoad providesthe following pre-defined WebSphere templates:
QALoad-WebSphere 5.0 IDBC Performance

QALoad WebSphere 5.0 Performance

QALoad-WebSphere 5.0 Web Application Performance

QALoad-WebShere 5.0 DBC Performance

Thistemplate monitorsthe performance of aWebShere IDBC server. The WebSphere DBC Performance
template returnscritical information about the JDBC performance of your WebSphere installation.

The default sampling interval for thistemplateis5 minutes.

The WebShere IDBC Performance template usesthe following WebSphere extended counters:

JDBC connectionPoolModule.avgWaitTime Average waiting time in milliseconds until a connection
Connectio

n Pool

Module

connectionPoolModule.concurrentWaiters WebSphere extended counter for monitoring
connectionPoolModule.concurrentWaiters

connectionPoolModule.faults Average waiting time in milliseconds until a connection

connectionPoolModule.percentMaxed Average percent of thetimethat all connectionsarein u

Rule: IF 'WebSphere
connectionPoolModule.connectionPoolM odule.percentl
"xx Server: "**" Data Source: "all")' > 25.

connectionPoolModule.percentUsed Average percent of the pool that isin use.

QALoad-W ebSphere 5.0 W eb Application Performance

Thistemplate monitorsthe performance of aWebShere 5.0 Web Application server. The WebSphere 5.0
Web Application Performance template returnscritical information about the Web Application
performance of your WebSphere installation.

The default sampling interval for thistemplateis5 minutes.

The WebSphere 5.0 Web Application Performance template usesthe following WebSpohere extended
counters:

WebSphere servlietSessionsModule.activateNonExistSessions Number of requests for a

servletSessionsModule session that no longer exists,
presumably because the
session timed out. This
counter may indicate a high
number of timeout
conditions.
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servletSessionsM odule.activeSessions

servletSessionsM odule.cacheDiscards

servletSessionsM odule.invalidatedSessions

servletSessionsM odule.invalidatedViaTimeout

WebSphere webAppModule.serviets.concurrentRequests
webAppModule

webAppModule.servlets.numErrors

webAppModule.servlets.responseTime

QALoad W ebSphere 5.0 Performance

Thistemplate includesthe following counters and categories:

QALoad Online Help

The number of concurrently
active sessions. A session is
active if WebSphereis
currently processing a
request, which usesthat
session. This counter may
indicate high activity.

Number of session objects
that have been forced out of
the cache. Thiscounter may
indicate aneed for more
memory in the cache.

Number of sessions
invalidated. This counter
may indicate a high number
of invalidated sessions.

Number of requests for a
session that no
CountSatistic exists,
presumably because the
session timed out. This
counter may indicate a high
number of timeout
conditions.

Number of requeststhat are
concurrently processed. This
counter may indicate high
activity for an application.

Total number of errorsin a
servlet or Java Server Page
(JSP). Thiscounter may
indicate a high number of
error incidents.

Responsetime, in
milliseconds, of a servlet
request. Thiscounter may
indicate a slow response time
of arequest.

WebSphere jvmRuntimeModule.freeMemory WebSphere extended counter for
jvmRuntimeModul monitoring
e jvmRuntimeModule.freeMemory
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WebSphere
orbPerfModule

WebSphere
systemModule

WebSphere
thread PoolModule

jvmRuntimeModule.usedMemory

orbPerfModule.concurrentRequests

orbPerfModule.interceptors.processingTime

orbPerfModule.referenceLookupTime

systemM odule.avgCpuUtilization

systemM odule.freeMemory

hreadPoolModule.activeThreads

WebSphere MQ Templates

WebJPhere MQ Templates

WebShere extended counter for
monitoring
jvmRuntimeModule.usedMemory

WebSphere extended counter for
monitoring
orbPerfModule.concurrentRequests

WebShere extended counter for
monitoring
orbPerfModule.interceptors.processingTime

WebSphere extended counter for
monitoring
orbPerfModule.referenceLookupTime

WebShere extended counter for
monitoring
systemModule.avgCpuUetilization

WebShere extended counter for
monitoring systemModule.freeMemory

WebShere extended counter for
monitoring
threadPoolM odule.activeThreads

QALoad providesthe following pre-defined WebShere MQ templates:
QALoad-WebSphere MQ Availability
QALoad-WebSphere MQ Performance

QALoad-W ebSphere MQ Availability

Thistemplate monitorsthe availability of aWebShere MQ server. The WebSohere MQ Availability
template returnscritical information about the availability of your WebSphere MQ installation.

The default sampling interval for thistemplateis5 minutes.

The WebShere MQ Availability template usesthe following WebSphere MQ extended counters:

Channel Events

Queue Manager Events

Queue Manager
Up/Down
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QALoad-W ebphere MQ Performance

Thistemplate monitorsthe performance of aWebShere MQ server. The WebSphere MQ Performance
template returnscritical information about the performance of your WebShere MQ installation.

The default sampling interval for thistemplateis5 minutes.

The WebShere MQ Performance template usesthe following WebSphere MQ extended counters:

Performance Events Thiscounter reportsthe number of
performance eventsfor the current
interval.

WMI Templates

WMI Templates

QALoad providesthe following pre-defined WMI templates:
QALoad-Active Monitoring Availability

QALoad-Citrix IMA Networking

QALoad-Citrix Metaframe All

QALoad-Citrix MetaFrame IMA

QALoad-Citrix MetaFrame Zone

QALoad-Cold Fusion

QALoad-Generic Application Availability and Performance
QALoad-M SIIS Availability

QALoad-M SIIS Performance

QALoad-Active Monitoring Availability

Thistemplate includesthe following counters and categories:

Memory Available M Bytes
Processor % Processor Time
System System Up Time

QALoad-Citrix IMA Networking

Thistemplate includesthe following counters and categories:

Citrix IMA Networking Bytes Received/sec
Bytes Sent/sec

Network Connections
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Network Interface Bytes Total/sec

QALoad-Citrix Metaframe All

Thistemplate includesthe following counters and categories:
Citrix MetaFrame XP Application Enumerations/sec

Application Resolution Time
(ms)

Application Resolutions/sec
Data Sore Connection Failure
DataStore bytes read/sec
DataStore byteswritten/sec
DataStore reads/sec

DataStore writes/sec

Dynamic Store bytes read/sec

DynamicSore bytes
written/sec

DynamicStore reads/sec
DynamicStore writes/sec

Filtered Application
Enumerations/sec

LocalHostCache bytes read/sec

LocalHostCache bytes
written/sec

LocalHostCache reads/sec
LocalHostCache writes/sec
Zone Elections

Zone Elections Won

Memory Page Reads/sec
PhysicalDisk % Disk Time
Processor % Processor Time
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QALoad-Citrix MetaFrame IMA

Thistemplate includesthe following counters and categories:

Citrix MetaFrame Application Enumerations/sec
XP

Application Resolution Time (ms)
Application Resolutions/sec
Data Store Connection Failure
DataStore bytesread/sec
DataStore bytes written/sec
DataStore reads/sec

DataStore writes/sec

Fltered Application
Enumerations/sec

LocalHostCache bytesread/sec

LocalHostCache byteswritten/sec

LocalHostCache reads/sec

LocalHostCache writes/sec
Terminal Services  Active Sessions

Total Sessions

QALoad-Citrix MetaFrame Zone

Thistemplate includesthe following counters and categories:

Citrix MetaFrame Dynamic Store bytes read/sec
XP

DynamicSore bytes written/sec
DynamicSore reads/sec
DynamicSore writes/sec
LocalHostCache bytesread/sec

LocalHostCache bytes
written/sec
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LocalHostCache reads/sec

Zone Elections

Zone Elections Won
Network Interface Bytes Total/sec

Current Bandwidth
Terminal Services  Active Sessions

Total Sessions

QALoad-Cold Fusion

Thistemplate includesthe following counters and categories:

ColdFusion MX Avg DB Time (msec)
Server

Avg Queue Time (msec)

Avg Req Time (msec)

BytesIn / Sec

Bytes Out / Sec

DB Hits/ Sec

Page Hits/ Sec

Queued Requests

Running Requests

Timed Out Requests
Memory % Committed BytesIn Use

Available Bytes

Page Faults/sec

Process % Processor Time

QALoad-Generic Application Availability and Performance

Thistemplate includesthe following counters and categories:

Process % Processor Time
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System System Up Time

QALoad-MSIIS Availability

Thistemplate includesthe following counters and categories:
System System Up Time
Web Service Current Anonymous Users

Current Connections

Logon Attempts/sec

NonAnonymous Users/sec

Not Found Errors/sec

Total Delete Requests

Total Files Sent

Total Get Requests

Total NonAnonymous
Users

Total Not Found Errors

QALoad-MSIISPerformance

Thistemplate includesthe following counters and categories:

Internet Current Blocked Async I/O
Information Requests
Services Global

Total Blocked Async I/O
Requests

Total Rejected Async 1/0O
Requests

URI Cache Flushes
URI Cache Hits

URI Cache Hits %
URI Cache Misses

PhysicalDisk % Disk Time
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Process % Processor Time
Redirector Current Commands

Network Errors/sec

Server Work Item Shortages
Server Work Queue Length
Queues

Web Service Not Found Errors/sec

Windows Registry Templates

W indows Registry Templates

QALoad providesthe following pre-defined Windows Registry templates:
QALoad-Active Monitoring Availability

QALoad-Citrix IMA Networking

QALoad-Citrix Metaframe all

QALoad-Citrix Metaframe IMA

QALoad-Citrix Metaframe Zone

QALoad-Cold Fusion

QALoad-Generic Application Availability and Performance
QALoad-M SIIS Availability

QALoad-M SlISPerformance

QALoad-Server Health

QALoad-Windows Availability

QALoad-Windows Performance

QALoad-Active Monitoring Availability

Thistemplate includesthe following counters and categories:

Category Description

Memory Available MBytes  Thiscounter monitorsthe Active
Monitoring client site and notifies
you when it islow on resources,
where Processor time is > 95% for
more than 3 intervals. The
parameter for this counter is
Instance. Thedefaultis _Total.

Processor % Processor Time  Raise an event when Active
Monitoring client siteislow on
memory resources, where Available
Memory isat or below 1MB for
morethan 3 intervals.
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System System Up Time This counter teststhe network
connection between two machines
and monitorsthe communication
status of the machinethat receives
communication.

QALoad-Citrix IMA Networking

Thistemplate includesthe following counters and categories:

Citrix IMA Bytes
Networking Received/sec(* _Total”)

Bytes Sent/sec(*_Total”)

Network Connections

Network Interface Bytes Total/sec

QALoad-Citrix Metaframe all

Thiscounter monitorsthe
total bytesreceived per
second.

Thiscounter monitors the
total bytes sent per second.

Thiscounter monitorsthe
network connections.

Thiscounter monitorsthe
network connection total
bytes/sec.

Thistemplate includesthe following counters and categories:

Citrix MetaFrame XP = Application Enumerations/sec = Thiscounter monitors

application enumerations/
sec.

Application Resolution Time This counter monitors

(ms)

application resolution time.

Application Resolutions/sec This counter monitors

application resolutions.

Data Sore Connection Failure Thiscounter monitors

DataStore bytesread/sec

datastore connection failure.

Thiscounter monitors
datastore bytes reads per
second.

DataStore byteswritten/sec Thiscounter monitors

DataStore reads/sec

datastore bytes written per
second.

Thiscounter monitors
datastore reads per second.
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Memory

PhysicalDisk

Processor
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DataStore writes/sec

Dynamic Sore bytes read/sec

This counter monitors
datastore writes per second.

Thiscounter monitors
DynamicSore bytesread per
second.

DynamicSore bytes written/sec This counter monitors

DynamicSore reads/sec

DynamicSore writes/sec

Fltered Application
Enumerations/sec

LocalHostCache bytesread/sec

LocalHostCache bytes
written/sec

LocalHostCache reads/ sec

LocalHostCache writes/ sec

Zone Elections

Zone Elections Won

Page Reads/sec

% Disk Time

% Processor Time

DynamicSore bytes written
per second.

Thiscounter monitors
DynamicSore reads per
second.

This counter monitors
DynamicSore writes per
second.

Thiscounter monitors
Fltered Application
Enumerations per second.

Thiscounter monitors
LoadHostCache bytesread
per second.

This counter monitors
LoadHostCache bytes
written per second.

Thiscounter monitors
LoadHostCache reads per
second.

This counter monitors
LoadHostCache writes per
second.

This counter monitors zone
elections.

This counter monitors zone
electionswon.

This counter monitors page
reads per second.

This counter monitors %
disk time.

This counter monitors %
processor time.
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Thistemplate includesthe following counters and categories:

Citrix MetaFrame
XP

Terminal Services

Application Enumerations/sec

Application Resolution Time (ms)

Application Resolutions/sec

Data Sore Connection Failure

DataStore bytes read/sec

DataStore byteswritten/sec

DataStore reads/sec

DataSore writes/sec

Filtered Application
Enumerations/sec

LocalHostCache bytes read/sec

LocalHostCache byteswritten/sec

LocalHostCache reads/sec

LocalHostCache writes/ sec

Active Sessions

Total Sessions

This counter monitorsthe
application enumeration per
second.

Thiscounter monitorsthe
application resolution time.

This counter monitorsthe
application resolution.

This counter monitorsthe
datastore connection failure.

Thiscounter monitorsthe
datastore bytesread per second.

Thiscounter monitorsthe
datastore bytes written per second.

Thiscounter monitorsthe
datastore reads per second.

Thiscounter monitorsthe
datastore writes per second.

This counter monitors filtered
application enumerations per
second.

Thiscounter monitors
LoadHostCache bytesread per
second.

This counter monitors
LoadHostCache bytes written per
second.

Thiscounter monitors
LoadHostCache reads per second.

Thiscounter monitors
LoadHostCache writes per second.

This counter monitors active
sessions.

This counter monitorstotal
sessions.
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QALoad-Citrix Metaframe Zone

Thistemplate includesthe following counters and categories:

Citrix MetaFrame XP Dynamic Sore bytesread/sec Thiscounter monitorsthe dynamic
store bytesread / sec.

DynamicSore bytes written/sec This counter monitorsthe dynamic
store bytes written / sec.

DynamicSore reads/sec Thiscounter monitorsthe dynamic
store reads/ sec.

DynamicSore writes/sec Thiscounter monitorsthe dynamic
store writes/ sec.

LocalHostCache bytesread/sec Thiscounter monitorsthe
LocalHostCache bytesread / sec.

LocalHostCache bytes Thiscounter monitorsthe
written/sec LocalHostCache byteswritten / sec.
LocalHostCache reads/sec Thiscounter monitorsthe

LocalHostCache reads/ sec.

Zone Elections Thiscounter monitorsthe zone
elections.
Zone ElectionsWon Thiscounter monitorsthe zone

electionswon.

Network Interface Bytes Total/sec This counter monitors network
connection total bytes.

Current Bandwidth This counter monitors network
connection current bandwidth.

Terminal Services Active Sessions Thiscounter monitors active
sessions.
Total Sessions Thiscounter monitorstotal sessions.

QALoad-Cold Fusion

Thistemplate includesthe following counters and categories:

ColdFusion MX Avg DB Time (msec)
Server

Avg Queue Time (msec)
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Process

Avg Req Time (msec)
BytesIn / Sec

Bytes Out / Sec

DB Hits/ Sec

Page Hits/ Sec
Queued Requests
Running Requests
Timed Out Requests

% Committed Bytes|In
Use

Available Bytes
Page Faults/sec

% Processor Time

QALoad-Generic Application Availability and Performance

Thistemplate includesthe following counters and categories:

Process

System

% Processor Time Thiscounter returnsthe
percentage of elapsed time
that all threads of a process
use the processor to execute
instructions. This process
could include code executed
to handle certain hardware
interrupts or trap conditions.

System Up Time This counter monitors critical
tasks by verifying the
existence of processes. You
can monitor single or multiple
tasksrunning on the system
by selecting the Processes tab
from the task manager and
then selecting processes that
you want to monitor. You can
also monitor only certain
instances of atask by
specifying a Process ID to
monitor. If you do not specify
aProcess ID, this counter
monitorsall instances of the
task.

QALoad Online Help
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QALoad-MSIIS Availability

Thistemplate includesthe following counters and categories:
System System Up Time
Web Service Current Anonymous Users

Current Connections

Logon Attempts/sec

NonAnonymous Users/sec

Not Found Errors/sec

Total Delete Requests

Total Files Sent

Total Get Requests

Total NonAnonymous
Users

Total Not Found Errors

QALoad-MSIISPerformance

Thistemplate includesthe following counters and categories:

Internet Current Blocked Async
Information I/O Requests
Services Global

Total Blocked Async I/O
Requests

Total Rejected Async 1/0O
Requests

URI Cache Hushes
URI Cache Hits
URI Cache Hits %

URI Cache Misses

PhysicalDisk % Disk Time
Process % Processor Time
Redirector Current Commands
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Network Errors/sec
Server Work Item Shortages
Server Work Queues Queue Length
Web Service Not Found Errors/sec

QALoad-Server Health

Thistemplate includesthe following counters and categories:

Memory % Committed BytesIn
Use
Pages/sec
PhysicalDisk % Disk Time

Avg. Disk Queue Length
Processor % Processor Time

System Processor Queue Length

QALoad-Windows Availability

Thistemplate monitorsthe availability of the Windows operating system, focusing on:
Logons

Security

Up time

The default sampling interval for thistemplate is5 minutes.

Thistemplate includesthe following counters and categories:

Server Errors Access Permissions The Microsoft Windows
Availability template uses these
Server registry countersto
Errors Logon monitor errors due to logon

Errors System problems.

Errors Granted Access

To enable these counters, you
must configure your Windows
system to audit logon and
logoff events. You can do this
by configuring the Audit Policy
in the User Manager for
Domains program.

Logon Total

Server Sessions The Microsoft Windows
Availability template usesthese
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) monitor how well users’
Sessions Forced Off sessions are running.
Sessions Logged Off If thereisalarge number of
Sessions Timed Out session errors, it isusually due

to systemsrebooting often or
network errors.

System System Up Time This counter returnsthe
number of secondsthat a
system was available for use. If
thisnumber continuesto reset
to zero, it meansthat the
system isrebooting often. For a
report that liststhe number of
timesthat the system has
rebooted over a period of time,
see the Microsoft Windows
Availability Report topic.

QALoad-Windows Performance

Thistemplate monitorsthe performance of the Microsoft Windows system, focusing on:
CPU

Disk I1/O

Disk space

Memory

Network

The default sampling interval for thistemplateis5 minutes.

Thistemplate includesthe following counters and categories:

LogicalDisk % Disk Time Thiscounter monitorsthe
percentage of elapsed time that
the disk servicesread and write
requests, including thetime that
the disk driver waitsin the disk
queue. If thisvalueis
consistently near 100%, the disk
isin very heavy use. You can
determine which processes are
making the majority of the disk
requests by monitoring them
individually.

% Free Space This counter monitorslow free-
space situations.

Avg. Disk Queue Length = Thiscounter indicatesthe
number of pending I/O service
requests. If thereturned valueis
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Available Bytes

Cache Faults/sec
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greater than 2, thereisadisk
problem. On a multi-disk
subsystem, such asastriped set
or striped with parity, you can
perform a calculation to
determinethe presence of a disk
problem. The basic formulais
(Disk Queue Length) - (Number
of Physical Disk Drivesin the
multi-disk configuration).

For example, if you have a
striped set with 3 disk drivesand
aqueuelength of 5, then you
get an acceptable value of 2 (5 -
3=2).

If the valuereturned by this
counter fallsunder 10 MB,
virtual memory isrunning low.
To resolve this, close some
applicationsor increase the
memory settings. If this counter
isconsistently low after an
application isrunning, it usually
indicates a system memory leak.

Asthevaluereturned by this
counter decreases, the value
returned by the Committed
Bytes counter increases. This
indicatesthat a processis
allocating memory from the
virtual address space but might
not be using it. Because the
virtual address spaceisalimited
resource, use these countersto
check for applicationsthat
allocate memory but do not use
it. To resolve this, add more
physical memory. When an
application finishes processing,
notethelast value. If this
counter doesnot return to the
original value, the application
hasamemory leak or ahidden
processthat hasnot properly
terminated.

The acceptable range for
committed bytes should be less
than the physical RAM. The
default value is 64 MB.

If the valuereturned by this
counter islessthan the value
returned by the Page faults/sec
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Committed Bytes

Page Faults/sec

Page Reads/sec

Pages/sec

Transition Faults/sec

Paging File % Usage Peak

PhysicalDisk % Disk Time
Avg. Disk Queue Length

Avg. Disk sec/Transfer
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counter, the system ispaging
too much for anormal system.
To resolve this, add more
physical memory.

This counter returnsthe amount
of virtual memory (in bytes) that
was committed, as opposed to
memory that has was reserved.

If the valuereturned by this
counter isgreater than 5, the
system ispaging too much. Add
more physical memory. A
consistent value of 10 or later
needsimmediate attention.

If this counter returnsa high
peak value, the system is
experiencing alot of paging
activity. A high value also
indicatesthat your system does
not contain enough physical
memory to handle the demands
placed on it by the application.
To resolve this, add more
physical memory. To calculate
the % disk time used for paging,
use the following calculation:

(% Disk Time used for paging) =
(Memory, Pages/sec) * (Average
Disk Transfer/sec) * 100

Thiscounter returnsthe
maximum use of your page file.
If the value the counter returns
consistently reaches 90%, the
virtual address space istoo
small. You should increase the
size of your paging file. When
the value returned by the
counter exceeds 75%, a
significant system performance
degradation becomes noticeable.



Disk Reads/sec
Disk Writes/sec

Processor % Interrupt Time

% Processor Time

% User Time

Redirector Network Errors/sec

Server Bytes Received/sec
Bytes Total/sec
Bytes Transmitted/sec

Errors Logon

Work Item Shortages

System Context Switches/sec

QALoad Online Help

Thiscounter monitorsthe
percentage of time that the
processor spent receiving and
servicing hardware interrupts
during the sampleinterval.

On single processor systems, if
the value returned by this
counter isconsistently higher
than 90%, the CPU probably has
a bottleneck. You should
examine each processin the
system to determine which one
isusing more of the processor
than it should. The process with
the highest peak isgenerally the
performance bottleneck.

Thiscounter monitorsnon-idle
processor time spent in User
mode as a percentage of the
sampleinterval.

This counter indicates how
many serious network errors
have occurred. These errors are
generally logged in the system
event log, so you can check
there for more information. If
an error occurs, take immediate
action to resolve the problem.

Thiscounter determinesif an
unauthorized user istrying to
access your system.

Thiscounter monitorsthe
number of timesthat a work
item was not allocated. You
might need to increase the
InitWorkltems and

MaxW orkltems parameters for
the LanMan Server if this
number continuesto increase.

If the valuereturned by this
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counter valueishigh, assign a
higher priority to the use of
critical sections or semaphores
by the program. Thisachieves a
higher throughput and reduces
task switching.

Processor Queue Length

Managing Monitoring Templates

Creating a New Template

To open the New Monitoring Template wizard:

1.

In Conductor, click Tools>Monitor Tasksto open the Manage Monitoring Tasks window.

2. Click TemplatessSNew Template. The New Monitoring Template Wizard appears.

3.

Click Next to start the procedure.

To create a new template:

Usethe following stepsin the New Monitoring Template wizard to create a new monitoring template:

El Note: (WebLogic and WebSphere) When QALoad detects a managed server environment, you must
also select theindividual server on which to model the template.
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Enter the template properties

Configure the monitor

Server discovery (WebLogic and WebSphere)
Choose the server (WebLogic and WebSphere)
Processthe server (WebLogic and WebSphere)
Counter discovery

Choose the counters

Choose the instances

Review, save, and create the template

Opening an Existing Template

Usethe following stepsto apply a previously created or pre-defined template.

To open and review an existing template:
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1.
2.

In the Conductor, click Tools>Monitor Tasksto open the Manage Monitoring Tasks window.

In the Manage Monitoring Taskswindow, click Templates>Open Existing. The Select a Monitor
Template File dialog box displays.

In the Look in field, select atemplate type, then select atemplate and click Open. The template
and itscountersdisplay in the Manage Monitoring Tasks window.
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Note: To apply atemplate to a task, use the New Monitoring Task wizard.

Editing Instances for Templates

Usethe following stepsto modify the instancesto monitor in acustom template:
Sep 1: Open the Edit Template Instances Wizard

Sep 2: Choosetheinstancesto monitor

Sep 3: Save thetemplate

Step 1: Open the Edit Template Instances wizard:

1. In the Conductor, click Tools>Monitor Tasksto display the Manage Monitoring Taskswindow.
2. Open thetemplate to edit.
3. Click Templates>Edit instances. The Edit Template Instances Wizard appears.

Step 2: Choose the instances of the counter to monitor:

Review the countersyou selected. When ared dot appears next to a counter, you must select an
instance for the counter.

1. Double-click the counter group to display the counters.

Select an instance for a counter and click Edit. The Select instance for counter dialog box appears.
To add an instance: In the Available Instance pane, select an instance and click Add.

To remove an instance: In the Selected instances pane, select an instance and click Remove.

Repeat until you select all instances of the counter that you want to apply to the task.

Click Save. You return to the Choose Instances dialog box.

Repeat this process for each designated counter.
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Click Next. The Summary dialog box displays.

Step 3: Save the template:

1. OntheSummary dialog box, review the monitors and countersyou have selected for the template.
Click Back to return to adialog box and make changesto the information.

2. Click Back to return to the previous step and edit the instances.

3. Click Finish to create the template.

Modifying Template Counters Using New Discovery Data

When you want to add or edit countersin acustom template, you can generate the discovery datathat you
add to the template. The Edit Monitoring Template wizard guides you through the process of generating
and applying new discovery data. Use the following stepsto modify template countersusing new
discovery:

Sep 1: Open the Edit Monitoring Template Wizard
Sep 2: Enter properties of the template

Sep 3: Configure the monitor
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Sep 4: Counter Discovery
Sep 5: Choosethe counters
Sep 6: Choose theinstances of the counter

Sep 7: Save the template

Step 1: Open the Edit Monitoring Template wizard:

1. Inthe Manage Monitoring Tasks window, open the template to edit.

2. Click Templates>Add/Edit Counter>Use new discovery data. The Edit Monitoring Template
wizard appears.

3. Click Next in the Welcome dialog box. The Enter properties of the template dialog box displays.

Note: (WebLogic and WebSphere) You can change the Java Settings field, if necessary. If the Javafile
location has changed, click the Browse button and select the new location.

Step 2: Enter properties of the template:

In the Enter properties of the template dialog box, do the following:
1. Review thetemplateinformation.
2. Typeor edit the description for the templatein the Description field

3. Click Next. The Configure Monitor dialog box displays.

Note: (WebLogic and WebSphere) You can modify any field in the Configure Monitor dialog box
except the Admin Server field.

Step 3: Configure the monitor:

In the Configure Monitor Dialog, do the following:

1. Typethe configuration datafor the host machine, if necessary. Thisdataisused to connect to the
host machine and to the host database during counter discovery and runtime data collection. The
required configuration data varies depending on the monitor type selected. Click alink below to
view therequired configuration details for your monitor type.

I Oracle Application Server
' VM
I SAP
I ServerVantage
I SNMP
I WebLogic
I WebSphere
I WebSphere MQ
I Windows Registry
I WMI
2. Click Next.
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I WebLogic and WebSphere) The Processing Servers dialog box displays. Follow the procedure for

selecting a server. Once you select the server, the automatic counter discovery process begins.

I (All other monitor types) The automatic counter discovery process begins.

Step 4: Counter discovery:

QALoad automatically performsthe counter discovery. The default maximum time for counter discovery is
300 seconds. When counter discovery iscomplete, the Choose Countersdialog box displays.

Step 5: Choose the counters:

When the counter discovery process completes, the Add the desired counter to thistemplate dialog box
appears.

1. From the Available Itemspanein the Choose Countersdialog box, select the Template tab or the
Counter tab.

2. To add an item, select atemplate or a counter to monitor in the task for thismachine and monitor
type, and click Add, or double-click theitem to display it in the Selected Items pane. Click Add
All to add all theitemson the selected tab to the Selected Items pane.

3. Toremove an item, double-click theitem in the Selected Items pane or select the item and click
Remove. Theitem isreturned to the Available Items pane.

Note: Select multiple counters and templates by doing one of the following:

I To select nonadjacent counter items, click one counter item, and then hold down CTRL and
click each additional counter item.

I To select adjacent counter items, click the first counter item in the sequence, and then hold
down SHIFT and click the last counter item.

4. Click Next. The Choose Instances dialog box displays.

Note: When you select atemplate containing countersthat are not present on the machine you are
defining, you receive a message with alist of the countersthat will not be added to the task.

Step 6: Choose the instances of the counter to monitor:

Review the selected counters. When ared dot appears next to a counter, select an instance of the counter.
1. Double-click the counter group to display the counters.

Select a counter and click Edit. The Select instance for counter dialog box appears.

In the Available Instance pane, select an instance and click Add.

Repeat until you select all instances of the counter that you want to apply to the task.

Click Save. The Choose Instances dialog box appears.

Repeat this process for each designated counter.
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Click Next. The Summary dialog box displays.

Step 7: Save the template:

1. OntheSummary dialog box, review the counters and instances you have selected for the template.
Click Back to return to a dialog box and make changesto the information.
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2.

Click Finish to create the template.

Modifying Template Counters Using Cached Discovery

When you need to add or edit countersin atemplate that you created, you can use the cached counter
discovery datato modify the template.

El Note: You cannot modify the countersin pre-defined templates.

Follow these stepsto modify template counters using cached discovery:

Sep 1: Slect the counter to add or remove

Sep 2: Choose theinstances of the counter

Sep 3: Save thetemplate

Step 1: Select the counter to add or remove:

1.
2.

5.

In Conductor, click Tools>Monitor Tasksto open the Manage Monitoring Tasks window.

Open thetemplate to edit, then click Templates>Add/Edit counter>Use cached discovery data.
The Edit Template Counterswizard appearswith the Add/Edit/Remove Template Counters
dialog box displayed.

From the Available Items pane, select the Template tab or the Counter tab.

To add an item, select atemplate or a counter to monitor for thismachine and monitor type, and
click Add, or double-click theitem to display it in the Selected Items pane. Click Add All to add
all theitemson the selected tab to the Selected Items pane.

To remove an item, select the item in the Selected Items pane and click Remove, or double-click
theitem to return it to the Available Items pane.

Note: Select multiple counters and templates by doing one of the following:

6.

I To select nonadjacent counter items, click one counter item, and then hold down Ctrl and
click each additional counter item.

I To select adjacent counter items, click the first counter item in the sequence, and then hold
down Shift and click the last counter item.

Click Next. The Add/Edit/Remove Template Instances dialog box displays.

El Note: When you select atemplate that contains counters not present on the machine you are
defining, a message displays with alist of the countersthat will not be added.

Step 2: Choose the instances of the counter to monitor:

1.
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Review the selected counters. When ared dot appears next to a counter, select an instance of the
counter.

Double-click the counter group to display the counters.

Select a counter and click Edit. The Select instance for counter dialog box appears.
In the Available Instance pane, select an instance and click Add.

Repeat until you select all instances of the counter that you want to apply.

Click Save. The Choose Instances dialog box appears.

Repeat this process for each designated counter.
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Click Next. The Summary dialog box displays.

Step 3: Save the template:

1.

2.

On the Summary dialog box, review the selected monitorsand counters for the template. Click
Back to return to adialog box and make changesto the information.

Click Finish to create the template.

Removing a Counter from a Template

Remove a counter from atemplate by following this procedure.

To remove a counter from atemplate:

1.

2
3.
4

In Conductor, click Tools>Monitor Tasksto open the Manage Monitoring Tasks window.
Select the counter or counter family to delete.
Click Templates>Remove counter.

When the verification dialog box displays, click OK.

Note: You cannot remove the only counter family in atemplate or the last counter in a family.

Creating and Editing Monitoring Tasks

Creating a New Monitoring Task

To open the New Monitoring Task wizard:

1.
OR

From the Conductor Sart Page, click Configure Monitoring in the Tasks area.

In the Conductor's Visual Designer, click Tools>Monitor Tasksto open the Manage Monitoring Tasks
window.

2.
3.

Click FilesSNew. The New Monitoring Task wizard appears.

Click Next to start the procedure.

Zl Note: You can open the Manage Monitoring Tasks window to edit or create atask by clicking the
browse button next to the Monitor task field in the Session node.

To create a new monitoring task:

Usethe following stepsin the New Monitoring Task Wizard to create anew monitoring task:

1.

R e

Define the monitor

Configure the monitor

Discover the servers (WebLogic and WebSphere)
Choose the servers (WebLogic and WebShere)
Processthe Server (WebLogic and WebSphere)

Discover the counters
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Choose the countersfor the monitoring task
Choosetheinstances of the counter to monitor
9. Review the monitor definition

10. Save and create the monitoring task

Using an Existing Monitoring Task

To select an existing monitoring task:

1. From the Conductor Sart Page, click Configure Monitoring in the Tasks area.

OR

In the Conductor's Visual Designer, click Tools>Monitor Tasksto open the Manage Monitoring Tasks
window.

2. Click File>Open. The Choose an Existing Task dialog box appears.
3. Select atask and click OK. The task displaysin Manage Monitoring Tasks window.

4. Select Enableruntime monitoring at the bottom of the window to enable the monitoring task.

Adding a Monitoring Machine
Use this procedure to add a monitor to an existing task.

I For WebLogic, you must use the same WebLogic jar filesand WebLogic version asthe current
monitor.

I For WebSphere, you must use the ssme WebShere Home, WebSphere client version, and
WebSphere server version asthe current monitor.

To open the New Monitoring Task wizard:

1. In the Conductor, click Tools>Monitor Tasksto open the Manage Monitoring Tasks window.

2. Click Actions>Add monitor. The Add Monitoring Machine wizard appears. Click Next to start the
procedure.

To add a monitoring machine:

Use the following stepsin the Add Monitoring Machine wizard to add a monitoring machine to the task:

N |
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Enter properties of the monitoring machine
Configure the monitor

Discover the Servers (WebLogic and WebSphere)
Choose the Servers (WebLogic and WebSphere)
Process the Server (WebLogic and WebSphere)
Discover the counters

Choose the countersfor the monitoring task

Choosetheinstances of the counter to monitor
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Review the monitor definition

10. Save and create the monitoring task

Editing a Monitoring Machine

To open the Edit Monitoring Machine wizard:

1. In Conductor, click Tools>Monitor Tasksto open the Manage Monitoring Tasks window.

2. Select amonitor in the Monitors panel, then click Actions>Edit monitor. The Edit Existing
Monitor wizard appears.

3. Click Next to start the procedure.

! You can open the Manage Monitoring Taskswindow to edit or create atask by clicking the
browse button next to the Monitor task field in the Session node.

To edit a monitoring machine:

Use the following stepsin the Edit Existing Monitor wizard to change the properties of amonitoring
machine:

1. Enter properties of the monitoring machine
Configure Monitor Dialog

Discover the Counters

Choose Counters

Choose Instances

Review Monitor Definition

N g koD

Summary
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Editing an Existing Server Group

(WebLogic and WebSphere) In a managed server environment, you can add, edit, or remove monitors
managed under the same administrative server using this procedure.

To open the Edit Existing Monitor Group wizard:

1.

2
3.
4

In the Conductor, click Tools>Monitor Tasks. The Manage Monitoring Tasks dialog box appears.
Select a monitor, then click Actions>Edit Monitor. The Edit Monitor dialog box appears.

Select Edit Server Group, then click OK. The Edit Existing Monitor Group wizard appears.

Click Next.

El Note: You can open the Manage Monitoring Tasks window to edit or create atask by clicking the
browse button next to the Monitor task field.

To add, edit, or remove a monitor:

Usethe following stepsin the Edit Existing Monitor Group Wizard:

1.
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Enter Properties of the Monitoring Machine
Configure Monitor Dialog

Discover Servers

Choose Servers

Process Server

Discover Counters

Choose Counters

Choose Instances

Review Monitor Definition

10. Summary

Editing a Single Server in a Managed Server Environment

(WebLogic and WebSphere) Use this procedure to edit the countersand instances for asingle server in a
managed server group.

To open the Edit Monitoring Machine wizard:

1.

2
3.
4

In the Conductor, click Tools>Monitor Tasks. The Manage Monitoring Tasks dialog box appears.
Select a monitor, then click Actions>Edit Monitor. The Edit Monitor dialog box appears.

Select Edit This Server, then click OK. The Edit Existing Monitor wizard appears.

Click Next.

Note: You can open the Manage Monitoring Tasks window to edit or create atask by clicking the
browse button next to the Monitor task field.

To edit the server:

Usethe following stepsin the Edit Existing Monitor wizard:
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Discover the counters
Choose counters

Choose instances

Review Monitor Definition

Summary

Editing Instances

Use the following procedure to edit instancesif the counters you are monitoring:

Step 1: Open the Edit Instances dialog box
Sep 2: Choosetheinstancesto monitor
Sep 3: Review the monitor definition
Step 4: Save the task
Step 1: Open the Edit Instances dialog boxes:
1. In the Conductor, click Tools>Monitor Tasksto open the Manage Monitoring Taskswindow.
2. Select themachine, the counter, or the instance to edit.
3. Click Tools>Monitoring>Edit instances. The Edit Instances dialog box displays.
Step 2: Edit the instances of a counter:
1. Inthe Choose Instancesdialog box, double-click the counter group in the left-hand paneto

display the counters.

2. Select acounter and click Edit. The Select instance for counter dialog box appears.
Note: When a counter can not be edited, the Edit button isunavailable.
3. Perform the necessary edits. You can do the following:

I In the Available Instances pane, select an instance and click Add. The instanceisadded to the
Selected Instances pane. Repeat until you select all instances of the counter that you want to
apply to the task.

I In the Selected Instances pane, select an instance and click Remove. Theinstance isremoved
from the Selected Instances pane and added to the Available Instances pane.

4. Click Save. The Choose Instances dialog box displays again.
5. Repeat thisprocess for each counter you want to edit.
Click Next. The Review Monitor Definition dialog box displays.
Step 3: Review the monitor definition:
1. Review theinformation for the monitoring machine you defined.
2. Select one of the following:

I Set up another monitor for thistask - returnsto the Define Monitor dialog box so you
can add another monitor to the monitoring task.

I Continue without adding any more monitors- continuesin thisdialog box.
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(Optional) Click Save as Template to create atemplate for thismonitoring task.

4. (Optional) Select a monitor in the Monitors pane and click Remove Monitor to delete amonitor
from the task.

5. (Optional) Type anew valuein the Sample Interval field. Thisisthe frequency, in seconds, at
which QALoad requests data from ServerVantage during runtime data collection.

6. Click Next. The Summary dialog box displays.

Step 4: Save the task:

1. Review the monitorsand countersyou have selected for the task. Click Back to return to adialog
box and make changesto theinformation.

2. IntheMonitoring task name field, type aname for the monitoring task.
3. IntheDescription field, type a description for the task.

4. Select amonitorin the Monitorspane, and click View Monitor Details. The Properties of dialog
box displayswith detailed information about the monitor configuration and the countersyou
selected.

5. Click Finish to createthe monitoring task.

6. Select Enable runtime monitoring at the bottom of the window to enable the monitoring task.
Note: You also can enable monitoring in the Session node of the Visual Designer. Use the drop-down
arrow in the Monitor task field to select an existing task, then select Enable monitoring. You can open
the Manage Monitoring Taskswindow to edit or create atask by clicking the browse button next to the
Monitor task field.

Removing a Monitor or a Counter from a Monitoring Task

Remove a monitor or a counter from a monitoring task, by following this procedure.

To remove a counter from a monitoring task:

1. IntheMonitorspane of the Manage Monitoring Tasks window, select the monitor, counter, or
counter family to delete.

2. Click Actions>Remove Monitor/Counter.

3. When the verification dialog box displays, click OK.

IEl Note: You cannot remove the last monitor on amachine, the last counter in the family, or the last
family of countersin the task.

Monitoring Managed Server Environments

Monitoring Managed Server Environments

WeblLogic and WebSphere servers can be configured into managed server environments, where a multi-
server group ismanaged by an administrative server. You can create tasks and templates for managed
server environmentsusing the procedures for creating and editing monitoring tasks and selecting the
servers from which to extract data.

When you select a WebLogic or WebSphere server to monitor and QALoad detects a managed server
environment, it automatically queriesthe administrative server for the individual serversit manages. All
serversthat QALoad discoversare listed as available serversthat you can select for monitoring. You also
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can create atemplate in a managed server environment by selecting an individual server on which to
model the template.

Edit the countersand instances for asingle server in a managed server group using the procedures for
creating and editing monitoring tasks. You also can add, edit, or remove monitors managed under the
same administrative server.

Creating Monitoring Tasks for Managed Servers

Usethe New Monitoring Task wizard to create monitoring tasks for individual servers or groups of servers
in amanaged server environment. When you create a monitoring task for a managed server environment,
you select an administrative server to monitor. QALoad queriesthe administrative server for the individual
serversit manages. All serversdiscovered are listed as available for monitoring.

Note: When theinformation returned by the administrative server indicates that it does not manage
any other servers, the counter discovery process begins for the individual administrative server.

Once you select the serversto monitor, QALoad beginsthe counter discovery process for each server in
turn. Select the counters and instances of countersto monitor on the first server. QALoad includesthesein
thetask, and then beginsthe counter discovery process for the next server you selected.

Creating Monitoring Templatesfor Managed Servers

You can select countersand instances and save them to atemplate that you can use for other monitoring
tasks.

When you create atemplate in a managed server environment, you select a server on which to model the
template and adding the counters and instances of countersto the template.

QALoad queriesthe administrative server for all the serversit manages. From thislist, select the server to
use asthe model when creating the template. QALoad's New Monitoring Template wizard guides you
through the process of adding the counters and instances of countersto the template.

El Note: You can select only one server as a model for the template. If the server you select is
unavailable, you arereturned to the managed server selection dialog box to choose another server.
Editing Monitorsin a Managed Server Environment

In amanaged server environment, you can edit a single server or modify an existing group of serversin a
task.

Edit an individual server using the Edit Existing Monitor wizard. You can add or remove counters and
instancesto monitor on the server. When you edit a server group, you use the Edit an Existing Server
Group wizard. You can add monitors, edit the properties of a monitor, or remove monitors managed
under the same administrative server. You also can change the countersand instancesto monitor on an
individual machine.

ServerVantage

Overview of Server Monitoring with ServerVantage

If you are currently alicensed user of Compuware's ServerVantage, you can integrate data from your
existing ServerVantage deployment directly into a QALoad timing file.

For thismethod to be successful, the following conditions must be met:
I ServerVantage must beinstalled and configured correctly on your system.

I ServerVantage must be scheduled to monitor the specified performance countersat atime that
coincideswith arunning QALoad test.
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I You must configure the port to use for the SQL database. The port must be open on the
ServerVantage database server so that QALoad can retrieve the counter data at the conclusion of
thetest. The default SQL port is1433.

I QALoad must be ableto accessthe ServerVantage database server on port 139 or 445 viatcp to
obtain time stampsat the beginning and end of the test.

I QALoad must be ableto accessthe ServerVantage agent using an ICMP ping during the monitor
setup. If security restrictions prevent pinging the agent, an entry can be added to the host's file on
the Conductor machine mapping the domain name of the agent to the IP address of amachine
that can be pinged, such asthe Conductor.

About ServerVantage

ServerVantage (formerly ECOTOOLS) monitorsthe availability and performance of applications, databases
and servers, allowing usersto centrally manage events across all application components— Web servers,
firewalls, application servers, file systems, databases, middleware, and operating systems. ServerVantage
simultaneously monitorsthese components, analyzes both historical and real-time events, and correlates
monitored information for problem detection.

Integration with ServerVantage is configured from the QALoad Conductor. Performance counters collected
during aload test areincluded in thetest'stiming file and can be sorted and displayed in QALoad Analyze
in much the same way as QALoad timing data. For more information about installing or configuring
ServerVantage, refer to its product documentation.

Setting Up Integration with ServerVantage

Usethe following stepsto set up integration with ServerVantage:
Sep 1: Open the New Monitoring Task Wizard

Sep 2: Define and Configure the Monitor

Sep 3: Review the Monitor Definition

Sep 4: Review the Summary and Create the Task

Step 1: To open the New Monitoring Task wizard:

1. Click Tools>Monitor Tasks.

2. Click the Set up monitoring link, then select Set up a new monitoring task, then click OK to
open the New Monitoring Task wizard. Click Next.

Step 2: To define and configure the monitor:

1. IntheDefine Monitor dialog box, click the arrow in the Monitor Type box and select
ServerVantage.

2. In the Control Server Database Host field, click the down arrow and select the hostname of the
machine where the ServerVantage server islocated.

Click Next. The Configure Monitor dialog box displays.
In the Username field, type a valid user name to accessthe ServerVantage server, if necessary.

In the Password field, type the password that correspondsto the user name above, if necessary.

AN

Select the Override Default Database check box to provide the ServerVantage database name.
When thisoption isnot selected, QALoad usesthe default ServerVantage database name. If you
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provided a different name during the installation of ServerVantage, select thisoption and typethe
namein the Database Name field.

7. Inthe Namefield in the Vantage Agent area, type the hosthname of amachine(s) where a
ServerVantage Agent isinstalled, and click the Add button to add it to your load test.

8. Click Next to proceed to the next step, Review Monitor Definition.

Step 3: To review the monitor definition:

1. Review theinformation for the monitoring machine you defined.

2. Select one of the following:
I Set up another monitor for thistask - returnsto the Define Monitor dialog box so you can

add another monitor to the monitoring task.

I Continuewithout adding any more monitors - continuesin thisdialog box.

3. (Optional) In the Monitors pane, select the monitor, then click Save as Template to create a
template for thismonitoring task.

4. (Optional) In the Monitors pane, select the monitor type, then click Remove Monitor to delete a
monitor from the task.

5. (Optional) Type anew valuein the Sample Interval field. Thisisthe frequency, in seconds, at
which QALoad requests data during runtime data collection.

6. Click Next to proceed to the next step, where you review the summary and create the task.

Step 4: To review the summary and create the task:

1. Review the monitorsand countersyou have selected for the task in the Summary dialog box. Click
Back to return to adialog box and make changesto the information.

2. IntheMonitoring task name field, type aname for the monitoring task. The task is saved so you
can reuse this configuration of countersand instances.
In the Description field, type a description for the task.

4. Select amonitor in the Monitors pane, and click View Monitor Details. The Properties of dialog
box displayswith detailed information about the monitor.

5. Click Finish to createthe monitoring task. The Manage Monitoring Tasks window displays.

Displaying ServerVantage Agent Data

If you set optionsto integrate ServerVantage resource utilization data before running atest, that datais
included in theresulting timing file. It can be sorted and displayed in QALoad Analyzein much the same
way as QALoad timing data. ServerVantage data providesa summary of all the Agentsthat ServerVantage
monitored during the load test and details aggregate statistics for Agent data pointsincluding minimum,
maximum, and mean data values.

When you open atiming file containing ServerVantage Agent data, QALoad Analyze displaystest data with
QALoad timing datatwo ways:

ServerVantage Agent workstationsare listed in the Server Monitoring group in the Workspace tree-
view, under the Resource Trends (ServerVantage) branch. From the Workspace, select Agent
workstationsto create detail or graphical views of the Agent data points. Secifically, you can:

Display Agent data point details.
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Graph Agent data point details.

I Detailed data point information isdisplayed in the Datawindow. The ServerVantage detail view
includes data such asthe name of the machine where you ran the ServerVantage Agent; the Agent
name; and the minimum, maximum, and mean data values for the Agent.

=l Note: ServerVantage resource utilization datais available only if you set the ServerVantage
integration optionson the QALoad Conductor’s Test Information window before executing aload test.

ApplicationVantage

Overview of ApplicationVantage

QALoad integrates with ApplicationVantage to help you analyze network performance during aload test.
ApplicationVantage provides granular thread detailsthat allow network managersto identify poorly
performing applications. QALoad also providestest datathat you can open in ApplicationVantage.

Before QALoad can collect network data during a load test, the following must be true:

I The ApplicationVantage Agent isinstalled on the same machine asthe QALoad Conductor. You
can install either the ApplicationVantage Agent or the ApplicationVantage Remote Agent.

I You have specified on which NIC to capturein the Manage Players/ Groups dialog box in
Conductor. How?

At test time when atransaction is started, the Player configured to capture ApplicationVantage data starts
an ApplicationVantage trace. The trace stopswhen the transaction completes. When a Player isrunning a
script that isset to run in ApplicationVantage mode, every transaction generates a new trace file. At the
end of the test, these files are packaged into the test'stiming file.

' Hint: For information about ApplicationVantage, refer to the documentation you received with your
purchase of thistool.

Configuring a test to use ApplicationVantage

Integration with ApplicationVantage enablesyou to study network problemsin detail. You can set up one
or more ApplicationVantage (AV) Player machines for the load test. These AV Player machinesrun a
QALoad script on a periodic basiswhile the AV Agent capturesthe network traffic that the script produces.
Theresulting AV trace files (*.opx) are sent back to the Conductor with the regular QALoad timing file for
analysis after the test iscomplete.

To enable ApplicationVantage, you must be running ApplicationVantage 10.0 or greater. You must enable
ApplicationVantage in the Propertieswindow, and set the Network Interface Card (NIC) Name used by the
machine on which the datais captured.

Enabling ApplicationVantage

You can enable or disable the ApplicationVantage for each load test on a script. To enable
ApplicationVantage, you must select the option, and then set the Network Interface Card (NIC) Name.

To enable ApplicationVantage:

1. Click thescripticon § for the appropriate script in the Visual Designer window. The Script
Properties panel appearson theright-hand side of the window.

2. In the Sript Properties panel, click the ApplicationVantage field, then select True.
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3. Click Tools>Manage Players.

4. If necessary, set the NIC Name.

Setting up Network Interface Card Name

To usethe ApplicationVantage Agent to collect data for ApplicationVantage, it isnecessary to specify
which Network Interface Card (NIC) to capture on. Thisisthe network information for the workstation
where your ApplicationVantage Remote Agent isinstalled.

To set up NIC Name:

1. On the Conductor'stoolbar, select Tools>SManage Player. The Manage Players/Groups dialog box
displayswith names of available Player machineslisted in the Players area.

2. Click the Player machine that will berunning the virtual user to be captured. The information for
that Player machine displaysin the Player Information area.

If necessary, click the button next to Application Vantage Settingsto expand the information.
4. From thedrop-down list in the NIC Name field, select the NIC that isused by the machine.
Click Save, then click OK.

ClientVantage

Overview of ClientVantage

ClientVantage manages end-user application performance and availability. Problems can be diagnosed by
powerful fault detection and analysis capabilities as well as resource monitoring.

ClientVantage must beinstalled on the same Windows workstation asthe QALoad Conductor and the
QALoad Player.

Vantage Analyzer

Vantage Analyzer Integration

Vantage Analyzer isdesigned for easy resolution of complex application performance issues. It enables you
to easily drill into specific problem transactionsto determine the cause of bottlenecksin your production
applications. It also enables you to find Java code and SQL statementsthat are consuming excessive
resources. Troublesome memory leaksthat are observed in your actual production servers can be quickly
resolved.

If you are currently alicensed user of Compuware's Vantage Analyzer, you can integrate data from your
existing Vantage Analyzer deployment directly into a QALoad timing file.

For thismethod to be successful, the following conditions must be met:

! Vantage Analyzer 10.1 SP1 must be installed and configured correctly on the same machine as
QALoad Analyze. For more information about installing or configuring Vantage Analyzer, refer to
its product documentation.

I Timehasto be synchronized between the QALoad Conductor machine and the Vantage Analyzer
Nucleus Server machine to make testing data more meaningful. The difference of the time between
thetwo machinesissaved in atiming file.
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Setting Up Integration with Vantage Analyzer

To set up integration with Vantage Analyzer:

542

1.

Open or create a session in the Conductor. From the Tools menu, choose Monitor Tasks. The
Manage Monitoring Tasks dialog box displays.

Click the Set up monitoring link and select Set up a new monitoring task. Click OK. If the
Welcometo the New Monitoring Task Wizard appears, click Next.

In the Define Monitor dialog box, click the arrow in the Monitor type box and select Vantage
Analyzer.

In the Nucleus Server Name or IP address field, type or select the machine host name or IP address
of themachine where the Vantage Analyzer Nucleus server runs.

Click Next. The Configure Monitor Dialog box displays.

In the Username field, typethe login user ID for the Vantage Analyzer Nucleus server machine
(not the Nucleus server itself).

In the Password field, type the login password for the Vantage Analyzer Nucleus server machine
(not the Nucleus server itself).

Click Next. The Review Monitor Definition dialog box displays.
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